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⽂档⽬录

API ⽂档
公共请求头部

公共响应头部

存储桶配置

绑定数据万象服务

查询数据万象服务

解绑数据万象服务

查询防盗链

设置防盗链

开通原图保护

查询原图保护状态

关闭原图保护

图⽚处理

基础图⽚处理

缩放

裁剪

旋转

格式转换

质量变换

⾼斯模糊

亮度

对⽐度

锐化

灰度图

图⽚⽔印

⽂字⽔印

获取图⽚基本信息

获取图⽚ EXIF
获取图⽚主⾊调

去除元信息

快速缩略模板

管道操作符

限制图⽚⼤⼩

⽀持字体列表

图⽚样式
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增加样式

查询样式

删除样式

图⽚压缩

Guetzli 压缩
开通 Guetzli 压缩
查询 Guetzli 状态
关闭 Guetzli 压缩

WebP 压缩
HEIF 压缩
TPG 压缩
AVIF 压缩
⾼级压缩

SVG 压缩
图⽚持久化处理

盲⽔印

异常图⽚检测

队列接⼝

查询队列

更新队列

AI 内容识别
⼈脸识别

⼈脸特效

⼈脸核⾝

⾝份证识别

图⽚⽂字识别（OCR）
通⽤⽂字识别

语⾳识别

任务接⼝

提交语⾳识别任务

查询指定的语⾳识别任务

批量拉取语⾳识别任务

队列接⼝

查询语⾳识别队列

更新语⾳识别队列

以图搜图

开通以图搜图

添加图库图⽚
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图⽚搜索接⼝

删除图库图⽚

队列接⼝

查询队列

更新队列

服务配置

开通 AI 内容识别
查询 AI 内容识别

智能语⾳

智能语⾳接⼝列表

智能语⾳服务配置接⼝

查询语⾳识别开通状态

媒体处理

媒体处理接⼝列表

媒体处理服务配置接⼝

查询媒体处理服务

绑定媒体处理服务

解绑媒体处理服务

媒体 bucket 接⼝
查询媒体处理开通状态

开通媒体处理

CreateMediaBucket
队列接⼝

搜索媒体处理队列

更新媒体处理队列

同步媒体处理

获取媒体截图

获取媒体⽂件截图

获取媒体⽂件截图（万象域名）

GenerateSnapshot
获取媒体信息

获取媒体⽂件信息

读取私有 M3U8
获取私有 m3u8

内容审核

⾳频审核

提交⾳频审核任务

⽂本审核
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⽂本内容同步审核

⽂档预览

查询⽂档预览开通状态

⽂档转码

同步请求接⼝

异步处理任务接⼝

提交⽂档转码任务

查询指定的⽂档转码任务

拉取符合条件的⽂档转码任务

异步处理队列接⼝

查询⽂档转码队列

更新⽂档转码队列

⽂档转 HTML
快速⼊门

⾃定义配置概述

配置项说明

⾼级功能

更新⽇志

⽂件处理

⽂件哈希值计算

哈希值计算同步请求

提交哈希值计算任务

查询哈希值计算结果

⽂件解压

提交⽂件解压任务

查询⽂件解压结果

多⽂件打包压缩

提交多⽂件打包压缩任务

查询多⽂件打包压缩结果

任务与⼯作流

⼯作流接⼝

创建⼯作流

查询⼯作流

删除⼯作流

更新⼯作流

测试⼯作流

⼯作流回调

⼯作流实例
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获取⼯作流实例详情

获取⼯作流实例详情列表

任务接⼝

媒体处理

提交媒体处理任务

提交视频转动图任务

提交视频拼接任务

提交添加数字⽔印任务

提交提取数字⽔印任务

提交获取媒体信息任务

提交⾳频降噪任务

提交视频质量评分任务

提交 SDRtoHDR 任务
提交转封装任务

提交智能封⾯任务

提交视频截帧任务

提交流分离任务

提交超分辨率任务

提交⾳视频转码任务

提交语⾳合成任务

提交精彩集锦任务

提交视频增强任务

提交视频标签任务

提交⼈声分离任务

提交极速⾼清任务

取消媒体处理任务

CancelMediaJob
查询媒体处理任务

DescribeMediaJob
DescribeMediaJobs

媒体处理任务回调

视频转动图

⾳视频拼接

添加数字⽔印

提取数字⽔印

获取媒体信息

降噪

视频质量评分
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SDRtoHDR
转封装（⾳视频分段）

智能封⾯

截帧

流分离

超分辨率

⾳视频转码

语⾳合成

精彩集锦

视频增强

视频标签

⼈声分离

极速⾼清转码

图⽚处理

提交图⽚处理任务

CreatePicJobs
取消图⽚处理任务

CancelPicJob
查询图⽚处理任务

DescribePicJob
DescribePicJobs

图⽚处理回调

多任务处理

提交多任务处理

MultiJobs
AI 内容识别
提交内容识别任务

提交翻译任务

提交语⾳识别任务

提交分词任务

取消内容识别任务

查询内容识别任务

查询内容识别任务

批量拉取内容识别任务

内容识别任务回调

翻译任务回调

分词任务回调

模板接⼝
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媒体处理

创建媒体处理模板

创建动图模板

创建拼接模板

创建极速⾼清转码模板

创建截图模板

创建超分辨率模板

创建⾳视频转码模板

创建转码 pro 模板
创建语⾳合成模板

创建精彩集锦模板

创建视频增强模板

创建⼈声分离模板

创建⽔印模板

创建智能封⾯模板

删除媒体处理模板

DeleteMediaTemplate
查询媒体处理模板

DescribeMediaTemplates
媒体处理

更新动图模板

更新拼接模板

更新极速⾼清转码模板

更新截图模板

更新超分辨率模板

更新⾳视频转码模板

⾳视频转码 pro
更新语⾳合成模板

更新精彩集锦模板

更新视频增强模板

更新⼈声分离模板

更新⽔印模板

更新智能封⾯模板

AI 内容识别
创建 AI 内容识别模板
创建语⾳识别模板

查询 AI 内容识别模板
DescribeTemplates



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第10 共2247⻚

更新 AI 内容识别模板
更新语⾳识别模板

批量任务接⼝

触发任务（独⽴节点）

触发任务（⼯作流）

取消任务

查询任务

批量拉取任务

错误码

附录

结构体
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API ⽂档
公共请求头部
最近更新时间：2024-01-18 09:33:22

描述

此篇⽂档将为您介绍在使⽤ API 时候会使⽤到的公共请求头部（Request Header），下⽂提到的头部在之后的具体 
API ⽂档中不再赘述。

请求头部列表

Header 名称 描述 类型 是否必选

Authorization 携带鉴权信息，⽤以验证请求合法性的签名信

息。
string 是。

Content-Length
RFC 2616 中定义的 HTTP 请求内容⻓度（字
节）。

integer
否。针对 PUT 和 POST 
请求，此头部是必选

项。

Content-Type
RFC 2616 中定义的 HTTP 请求内容类型
（MIME），例如 application/xml。 string

否。针对有请求体的 
PUT 和 POST 请求，此
头部是必选项。

Content-MD5

RFC 1864 中定义的经过 Base64 编码的请求
体内容 MD5 哈希值，例如 
ZzD3iDJdrMAAb00lgLLeig==。此头部⽤于完
整性检查，验证请求体在传输过程中是否发⽣

变化。

string 否。

Date RFC 1123 中定义的 GMT 格式当前时间，例
如 Wed, 29 May 2019 04:10:12 GMT。

string 否。

Host 请求的主机，形式为 <BucketName-
APPID>.ci.<Region>.myqcloud.com

string 是。

x-ci-security-
token

使⽤临时安全凭证时需要传⼊的安全令牌字

段。
string

否。当使⽤临时密钥并

通过 Authorization 携带
鉴权信息时，此头部为

必选项。
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公共响应头部
最近更新时间：2024-01-18 09:33:22

描述

此篇⽂档将为您介绍在使⽤ API 时候会出现的公共返回头部（Response Header），下⽂提到的头部会在之后的具
体 API ⽂档中不再赘述。

响应头部列表

Header 名称 描述 类型

Content-Length RFC 2616 中定义的 HTTP 响应内容⻓度（字节）。 string

Content-Type RFC 2616 中定义的 HTTP 响应内容类型
（MIME）。

string

Connection RFC 2616 中定义，表明响应完成后是否会关闭⽹络
连接。枚举值：keep-alive，close。

Enum

Date RFC 1123 中定义的 GMT 格式服务端响应时间，例
如Wed, 29 May 2019 04:10:12 GMT。

string

Server 接受请求并返回响应的服务器的名称，默认值：

tencent-ci。
string

x-ci-request-id 每次请求发送时，服务端将会⾃动为请求⽣成⼀个 
ID。

string

x-ci-trace-id 每次请求出错时，服务端将会⾃动为这个错误⽣成⼀

个ID。仅当请求出错时才会在响应中包含此头部。
string
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存储桶配置

绑定数据万象服务
最近更新时间：2024-01-18 09:33:22

功能描述

⽤于开通数据万象服务，需要绑定对象存储（Cloud Object Storage，COS）上已有的存储桶。存储桶的其他功能如
查询、修改等，使⽤ COS 的 API 接⼝。

请求

请求⽰例
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PUT / HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明：

 Authorization：Auth String （详情参阅 请求签名 ⽂档）。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728
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请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应的响应体为空。

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第17 共2247⻚

查询数据万象服务
最近更新时间：2024-01-18 09:33:22

功能描述

⽤于查询该 Bucket 是否已开通数据万象服务。

请求

请求⽰例
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GET / HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

 Authorization： Auth String （详情参阅 请求签名 ⽂档）。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728
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请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

https://www.tencentcloud.com/document/product/436/7729
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<?xml version="1.0" encoding="UTF-8" ?>

<CIStatus>on</CIStatus>

节点信息如下：

节点名称（关键字） 描述

CIStatus on 与 off 两种状态
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解绑数据万象服务
最近更新时间：2024-01-18 09:33:22

功能描述

解绑开通数据万象服务的 Bucket（Bucket 及桶中⽂件会保留在对象存储（Cloud Object Storage，COS））。

请求

请求⽰例
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PUT /?unbind HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

 Authorization：Auth String （详情参阅 请求签名 ⽂档）。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728
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请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应的响应体为空。

https://www.tencentcloud.com/document/product/436/7729
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查询防盗链
最近更新时间：2024-01-18 09:33:22

功能描述

⽤于查询 Bucket 中防盗链详情（⿊⽩名单）。

请求

请求⽰例
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GET /?hotlink HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

 Authorization：Auth String （详情参阅 请求签名 ⽂档）。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728
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请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

具体内容包括防盗链的种类并枚举所有地址。

https://www.tencentcloud.com/document/product/436/7729
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<?xml version="1.0" encoding="UTF-8" ?>

<Hotlink>

    <Status>on</Status>

    <Type>white</Type>

    <Url>xxx</Url>

    <Url>xxx</Url>

</Hotlink>
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设置防盗链
最近更新时间：2024-01-18 09:33:22

功能描述

⽤于对存储桶添加防盗链（设置⿊⽩名单）。

请求

请求⽰例
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PUT /?hotlink HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

Authorization: Auth String （详情请参⻅ 请求签名 ⽂档）。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第30 共2247⻚

请求体

该请求的请求体具体节点内容为：

<Hotlink>

        <Url>xxxxx</Url>

        <Type>black</Type>

</Hotlink>>

具体内容描述如下：

名称 ⽗节点 描述 类型 是否必选



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第31 共2247⻚

Url Hotlink 域名地址 Container 是

Type Hotlink 防盗链类型，white 为⽩名单，black 为⿊名单，off 为关
闭。

String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为空。

实际案例

请求

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第32 共2247⻚

PUT /?hotlink HTTP/1.1

Host: examplebucket-1250000000.pic.ap-chengdu.myqcloud.com

Date: Wed, 18 Mar 2000 06:57:54 GMT

Authorization: XXXXXXXXXXXX

<Hotlink>

        <Url>www.example.com</Url>

        <Type>black</Type>

</Hotlink>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第33 共2247⻚

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Fri, 25 Feb 2017 04:10:22 GMT

Server: tencent-cos

x-cos-request-id: NTg3ZjFjMmJfOWIxZjRlXzZmNDhf****



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第34 共2247⻚

开通原图保护
最近更新时间：2024-01-18 09:33:22

功能描述

对 Bucket 开通原图保护功能。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第35 共2247⻚

PUT /?origin-protect HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

 Authorization：Auth String （详情参阅 请求签名 ⽂档）。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第36 共2247⻚

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应的响应体为空。

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第37 共2247⻚

查询原图保护状态
最近更新时间：2024-01-18 09:33:22

功能描述

⽤于查询原图保护功能是否开启。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第38 共2247⻚

GET /?origin-protect HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

 Authorization：Auth String （详情参阅 请求签名 ⽂档）。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第39 共2247⻚

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第40 共2247⻚

<?xml version="1.0" encoding="UTF-8" ?>

<OriginProtectStatus>on</OriginProtectStatus>

节点名称（关键字） 描述

OriginProtectStatus on 与 off 两种状态。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第41 共2247⻚

关闭原图保护
最近更新时间：2024-01-18 09:33:22

功能描述

⽤于关闭原图保护功能。

请求

请求语法



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第42 共2247⻚

DELETE /?origin-protect HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

 Authorization：Auth String （详情参阅 请求签名 ⽂档）。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第43 共2247⻚

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应的响应体为空。

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第44 共2247⻚

图⽚处理

基础图⽚处理

缩放
最近更新时间：2024-01-18 15:11:51

功能概述

腾讯云数据万象通过 imageMogr2 接⼝提供图⽚缩放功能。处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素
且总像素不超过2.5亿像素，处理结果图宽⾼设置不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。
该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第45 共2247⻚

GET /<ObjectKey>?imageMogr2/thumbnail/<imageSizeAndOffsetGeometry> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第46 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/thumbnail/<imageSizeAndOffsetGeometry>"

  }]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第47 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第48 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/thumbnail/<imageSizeAndOffsetGeometry>"

  }]

}

处理参数说明

操作名称：thumbnail。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/thumbnail/!<Scale>p 指定图⽚的宽⾼为原图的 Scale%

/thumbnail/!<Scale>px 指定图⽚的宽为原图的 Scale%，⾼度不变

/thumbnail/!x<Scale>p 指定图⽚的⾼为原图的 Scale%，宽度不变

/thumbnail/<Width>x 指定⽬标图⽚宽度为 Width，⾼度等⽐缩放

/thumbnail/x<Height> 指定⽬标图⽚⾼度为 Height，宽度等⽐缩放

/thumbnail/<Width>x<Height> 限定缩略图的宽度和⾼度的最⼤值分别为 Width 和 Height，进⾏等⽐缩放

/thumbnail/<Width>x<Height>>
限定缩略图的宽度和⾼度的最⼤值分别为 Width 和 Height，进⾏等⽐缩⼩，
⽐例值为宽缩放⽐和⾼缩放⽐的较⼩值，如果⽬标宽（⾼）都⼤于原图宽

（⾼），则不变

/thumbnail/<Width>x<Height><
限定缩略图的宽度和⾼度的最⼤值分别为 Width 和 Height，进⾏等⽐放⼤，
⽐例值为宽缩放⽐和⾼缩放⽐的较⼩值。如果⽬标宽(⾼)⼩于原图宽(⾼)，则
不变

/thumbnail/!
<Width>x<Height>r

限定缩略图的宽度和⾼度的最⼩值分别为 Width 和 Height，进⾏等⽐缩放

/thumbnail/<Width>x<Height>! 忽略原图宽⾼⽐例，指定图⽚宽度为 Width，⾼度为 Height，强⾏缩放图
⽚，可能导致⽬标图⽚变形

/thumbnail/<Area>@ 等⽐缩放图⽚，缩放后的图像，总像素数量不超过 Area



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第49 共2247⻚

/pad/ 将原图缩放为指定 Width 和 Height 的矩形内的最⼤图⽚，之后使⽤ color 参
数指定的颜⾊居中填充空⽩部分；取值0或1，0代表不使⽤ pad 模式，1代表
使⽤ pad 模式

/color/ 填充颜⾊，缺省为⽩⾊，需设置为⼗六进制 RGB 格式（如 #FF0000），详
情参考 RGB 编码表，需经过 URL 安全的 Base64 编码，默认值为 #FFFFFF

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场

景，会直接返回原图⽽不报错

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。
原图如下：

案例⼀：缩放宽⾼

假设缩放图⽚宽⾼为原图50%，⽰例如下：

https://www.rapidtables.com/web/color/RGB_Color.html
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第50 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第51 共2247⻚

案例⼆：缩放宽度，⾼度不变

假设缩放指定图⽚宽度为原图50%，⾼度不变，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第52 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第53 共2247⻚

案例三：Pad 模式缩放

将原图缩放为600 x 600的矩形内的最⼤图⽚，并使⽤指定颜⾊填充空⽩部分，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第54 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第55 共2247⻚

案例四：Pad 模式缩放并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第56 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature> 为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第57 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第58 共2247⻚

裁剪
最近更新时间：2024-01-18 15:11:51

功能概述

腾讯云数据万象通过 imageMogr2 接⼝提供裁剪功能，包括普通裁剪、缩放裁剪、内切圆裁剪、圆⾓裁剪和⼈脸智
能裁剪。

该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

限制说明

⽀持格式：⽀持处理 JPG、BMP、GIF、PNG、WEBP 格式，并且⽀持 HEIF 格式的解码和处理操作。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置

不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。
动图帧数限制：gif 帧数限300帧。

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第59 共2247⻚

GET /<ObjectKey>?imageMogr2/cut/<width>x<height>x<dx>x<dy>

                           /crop/<imageSizeAndOffsetGeometry>

                           /iradius/<radius>

                           /rradius/<radius>

                           /scrop/<Width>x<Height> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第60 共2247⻚

 请忽略上⾯的空格与换⾏符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第61 共2247⻚

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cut/<width>x<height>x<dx>x<dy>

                       /crop/<imageSizeAndOffsetGeometry>

                       /iradius/<radius>

                       /rradius/<radius>

                       /scrop/<Width>x<Height>"

  }]

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第62 共2247⻚

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cut/<width>x<height>x<dx>x<dy>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第63 共2247⻚

                       /crop/<imageSizeAndOffsetGeometry>

                       /iradius/<radius>

                       /rradius/<radius>

                       /scrop/<Width>x<Height>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会

直接返回原图⽽不报错

普通裁剪参数说明

操作名称：cut。

参数 含义

<width> 指定⽬标图⽚的宽为 width

<height> 指定⽬标图⽚的⾼为 height

<dx> 相对于图⽚左上顶点⽔平向右偏移 dx

<dy> 相对于图⽚左上顶点⽔平向下偏移 dy

说明：

 参数取值范围应⼤于0，⼩于原图宽⾼。

缩放裁剪参数说明

操作名称：crop。

参数 含义

/crop/<Width>x 指定⽬标图⽚宽度为 Width，⾼度不变。Width 取值范围应⼤于0，⼩于原图宽度

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第64 共2247⻚

/crop/x<Height> 指定⽬标图⽚⾼度为 Height，宽度不变。Height 取值范围应⼤于0，⼩于原图⾼度

/crop/<Width>x<Height> 指定⽬标图⽚宽度为 Width，⾼度为 Height 。Width 和 Height 取值范围都应⼤于
0，⼩于原图宽度/⾼度

在进⾏缩放裁剪操作时，您也可以使⽤ gravity 参数指定操作的起点位置，详⻅下⽂中 缩放裁剪操作⽰例。

内切圆裁剪参数说明

操作名称：iradius。

参数 含义

/iradius/<radius> 内切圆裁剪功能，radius 是内切圆的半径，取值范围为⼤于0且⼩于原图最⼩边⼀半
的整数。内切圆的圆⼼为图⽚的中⼼。图⽚格式为 gif 时，不⽀持该参数。

圆⾓裁剪参数说明

操作名称：rradius。

参数 含义

/rradius/<radius> 圆⾓裁剪功能，radius 为图⽚圆⾓边缘的半径，取值范围为⼤于0且⼩于原图最⼩边
⼀半的整数。圆⾓与原图边缘相切。图⽚格式为 gif 时，不⽀持该参数。

⼈脸智能裁剪参数说明

操作名称：scrop。

参数 含义

/scrop/<Width>x<Height> 基于图⽚中的⼈脸位置进⾏缩放裁剪。⽬标图⽚的宽度为 Width、⾼度为 
Height。

九宫格⽅位图

九宫格⽅位图可为图⽚的多种操作提供位置参考。红点为各区域位置的原点（通过 gravity 参数选定各区域后位移操
作会以相应远点为参照）。  



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第65 共2247⻚

注意：

当 gravity 参数设置为 center 时，dx、dy 参数⽆效。

当 gravity 参数设置为 north 或 south 时，dx 参数⽆效（⽔印会⽔平居中）。
当 gravity 参数设置为 west 或 east 时，dy 参数⽆效（⽔印会垂直居中）。

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：普通裁剪

相对于图⽚左上顶点⽔平向右平移100像素，垂直向下平移10像素，指定⽬标图⽚⼤⼩为600×600进⾏裁剪：

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第66 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/cut/

原图如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第67 共2247⻚

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第68 共2247⻚

案例⼆：缩放裁剪

假设以中⼼点 center 为参考点，缩放裁剪⾄300×400，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第69 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/crop

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第70 共2247⻚

案例三：内切圆裁剪

取半径为200，进⾏内切圆裁剪：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第71 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/irad

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第72 共2247⻚

案例四：圆⾓裁剪

取半径为100，进⾏圆⾓裁剪：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第73 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/rrad

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第74 共2247⻚

案例五：⼈脸智能裁剪

基于图⽚中的⼈脸位置进⾏缩放裁剪，⽬标图⽚⼤⼩为100×600，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第75 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/scro

说明：

如果图⽚中没有识别到⼈脸，则返回原图。

案例六：⼈脸智能裁剪并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第76 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature> 为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第77 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第78 共2247⻚

旋转
最近更新时间：2024-01-18 15:11:51

功能概述

腾讯云数据万象通过 imageMogr2 接⼝提供旋转功能，包括普通旋转和⾃适应旋转。
该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

限制说明

⽀持格式：⽀持处理 JPG、BMP、GIF、PNG、WEBP 格式，并且⽀持 HEIF 格式的解码和处理操作。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接⼝形式

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第79 共2247⻚

GET /<ObjectKey>?imageMogr2/rotate/<rotateDegree>

               /auto-orient HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

注意：

 请忽略上⾯的空格与换⾏符。

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第80 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/rotate/<rotateDegree>

                       /auto-orient"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第81 共2247⻚

  }]

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第82 共2247⻚

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/rotate/<rotateDegree>

                       /auto-orient"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/rotate/<rotateDegree> 普通旋转：图⽚顺时针旋转⾓度，取值范围0 - 360，默认不旋转。

/auto-orient ⾃适应旋转：根据原图 EXIF 信息将图⽚⾃适应旋转回正。

/flip/<flip> 镜像翻转：flip 值为 vertical 表⽰垂直翻转，horizontal 表⽰⽔平翻转

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直

接返回原图⽽不报错

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：普通旋转

顺时针旋转90度，⽰例如下：

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第83 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/rota

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第84 共2247⻚

案例⼆：普通旋转并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第85 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第86 共2247⻚

为了防⽌未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第87 共2247⻚

格式转换
最近更新时间：2024-01-18 15:11:51

功能概述

腾讯云数据万象通过 imageMogr2 接⼝提供格式转换、gif 格式优化、渐进显⽰功能。
该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

限制说明

gif、webp、tpg 等动图，⽀持互相转换。
jpg、png、bmp、tpg、heif 等静态图⽚，⽀持互相转换。

接⼝形式

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第88 共2247⻚

GET /<ObjectKey>?imageMogr2/format/<Format>

               /cgif/<FrameNumber>

               /interlace/<Mode> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第89 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>

                       /cgif/<FrameNumber>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第90 共2247⻚

                       /interlace/<Mode>"

  }]

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第91 共2247⻚

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>

                       /cgif/<FrameNumber>

                       /interlace/<Mode>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/format/<Format> 格式转换：⽬标缩略图的图⽚格式可为：jpg，bmp，gif，png，webp，yjpeg 等，其
中 yjpeg 为数据万象针对 jpeg 格式进⾏的优化，本质为 jpg 格式；缺省为原图格式。

/cgif/<FrameNumber>

gif 格式优化：只针对原图为 gif 格式，对 gif 图⽚格式进⾏的优化，降帧降颜⾊。分
为以下两种情况：

FrameNumber=1，则按照默认帧数30处理，如果图⽚帧数⼤于该帧数则截取。
FrameNumber 取值( 1,100 ]，则将图⽚压缩到指定帧数 （FrameNumber）。

/interlace/<Mode>

输出为渐进式 jpg 格式。Mode 可为0或1。
0：表⽰不开启渐进式；
1：表⽰开启渐进式。
该参数仅在输出图⽚格式为 jpg 格式时有效。如果输出⾮ jpg 图⽚格式，会忽略该参
数，默认值0。

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直

接返回原图⽽不报错

实际案例

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第92 共2247⻚

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：将 jpeg 格式的原图⽚转换为 png 格式

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/form

案例⼆：将 jpeg 格式的原图⽚转换为 png 格式并携带私有⽂件签名

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第93 共2247⻚

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第94 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第95 共2247⻚

质量变换
最近更新时间：2024-01-18 15:11:51

功能概述

腾讯云数据万象通过 imageMogr2 接⼝对图⽚质量进⾏调节。
该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

说明：

 该接⼝⽀持 jpg、webp、tpg、heif、avif 格式图⽚。

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第96 共2247⻚

GET /<ObjectKey>?imageMogr2/quality/<Quality>

                           /rquality/<quality>

                           /lquality/<quality> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第97 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/quality/<Quality>

                       /rquality/<quality>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第98 共2247⻚

                       /lquality/<quality>"

  }]

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第99 共2247⻚

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/quality/<Quality>

                       /rquality/<quality>

                       /lquality/<quality>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

操作名称：quality。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/quality/<Quality>
图⽚的绝对质量，取值范围0 - 100，默认值为原图质量；取原图质量和指定质量的最⼩
值；<Quality>后⾯加“!”表⽰强制使⽤指定值，例如：  90! 。

/rquality/<quality> 图⽚的相对质量，取值范围0 - 100，数值以原图质量为标准。例如原图质量为80，将 
rquality 设置为80后，得到处理结果图的图⽚质量为64（80x80%）。

/lquality/<quality>
图⽚的最低质量，取值范围0 - 100，设置结果图的质量参数最⼩值。
例如原图质量为85，将 lquality 设置为80后，处理结果图的图⽚质量为85。
例如原图质量为60，将 lquality 设置为80后，处理结果图的图⽚质量会被提升⾄80。

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直接返

回原图⽽不报错

实际案例

说明：

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第100 共2247⻚

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：设置绝对质量

假设设置绝对质量为60，⽰例如下：

http://examples-1251000004.picsh.myqcloud.com/sample.jpeg?imageMogr2/quality/60

效果如下：

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第101 共2247⻚

案例⼆：设置相对质量

假设设置相对质量为60，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第102 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/rqua

效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第103 共2247⻚

案例三：设置相对质量为60并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第104 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature> 为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第105 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第106 共2247⻚

⾼斯模糊
最近更新时间：2024-01-18 15:11:51

功能概述

腾讯云数据万象通过 imageMogr2 接⼝对图⽚进⾏模糊处理。
该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

限制说明

⽀持格式：⽀持处理 JPG、BMP、GIF、PNG、WEBP 格式，并且⽀持 HEIF 格式的解码和处理操作。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第107 共2247⻚

GET /<ObjectKey>?imageMogr2/blur/<radius>x<sigma>  HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第108 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/blur/<radius>x<sigma>"

  }]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第109 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第110 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/blur/<radius>x<sigma>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

操作名称：blur。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

radius<radius> 模糊半径，取值范围为1 - 50

sigma<sigma> 正态分布的标准差，必须⼤于0

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直接返回

原图⽽不报错

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可参⻅ 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：模糊半径取8，sigma 值取5，进⾏⾼斯模糊处理

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第111 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/blur

⾼斯模糊处理后效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第112 共2247⻚

案例⼆：模糊半径取8，sigma 值取5，进⾏⾼斯模糊处理，并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第113 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第114 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第115 共2247⻚

亮度
最近更新时间：2024-01-18 15:11:51

功能概述

腾讯云数据万象通过 imageMogr2 接⼝调节图⽚亮度。
该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

限制说明

⽀持格式：⽀持处理 JPG、BMP、GIF、PNG、WEBP 格式，并且⽀持 HEIF 格式的解码和处理操作。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第116 共2247⻚

GET /<ObjectKey>?imageMogr2/bright/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第117 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/bright/<value>"

  }]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第118 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第119 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/bright/<value>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

操作名称：bright。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/bright/<value>

图⽚亮度调节功能，value 为亮度参数值，取值范围为[-100, 100]的整数。
取值＜0：降低图⽚亮度。
取值 = 0：不调整图⽚亮度。
取值＞0：提⾼图⽚亮度。

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直接返

回原图⽽不报错。

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：亮度调节

将图⽚亮度提⾼70，⽰例如下：

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第120 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/brig

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第121 共2247⻚

案例⼆：亮度调节并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第122 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第123 共2247⻚

为了防⽌未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第124 共2247⻚

对⽐度
最近更新时间：2024-01-18 15:11:51

功能概述

对⽐度指⼀幅图像中明暗区域最亮的⽩和最暗的⿊之间不同亮度层级的测量，即指⼀幅图像灰度反差的⼤⼩。腾讯

云数据万象通过 imageMogr2 接⼝调节图⽚对⽐度。
该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

限制说明

⽀持格式：⽀持处理 JPG、BMP、GIF、PNG、WEBP 格式，并且⽀持 HEIF 格式的解码和处理操作。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置

不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。
动图帧数限制：gif 帧数限300帧。

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第125 共2247⻚

GET /<ObjectKey>?imageMogr2/contrast/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第126 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/contrast/<value>"

  }]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第127 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第128 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/contrast/<value>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

操作名称：contrast。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/contrast/<value>

图⽚对⽐度调节功能，value 为对⽐度参数值，取值范围为[-100, 100]的整数。
取值＜0：降低图⽚对⽐度。
取值 = 0：不调整图⽚对⽐度。
取值＞0：提⾼图⽚对⽐度。

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直接返

回原图⽽不报错。

实际案例

案例⼀：对⽐度调节

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。
将图⽚对⽐度降低50，⽰例如下：

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第129 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/cont

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第130 共2247⻚

案例⼆：对⽐度调节并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第131 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature> 为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第132 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第133 共2247⻚

锐化
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 imageMogr2 接⼝对图⽚进⾏锐化处理。
该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

限制说明

⽀持格式：⽀持处理 JPG、BMP、GIF、PNG、WEBP 格式，并且⽀持 HEIF 格式的解码和处理操作。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第134 共2247⻚

GET /<ObjectKey>?imageMogr2/sharpen/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第135 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/sharpen/<value>"

  }]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第136 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第137 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/sharpen/<value>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

操作名称：sharpen。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/sharpen/<value> 图⽚锐化功能，value 为锐化参数值，取值范围为10 - 300间的整数（推荐使⽤70）。参数
值越⼤，锐化效果越明显。

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直接返

回原图⽽不报错。

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：锐化

假设设置锐化参数为70，进⾏锐化处理，⽰例如下：

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第138 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/shar

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第139 共2247⻚

案例⼆：锐化并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第140 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第141 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第142 共2247⻚

灰度图
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 imageMogr2/grayscale 接⼝将图⽚设置为灰度图。

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第143 共2247⻚

GET /<ObjectKey>?imageMogr2/grayscale/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第144 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/grayscale/<value>"

  }]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第145 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第146 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/grayscale/<value>"

  }]

}

处理参数说明

操作名称：grayscale。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/grayscale/<value> 将图⽚设置为灰度图。

value 取值为0表⽰不改变图⽚。value 取值为1表⽰将图⽚变为灰度图。

/ignore-error/1 当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直接

返回原图⽽不报错。

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：转为灰度图

将图⽚变为灰度图，⽰例如下：

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第147 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/gray

最终效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第148 共2247⻚

案例⼆：锐化并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第149 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第150 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第151 共2247⻚

图⽚⽔印
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 watermark 接⼝提供图⽚⽔印处理功能。⽬前⽔印图⽚必须指定为已存储于数据万象中的图
⽚。处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置不超过
9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

说明：

⼀张图⽚上，最多添加10张不同的图⽚⽔印。
不⽀持添加动图作为⽔印。

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第152 共2247⻚

GET /<ObjectKey>?watermark/1/image/<encodedURL>

                            /gravity/<gravity>

                            /dx/<dx>

                            /dy/<dy>

                            /blogo/<type> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第153 共2247⻚

 请忽略上⾯的空格与换⾏符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第154 共2247⻚

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/1/image/<encodedURL>

                     /gravity/<gravity>

                     /dx/<dx>

                     /dy/<dy>

                     /blogo/<type>"

  }]

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第155 共2247⻚

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/1/image/<encodedURL>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第156 共2247⻚

                     /gravity/<gravity>

                     /dx/<dx>

                     /dy/<dy>

                     /blogo/<type>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

操作名称：watermark，数字1，表⽰⽔印类型为图⽚⽔印。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/image/
⽔印图⽚地址，需要经过 URL 安全的 Base64 编码。例如，⽔印图⽚为  http://examplebucke

shanghai.myqcloud.com/shuiyin_2.png ，则该处编码后的字符串

为  aHR0cDovL2V4YW1wbGVidWNrZXQtMTI1MDAwMDAwMC5jb3MuYXAtc2hhbmdoYWkubXlxY2

/gravity/ 图⽚⽔印位置，九宫格位置（参考九宫格⽅位图 ），默认值 SouthEast。

/dx/ ⽔平（横轴）边距，单位为像素，缺省值为0。

/dy/ 垂直（纵轴）边距，单位为像素，默认值为0。

/blogo/
⽔印图适配功能，适⽤于⽔印图尺⼨过⼤的场景（如⽔印墙）。共有两种类型：

当 blogo 设置为1时，⽔印图会被缩放⾄与原图相似⼤⼩后添加。
当 blogo 设置为2时，⽔印图会被直接裁剪⾄与原图相似⼤⼩后添加。

/scatype/

根据原图的⼤⼩，缩放调整⽔印图的⼤⼩：

当 scatype 设置为1时，按原图的宽缩放。
当 scatype 设置为2时，按原图的⾼缩放。
当 scatype 设置为3时，按原图的整体⾯积缩放。

/spcent/

与 scatype 搭配使⽤：
当 scatype 设置为1时，该有效值为[1,1000]，单位为千分⽐。
当 scatype 设置为2时，该有效值为[1,1000]，单位为千分⽐。
当 scatype 设置为3时，该有效值为[1,250]，单位为千分⽐。⽰例：  http://examples-125100

shanghai.myqcloud.com/sample.jpeg?watermark/1/image/xxxxxxx/scatype/3/spc

/dissolve/ 图⽚⽔印的透明度，取值为1 - 100，默认90（90%不透明度）。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/33430


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第157 共2247⻚

/batch/ 平铺⽔印功能，可将图⽚⽔印平铺⾄整张图⽚。值为1时，表⽰开启平铺⽔印功能。

/degree/ 当 batch 值为1时⽣效。图⽚⽔印的旋转⾓度设置，取值范围为0 - 360，默认0。

注意：

 指定的⽔印图⽚必须同时满⾜如下3个条件：  
⽔印图⽚与源图⽚必须位于同⼀个存储桶下。

URL 需使⽤ COS 域名（不能使⽤ CDN 加速域名，例如  examplebucket-

1250000000.file.myqcloud.com/shuiyin_2.png  不可⽤ ），且需保证⽔印图可访问（如果⽔印图读取权

限为私有，则需要携带有效签名）。

URL 必须以  http:// 开始，不能省略 HTTP 头，也不能填 HTTPS 头，例如  examplebucket-

1250000000.cos.ap-shanghai.myqcloud.com/shuiyin_2.png ，  https://examplebucket-

1250000000.cos.ap-shanghai.myqcloud.com/shuiyin_2.png  为⾮法的⽔印 URL。

九宫格⽅位图

九宫格⽅位图可为图⽚的多种操作提供位置参考。红点为各区域位置的原点（通过 gravity 参数选定各区域后位移操
作会以相应远点为参照）。  



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第158 共2247⻚

说明：

当 gravity 参数设置为 center 时，dx、dy 参数⽆效。

当 gravity 参数设置为 north 或 south 时，dx 参数⽆效（⽔印会⽔平居中）。
当 gravity 参数设置为 west 或 east 时，dy 参数⽆效（⽔印会垂直居中）。

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：添加图⽚⽔印

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第159 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/1/ima

添加图⽚⽔印后效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第160 共2247⻚

案例⼆：添加图⽚⽔印并设置平铺、透明度



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第161 共2247⻚

https://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/1/im

添加图⽚⽔印并设置旋转45度平铺、透明度为40%后，效果如下： 



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第162 共2247⻚

案例三：添加图⽚⽔印并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第163 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第164 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第165 共2247⻚

⽂字⽔印
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 watermark 接⼝提供实时⽂字⽔印处理功能。处理图⽚原图⼤⼩不超过32MB、宽⾼不超过
30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过
2.5亿像素。

该功能⽀持以下的处理⽅式：

下载时处理

上传时处理

云上数据处理

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第166 共2247⻚

GET /<ObjectKey>?watermark/2/text/<encodedText>

                            /font/<encodedFont>

                            /fontsize/<fontSize>

                            /fill/<encodedColor>

                            /dissolve/<dissolve>

                            /gravity/<gravity>

                            /dx/<dx>

                            /dy/<dy>

                            /batch/<type>

                            /degree/<degree>

                            /shadow/<shadow> HTTP/1.1



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第167 共2247⻚

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

 请忽略上⾯的空格与换⾏符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第168 共2247⻚

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/2/text/<encodedText>

                        /font/<encodedFont>

                        /fontsize/<fontSize>

                        /fill/<encodedColor>

                        /dissolve/<dissolve>

                        /gravity/<gravity>

                        /dx/<dx>

                        /dy/<dy>

                        /batch/<type>

                        /degree/<degree>

                        /shadow/<shadow>"

  }]

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息请参⻅ 图⽚持久化处理。

3. 云上数据处理

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第169 共2247⻚

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/2/text/<encodedText>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第170 共2247⻚

                        /font/<encodedFont>

                        /fontsize/<fontSize>

                        /fill/<encodedColor>

                        /dissolve/<dissolve>

                        /gravity/<gravity>

                        /dx/<dx>

                        /dy/<dy>

                        /batch/<type>

                        /degree/<degree>

                        /shadow/<shadow>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

操作名称：watermark，数字2，表⽰⽔印类型为⽂字⽔印。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/text/ ⽔印内容，需要经过 URL 安全的 Base64 编码

/font/ ⽔印字体，需要经过 URL 安全的 Base64 编码，默认值 tahoma.ttf 。⽔印字体列表请参⻅ ⽀
持字体列表

/fontsize/ ⽔印⽂字字体⼤⼩，单位为磅，缺省值13。如需按照原图⽚的⼤⼩⽐例缩放⽂字⽔印，请将
⽂字⽔印转换为 PNG 图⽚，并参⻅ 图⽚⽔印 ⽂档进⾏配置

/fill/ 字体颜⾊，缺省为灰⾊，需设置为⼗六进制 RGB 格式（例如 #FF0000），详情请参⻅ RGB 
编码表，需经过 URL 安全的 Base64 编码，默认值为 #3D3D3D

/dissolve/ ⽂字透明度，取值1 - 100 ，默认90（90%不透明度）

/gravity/ ⽂字⽔印位置，九宫格位置（参⻅九宫格⽅位图），默认值 SouthEast

/dx/ ⽔平（横轴）边距，单位为像素，缺省值为0

/dy/ 垂直（纵轴）边距，单位为像素，默认值为0

/batch/ 平铺⽔印功能，可将⽂字⽔印平铺⾄整张图⽚。值为1时，表⽰开启平铺⽔印功能

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/1045/40681
https://www.tencentcloud.com/document/product/1045/33720
https://www.rapidtables.com/web/color/RGB_Color.html
https://www.tencentcloud.com/document/product/1045/33430


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第171 共2247⻚

/degree/ 当 batch 值为1时⽣效。⽂字⽔印的旋转⾓度设置，取值范围为0 - 360，默认0

/shadow/ ⽂字阴影效果，有效值为[0,100]，默认为0，表⽰⽆阴影

九宫格⽅位图

九宫格⽅位图可为图⽚的多种操作提供位置参考。红点为各区域位置的原点（通过 gravity 参数选定各区域后位移操

作会以相应圆点为参照）。

注意：

当 gravity 参数设置为 center 时，dx、dy 参数⽆效。
当 gravity 参数设置为 north 或 south 时，dx 参数⽆效（⽔印会⽔平居中）。
当 gravity 参数设置为 west 或 east 时，dy 参数⽆效（⽔印会垂直居中）。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第172 共2247⻚

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：添加⽂字⽔印

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/2/tex

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第173 共2247⻚

添加⽂字⽔印后，效果如下：

案例⼆：添加⽂字⽔印并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第174 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参⻅ 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第175 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第176 共2247⻚

获取图⽚基本信息
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 imageInfo 接⼝查询图⽚基本信息，包括格式、⻓、宽等。

使⽤限制

待处理的图⽚，原图⼤⼩不超过32MB。
宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置不超过9999像素。

针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

接⼝⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第177 共2247⻚

download_url?imageInfo

处理参数说明

请求参数

操作名称：imageInfo。

参数 含义



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第178 共2247⻚

download_url ⽂件的访问链接，具体构成为<BucketName-APPID>.cos.
<Region>.myqcloud.com/<picture name>，<br>例如  examplebucket-
1250000000.cos.ap-shanghai.myqcloud.com/picture.jpeg 

响应参数

参数 含义

format 图⽚类型。例如 png、gif 等

width 图⽚的宽度。单位为像素（px）

height 图⽚的⾼度。单位为像素（px）

size 图⽚的⼤⼩。单位为 Bytes

md5 图⽚的 md5 值

frame_count 图⽚的帧数。静态图为1，动图为对应的帧数

实际案例

案例⼀：公有读

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第179 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageInfo

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第180 共2247⻚

{"format": "jpeg", "width": "960", "height": "540", "size": "158421", "md5": "77a16

案例⼆：私有读、携带签名

获取⽅式同上，仅增加签名部分，并与获取参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第181 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第182 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第183 共2247⻚

获取图⽚ EXIF
最近更新时间：2024-01-18 15:11:52

功能概述

EXIF（Exchangeable Image File）全称为可交换图像⽂件，可记录数码照⽚的拍摄参数、缩略图及其他属性信息。
腾讯云数据万象通过 exif 接⼝获取 EXIF 信息。处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不
超过2.5亿像素，处理结果图宽⾼设置不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

注意：

 如图⽚⽆ exif 信息，将返回  {"error" : "no exif data"} 。

接⼝⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第184 共2247⻚

GET /<ObjectKey>?exif HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

处理参数说明

操作名称：exif。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第185 共2247⻚

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

实际案例

案例⼀：公有读

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?exif



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第186 共2247⻚

案例⼆：私有读、携带签名

获取⽅式同上，仅增加签名部分，并与获取参数以“&”连接，⽰例如下：

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第187 共2247⻚

注意事项

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第188 共2247⻚

获取图⽚主⾊调
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 imageAve 接⼝获取图⽚主⾊调信息。处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素
且总像素不超过2.5亿像素，处理结果图宽⾼设置不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

接⼝⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第189 共2247⻚

GET /<ObjectKey>?imageAve HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

参数说明

操作名称：imageAve



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第190 共2247⻚

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

实际案例

案例⼀：公有读

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第191 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageAve

响应

{"RGB": "0x736246"}

案例⼆：私有读、携带签名

获取⽅式同上，仅增加签名部分，并与获取参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第192 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第193 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第194 共2247⻚

去除元信息
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 imageMogr2 接⼝可去除图⽚元信息，包括 exif 信息。
该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

限制说明

⽀持格式：⽀持处理 JPG、BMP、GIF、PNG、WEBP 格式，并且⽀持 HEIF 格式的解码和处理操作。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第195 共2247⻚

GET /<ObjectKey>?imageMogr2/strip HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第196 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/strip"

  }]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第197 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第198 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/strip"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

操作名称：strip。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/ignore-
error/1

当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直接返回原

图⽽不报错

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：公有读

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第199 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/stri

案例⼆：私有读、携带签名

处理⽅式同上，仅增加签名部分，并与图⽚处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第200 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第201 共2247⻚

为了防⽌未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第202 共2247⻚

快速缩略模板
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 imageView2 接⼝提供常⽤图⽚处理模板。开发者根据业务需求，只需在下载 URL 后⾯附加相
应的参数，就可以⽣成相应的缩略图。处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿
像素，处理结果图宽⾼设置不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素，动图 gif 帧数限300

帧。

该功能⽀持以下处理⽅式：

下载时处理

上传时处理

云上数据处理

接⼝⽰例

1. 下载时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第203 共2247⻚

GET /<ObjectKey>?imageView2/<mode>/w/<Width>

                                  /h/<Height>

                                  /format/<Format>

                                  /q/<Quality>

                                  /rq/<Quality>

                                  /lq/<Quality> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

注意：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第204 共2247⻚

 质量变换参数仅针对 jpg 和 webp 格式图⽚。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第205 共2247⻚

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageView2/<mode>/w/<Width>

                 /h/<Height>

                 /format/<Format>

                 /q/<Quality>

                 /rq/<Quality>

                 /lq/<Quality>"

  }]

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第206 共2247⻚

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageView2/<mode>/w/<Width>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第207 共2247⻚

                 /h/<Height>

                 /format/<Format>

                 /q/<Quality>

                 /rq/<Quality>

                 /lq/<Quality>"

  }]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/1/w/<Width>/h/<Height>

限定缩略图的宽⾼最⼩值。该操作会将图像等⽐缩放直⾄某⼀边达到设定

最⼩值，之后将另⼀边居中裁剪⾄设定值。若只指定⼀边，则表⽰宽⾼相

等的正⽅形。

例如，原图⼤⼩为1000x500，将参数设定为 ?imageView2/1/w/500/h/400 
后，图像会先等⽐缩放⾄800x400，之后左右各裁剪150，得到500x400⼤
⼩的图像

/2/w/<Width>/h/<Height>

限定缩略图的宽⾼最⼤值。该操作会将图像等⽐缩放⾄宽⾼都⼩于设定最

⼤值。

例如，原图⼤⼩为 1000x500，将参数设定为 ?imageView2/2/w/500/h/400 
后，图像会等⽐缩放⾄500x250。如果只指定⼀边，则另⼀边⾃适应

/3/w/<Width>/h/<Height>

限定缩略图的宽⾼最⼩值。该操作会将图像等⽐缩放⾄宽⾼都⼤于设定最

⼩值。

例如，原图⼤⼩为 1000x500，将参数设定为 ?imageView2/3/w/500/h/400 
后，图像会等⽐缩放⾄800x400。如果只指定⼀边，则另⼀边设为相同值

/4/w/<LongEdge>/h/<ShortEdge> 限定缩略图的⻓边和短边的最⼩值分别为 LongEdge 和 ShortEdge，进⾏
等⽐压缩；如果只指定⼀边，代表另外⼀边为同样的值

/5/w/<LongEdge>/h/<ShortEdge>
限定缩略图的⻓边和短边的最⼤值分别为 LongEdge 和 ShortEdge，进⾏
等⽐压缩，居中裁剪；如果只指定⼀边，则表⽰宽⾼相等的正⽅形；缩放

后其中⼀边多余的部分会被裁剪掉

/format/<Format> ⽬标缩略图的图⽚格式，Format 可为：jpg，bmp，gif，png，webp，缺
省为原图格式

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第208 共2247⻚

/q/<Quality> 图⽚质量，取值范围 0 - 100，默认值为原图质量；取原图质量和指定质量
的最⼩值；<Quality> 后⾯加!（注意为英⽂字符），表⽰强制使⽤指定值

/rq/<quality>
图⽚的相对质量，取值范围0 - 100，数值以原图质量为标准。例如原图质
量为80，将 rquality 设置为80后，得到处理结果图的图⽚质量为64
（80x80%）

/lq/<quality>

图⽚的最低质量，取值范围0 - 100，设置结果图的质量参数最⼩值。
例如，原图质量为85，将 lquality 设置为80后，处理结果图的图⽚质量为
85；
例如，原图质量为60，将 lquality 设置为80后，处理结果图的图⽚质量会
被提升⾄80

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

案例⼀：选⽤模板样式1

选⽤样式1，并限定缩略图的宽⾼最⼩值为400 × 600，绝对质量为85：

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第209 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageView2/1/w/

缩略图效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第210 共2247⻚

案例⼆：选⽤模板样式1并携带私有签名

处理⽅式同上，仅增加签名部分，并与处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第211 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第212 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第213 共2247⻚

管道操作符
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象的管道操作符  | 能够实现对图⽚按顺序进⾏多种处理。⽤户可以通过管道操作符将多个处理参数分

隔开，从⽽实现在⼀次访问中按顺序对图⽚进⾏不同处理。处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素
且总像素不超过2.5亿像素，处理结果图宽⾼设置不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

接⼝⽰例

⽤户在图⽚ URL 链接后以样式分隔符  ? 与处理样式相连接，多个处理样式之间以管道操作符  | 分隔，样式按照

先后顺序执⾏，⽬前最多⽀持10层管道。

实际案例

本次案例先将原图缩放为50%，然后在图的右下⾓添加“数据万象”的⽂字⽔印。
假设原图 URL 为：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第214 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg

原图显⽰如下：  



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第215 共2247⻚

案例⼀：对图⽚进⾏缩放并添加⽔印

⾸先增加缩放操作，则 URL 为：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第216 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

图⽚显⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第217 共2247⻚

使⽤管道操作符再添加⽂字⽔印的样式处理，则最终 URL 为：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第218 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

图⽚最终处理效果如下：  



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第219 共2247⻚

案例⼆：使⽤管道操作符并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第220 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第221 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第222 共2247⻚

限制图⽚⼤⼩
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 imageMogr2/size-limit 接⼝可限制图⽚处理（例如缩放、压缩等）后的⽂件⼤⼩。

限制说明

⽀持格式：仅⽀持对处理后为 JPG 格式的图⽚限制⼤⼩。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过50000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置

不超过50000像素。

接⼝⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第223 共2247⻚

GET /<ObjectKey>?imageMogr2/size-limit HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第224 共2247⻚

处理参数说明

操作名称：size-limit。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

size-limit

限制图⽚转换后的⼤⼩，⽀持以兆字节（m）和千字节（k）为单位
仅⽀持 JPG 格式的图⽚，可以⽤于限制处理后图⽚的⼤⼩。
 若在尾部加上  ! ，表⽰⽤处理后的图⽚⼤⼩与原图⼤⼩做⽐较，如果处理后的图⽚⽐原图

⼩，则返回处理后的图⽚，否则返回原图。例如：examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/picture.jpg?imageMogr2/size-limit/15k!
建议搭配  strip 参数使⽤，去除图⽚的⼀些冗余信息，会有更好的效果。例如：

examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/picture.png?
imageMogr2/strip/format/jpg/size-limit/15k!

/ignore-
error/1

当处理参数中携带此参数时，针对⽂件过⼤、参数超限等导致处理失败的场景，会直接返回原

图⽽不报错。

实际案例

案例⼀：转换图⽚格式并限制⼤⼩

将 PNG 图⽚转换为 JPG 格式，并限制图⽚⼤⼩为15KB，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第225 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/strip

案例⼆：转换图⽚格式、限制⼤⼩并携带私有⽂件签名

处理⽅式同上，仅增加签名部分，并与处理参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第226 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.png?q-sign-algorithm

说明：

 <signature>  为签名部分，获取⽅式请参考 请求签名。

注意事项

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第227 共2247⻚

为了避免未授权⼈员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签⼊到请求

签名中，处理参数整体是参数的 key，value 为空，如下是简单的⽰例（仅做样式参考，可能已经过期⽆法直接访
问），详细计算⽅法请参⻅ 请求签名。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://www.tencentcloud.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第228 共2247⻚

⽀持字体列表
最近更新时间：2024-01-18 15:11:52

数据万象⽀持字体列表如下。

字体名称 ⽀持语⾔

simfang仿宋.ttf 中/英

simhei⿊体.ttf 中/英

simkai楷体.ttf 中/英

simsun宋体.ttc 中/英

STHeiti Light华⽂⿊体.ttc 中/英

STHeiti Medium.ttc 中/英

幼圆.TTF 中/英

ahronbd.ttf 英⽂

arial.ttf 英⽂

ariblk.ttf 英⽂

Helvetica.dfont 英⽂

HelveticaNeue.dfont 英⽂



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第229 共2247⻚

图⽚样式

增加样式
最近更新时间：2024-01-18 15:11:52

功能描述

该接⼝⽤于对某⼀个存储桶设置样式功能，设置样式后，可以⽅便地对图⽚进⾏统⼀的处理。

说明：

 Bucket 接⼝⽬前频控存在限制要求，写请求最多1qps，读请求最多10qps。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第230 共2247⻚

PUT /?style HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

<XML File>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第231 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参阅 公共请求头部 ⽂档。

请求体

<?xml version="1.0" encoding="UTF-8" ?>

<AddStyle>

    <StyleName>string</StyleName>

    <StyleBody>string</StyleBody>

</AddStyle>

https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第232 共2247⻚

具体节点描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

AddStyle ⽆ 待添加的样式信息 Container 是

Container 节点 AddStyle 的内容：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

StyleName AddStyle 样式名称 string 是

StyleBody AddStyle 样式详情 string 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参阅 公共响应头部 ⽂档。

响应体

该响应体返回为空。

错误码

此接⼝⽆特殊错误信息，全部错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/436/7729
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第233 共2247⻚

PUT /?style HTTP/1.1

Host: examplebucket-1250000000.pic.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX

<?xml version="1.0" encoding="UTF-8" ?>

<AddStyle>

    <StyleName>style_name</StyleName>

    <StyleBody>imageMogr2/thumbnail/!50px</StyleBody>

</AddStyle>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第234 共2247⻚

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Tue, 03 Apr 2019 09:06:16 GMT

x-cos-request-id: xxxxxxxxxxxxxxxxxx



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第235 共2247⻚

查询样式
最近更新时间：2024-01-18 15:11:52

功能描述

⽤于查询该 Bucket 下已有的样式。若不使⽤请求体，则查询该 Bucket 下的全部样式，若使⽤请求体，则查询请求
体中携带的样式名信息。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第236 共2247⻚

GET /?style HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求⾏

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第237 共2247⻚

GET /?style HTTP/1.1

该 API 接⼝接受 GET 请求。

请求头

公共头部

该请求操作的实现使⽤公共请求头，了解公共请求头详情，请参阅 公共请求头部 章节。

⾮公共头部

https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第238 共2247⻚

该请求操作⽆特殊的请求头部信息。

请求体

<?xml version="1.0" encoding="UTF-8" ?>

<GetStyle>

  <StyleName>string</StyleName>

</GetStyle>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第239 共2247⻚

响应

响应头

公共响应头

该响应使⽤公共响应头，了解公共响应头详情，请参阅 公共响应头部 章节。

特有响应头

该响应⽆特殊的响应头。

响应体

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第240 共2247⻚

<StyleList>

  <StyleRule>

  <StyleName>string</StyleName>

  <StyleBody>string</StyleBody>

</StyleRule>

  <StyleRule>

  <StyleName>string</StyleName>

  <StyleBody>string</StyleBody>

</StyleRule>

</StyleList>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第241 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第242 共2247⻚

删除样式
最近更新时间：2024-01-18 15:11:52

功能描述

⽤于删除某⼀特定样式。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第243 共2247⻚

DELETE /?style HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

<XML File>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第244 共2247⻚

请求⾏

DELETE /?style HTTP/1.1

该 API 接⼝接受 DELETE 请求。

请求头

公共头部

该请求操作的实现使⽤公共请求头，了解公共请求头详情，请参阅 公共请求头部 章节。

https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第245 共2247⻚

⾮公共头部

该请求操作⽆特殊的请求头部信息。

请求体

<?xml version="1.0" encoding="UTF-8" ?>

<DeleteStyle>

  <StyleName>string</StyleName>

</DeleteStyle>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第246 共2247⻚

响应

响应头

公共响应头

该响应使⽤公共响应头，了解公共响应头详情，请参阅 公共响应头部 章节。

特有响应头

该响应⽆特殊的响应头。

响应体

该响应体返回为空。

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第247 共2247⻚

图⽚压缩

Guetzli 压缩
开通 Guetzli 压缩
最近更新时间：2024-01-18 15:11:52

功能描述

对 Bucket 开通 Guetzli 压缩功能。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第248 共2247⻚

PUT /?guetzli HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。
Guetzli 压缩⽬前暂不⽀持通过 COS 域名使⽤，请参考⽰例使⽤ pic 域名。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第249 共2247⻚

请求⾏

PUT /?guetzli HTTP/1.1

该 API 接⼝接受 PUT 请求。

请求头

公共头部

该请求操作的实现使⽤公共请求头，了解公共请求头详情，请参阅 公共请求头部 章节。

https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第250 共2247⻚

⾮公共头部

该请求操作⽆特殊的请求头部信息。

请求体

该请求的请求体为空。

响应

响应头

公共响应头

该响应使⽤公共响应头，了解公共响应头详情，请参阅 公共响应头部 章节。

特有响应头

该响应⽆特殊的响应头。

响应体

该响应体返回为空。

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第251 共2247⻚

查询 Guetzli 状态
最近更新时间：2024-01-18 15:11:52

功能描述

⽤于查询 Guetzli 压缩功能是否开启。

请求

请求语法



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第252 共2247⻚

GET /?guetzli HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求⾏

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第253 共2247⻚

GET /?guetzli HTTP/1.1

该 API 接⼝接受 GET 请求。

请求头

公共头部

该请求操作的实现使⽤公共请求头，了解公共请求头详细请参⻅ 公共请求头部 章节。

⾮公共头部

https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第254 共2247⻚

该请求操作⽆特殊的请求头部信息。

请求体

该请求的请求体为空。

响应

响应头

公共响应头

该响应使⽤公共响应头，了解公共响应头详细请参⻅ 公共响应头部 章节。

特有响应头

该响应⽆特殊的响应头。

响应体

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第255 共2247⻚

<?xml version="1.0" encoding="UTF-8" ?>

<GuetzliStatus>on</GuetzliStatus>

拥有  on  与  off  两种状态。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第256 共2247⻚

关闭 Guetzli 压缩
最近更新时间：2024-01-18 15:11:52

功能描述

⽤于关闭 Guetzli 压缩功能。

请求

请求语法



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第257 共2247⻚

DELETE /?guetzli HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求⾏

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第258 共2247⻚

DELETE /?guetzli HTTP/1.1

该 API 接⼝接受 DELETE 请求。

请求头

公共头部

该请求操作的实现使⽤公共请求头，了解公共请求头详情，请参阅 公共请求头部 章节。

⾮公共头部

https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第259 共2247⻚

该请求操作⽆特殊的请求头部信息。

请求体

该请求的请求体为空。

响应

响应头

公共响应头

该响应使⽤公共响应头，了解公共响应头详情，请参阅 公共响应头部 章节。

特有响应头

该响应⽆特殊的响应头。

响应体

该响应体返回为空。

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第260 共2247⻚

WebP 压缩
最近更新时间：2024-01-18 15:11:52

功能描述

图⽚压缩指在图⽚质量保持不变的情况，尽可能的减⼩图⽚⼤⼩，以达到节省图⽚存储空间、减少图⽚访问流量、

提升图⽚访问速度的效果。

数据万象（Cloud Infinite，CI） 产品推出了 WebP 压缩功能，可将图⽚转换为 webp 压缩图⽚格式，其在压缩⽅⾯

相⽐ jpg 格式更优越。在相同图⽚质量的情况下，webp 格式图⽚要⽐ jpg 格式图⽚减⼩25%以上，可以适配多终端
使⽤场景。

限制说明

⽀持格式：⽀持将 jpg、png、bmp、gif、tpg、heif、avif 等格式图⽚转换为 webp 格式。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

使⽤⽅式

数据万象通过 imageMogr2 接⼝提供 WebP 压缩功能。
该功能⽀持以下的处理⽅式：

下载时处理

上传时处理

云上数据处理

说明：

WebP 压缩为付费服务，费⽤同基础图⽚处理，具体费⽤请参⻅ 图⽚处理费⽤。
图⽚转换为 WebP 格式后，部分浏览器⽆法读取 WebP 图⽚的 exif 信息，导致没有旋转。您可参⻅ 旋转 ⽂档，增加 
auto-orient 参数，对原图旋转后再进⾏压缩。
WebP 压缩默认继承原始图⽚的质量参数。您可参⻅ 质量变换 ⽂档，通过修改图⽚质量来调节压缩率。

接⼝⽰例

1. 下载时处理

https://www.tencentcloud.com/document/product/1045/33422
https://www.tencentcloud.com/document/product/1045/45582
https://www.tencentcloud.com/document/product/1045/33715
https://www.tencentcloud.com/document/product/1045/33717


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第261 共2247⻚

GET /<ObjectKey>?imageMogr2/format/webp HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第262 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/webp"

}]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第263 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第264 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/webp"

}]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为 webp。

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，请使⽤上传

时处理或云上数据处理⽅式。

假设原图格式为 png，图⽚⼤⼩为1335.2KB，如下图所⽰： 

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第265 共2247⻚

将原图转换为 webp 格式，请求 URL 如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第266 共2247⻚

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

效果如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第267 共2247⻚

压缩率对⽐

格式 图⽚⼤⼩

png（原图） 1335.2KB

webp 65KB（压缩率95.13%）



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第268 共2247⻚

HEIF 压缩
最近更新时间：2024-01-18 15:11:52

功能描述

图⽚压缩指在图⽚质量保持不变的情况，尽可能的减⼩图⽚⼤⼩，以达到节省图⽚存储空间、减少图⽚访问流量、

提升图⽚访问速度的效果。

数据万象（Cloud Infinite，CI） 产品推出了 HEIF 压缩功能，可将图⽚转换为 heif 格式，它具有超⾼的压缩率，在图

⽚质量相同的情况下，图⽚⼤⼩⽐ jpg 格式图⽚减⼩80%以上，iOS 系统已将 heif 图⽚作为相册默认格式，Android 
P 系统已原⽣⽀持 heif。

限制说明

⽀持格式：⽀持将 jpg、png、bmp、webp、tpg、avif 等格式图⽚转换为 heif 格式。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

前提条件

使⽤ HEIF 压缩，需要先开通存储桶的图⽚⾼级压缩功能，您需要在相应的存储桶配置⻚中通过开关按钮开启功能，
详情请参⻅ 设置图⽚⾼级压缩。

使⽤⽅式

数据万象通过 imageMogr2 接⼝提供 HEIF 压缩功能。
该功能⽀持以下的处理⽅式：

下载时处理

上传时处理

云上数据处理

说明：

 HEIF 压缩为付费服务，计费项为图⽚⾼级压缩费⽤，具体费⽤请参⻅图⽚处理费⽤。

https://www.tencentcloud.com/document/product/1045/33422
https://www.tencentcloud.com/document/product/436/40117


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第269 共2247⻚

接⼝⽰例

1. 下载时处理

download_url?imageMogr2/format/heif

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第270 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/heif"

}]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第271 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第272 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/heif"

}]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情 ⽂档。

处理参数说明

参数 含义

download_url
⽂件的访问链接，具体构成为<BucketName-APPID>.cos.
<Region>.myqcloud.com/<picture name>， 例如  examplebucket-

1250000000.cos.ap-shanghai.myqcloud.com/picture.jpeg 。

/format/<Format> 压缩格式，此处为 heif。

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，请使⽤上传

时处理或云上数据处理⽅式。

假设原图格式为 png，图⽚⼤⼩为1335.2KB，如下图所⽰。 

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第273 共2247⻚

将原图转换为 heif 格式，请求 URL 如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第274 共2247⻚

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

压缩率对⽐

格式 图⽚⼤⼩

png（原图） 1335.2KB

heif 52.87KB（压缩率96.0%）



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第275 共2247⻚

TPG 压缩
最近更新时间：2024-01-18 15:11:52

功能描述

图⽚压缩指在图⽚质量保持不变的情况，尽可能的减⼩图⽚⼤⼩，以达到节省图⽚存储空间、减少图⽚访问流量、

提升图⽚访问速度的效果。

数据万象（Cloud Infinite，CI） 产品推出了 TPG 压缩功能，可将图⽚转换为 tpg 格式，它是腾讯推出的⾃研图⽚格

式，能⽀持动图，⽬前 QQ 浏览器、QQ 空间等产品已默认⽀持 tpg 图⽚，在图⽚质量相同的情况下，图⽚⼤⼩⽐ 
gif 格式图⽚减少90%以上，⽐ png 图⽚⼩50%以上。

限制说明

⽀持格式：⽀持将 jpg、png、bmp、gif、webp、heif、avif 等格式图⽚转换为 tpg 格式。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

前提条件

使⽤ TPG 压缩，需要先开通存储桶的图⽚⾼级压缩功能，您需要在相应的存储桶配置⻚中通过开关按钮开启功能，
详情请参⻅ 设置图⽚⾼级压缩。
TPG 是腾讯⾃研的图⽚格式，使⽤前请确认图⽚加载环境已⽀持 TPG 解码，腾讯云数据万象提供集成 TPG 解码器
的 iOS、Android 终端 SDK，可帮助您快速接⼊和使⽤ TPG。

使⽤⽅式

数据万象通过 imageMogr2 接⼝提供 tpg 压缩功能。

该功能⽀持以下的处理⽅式：

下载时处理

上传时处理

云上数据处理

说明

 TPG 压缩为付费服务，计费项为图⽚⾼级压缩费⽤，由数据万象收取，具体费⽤请参⻅数据万象 图⽚处理费⽤。

https://www.tencentcloud.com/document/product/1045/33422
https://www.tencentcloud.com/document/product/436/40117
https://www.tencentcloud.com/document/product/1045/47707
https://www.tencentcloud.com/document/product/1045/45575
https://www.tencentcloud.com/document/product/1045/45582


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第276 共2247⻚

接⼝⽰例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/tpg HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第277 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/tpg"

}]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第278 共2247⻚

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第279 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/tpg"

}]

}

说明

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为 tpg。

实际案例

说明

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，请使⽤上传

时处理或云上数据处理⽅式。

假设原图格式为 png，图⽚⼤⼩为1335.2KB，如下图所⽰： 

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第280 共2247⻚

将原图转换为 tpg 格式，请求 URL 如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第281 共2247⻚

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

压缩率对⽐

格式 图⽚⼤⼩

png（原图） 1335.2KB

tpg 36.67KB（压缩率97.3%）



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第282 共2247⻚

AVIF 压缩
最近更新时间：2024-01-18 15:11:52

功能描述

图⽚压缩指在图⽚质量保持不变的情况，尽可能的减⼩图⽚⼤⼩，以达到节省图⽚存储空间、减少图⽚访问流量、

提升图⽚访问速度的效果。

数据万象（Cloud Infinite，CI） 产品推出了 AVIF 压缩功能，可将图⽚转换为 avif 格式，avif 是基于 AV1 的⼀种全新

图⽚格式，在2020年2⽉由 Netflix ⾸次公布于众，⽬前已⽀持 Chrome、Firefox 等浏览器。

限制说明

⽀持格式：⽀持将 jpg、png、bmp、gif、webp、tpg、heif 等格式图⽚转换为 avif 格式。
体积限制：处理图⽚原图⼤⼩不超过32MB、宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素；针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。
动图帧数限制：gif 帧数限300帧。

前提条件

使⽤ AVIF 压缩，需要先开通存储桶的图⽚⾼级压缩功能，您需要在相应的存储桶配置⻚中通过开关按钮开启功能，
详情请参⻅ 图⽚⾼级压缩。

使⽤⽅式

数据万象通过 imageMogr2 接⼝提供 avif 压缩功能。
该功能⽀持以下的处理⽅式：

下载时处理

上传时处理

云上数据处理

说明：

AVIF 压缩为付费服务，计费项为图⽚⾼级压缩费⽤，具体费⽤请参⻅ 图⽚处理费⽤。

接⼝⽰例

https://www.tencentcloud.com/document/product/1045/33422
https://www.tencentcloud.com/document/product/1045/40106
https://www.tencentcloud.com/document/product/1045/45582


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第283 共2247⻚

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/avif HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第284 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/avif"

}]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第285 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第286 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/avif"

}]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为 avif。

实际案例

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，请使⽤上传

时处理或云上数据处理⽅式。

假设原图格式为 png，图⽚⼤⼩为1335.2KB，如下图所⽰： 

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第287 共2247⻚

将原图转换为 avif 格式，请求 URL 如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第288 共2247⻚

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

压缩率对⽐

格式 图⽚⼤⼩

png（原图） 1335.2KB

avif 62.8KB（压缩率95.3%）



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第289 共2247⻚

⾼级压缩
最近更新时间：2024-01-18 15:11:52

功能概述

数据万象提供图⽚⾼级压缩功能，可以更加⾼效地将图⽚转换为 TPG 或 HEIF 等⾼压缩⽐格式，有效降低图⽚传输
链路及加载耗时，降低带宽及流量成本。

该功能⽀持以下的处理⽅式：

下载时处理

上传时处理

云上数据处理

功能 简介

TPG 
压缩

TPG 是腾讯推出的⾃研图⽚格式，可将 JPG、PNG、WEBP 等格式图⽚转换为 TPG 格式，⼤幅减
⼩图⽚⼤⼩。

HEIF 
压缩

针对 iOS 环境的图⽚使⽤场景，可将 JPG、PNG、GIF、WEBP 等格式图⽚转换为 HEIF 格式，
HEIF 格式有着超⾼压缩率。

说明：

使⽤图⽚⾼级压缩功能时，您需要在相应的存储桶配置⻚中通过开关按钮开启服务，详情请参⻅ 图⽚⾼级压缩。

TPG 是腾讯⾃研的图⽚格式，如需使⽤请确认图⽚加载环境⽀持 TPG 解码，腾讯云数据万象提供集成 TPG 解码器
的iOS、Android、Windows 终端 SDK，可帮助您快速接⼊和使⽤ TPG。
⽬前 iOS 11以上及 Android P 系统已原⽣⽀持 HEIF 格式。
图⽚⾼级压缩为付费服务，具体费⽤可查看 计费与定价。

接⼝⽰例

1. 下载时处理

https://www.tencentcloud.com/document/product/1045/40106
https://main.qcloudimg.com/raw/851dd252378813d250eeca5ed55ffd36/TPG_win_SDK.zip
https://www.tencentcloud.com/document/product/1045/33431


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第290 共2247⻚

download_url?imageMogr2/format/<Format>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第291 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>"

  }]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第292 共2247⻚

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第293 共2247⻚

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>"

  }]

}

说明：

 本篇⽂档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图⽚⾄存储桶。如有保存需求，您可查阅 图
⽚持久化处理 ⽂档并配置上传时处理或云上数据处理。

处理参数说明

参数 含义

download_url
⽂件的访问链接，具体构成为<BucketName-APPID>.cos.
<Region>.myqcloud.com/<picture name>，<br>例如  examplebucket-

1250000000.cos.ap-shanghai.myqcloud.com/picture.jpeg 。

/format/<Format> 压缩格式，⽬标缩略图的图⽚格式为 TPG 或 HEIF。

实际案例

假设原图格式为 PNG，图⽚⼤⼩为1335.2KB，如下图所⽰。 

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第294 共2247⻚

将原图转换为 TPG 格式，URL 地址如下。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第295 共2247⻚

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

将原图转换为 HEIF 格式，URL 地址如下。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第296 共2247⻚

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

压缩率对⽐

格式 图⽚⼤⼩

PNG（原图） 1335.2KB

TPG 36.67KB（压缩率97.3%）

HEIF 52.87KB（压缩率96.0%）



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第297 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第298 共2247⻚

SVG 压缩
最近更新时间：2024-01-18 15:11:52

功能描述

图⽚压缩指在图⽚质量保持不变的情况，尽可能的减⼩图⽚⼤⼩，以达到节省图⽚存储空间、减少图⽚访问流量、

提升图⽚访问速度的效果。

数据万象（Cloud Infinite，CI） 产品推出了 SVG 压缩功能，可以在不影响显⽰效果的情况下，通过⼀定的优化算法

删除 SVG ⽂件中的冗余信息，最终达到减少 SVG ⽂件体积的⽬的。

限制说明

⽀持格式：仅⽀持将 svg 格式图⽚作为输⼊。
体积限制：处理图⽚原图⼤⼩不超过32MB。

使⽤⽅式

数据万象通过 imageMogr2 接⼝提供 SVG 压缩功能。
该功能⽀持以下的处理⽅式：

下载时处理

上传时处理

云上数据处理

说明：

  SVG 压缩为付费服务，计费项为图⽚⾼级压缩费⽤，具体费⽤请参⻅ 图⽚处理费⽤。

接⼝⽰例

1. 下载时处理

https://www.tencentcloud.com/document/product/1045/33422
https://www.tencentcloud.com/document/product/1045/45582


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第299 共2247⻚

GET /<ObjectKey>?imageMogr2/format/svgc HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第300 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/svgc"

}]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第301 共2247⻚

}

说明：

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图⽚持久化处理。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://www.tencentcloud.com/document/product/1045/33695


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第302 共2247⻚

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/svgc"

}]

}

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

处理参数说明

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为svgc。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第303 共2247⻚

图⽚持久化处理
最近更新时间：2024-01-18 15:11:52

上传时处理

数据万象提供的上传时处理功能可以帮助使⽤者在上传时实现图⽚处理。您只需要在请求包头部中加⼊ Pic-
Operations 项并设置好相应参数，就可在图⽚上传时实现相应的图⽚处理，并可将原图和处理结果存⼊到 COS。⽬
前⽀持32M以内⽂件处理。

请求语法

图⽚上传的请求包与 COS V5 简单上传⽂件接⼝⼀致，只在请求包头部增加图⽚处理参数。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第304 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

COS 简单上传⽂件接⼝，请参⻅ COS PUT Object ⽂档。
Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7749
https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第305 共2247⻚

持久化处理的 QPS 限制为100，如您有更⾼需求请 联系我们。

请求内容

Pic-Operations 为 json 格式的字符串，具体参数如下：

参数名称 类型
是否必

选
描述

is_pic_info Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules Array 否
处理规则，⼀条规则对应⼀个处理结果（⽬前⽀持五条规则），不填则不进

⾏图⽚处理

 rules（json 数组）中每⼀项具体参数如下：

参数名称 类型 是否必选 描述

bucket String 否
存储结果的⽬标存储桶名称，格式为 BucketName-APPID，如果不指
定的话默认保存到当前存储桶

fileid String 是

处理后⽂件的保存路径及名称。名称规则说明：

例如源⽂件的路径及⽂件名为：/p1/test1.jpg
1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表⽰在 p2 ⽂
件夹中存储了⼀个⽂件名为 test2.jpg 的⽂件
2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表⽰在 p1 
⽂件夹中新建了⼀个 p2 ⽂件夹，然后在 p2 ⽂件夹中存储了⼀个⽂件
名为 test2.jpg 的⽂件
3. 注意：请不要以/结尾，否则会产⽣空⽂件名

rule String 是

处理参数，参⻅数据万象图⽚处理 API。若按指定样式处理，则
以  style/ 开头，后加样式名，如样式名为  test ，则 rule 字段
为  style/test 

返回内容

响应包体具体数据内容如下：

参数名称 类型 描述

UploadResult Container 原图信息

 UploadResult 节点内容：

参数名称 类型 描述

OriginalInfo Container 原图信息

https://www.tencentcloud.com/document/product/1045/42350


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第306 共2247⻚

ProcessResults Container 图⽚处理结果

 OriginalInfo 节点内容：

节点名称 类型 描述

Key String 原图⽂件名

Location String 图⽚路径

ImageInfo Container 原图图⽚信息

ETag String 原图 ETag 信息（若处理结果图覆盖原图则为结果
图 ETag 信息）

 ImageInfo 节点内容：

节点名称 类型 描述

Format String 格式

Width Int 图⽚宽度

Height Int 图⽚⾼度

Quality Int 图⽚质量

Ave String 图⽚主⾊调

Orientation Int 图⽚旋转⾓度

 ProcessResults 节点内容：

节点名称 类型 描述

Object Container 每⼀个图⽚处理结果

 Object 节点内容：

节点名称 类型 描述

Key String ⽂件名

Location String 图⽚路径

Format String 图⽚格式



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第307 共2247⻚

Width Int 图⽚宽度

Height Int 图⽚⾼度

Size Int 图⽚⼤⼩

Quality Int 图⽚质量

ETag String 处理结果图 ETag 信息

⽰例

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第308 共2247⻚

PUT /filename.jpg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed, 28 Oct 2015 20:32:00 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations: {"is_pic_info":1,"rules":[{"fileid":"test.jpg","rule":"imageView2/f

Content-Length: 64

[Object]

返回



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第309 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

        <OriginalInfo>

            <Key>filename.jpg</Key>

            <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/filename



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第310 共2247⻚

            <ETag>&quot;580cd6930444576523c25f86ce2af9b1fc2d5484&quot;</ETag>

            <ImageInfo>

                <Format>JPEG</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Quality>100</Quality>

                <Ave>0xa18454</Ave>

                <Orientation>1</Orientation>

            </ImageInfo>

        </OriginalInfo>

        <ProcessResults>

            <Object>

                <Key>test.jpg</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test

                <Format>png</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Size>463092</Size>

                <Quality>100</Quality>

                <ETag>&quot;eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot;</ETag>

            </Object>

        </ProcessResults>

</UploadResult>

注意：

上传时处理⽀持 COS V5 的分块上传功能，您在使⽤ COS V5 的 Complete Multipart Upload 接⼝时只需在请求包头
部中加⼊ Pic-Operations 项，即可实现图⽚处理。

https://www.tencentcloud.com/document/product/436/7742


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第311 共2247⻚

POST /<ObjectKey>?uploadId=UploadId HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

COS 接⼝请参⻅ COS Complete Multipart Upload ⽂档。

https://www.tencentcloud.com/document/product/436/7742


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第312 共2247⻚

云上数据处理

数据万象的图⽚处理 API 能够对已存储在 COS 的图⽚进⾏相应处理操作，并将结果存⼊到 COS。

请求语法

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第313 共2247⻚

Authorization: Auth String

Pic-Operations: <PicOperations>

请求内容

Pic-Operations 为 json 格式的字符串，具体参数如下：

参数名称 类型
是否必

选
描述

is_pic_info Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules Array 否
处理规则，⼀条规则对应⼀个处理结果（⽬前⽀持五条规则），不填则不进

⾏图⽚处理

 rules（json 数组）中每⼀项具体参数如下：

参数名

称
类型

是否必

选
描述

bucket String 否
存储结果的⽬标 bucket 名称，形如 BucketName-APPID，如果不指定的话默
认保存到当前存储桶

fileid String 是

处理后⽂件的保存路径及名称。名称规则说明：

例如源⽂件的路径及⽂件名为：/p1/test1.jpg
1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表⽰在 p2 ⽂件夹中
存储了⼀个⽂件名为 test2.jpg 的⽂件
2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表⽰在 p1 ⽂件夹
中新建了⼀个 p2 ⽂件夹，然后在 p2 ⽂件夹中存储了⼀个⽂件名为 test2.jpg 
的⽂件

3. 注意：请不要以/结尾，否则会产⽣空⽂件名

rule String 是

处理参数，参⻅数据万象 基础图⽚处理 API。若按指定样式处理，则
以  style/ 开头，后加样式名，如样式名为  test ，则 rule 字段
为  style/test 

返回内容

响应包体具体数据内容如下：

参数名称 类型 描述

UploadResult Container 原图信息

 UploadResult 节点内容：

参数名称 类型 描述

https://www.tencentcloud.com/document/product/1045/33694


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第314 共2247⻚

OriginalInfo Container 原图信息

ProcessResults Container 图⽚处理结果

 OriginalInfo 节点内容：

节点名称 类型 描述

Key String 原图⽂件名

Location String 图⽚路径

ImageInfo Container 原图图⽚信息

ETag String 原图 ETag 信息（若处理结果图覆盖原图则为结果图 ETag 信息）

 ImageInfo 节点内容：

节点名称 类型 描述

Format String 格式

Width Int 图⽚宽度

Height Int 图⽚⾼度

Quality Int 图⽚质量

Ave String 图⽚主⾊调

Orientation Int 图⽚旋转⾓度

 ProcessResults 节点内容：

节点名称 类型 描述

Object Container 每⼀个图⽚处理结果

 Object 节点内容：

节点名称 类型 描述

Key String ⽂件名

Location String 图⽚路径

Format String 图⽚格式



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第315 共2247⻚

Width Int 图⽚宽度

Height Int 图⽚⾼度

Size Int 图⽚⼤⼩

Quality Int 图⽚质量

ETag String 处理结果图 ETag 信息

⽰例

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第316 共2247⻚

POST /filename.jpg?image_process HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed，18 Jan 2017 16:17:03 GMT

Authorization: XXXXXXXXXX

Pic-Operations: {"is_pic_info":1,"rules":[{"fileid":"test.jpg","rule":"imageView2/f

Content-Length: XX

返回



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第317 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

            <OriginalInfo>

                <Key>filename.jpg</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/file



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第318 共2247⻚

                <ETag>&quot;eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot;</ETag>

                <ImageInfo>

                    <Format>JPEG</Format>

                    <Width>640</Width>

                    <Height>427</Height>

                    <Quality>100</Quality>

                    <Ave>0xa18454</Ave>

                    <Orientation>1</Orientation>

                </ImageInfo>

            </OriginalInfo>

            <ProcessResults>

                <Object>

                    <Key>test.jpg</Key>

                    <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/

                    <Format>png</Format>

                    <Width>640</Width>

                    <Height>427</Height>

                    <Size>463092</Size>

                    <Quality>100</Quality>

                    <ETag>&quot;eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot;</ETa

                </Object>

            </ProcessResults>

</UploadResult>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第319 共2247⻚

盲⽔印
最近更新时间：2024-01-18 15:11:52

简介

盲⽔印功能是指将⽔印以不可⻅的形式添加到图⽚中，这样的⽔印不会图⽚观感产⽣影响，同时也保证了图⽚的原

创性。当发现图⽚被盗取后，您可以通过 提取盲⽔印，将不可⻅的⽔印提取出来，验证图⽚的归属。 
通过该 API 接⼝，您可以：

在上传时为图⽚添加盲⽔印、提取盲⽔印

对 COS 上的图⽚添加盲⽔印、提取盲⽔印
在下载时为图⽚添加盲⽔印（不⽀持下载时提取盲⽔印）

数据万象提供的盲⽔印功能拥有半盲⽔印、全盲⽔印和⽂字盲⽔印三种类型：

⽔印类型 特性 适⽤场景

半盲⽔印（type1） 抗攻击性强，但提取⽔印需原图 ⼩图（640px x 640px以下）使⽤

全盲⽔印（type2） 提取⽅便，提取⽔印仅需⽔印图，⽆需对⽐原

图
批量添加，批量校验

⽂字盲⽔印

（type3）
可直接将⽂字信息添加⾄图⽚中 终端信息添加

盲⽔印是付费服务，使⽤时需在相应存储桶配置⻚中通过开关开通服务。具体费⽤请参⻅ 图⽚处理费⽤。

说明：

暂不⽀持为动图（例如 GIF 图⽚）添加盲⽔印。
使⽤盲⽔印功能，⽔印图的宽⾼不得超过原图的1/8。
为保证盲⽔印效果，⽔印图请选⽤⿊底⽩⾊图⽚。

⽂字盲⽔印当前⽀持数字[0 - 9]及英⽂⼤⼩写[A - Z,a - z]。
盲⽔印可抵抗裁剪、涂抹、变⾊等多种图⽚盗取攻击，防盗效果与原图⼤⼩及攻击程度相关。如需详细咨询请 提交

⼯单。

盲⽔印已⽀持数据万象所有地域，详情请查看 地域与域名。

适⽤场景

鉴权追责

https://www.tencentcloud.com/document/product/1045/43029
https://www.tencentcloud.com/document/product/1045/45582
https://console.tencentcloud.com/workorder/category
https://www.tencentcloud.com/document/product/1045/33423


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第320 共2247⻚

您可对图⽚资源增加半盲⽔印，在发现恶意攻击⽅盗取您的资源后将疑似被盗取图取回，并与相应原图进⾏盲⽔印

提取操作，若能够得到有效⽔印图即可证明资源归属。

上传查重

为解决部分⽤户使⽤其他⽤户资源重复上传相同信息的问题（如房产图、汽⻋图、商品图等），您可在⽤户上传图

⽚资源前先进⾏全盲⽔印提取，若提取到⽔印图信息则证明该图⽚来⾃之前已有资源，并进⾏相应操作（如提醒⽤

户请勿重复上传资源）；若不存在全盲⽔印则添加全盲⽔印，保护图⽚资源不被其他⽤户下载后重复上传。

资源防泄露

对于内部分享的图⽚资源，您可通过⽂字盲⽔印将访问⽅的信息在请求图⽚时添加⾄图⽚中，当资源泄露后可通过

流传出的资源图提取出盲⽔印，进⽽得到泄露⽅信息。

添加盲⽔印

请求⼀：上传时添加盲⽔印

图⽚上传时添加盲⽔印的请求包与 PUT Object 接⼝⼀致，只需在请求包头部增加图⽚处理参数 Pic-Operations 并使

⽤盲⽔印参数即可。

请求⽰例

https://www.tencentcloud.com/document/product/436/7749


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第321 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

[Object Content]

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第322 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。
请求包头部增加图⽚处理参数 Pic-Operations，Pic-Operations 为 json 格式的字符串，具体参数如下：

参数名称 描述 类型 是否必选

is_pic_info 是否返回原图信息。0表⽰不返回原图信息，1表⽰返回原图信息，默认
为0

Int 否

rules 处理规则，⼀条规则对应⼀个处理结果（⽬前最多⽀持五条规则），不填

则不进⾏图⽚处理
Array 否

rules（json 数组）中每⼀项具体参数如下：

参数名

称
描述 类型

是否必

选

bucket 存储结果的⽬标存储桶名称，格式为：BucketName-APPID，如果不指定的
话默认保存到当前存储桶

String 否

fileid

处理后⽂件的保存路径及名称。名称规则说明：

例如源⽂件的路径及⽂件名为：/p1/test1.jpg
1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表⽰在 p2 ⽂件夹
中存储了⼀个⽂件名为 test2.jpg 的⽂件。
2. 不以 / 开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表⽰在 p1 ⽂件
夹中新建了⼀个 p2 ⽂件夹，然后在 p2 ⽂件夹中存储了⼀个⽂件名为 
test2.jpg 的⽂件。
3. 注意：请不要以 / 结尾，否则会产⽣空⽂件名。

String 是

rule
处理参数，可参⻅图⽚处理 API。 若按指定样式处理，则以  style/  开
头，后加样式名，如样式名为“test”，则 rule 字段为  style/test 

String 是

使⽤盲⽔印需在 rule 中添加⽔印图参数（watermark），⽰例格式如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第323 共2247⻚

watermark/3/type/<type>/image/<imageUrl>/text/<text>/level/<level>

⽰例参数说明如下：

参数名称 描述 类型
是否必

选

type 盲⽔印类型，有效值：1为半盲⽔印；2为全盲⽔印；3为⽂字盲⽔印 Int 是

image 盲⽔印图⽚地址，需要经过 URL 安全的 Base64 编码。 当 type 为1或2时必
填，type 为3时⽆效。 指定的⽔印图⽚必须同时满⾜如下条件：

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第324 共2247⻚

1. 盲⽔印图⽚与原图⽚必须位于同⼀个存储桶下；
2. URL 必须以 http:// 开始，不能省略 http 头，也不能填 https 头，例如以下
地址为⾮法⽔印地址：

examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/watermark.png
https://examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/watermark.png

text 盲⽔印⽂字，需要经过 URL 安全的 Base64 编码。当 type 为3时必填，type 
为1或2时⽆效。

String 否

level 只对全盲⽔印（type=2）有效。level 的取值范围为{1,2,3}，默认值为1，
level 值越⼤则图⽚受影响程度越⼤、盲⽔印效果越好。

Int 否

请求参数

此接⼝⽆请求参数。

请求体

此接⼝请求的请求体为需要添加盲⽔印的原⽂件（图⽚）内容。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

响应体具体数据内容如下：

参数名称 描述 类型

UploadResult 原图信息 Container

UploadResult 节点内容： 

参数名称 描述 类型

OriginalInfo 原图信息 Container

ProcessResults 图⽚处理结果 Container

OriginalInfo 节点内容：

节点名称 描述 类型

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第325 共2247⻚

Key 原图⽂件名 String

Location 图⽚路径 String

ImageInfo 原图图⽚信息 Container

ImageInfo 节点内容：

节点名称 描述 类型

Format 格式 String

Width 图⽚宽度 Int

Height 图⽚⾼度 Int

Quality 图⽚质量 Int

Ave 图⽚主⾊调 String

Orientation 图⽚旋转⾓度 Int

ProcessResults 节点内容：

节点名称 描述 类型

Object 每⼀个图⽚处理结果 Container

Object 节点内容：

节点名称 描述 类型

Key ⽂件名 String

Location 图⽚路径 String

Format 图⽚格式 String

Width 图⽚宽度 Int

Height 图⽚⾼度 Int

Size 图⽚⼤⼩ Int

Quality 图⽚质量 Int

实际案例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第326 共2247⻚

请求

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

{

    "is_pic_info": 1,

    "rules": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第327 共2247⻚

        "fileid": "exampleobject",

        "rule": "watermark/3/type/1/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQucGljc

    }]

}

Content-Length: 64

[Object Content]

响应

HTTP/1.1 200 OK



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第328 共2247⻚

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

          <OriginalInfo>

              <Key>exampleobject</Key>

              <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampl

              <ImageInfo>

                   <Format>JPEG</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Quality>100</Quality>

                   <Ave>0xa18454</Ave>

                   <Orientation>1</Orientation>

              </ImageInfo>

          </OriginalInfo>

          <ProcessResults>

              <Object>

                   <Key>exampleobject</Key>

                   <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/e

                   <Format>png</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Size>463092</Size>

                   <Quality>100</Quality>

              </Object>

          </ProcessResults>

</UploadResult>

注意：

请求体的 [Object Content] 字段为原图的图⽚内容(⼆进制字符串)，请求头 Pic-Operations 的 rule 字段中，imageUrl 

为⽔印图⽚的地址。

响应体的 ProcessResults 中的 Location 字段为处理后已经携带盲⽔印的图⽚的地址。

请求⼆：下载时添加盲⽔印

图⽚下载时添加盲⽔印与添加普通⽔印操作相同，只需在图⽚访问链接后使⽤ watermark 参数即可。

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第329 共2247⻚

GET /<ObjectKey>?watermark/3/type/<type>/image/<imageUrl>/text/<text> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

请求参数

请求参数说明如下：

参数 描述 类型 是否必

选



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第330 共2247⻚

ObjectKey 对象⽂件名，例如 folder/sample.jpg。 String 是

type 盲⽔印类型，有效值：1为半盲⽔印；2为全盲⽔印；3为⽂字盲⽔印 Int 是

image

盲⽔印图⽚地址，需要经过 URL 安全的 Base64 编码。 当 type 为1或2时
必填，type 为3时⽆效。 指定的⽔印图⽚必须同时满⾜如下条件：
1. 盲⽔印图⽚与原图⽚必须位于同⼀个存储桶下；
2. URL 必须以 http:// 开始，不能省略 http 头，也不能填 https 头，例如以
下地址为⾮法⽔印地址：

examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/watermark.png
https://examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/watermark.png

String 否

text 盲⽔印⽂字，需要经过 URL 安全的 Base64 编码。 当 type 为3时必填，
type 为1或2时⽆效。

String 否

level 只对全盲⽔印（type=2）有效。level 的取值范围为{1,2,3}，默认值为1，
level 值越⼤则图⽚受影响程度越⼤、盲⽔印效果越好。

Int 否

实际案例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第331 共2247⻚

https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark

请求三：对 COS 上的图⽚添加盲⽔印

通过 API 能够对已存储在 COS 的图⽚进⾏添加盲⽔印的操作，并将结果存⼊到 COS。

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第332 共2247⻚

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第333 共2247⻚

请求头

此接⼝使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。
请求包头部增加图⽚处理参数 Pic-Operations，Pic-Operations 为 json 格式的字符串，具体参数如下：

参数名称 描述 类型 是否必选

is_pic_info 是否返回原图信息。0表⽰不返回原图信息，1表⽰返回原图信息，默认
为0

Int 否

rules 处理规则，⼀条规则对应⼀个处理结果（⽬前最多⽀持五条规则），不填

则不进⾏图⽚处理
Array 否

rules（json 数组）中每⼀项具体参数如下：

参数名称 描述 类型
是否必

选

bucket 存储结果的⽬标存储桶名称，格式为：BucketName-APPID，如果不指定
的话默认保存到当前存储桶

String 否

fileid

处理后⽂件的保存路径及名称。名称规则说明：

例如源⽂件的路径及⽂件名为：/p1/test1.jpg
1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表⽰在 p2 ⽂件夹
中存储了⼀个⽂件名为 test2.jpg 的⽂件。
2. 不以 / 开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表⽰在 p1 ⽂件
夹中新建了⼀个 p2 ⽂件夹，然后在 p2 ⽂件夹中存储了⼀个⽂件名为 
test2.jpg 的⽂件。
3. 注意：请不要以 / 结尾，否则会产⽣空⽂件名。

String 是

rule
处理参数，可参⻅图⽚处理 API。 若按指定样式处理，则以  style/  开
头，后加样式名，如样式名为“test”，则 rule 字段为  style/test 

String 是

使⽤盲⽔印需在 rule 中添加⽔印图参数（watermark），⽰例格式如下：

https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第334 共2247⻚

watermark/3/type/<type>/image/<imageUrl>/text/<text>/level/<level>

⽰例参数说明如下：

参数 描述 类型
是否必

选

type 盲⽔印类型，有效值：1为半盲⽔印；2为全盲⽔印；3为⽂字盲⽔印 Int 是

image 盲⽔印图⽚地址，需要经过 URL 安全的 Base64 编码。 当 type 为1或2时必
填，type 为3时⽆效。 指定的⽔印图⽚必须同时满⾜如下条件：

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第335 共2247⻚

1. 盲⽔印图⽚与原图⽚必须位于同⼀个存储桶下；
2. URL 必须以 http:// 开始，不能省略 http 头，也不能填 https 头，例如以下
地址为⾮法⽔印地址：

examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/watermark.png
https://examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/watermark.png

text 盲⽔印⽂字，需要经过 URL 安全的 Base64 编码。当 type 为3时必填，type 
为1或2时⽆效。

String 否

level 只对全盲⽔印（type=2）有效。level 的取值范围为{1,2,3}，默认值为1，
level 值越⼤则图⽚受影响程度越⼤、盲⽔印效果越好。

Int 否

请求参数

此接⼝⽆请求参数。

请求体

此接⼝⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

响应体具体数据内容如下：

参数名称 描述 类型

UploadResult 原图信息 Container

UploadResult 节点内容： 

参数名称 描述 类型

OriginalInfo 原图信息 Container

ProcessResults 图⽚处理结果 Container

OriginalInfo 节点内容： 

节点名称 描述 类型

Key 原图⽂件名 String

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第336 共2247⻚

Location 图⽚路径 String

ImageInfo 原图图⽚信息 Container

ImageInfo 节点内容： 

节点名称 描述 类型

Format 格式 String

Width 图⽚宽度 Int

Height 图⽚⾼度 Int

Quality 图⽚质量 Int

Ave 图⽚主⾊调 String

Orientation 图⽚旋转⾓度 Int

ProcessResults 节点内容：

节点名称 描述 类型

Object 每⼀个图⽚处理结果 Container

Object 节点内容：

节点名称 描述 类型

Key ⽂件名 String

Location 图⽚路径 String

Format 图⽚格式 String

Width 图⽚宽度 Int

Height 图⽚⾼度 Int

Size 图⽚⼤⼩ Int

Quality 图⽚质量 Int

实际案例

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第337 共2247⻚

POST /exampleobject?image_process HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

{

    "is_pic_info": 1,

    "rules": [{

        "fileid": "exampleobject",

        "rule": "watermark/3/type/1/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQucGljc



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第338 共2247⻚

    }]

}

Content-Length: 64

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第339 共2247⻚

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

          <OriginalInfo>

              <Key>exampleobject</Key>

              <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampl

              <ImageInfo>

                   <Format>JPEG</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Quality>100</Quality>

                   <Ave>0xa18454</Ave>

                   <Orientation>1</Orientation>

              </ImageInfo>

          </OriginalInfo>

          <ProcessResults>

              <Object>

                   <Key>exampleobject</Key>

                   <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/e

                   <Format>png</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Size>463092</Size>

                   <Quality>100</Quality>

              </Object>

          </ProcessResults>

</UploadResult>

提取盲⽔印

请求⼀：上传时提取盲⽔印

请求⽰例

上传图⽚并提取盲⽔印的请求包与 PUT Object 接⼝⼀致，只需在请求包头部增加图⽚处理参数 Pic-Operations 并使
⽤提取盲⽔印参数（watermark/4）即可。

https://www.tencentcloud.com/document/product/436/7749


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第340 共2247⻚

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization:XXXXXXXXXXXX

Pic-Operations: <PicOperations>

[Object Content]

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第341 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。
请求包头部增加图⽚处理参数 Pic-Operations，Pic-Operations 为 json 格式的字符串，具体参数如下：

参数名称 描述 类型 是否必选

is_pic_info 是否返回原图信息。0表⽰不返回原图信息，1表⽰返回原图信息，默认
为0

Int 否

rules 处理规则，⼀条规则对应⼀个处理结果（⽬前最多⽀持五条规则），不填

则不进⾏图⽚处理
Array 否

rules（json 数组）中每⼀项具体参数如下：

参数名

称
描述 类型

是否必

选

bucket 存储结果的⽬标存储桶名称，格式为：BucketName-APPID，如果不指定的
话默认保存到当前存储桶

String 否

fileid

处理后⽂件的保存路径及名称。名称规则说明：

例如源⽂件的路径及⽂件名为：/p1/test1.jpg
1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表⽰在 p2 ⽂件夹
中存储了⼀个⽂件名为 test2.jpg 的⽂件。
2. 不以 / 开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表⽰在 p1 ⽂件
夹中新建了⼀个 p2 ⽂件夹，然后在 p2 ⽂件夹中存储了⼀个⽂件名为 
test2.jpg 的⽂件。
3. 注意：请不要以 / 结尾，否则会产⽣空⽂件名。

String 是

rule
处理参数，请参⻅图⽚处理 API。 若按指定样式处理，则以  style/  开
头，后加样式名，如样式名为“test”，则 rule 字段为  style/test 

String 是

提取盲⽔印需在 rule 中添加⽔印图参数（watermark），⽰例格式如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第342 共2247⻚

watermark/4/type/<type>/image/<imageUrl>

⽰例参数说明如下：

参数 描述 类型
是否必

选

type 盲⽔印类型，有效值：1为半盲⽔印；2为全盲⽔印；3为⽂字盲⽔印，必须
跟添加盲⽔印时的 type 类型⼀致。

Int 是

image 图⽚地址，根据 type 值填写： String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第343 共2247⻚

当 type 为1，则 image 必填，且为原图图⽚地址。
当 type 为2，则 image 必填，且为⽔印图地址。
当 type 为3，则 image ⽆需填写（⽆效）。
image 需要经过 URL 安全的 Base64 编码，指定的图⽚必须同时满⾜如下
条件：

1. 图⽚与存在⽔印的图⽚必须位于同⼀个对象存储桶下。
2. URL 必须以 http:// 开始，不能省略 http 头，也不能填 https 头，例如以
下地址为⾮法⽔印地址：

examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/watermark.png
https://examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/watermark.png

请求参数

此接⼝⽆请求参数。

请求体

此接⼝请求的请求体为图⽚内容。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

响应体的 UploadResult.ProcessResults.Object 字段中新增 WatermarkStatus 字段，当盲⽔印提取的请求体中 type 
参数为2时携带 WatermarkStatus 参数，其他情况不返回该参数。

参数 ⽗节点 描述
类

型

WatermarkStatus Object
当 type 为2时返回该字段，表⽰提取到全盲⽔印的可信度。具体为0-
100的数字，75分以上表⽰确定有盲⽔印，60-75表⽰疑似有盲⽔
印，60以下可认为未提取到盲⽔印

Int

实际案例

请求

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第344 共2247⻚

PUT /exampleobject1 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

{

    "is_pic_info": 1,

    "rules": [{

        "fileid": "exampleobject2",

        "rule": "watermark/4/type/2/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQucGljc



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第345 共2247⻚

    }]

}

Content-Length: 64

[Object Content]

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第346 共2247⻚

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

      <OriginalInfo>

          <Key>exampleobject1</Key>

          <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampleobj

          <ImageInfo>

                <Format>JPEG</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Quality>100</Quality>

                <Ave>0xa18454</Ave>

                <Orientation>1</Orientation>

                <FrameCount>1</FrameCount>

          </ImageInfo>

      </OriginalInfo>

      <ProcessResults>

          <Object>

                <Key>exampleobject2</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exam

                <Format>png</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Size>463092</Size>

                <Quality>100</Quality>

                <FrameCount>1</FrameCount>

                <WatermarkStatus>86</WatermarkStatus>

          </Object>

      </ProcessResults>

</UploadResult>

注意：

对于 type 值为1的请求，请求头 Pic-Operations 的 rule 字段中，imageUrl 为未添加盲⽔印的原图地址；对于 type 值
为2的请求，包头 Pic-Operations 的 rule 字段中，imageUrl 为⽔印图的地址。
响应体 ProcessResults 字段的 url 为提取出来的⽔印图地址。

请求⼆：对 COS 上的图⽚提取盲⽔印

对 COS 上的图⽚提取盲⽔印的请求包与 云上数据处理 接⼝⼀致，只需在请求包头部增加图⽚处理参数 Pic-
Operations 并使⽤提取盲⽔印参数（watermark/4）即可。

 

https://www.tencentcloud.com/document/product/436/40592


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第347 共2247⻚

异常图⽚检测
最近更新时间：2024-01-18 15:11:52

功能概述

腾讯云数据万象通过 ImageInspect 接⼝检测图⽚中是否隐含其他类型的可疑⽂件。

限制说明

⽀持格式：⽀持检测 PNG 后带 TS 视频流、BMP 带 TS 视频流、纯 TS 视频流（仅更改后缀）三种类型的异常图
⽚。

体积限制：处理图⽚原图⼤⼩不超过32MB，宽⾼不超过30000像素且总像素不超过2.5亿像素，处理结果图宽⾼设置
不超过9999像素。针对动图，原图宽 x ⾼ x 帧数不超过2.5亿像素。

接⼝⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第348 共2247⻚

GET /<ObjectKey>?ci-process=ImageInspect HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

处理参数说明

请求参数



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第349 共2247⻚

操作名称：ImageInspect。

参数 含义

ObjectKey 对象⽂件名，例如 folder/sample.jpg。

响应参数

参数 含义

picSize 检测到的可疑⽂件的⼤⼩，单位为 Bytes

picType 检测到的可疑⽂件类型。例如 ts、mkv 等

suspicious 是否检测到图⽚格式以外的⽂件。false 为正常图⽚⽂件，true 表⽰含有其他格式的可
疑⽂件

suspiciousBeginByte 检测到的可疑⽂件的起始字节位置，单位为 Bytes

suspiciousEndByte 检测到的可疑⽂件的末尾字节位置，单位为 Bytes

suspiciousSize 检测到的可疑⽂件的⼤⼩

suspiciousType 检测到的可疑⽂件的类型，例如 MPEG-TS

实际案例

案例⼀：公有读

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第350 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?ci-process=Imag

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第351 共2247⻚

{"picSize":1097476,"picType":"PNG","suspicious":true,"suspiciousBeginByte":120,"sus

案例⼆：私有读、携带签名

获取⽅式同上，仅增加签名部分，并与获取参数以“&”连接，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第352 共2247⻚

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明：

 <signature> 为签名部分，获取⽅式请参考 请求签名。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第353 共2247⻚

队列接⼝

查询队列
最近更新时间：2024-01-18 15:11:52

功能描述

搜索图⽚处理队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第354 共2247⻚

GET /picqueue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第355 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

参数名称（关键

字）
描述 类型

是否必

选

queueIds 队列 ID，以“,”符号分割字符串 String 否

state
1. Active 表⽰队列内的作业会被媒体处理服务调度执⾏。
2. Paused 表⽰队列暂停，作业不再会被媒体处理调度执⾏，队列
内的所有作业状态维持在暂停状态，已经执⾏中的任务不受影响。

String 否

pageNumber 第⼏⻚,默认值1 String 否

pageSize 每⻚个数,默认值10 String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第356 共2247⻚

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p8366c460c67b4c65a9bf81b41eaa3c4b</QueueId>

        <Name>queue-pic-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第357 共2247⻚

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前⻚数，同请求中的 
pageNumber

Int

PageSize Response 每⻚个数，同请求中的 
pageSize

Int

QueueList Response 队列数组 Container数组

NonExistPIDs Response 不存在的队列 ID 列表 String数组

Container 节点 QueueList 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueId Response.QueueList 队列 ID String

Name Response.QueueList 队列名字 String

State Response.QueueList 当前状态，Active 或者 Paused String

NotifyConfig Response.QueueList 回调配置 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第358 共2247⻚

MaxSize Response.QueueList 队列最⼤⻓度 Int

MaxConcurrent Response.QueueList 当前队列最⼤并⾏执⾏的任务数 Int

Category Response.QueueList 队列类型 String

UpdateTime Response.QueueList 更新时间 String

CreateTime Response.QueueList 创建时间 String

Container 节点 NotifyConfig 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Url Response.QueueList.NotifyConfig 回调地址 String

State Response.QueueList.NotifyConfig 开关状态，On 或者 Off String

Type Response.QueueList.NotifyConfig 回调类型，Url String

Event Response.QueueList.NotifyConfig 任务完成：TaskFinish；⼯作流完成：
WorkflowFinish

String

ResultFormat Response.QueueList.NotifyConfig 回调类型, XML 或者 JSON String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：搜索指定队列

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第359 共2247⻚

GET /picqueue?queueIds=pb926e1dce3ed4e47a4f08692164f4869,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应1



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第360 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x

<Response>

    <RequestId>NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x</RequestId>

    <QueueList>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第361 共2247⻚

        <QueueId>p8366c460c67b4c65a9bf81b41eaa3c4b</QueueId>

        <Name>queue-pic-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

请求2：查询队列列表



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第362 共2247⻚

GET /picqueue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应2



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第363 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第364 共2247⻚

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p8366c460c67b4c65a9bf81b41eaa3c4b</QueueId>

        <Name>queue-pic-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第365 共2247⻚

更新队列
最近更新时间：2024-01-18 15:11:52

功能描述

更新图⽚处理队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第366 共2247⻚

PUT /picqueue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第367 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有以下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第368 共2247⻚

    <Name>My-Queue-Pic</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

具体的数据内容如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选 默认值 限制

Request ⽆
保存结果的

容器
Container 是 ⽆ ⽆

Container 节点 Request 的内容：

节点名称

（关键字）
⽗节点 描述 类型

是否必

选

默认

值

限

制

Name Request 队列名称,⻓度不超过128 String 是 ⽆ ⽆

State Request

1. Active 表⽰队列内的作业会被媒体处
理服务调度执⾏。

2. Paused 表⽰队列暂停，作业不再会
被媒体处理调度执⾏，队列内的所有作

业状态维持在暂停状态，已经执⾏中的

任务不受影响。

String 是 ⽆ ⽆

NotifyConfig Request 回调配置 Container 是 ⽆ ⽆

Container 节点 NotifyConfig 的内容：

节点名称

（关键字）
⽗节点 描述 类型 是否必选

默认

值
限制

State Request.NotifyConfig
回调开

关，

Off/On
String 否 Off On/Off

Event Request.NotifyConfig 回调事

件

String 当 State=On
时, 必选

⽆ 任务完成：

TaskFinish；⼯



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第369 共2247⻚

作流完成：

WorkflowFinish

ResultFormat Request.NotifyConfig 回调格

式
String 否 XML JSON/XML

Type Request.NotifyConfig 回调类

型
String 当 State=On

时, 必选
⽆ Url 或 TDMQ

Url Request.NotifyConfig
回调地

址
String

当 State=On, 
且Type=Url
时, 必选

⽆
不能为内⽹地

址

MqMode Request.NotifyConfig
TDMQ 
使⽤模

式

String

当 State=On, 
且

Type=TDMQ
时, 必选

Queue

主题订阅：

Topic 
 队列服务: 
Queue

MqRegion Request.NotifyConfig
TDMQ 
所属园

区

String

当 State=On, 
且

Type=TDMQ
时, 必选

⽆

⽬前⽀持园区 
sh（上海）、bj
（北京）、gz
（⼴州）、cd
（成都）、hk
（⾹港）

MqName Request.NotifyConfig
TDMQ 
主题名

称

String

当 State=On, 
且

Type=TDMQ
时, 必选

⽆ ⽆

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第370 共2247⻚

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>pb926e1dce3ed4e47a4f08692164f4869</QueueId>

        <Name>My-Queue-Pic</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第371 共2247⻚

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

Queue Response 队列信息 Container

Container 节点 Queue 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueId Response.Queue 队列 ID String

Name Response.Queue 队列名字 String

State Response.Queue 当前状态，Active 或者 
Paused

String

NotifyConfig Response.Queue 回调配置,同 
Request.NotifyConfig

Container

MaxSize Response.Queue 队列最⼤⻓度 Int

MaxConcurrent Response.Queue 当前队列最⼤并⾏执⾏

的任务数
Int

Category Response.Queue 队列类型 String

UpdateTime Response.Queue 更新时间 String

CreateTime Response.Queue 创建时间 String

错误码



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第372 共2247⻚

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

PUT /picqueue/pb926e1dce3ed4e47a4f08692164f4869 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第373 共2247⻚

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-Pic</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第374 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第375 共2247⻚

        <QueueId>pb926e1dce3ed4e47a4f08692164f4869</QueueId>

        <Name>My-Queue-Pic</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第376 共2247⻚

AI 内容识别
⼈脸识别

⼈脸特效
最近更新时间：2024-01-20 09:22:44

功能描述

⼈脸特效⽀持⼈脸美颜、⼈脸性别变换、⼈脸年龄变化、⼈像分割的特效功能，适⽤于社交娱乐、⼴告营销、互动

传播等场景。

功能 说明

⼈脸美颜
可⽤于⾃拍照⽚等⼈像美化场景，上传照⽚即可⼀键智能实现美⽩、磨⽪、瘦脸、⼤眼、美

型，⽀持⾃定义调整参数，帮助提升个⼈形象。

⼈脸性别变换
⽤户上传⼀张⼈脸图⽚，基于⼈脸编辑与⽣成算法，输出⼀张⼈脸性别转换的图⽚。男变⼥

可实现美颜、淡妆、加刘海和⻓发的效果；⼥变男可实现加⽑须、变短发的效果。

⼈脸年龄变化
⽤户上传⼀张⼈脸图⽚，基于⼈脸编辑与⽣成算法，输出⼀张⼈脸变⽼或变年轻的图⽚，⽀

持实现⼈脸不同年龄的变化。

⼈像分割
指对图⽚中的⼈体轮廓范围进⾏识别，将其与背景进⾏分离，返回分割后的⼆值图、灰度

图、前景⼈像图。可应⽤于⼈像抠图、照⽚合成、⼈像特效等场景，极⼤提升⼯具效率。

说明：

当前⼈脸特效的图⽚限制为：图⽚ base64 编码后⼤⼩不可超过5MB。⽀持 PNG、JPG、JPEG、BMP 格式，不⽀
持 GIF 图⽚。当使⽤⼈像分割时，图⽚分辨率须⼩于2000 × 2000px。
⼈脸特效为付费服务，计费详情请查看内容识别费⽤。

该功能⽬前仅提供 API 使⽤⽅式。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第377 共2247⻚

GET /<ObjectKey>?ci-process=face-effect&type=<type> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第378 共2247⻚

请求参数

参数名称 描述 类型
是否必

选

ObjectKey 对象⽂件名，例如：folder/document.jpg。 String 是

ci-process 数据万象处理能⼒，⼈脸特效固定为 face-effect。 String 是

type
⼈脸特效类型。⼈脸美颜：face-beautify；⼈脸性别转换：face-
gender-transformation；⼈脸年龄变化：face-age-transformation；⼈
像分割：face-segmentation。

String 是

whitening type 为 face-beautify  时⽣效，美⽩程度，取值范围[0,100]。0表⽰不
美⽩，100表⽰最⾼程度。默认值30。

Integer 否

smoothing type 为 face-beautify  时⽣效，磨⽪程度，取值范围[0,100]。0表⽰不
磨⽪，100表⽰最⾼程度。默认值10。

Integer 否

faceLifting type 为 face-beautify  时⽣效，瘦脸程度，取值范围[0,100]。0表⽰不
瘦脸，100表⽰最⾼程度。默认值70。

Integer 否

eyeEnlarging type 为 face-beautify  时⽣效，⼤眼程度，取值范围[0,100]。0表⽰不
⼤眼，100表⽰最⾼程度。默认值70。

Integer 否

gender
type 为  face-gender-transformation 时⽣效，选择转换⽅向，0表⽰男
变⼥，1表⽰⼥变男。⽆默认值。注意：仅对图⽚中⾯积最⼤的⼈脸进
⾏转换。

Integer 是

age type 为 face-age-transformation  时⽣效，变化到的⼈脸年龄，范围为
[10,80]，⽆默认值。注意：仅对图⽚中⾯积最⼤的⼈脸进⾏转换。

Integer 是

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第379 共2247⻚

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

  <ResultImage>base64编码的图⽚</ResultImage>

  <ResultMask>base64编码的⽂件</ResultMask>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第380 共2247⻚

Response 的内容：

节点名称（关

键字）
⽗节点 描述 类型

ResultImage Response 处理后的图⽚ base64 数据。 String

ResultMask Response

⼈像分割输出参数，⼀个通过 Base64 编码的⽂件，解码后⽂
件由 Float 型浮点数组成。这些浮点数代表原图从左上⾓开始
的每⼀⾏的每⼀个像素点，每⼀个浮点数的值是原图相应像素

点位于⼈体轮廓内的置信度（0-1）转化的灰度值（0-255）。

String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第381 共2247⻚

GET /test.jpg?ci-process=face-effect&type=face-beautify&whitening=70&smoothing=80&f

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第382 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <ResultImage>base64编码的图⽚</ResultImage>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第383 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第384 共2247⻚

⼈脸核⾝

⾝份证识别
最近更新时间：2024-01-20 09:22:44

功能描述

⽀持中国⼤陆居⺠⼆代⾝份证正反⾯所有字段的识别，包括姓名、性别、⺠族、出⽣⽇期、住址、公⺠⾝份证号、

签发机关、有效期限；具备⾝份证照⽚、⼈像照⽚的裁剪功能和翻拍、PS、复印件告警功能，以及边框和框内遮挡
告警、临时⾝份证告警和⾝份证有效期不合法告警等扩展功能。

说明：

当前⾝份证识别的图⽚限制为：要求图⽚经 Base64 编码后不超过7M，分辨率建议500 × 800以上，⽀持 PNG、
JPG、JPEG、BMP 格式。建议卡⽚部分占据图⽚2/3以上。
⾝份证识别为付费服务，计费详情请参⻅内容识别费⽤。

该功能⽬前仅提供 API 使⽤⽅式。

请求

上传时处理

⾝份证图⽚上传时识别的请求包与 COS 简单上传⽂件接⼝⼀致，只需增加相关处理参数，即可在图⽚上传时返回识
别结果，并可将原图存⼊到 COS。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第385 共2247⻚

PUT /<ObjectKey>?ci-process=IDCardOCR&CardSide=<CardSide>&Config=<Config> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第386 共2247⻚

云上数据处理

云上数据处理请求能够对已存储在 COS 的⾝份证图⽚进⾏相应处理操作，返回识别结果。

GET /<ObjectKey>?ci-process=IDCardOCR&CardSide=<CardSide>&Config=<Config> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第387 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求参数

参数名称 描述 类型
是否必

选

ObjectKey 对象⽂件名，例如：folder/document.jpg String 是

ci-process 数据万象处理能⼒，⾝份证识别固定为 IDCardOCR String 是

CardSide
FRONT：⾝份证有照⽚的⼀⾯（⼈像⾯）
BACK：⾝份证有国徽的⼀⾯（国徽⾯）
该参数如果不填，将为您⾃动判断⾝份证正反⾯

String 否

Config

以下可选字段均为 bool 类型，默认 false：
CropIdCard，⾝份证照⽚裁剪（去掉证件外多余的边缘、⾃动矫正拍
摄⾓度）

CropPortrait，⼈像照⽚裁剪（⾃动抠取⾝份证头像区域）
CopyWarn，复印件告警
BorderCheckWarn，边框和框内遮挡告警
ReshootWarn，翻拍告警
DetectPsWarn，PS 检测告警
TempIdWarn，临时⾝份证告警
InvalidDateWarn，⾝份证有效⽇期不合法告警
Quality，图⽚质量分数（评价图⽚的模糊程度）
MultiCardDetect，是否开启多卡证检测
参数设置⽅式参考：

Config = {"CropIdCard":true,"CropPortrait":true}

String 否

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第388 共2247⻚

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

  <IdInfo>

    ⾝份证识别信息

  </IdInfo>

  <AdvancedInfo>

    ⾝份证识别信息

  </AdvancedInfo>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第389 共2247⻚

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

IdInfo Response ⾝份证识别信息 Container

AdvancedInfo Response 扩展信息，不请求则不

返回
Container

IdInfo⾝份证识别信息中包含如下内容：

节点名称（关键字） ⽗节点 描述 类型

Name IdInfo 姓名（⼈像⾯） String

Sex IdInfo 性别（⼈像⾯） String

Nation IdInfo ⺠族（⼈像⾯） String

Birth IdInfo 出⽣⽇期（⼈像⾯） String

Address IdInfo 地址（⼈像⾯） String

IdNum IdInfo ⾝份证号（⼈像⾯） String

Authority IdInfo 发证机关（国徽⾯） String

ValidDate IdInfo 证件有效期（国徽⾯） String

AdvancedInfo扩展信息信息中包含如下内容：

节点名称（关键

字）
⽗节点 描述 类型

IdCard AdvancedInfo 裁剪后⾝份证照⽚的 Base64 编码，设置 
Config.CropIdCard 为 true 时返回

String

Portrait AdvancedInfo ⾝份证头像照⽚的 Base64 编码，设置 Config.CropPortrait 
为 true 时返回

String

Quality AdvancedInfo 图⽚质量分数，设置  Config.Quality 为 true 时返回（取值范
围：0~100，分数越低越模糊，建议阈值≥50）

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第390 共2247⻚

BorderCodeValue AdvancedInfo
⾝份证边框不完整告警阈值分数，设置 
Config.BorderCheckWarn 为 true 时返回（取值范围：
0~100，分数越低边框遮挡可能性越低，建议阈值≥50）

String

WarnInfos IdInfo

告警信息，Code 告警码列表和释义：
9100 ⾝份证有效⽇期不合法告警
9101 ⾝份证边框不完整告警
9102 ⾝份证复印件告警
9103 ⾝份证翻拍告警
9104 临时⾝份证告警
9105 ⾝份证框内遮挡告警
9106 ⾝份证 PS 告警
可能存在多个 WarnInfos

String

实际案例

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第391 共2247⻚

GET /test.jpg?ci-process=IDCardOCR&CardSide=FRONT&Config={"CropIdCard"：true, "CropI

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第392 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <IdInfo>

     <Name>张明</Name>

     <Sex>男</Sex>
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     <Nation>汉</Nation>

     <Birth>1987/1/1</Birth>

     <Address>北京市⽯景⼭区⾼新技术园腾讯⼤楼</Address>

     <IdNum>440524198701010014</IdNum>

  </IdInfo>

  <AdvancedInfo>

     <IdCard>裁剪后⾝份证照⽚的 Base64 编码</IdCard>

     <Portrait>⾝份证头像照⽚的 Base64 编码</Portrait>

  </AdvancedInfo>

</Response>

错误码

以下仅列出了接⼝业务逻辑相关的错误码，其他错误信息请参⻅ 错误码 ⽂档。

错误码 描述

FailedOperation.DownLoadError ⽂件下载失败

FailedOperation.EmptyImageError 图⽚内容为空

FailedOperation.IdCardInfoIllegal ⾝份证信息不合法（⾝份证号、姓名字段校验⾮法

等）

FailedOperation.ImageBlur 图⽚模糊

FailedOperation.ImageDecodeFailed 图⽚解码失败

FailedOperation.ImageNoIdCard 图⽚中未检测到⾝份证

FailedOperation.ImageSizeTooLarge 图⽚尺⼨过⼤，请参考输出参数中关于图⽚⼤⼩限制

的说明

FailedOperation.MultiCardError 照⽚中存在多张卡

FailedOperation.OcrFailed OCR 识别失败

FailedOperation.UnKnowError 未知错误

FailedOperation.UnOpenError 服务未开通

InvalidParameter.ConfigFormatError Config 格式错误

InvalidParameterValue.InvalidParameterValueLimit 参数值错误

LimitExceeded.TooLargeFileError ⽂件内容太⼤

https://www.tencentcloud.com/document/product/1045/43611
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ResourcesSoldOut.ChargeStatusException 计费状态异常
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图⽚⽂字识别（OCR）
通⽤⽂字识别
最近更新时间：2024-01-20 09:22:44

功能描述

通⽤⽂字识别功能（Optical Character Recognition，OCR）基于⾏业前沿的深度学习技术，将图⽚上的⽂字内容，
智能识别为可编辑的⽂本，可应⽤于随⼿拍扫描、纸质⽂档电⼦化、电商⼴告审核等多种场景，⼤幅提升信息处理

效率。

本接⼝属于 GET 请求，为同步请求⽅式。

费⽤说明

成功调⽤接⼝会产⽣ 通⽤⽂字识别费⽤ 和 COS 读请求费⽤。
如果图⽚属于 COS 上的低频存储类型，成功调⽤接⼝会产⽣ COS 低频数据取回费⽤。
不⽀持对 COS 上的归档存储类型和深度归档存储类型的图⽚进⾏处理，如果需要处理此类型图⽚，请先 恢复归档⽂
件。

限制说明

图⽚⽀持格式：PNG、JPG、JPEG、BMP 及 PDF ⽂件。
图⽚⼤⼩：所下载⽂件经 Base64 编码后不超过7MB。
图⽚分辨率：建议⼤于600*800像素，否则影响识别效果。
调⽤接⼝需携带签名，具体规则请参⻅ 请求签名 ⽂档。

请求

请求⽰例

https://www.tencentcloud.com/zh/pdf/document/1045/33453?lang=zh&domain=www.tencentcloud.com
https://www.tencentcloud.com/document/product/436/40100
https://www.tencentcloud.com/document/product/436/40097
https://www.tencentcloud.com/document/product/436/12633
https://www.tencentcloud.com/document/product/1045/33452
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GET /<ObjectKey>?ci-process=OCR&type=general&language-type=zh&ispdf=true&pdf-pagenu

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求参数

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
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参数名称 描述 类型 是否必

选

ObjectKey 对象⽂件名，例如：folder/document.jpg。 String 是

ci-process 数据万象处理能⼒，图⽚⽂字识别固定为 OCR。 String 是

type

OCR 的识别类型，有效值为 general，accurate，efficient，fast，
handwriting。general 表⽰通⽤印刷体识别；accurate 表⽰印刷体
⾼精度版；efficient 表⽰印刷体精简版；fast 表⽰印刷体⾼速版；
handwriting 表⽰⼿写体识别。默认值为 general。

String 否

language-type
type 值为 general 时有效，表⽰识别语⾔类型。⽀持⾃动识别语⾔
类型，同时⽀持⾃选语⾔种类，默认中英⽂混合(zh)，各种语⾔均
⽀持与英⽂混合的⽂字识别。可选值请参⻅ 可识别的语⾔类型。

String 否

ispdf
type 值为 general、fast 时有效，表⽰是否开启 PDF 识别，有效值
为 true 和 false，默认值为 false，开启后可同时⽀持图⽚和 PDF 
的识别。

Boolean 否

pdf-
pagenumber

type 值为 general、fast 时有效，表⽰需要识别的 PDF ⻚⾯的对应
⻚码，仅⽀持 PDF 单⻚识别，当上传⽂件为 PDF 且 ispdf 参数值
为 true 时有效，默认值为1。

Integer 否

isword type 值为 general、accurate 时有效，表⽰识别后是否需要返回单
字信息，有效值为 true 和 false，默认为 false。

Boolean 否

enable-word-
polygon

type 值为 handwriting 时有效，表⽰是否开启单字的四点定位坐标
输出，有效值为 true 和 false，默认值为 false。

Boolean 否

可识别的语⾔类型

可选值 语⾔ 可选值 语⾔

zh 中英混合 rus 俄语

zh_rare ⽀持英⽂、数字、中⽂⽣僻字、繁体字，

特殊符号等
ita 意⼤利语

auto ⾃动 hol 荷兰语

mix 混合语种 swe 瑞典语

jap ⽇语 fin 芬兰语

kor 韩语 dan 丹⻨语

spa ⻄班⽛语 nor 挪威语
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fre 法语 hun 匈⽛利语

ger 德语 tha 泰语

por 葡萄⽛语 hi 印地语

vie 越语 ara 阿拉伯语

may ⻢来语

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352
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<Response>

  <TextDetections>

    <DetectedText></DetectedText>

    <Confidence></Confidence>

    <Polygon>

      <X></X>

      <Y></Y>

    </Polygon>

    <ItemPolygon>

      <X></X>

      <Y></Y>
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      <Width></Width>

      <Height></Height>

    </ItemPolygon>

    <Words>

      <Confidence></Confidence>

      <Character></Character>

      <WordCoordPoint>

        <WordCoordinate>

          <X></X>

          <Y></Y>

        </WordCoordinate>

      </WordCoordPoint>

    </Words>

  </TextDetections>

  <Language></Language>

  <Angel></Angel>

  <PdfPageSize></PdfPageSize>

  <RequestId></RequestId>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器。 Container

Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

TextDetections Response 检测到的⽂本信息，包括⽂本⾏内容、置信度、⽂本⾏坐标以

及⽂本⾏旋转纠正后的坐标。
Container

Language Response 检测到的语⾔类型，⽬前⽀持的语⾔类型可参考⼊参 
language-type 说明。

String

Angel Response 图⽚旋转⾓度（⾓度制），⽂本的⽔平⽅向为0°；顺时针为
正，逆时针为负。

Float

PdfPageSize Response 图⽚为 PDF 时，返回 PDF 的总⻚数，默认为0。 Integer

RequestId Response 唯⼀请求 ID，每次请求都会返回。定位问题时需要提供该次请
求的 RequestId。

String

TextDetections 节点的内容：
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节点名称（关

键字）

⽗节点 描述 类型

DetectedText TextDetections 识别出的⽂本⾏内容。 String

Confidence TextDetections 置信度 0 - 100。 Integer

Polygon TextDetections ⽂本⾏坐标，以顶点坐标表⽰ 注意：此字段可能返回 
null，表⽰取不到有效值。

Container

ItemPolygon TextDetections ⽂本⾏在旋转纠正之后的图像中的像素坐标，表⽰为（左

上⾓ x, 左上⾓ y，宽 width，⾼ height）。
Container

Words TextDetections
识别出来的单字信息包括单字（包括单字 Character 和单
字置信度 confidence），⽀持识别的接⼝：general、
accurate。

Container

WordPolygon TextDetections
字的坐标数组，以四个顶点坐标表⽰。

注意：此字段可能返回 null，表⽰取不到有效值。⽀持识
别的类型：handwriting。

Container

Polygon 节点的内容：

节点名称（关键字） ⽗节点 描述 类型

X Polygon 横坐标。 Integer

Y Polygon 纵坐标。 Integer

ItemPolygon 节点的内容：

节点名称（关键字） ⽗节点 描述 类型

X ItemPolygon 左上⾓ x。 Integer

Y ItemPolygon 左上⾓ y。 Integer

Width ItemPolygon 宽 width。 Integer

Height ItemPolygon ⾼ height。 Integer

Words 节点的内容：

节点名称（关键字） ⽗节点 描述 类型

Confidence Words 置信度 0 - 100。 Integer
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Character Words 识别出来的单词信息。 String

WordCoordPoint Words 单字在原图中的四点坐标，⽀持识别的接⼝：

general、accurate。
Container

WordCoordPoint 节点的内容：

节点名称（关键字） ⽗节点 描述 类型

WordCoordinate WordCoordPoint 单字在原图中的坐标，以四个顶点坐标表⽰，

以左上⾓为起点，顺时针返回。
Container

WordCoordinate 节点的内容：

节点名称（关键字） ⽗节点 描述 类型

X WordCoordinate 横坐标。 Integer

Y WordCoordinate 纵坐标。 Integer

WordPolygon 节点的内容：

节点名称（关键字） ⽗节点 描述 类型

LeftTop WordPolygon 左上顶点坐标。 Container

RightTop WordPolygon 右上顶点坐标。 Container

RightBottom WordPolygon 右下顶点坐标。 Container

LeftBottom WordPolygon 左下顶点坐标。 Container

LeftTop，RightTop，RightBottom，LeftBottom 节点的内容：

节点名称（关键字） ⽗节点 描述 类型

X WordCoordinate 横坐标。 Integer

Y WordCoordinate 纵坐标。 Integer

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

https://www.tencentcloud.com/document/product/1045/49353
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请求

GET /<ObjectKey>?ci-process=OCR&type=general&language-type=zh&ispdf=true&isword=tru

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<Response>

    <Angel>359.99</Angel>

    <Language>mix</Language>

    <PdfPageSize>0</PdfPageSize>
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    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TextDetections>

        <Confidence>99</Confidence>

        <DetectedText>你好</DetectedText>

        <ItemPolygon>

            <Height>64</Height>

            <Width>123</Width>

            <X>140</X>

            <Y>167</Y>

        </ItemPolygon>

        <Polygon>

            <X>140</X>

            <Y>167</Y>

        </Polygon>

        <Polygon>

            <X>263</X>

            <Y>167</Y>

        </Polygon>

        <Polygon>

            <X>263</X>

            <Y>231</Y>

        </Polygon>

        <Polygon>

            <X>140</X>

            <Y>231</Y>

        </Polygon>

        <Words>

            <Character>你</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>212</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>231</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>212</X>

                    <Y>231</Y>

                </WordCoordinate>

            </WordCoordPoint>
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        </Words>

        <Words>

            <Character>好</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>341</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>263</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>263</X>

                    <Y>231</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>230</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

    </TextDetections>

    <TextDetections>

        <Confidence>99</Confidence>

        <DetectedText>再⻅</DetectedText>

        <ItemPolygon>

            <Height>43</Height>

            <Width>245</Width>

            <X>526</X>

            <Y>1444</Y>

        </ItemPolygon>

        <Polygon>

            <X>526</X>

            <Y>1444</Y>

        </Polygon>

        <Polygon>

            <X>771</X>

            <Y>1444</Y>

        </Polygon>

        <Polygon>

            <X>771</X>

            <Y>1487</Y>

        </Polygon>

        <Polygon>

            <X>526</X>
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            <Y>1487</Y>

        </Polygon>

        <Words>

            <Character>再</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>564</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1487</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>564</X>

                    <Y>1487</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

        <Words>

            <Character>⻅</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>641</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>641</X>

                    <Y>1487</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1487</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

    </TextDetections>
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</Response>



数据万象
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语⾳识别

任务接⼝

提交语⾳识别任务
最近更新时间：2024-01-20 09:22:44

功能描述

CreateSpeechJobs 接⼝⽤于提交⼀个语⾳识别任务。

请求

请求⽰例
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POST /asr_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：
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Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/43609
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  <Tag>SpeechRecognition</Tag>

  <Input>

    <Object></Object>

  </Input>

  <Operation>

    <SpeechRecognition></SpeechRecognition>

    <Output>

      <Region></Region>

      <Bucket></Bucket>

      <Object></Object>

    </Output>

  </Operation>

  <QueueId></QueueId>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag，⽬前仅⽀持：
SpeechRecognition

String 是

Input Request 待操作的语⾳⽂件 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Object Request.Input 语⾳⽂件在 COS 上的 key，Bucket 由 
Host 指定

String 是
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Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

SpeechRecognition Request.Operation 当 Tag 为 SpeechRecognition 时有
效，指定该任务的参数

Container 否

Output Request.Operation 结果输出地址 Container 是

Container 类型 SpeechRecognition 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是

否

必

选

EngineModelType Request.Operation.SpeechRecognition

引擎模型类型。

电话场景：

• 8k_zh：电话 8k 中⽂普
通话通⽤（可⽤于双声道

⾳频）；

• 8k_zh_s：电话 8k 中⽂
普通话话者分离（仅适⽤

于单声道⾳频）；

⾮电话场景：

• 16k_zh：16k 中⽂普通
话通⽤；

• 16k_zh_video：16k ⾳
视频领域；

• 16k_en：16k 英语； 
• 16k_ca：16k 粤语。

String 是

ChannelNum Request.Operation.SpeechRecognition
语⾳声道数。1：单声
道；2：双声道（仅⽀持 
8k_zh 引擎模型）。

Integer 是

ResTextFormat Request.Operation.SpeechRecognition

识别结果返回形式。0： 
识别结果⽂本(含分段时间
戳)； 1：仅⽀持16k中⽂
引擎，含识别结果详情(词
时间戳列表，⼀般⽤于⽣

成字幕场景)。

Integer 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第414 共2247⻚

FilterDirty Request.Operation.SpeechRecognition 是否过滤脏词（⽬前⽀持

中⽂普通话引擎）。0：
不过滤脏词；1：过滤脏
词；2：将脏词替换为 * 。
默认值为0。

Integer 否

FilterModal Request.Operation.SpeechRecognition

是否过语⽓词（⽬前⽀持

中⽂普通话引擎）。0：
不过滤语⽓词；1：部分
过滤；2：严格过滤 。默
认值为 0。

Integer 否

ConvertNumMode Request.Operation.SpeechRecognition

是否进⾏阿拉伯数字智能

转换（⽬前⽀持中⽂普通

话引擎）。0：不转换，
直接输出中⽂数字，1：
根据场景智能转换为阿拉

伯数字。默认值为1。

Integer 否

Container 类型 Output 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存

储桶
String 是

Object Request.Operation.Output 结果⽂件的名

称
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第415 共2247⻚

<Response>

  <JobsDetail>

    <Code></Code>

    <Message></Message>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <QueueId></QueueId>

    <Tag><Tag>

    <Input>

      <Object></Object>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第416 共2247⻚

    </Input>

    <Operation>

      <SpeechRecognition></SpeechRecognition>

      <Output>

        <Region></Region>

        <Bucket></Bucket>

        <Object></Object>

      </Output>

      <MediaInfo>

      </MeidaInfo>

    </Operation>

  </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：SpeechRecognition String

State Response.JobsDetail 任务的状态，为 Submitted、Running、
Success、Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第417 共2247⻚

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容： 

同上⾯请求中的 Request.Input 节点。
Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

Output Response.JobsDetail.Operation ⽂件的输出地址 Container

MediaInfo Response.JobsDetail.Operation 转码输出视频的信息，没有

时不返回
Container

Container 节点 Output 的内容： 
同上⾯请求中的 Request.Operation.Output 节点。
Container 节点 SpeechRecognition 的内容： 

同上⾯请求中的 Request.Operation.SpeechRecognition节点。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第418 共2247⻚

查询指定的语⾳识别任务
最近更新时间：2024-01-20 09:22:44

功能描述

DescribeSpeechJob ⽤于查询指定的语⾳识别任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第419 共2247⻚

GET /asr_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第420 共2247⻚

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第421 共2247⻚

<Response>

  <JobsDetail></JobsDetail>

  <NonExistJobIds></NonExistJobIds>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第422 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息，同 CreateSpeechJobs 接⼝的 
Response.JobsDetail 节点

Container

NonExistJobIds Response 查询的 ID 中不存在的任务，所有任务都存在时不返
回

String

SpeechRecognitionResult Response 在 job 的类型为 SpeechRecognition 且 job 状态为 
success 时，返回语⾳识别的识别结果详情。

Container

Container 节点 SpeechRecognitionResult 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Result Response.SpeechRecognitionResult 识别结果 Container

ResultDetail Response.SpeechRecognition.ResultDetail

识别结果详情，包含每个

句⼦中的词时间偏移，⼀

般⽤于⽣成字幕的场景。

(识别请求中
ResTextFormat=1时该字
段不为空)
注意：此字段可能返回 
null，表⽰取不到有效值。

Array of 
SentenceDetail

AudioTime Response.SpeechRecognition.audioTime 语⾳时⻓ double

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第423 共2247⻚

批量拉取语⾳识别任务
最近更新时间：2024-01-20 09:22:44

功能描述

DescribeSpeechJobs ⽤于拉取符合条件的语⾳识别任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第424 共2247⻚

GET /asr_jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第425 共2247⻚

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

请求参数

参数的具体内容如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

queueId ⽆ 拉取该队列 ID 下的任务。 String 是

tag ⽆ 任务的 Tag：SpeechRecognition。 String 是

orderByTime ⽆ Desc 或者 Asc。默认为 Desc。 String 否

nextToken ⽆ 请求的上下⽂，⽤于翻⻚。上次返回的值。 String 否

size ⽆ 拉取的最⼤任务数。默认为10。最⼤为100。 Integer 否

states ⽆

拉取该状态的任务，以  , 分割，⽀持多状态：All、
Submitted、Running、Success、Failed、Pause、
Cancel。默认为 All。

String 否

startCreationTime ⽆
拉取创建时间⼤于该时间的任务。格式为：  %Y-%m-

%dT%H:%m:%S%z 
String 否

endCreationTime ⽆
拉取创建时间⼩于该时间的任务。格式为：  %Y-%m-

%dT%H:%m:%S%z 
String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第426 共2247⻚

<Response>

  <JobsDetail></JobsDetail>

  <NextToken></NextToken>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第427 共2247⻚

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

JobsDetail Response 任务的详细信息，同 CreateSpeechJobs 接⼝中的 
Response.JobsDetail 节点

Container

NextToken Response 翻⻚的上下⽂ Token String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第428 共2247⻚

队列接⼝

查询语⾳识别队列
最近更新时间：2024-01-20 09:22:44

功能描述

DescribeSpeechQueues 接⼝⽤于查询语⾳识别队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第429 共2247⻚

GET /asrqueue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第430 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

名称 类型 描述
是否必

选

queueIds string 队列 ID，以“,”符号分割字符串。 否

state string

1.  Active 表⽰队列内的作业会被语⾳识别服务调度执⾏。
2. Paused 表⽰队列暂停，作业不再会被语⾳识别服务调度执⾏，
队列内的所有作业状态维持在暂停状态，已经处于识别中的任务将

继续执⾏，不受影响。

否

pageNumber string 第⼏⻚。 否

pageSize string 每⻚个数。 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第431 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第432 共2247⻚

        <UpdateTime></UpdateTime>

        <CreateTime></CreateTime>

        <NotifyConfig>

            <Url></Url>

            <Type></Type>

            <State></State>

            <Event></Event>

        </NotifyConfig>

    </QueueList>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前⻚数，同请求中的 pageNumber Int

PageSize Response 每⻚个数，同请求中的 pageSize Int

QueueList Response 队列数组 Container

Container 节点 QueueList 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueId Response.QueueList 队列 ID String

Name Response.QueueList 队列名字 String

State Response.QueueList 当前状态，Active 或者 Paused String

NotifyConfig Response.QueueList 回调配置 Container

MaxSize Response.QueueList 队列最⼤⻓度 Int

MaxConcurrent Response.QueueList 当前队列最⼤并⾏执⾏的任务数 Int

UpdateTime Response.QueueList 更新时间 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第433 共2247⻚

CreateTime Response.QueueList 创建时间 String

Container 节点 NotifyConfig 的内容：

节点名称（关键字） ⽗节点 描述 类型

Url Response.QueueList.NotifyConfig 回调地址 String

State Response.QueueList.NotifyConfig 开关状态，On 或者 Off String

Type Response.QueueList.NotifyConfig 回调类型，Url String

Event Response.QueueList.NotifyConfig 触发回调的事件 String

该响应体返回为 application/xml 数据，当指定queueIds时包含完整节点数据的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第434 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url></Url>

        </NotifyConfig>

    </QueueList>

    <NonExistPIDs>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第435 共2247⻚

        <QueueID>B</QueueID>

        <QueueID>C</QueueID>

    </NonExistPIDs>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

QueueList Response 队列数组，同上⾯解释的 
QueueList

Container

NonExistPIDs Response 不存在的队列 ID 列表 Container

Container 节点 NonExistPIDs 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueID Response.NonExistPIDs 队列 ID String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第436 共2247⻚

更新语⾳识别队列
最近更新时间：2024-01-20 09:22:44

功能描述

UpdateSpeechQueue 接⼝⽤于更新语⾳识别队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第437 共2247⻚

PUT /asrqueue/p8eb46b8cc1a94bc09512d16c5c4f4d3a HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第438 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有以下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第439 共2247⻚

    <Name>Queue Name</Name>

    <QueueID></QueueID>

    <State></State>

    <NotifyConfig>

        <Type></Type>

        <Url></Url>

        <Event></Event>

    </NotifyConfig>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选
限制

Name Request 模板名称 String 是 ⻓度限制100字符

QueueID Request 管道 ID String 是 -

State Request 管道状态 String 是

1. Active 表⽰管道内的作业会被语⾳识
别服务调度执⾏

2. Paused 表⽰管道暂停，作业不再会
被语⾳识别服务调度执⾏，管道内的所

有作业状态维持在已提交状态，已经处

于识别中的任务将继续执⾏，不受影响

NotifyConfig Request 通知渠道 Container 是 第三⽅回调 Url

Container 类型 NotifyConfig 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选
限制

Url Request.NotifyConfig 回调配置 String 否
⻓度限制100
字符

Type Request.NotifyConfig 回调类型，普通回调：

Url
String 否 ⻓度限制100

字符



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第440 共2247⻚

Event Request.NotifyConfig 回调事件 String 否
⻓度限制100
字符

State Request.NotifyConfig 回调开关，Off，On String 否
⻓度限制100
字符

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第441 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Queue>

        <QueueId></QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>mts-topic-1</Url>

            <Type></Type>

            <Event></Event>

        </NotifyConfig>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第442 共2247⻚

        <CreateTime></CreateTime>

        <UpdateTime></UpdateTime>

    </Queue>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

Queue Response 队列信息，详情同 [DescribeSpeechQueues]中的 
Response.QueueList

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第443 共2247⻚

以图搜图

开通以图搜图
最近更新时间：2024-01-20 09:22:44

功能描述

该接⼝⽤于开通 Bucket 搜图功能。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第444 共2247⻚

POST /ImageSearchBucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第445 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求参数

此接⼝⽆请求参数。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第446 共2247⻚

<Request>

    <MaxCapacity>10000</MaxCapacity>

    <MaxQps>10</MaxQps>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第447 共2247⻚

Request 节点的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

MaxCapacity Request 图库容量限制 Int 是

MaxQps Request 图库访问限制，默

认10
Int 否

说明：

 图库容量设置后不允许修改。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应⽆响应体。

错误码

此接⼝遵循统⼀的错误响应和错误码，详情请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/436/7729
https://www.tencentcloud.com/document/product/436/7730


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第448 共2247⻚

POST /ImageSearchBucket HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 50

Content-Type: application/xml

<Request>

    <MaxCapacity>10000</MaxCapacity>

    <MaxQps>10</MaxQps>

</Request>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第449 共2247⻚

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第450 共2247⻚

添加图库图⽚
最近更新时间：2024-01-20 09:22:44

功能描述

该接⼝⽤于添加图库图⽚。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第451 共2247⻚

POST /<ObjectKey>?ci-process=ImageSearch&action=AddImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第452 共2247⻚

 Authorization: Auth String （详情请参⻅ 请求签名 ⽂档）。

请求参数

此接⼝⽆请求参数。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第453 共2247⻚

<Request>

    <EntityId>apple</EntityId>

    <CustomContent>myapple</CustomContent>

    <Tags>{"key1":"val1","key2":"val2"}</Tags>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Request节点的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

EntityId Request 物品 ID，最多⽀持64个字符。若 EntityId 已存在，
则对其追加图⽚

String 是

CustomContent Request ⽤户⾃定义的内容，最多⽀持4096个字符，查询时
原样带回

String 否

Tags Request 图⽚⾃定义标签，最多不超过10个，json 字符串，
格式为 key:value 对

String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应⽆响应体。

错误码

此接⼝遵循统⼀的错误响应和错误码，详情请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/436/7729
https://www.tencentcloud.com/document/product/436/7730


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第454 共2247⻚

POST /<ObjectKey>?ci-process=ImageSearch&action=AddImage HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 100

Content-Type: application/xml

<Request>

    <EntityId>apple</EntityId>

    <CustomContent>myapple</CustomContent>

    <Tags>{"key1":"val1","key2":"val2"}</Tags>

</Request>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第455 共2247⻚

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第456 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第457 共2247⻚

图⽚搜索接⼝
最近更新时间：2024-01-20 09:22:44

功能描述

该接⼝⽤于检索图⽚。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第458 共2247⻚

GET /<ObjectKey>?ci-process=ImageSearch&action=SearchImage&MatchThreshold=&Offset= 

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第459 共2247⻚

 Authorization: Auth String （详情请参⻅ 请求签名 ⽂档）。

请求参数

参数的具体内容如下：

节点名称（关键

字）
描述 类型

是否必

选

MatchThreshold 出参 Score 中，只有超过 MatchThreshold 值的结果才会返回。默认
为0

Int 否

Offset 起始序号，默认值为0 Int 否

Limit 返回数量，默认值为10，最⼤值为100 Int 否

Filter 针对⼊库时提交的 Tags 信息进⾏条件过滤。⽀持>、>=、<、<=、
=、!=，多个条件之间⽀持 AND 和 OR 进⾏连接

String 否

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728
https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第460 共2247⻚

<Response>

    <Count>2</Count>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey1</PicName>

        <Score>99</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

    <ImageInfos>

        <EntityId>apple</EntityId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第461 共2247⻚

        <PicName>ObjectKey2</PicName>

        <Score>90</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Response 节点的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

Count Response 数量 Int

ImageInfos Response 图⽚信息 Container

ImageInfos 节点为数组，其中每⼀项内容为

节点名称（关键字） ⽗节点 描述 类型

EntityId ImageInfos 物品 ID String

CustomContent ImageInfos 图⽚⾃定义的内容 String

Tags ImageInfos ⾃定义标签信息，json 
字符串

String

PicName ImageInfos 图⽚名称 String

Score ImageInfos 相似度 Int

错误码

此接⼝遵循统⼀的错误响应和错误码，详情请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/436/7730


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第462 共2247⻚

GET /<ObjectKey>?ci-process=ImageSearch&action=SearchImage&MatchThreshold=10&Offset

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第463 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 150

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Count>2</Count>

    <ImageInfos>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第464 共2247⻚

        <EntityId>apple</EntityId>

        <PicName>ObjectKey</PicName>

        <Score>99</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey2</PicName>

        <Score>90</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第465 共2247⻚

删除图库图⽚
最近更新时间：2024-01-20 09:22:44

功能描述

该接⼝⽤于删除图库图⽚。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第466 共2247⻚

POST /<ObjectKey>?ci-process=ImageSearch&action=DeleteImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第467 共2247⻚

 Authorization: Auth String （详情请参⻅ 请求签名 ⽂档）。

请求参数

此接⼝⽆请求参数。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第468 共2247⻚

<Request>

    <EntityId>apple</EntityId>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Request 节点的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

EntityId Request 物品 ID String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应⽆响应体。

错误码

此接⼝遵循统⼀的错误响应和错误码，详情请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/436/7729
https://www.tencentcloud.com/document/product/436/7730


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第469 共2247⻚

POST /<ObjectKey>?ci-process=ImageSearch&action=DeleteImage HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 20

Content-Type: application/xml

<Request>

    <EntityId>apple</EntityId>

</Request>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第470 共2247⻚

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第471 共2247⻚

队列接⼝

查询队列
最近更新时间：2024-01-20 09:22:44

功能描述

搜索 AI 内容识别队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第472 共2247⻚

GET /ai_queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第473 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

参数名称（关键

字）
描述 类型

是否必

选

queueIds 队列 ID，以“,”符号分割字符串 String 否

state
1. Active 表⽰队列内的作业会被媒体处理服务调度执⾏
2. Paused 表⽰队列暂停，作业不再会被媒体处理调度执⾏，队列
内的所有作业状态维持在暂停状态，已经执⾏中的任务不受影响

String 否

pageNumber 第⼏⻚，默认值1 String 否

pageSize 每⻚个数，默认值10 String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第474 共2247⻚

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>queue-ai-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第475 共2247⻚

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前⻚数，同请求中的 
pageNumber

Int

PageSize Response 每⻚个数，同请求中的 
pageSize

Int

QueueList Response 队列数组 Container数组

NonExistPIDs Response 不存在的队列 ID 列表 String数组

Container 节点 QueueList 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueId Response.QueueList 队列 ID String

Name Response.QueueList 队列名字 String

State Response.QueueList 当前状态，Active 或者 
Paused

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第476 共2247⻚

NotifyConfig Response.QueueList 回调配置 Container

MaxSize Response.QueueList 队列最⼤⻓度 Int

MaxConcurrent Response.QueueList 当前队列最⼤并⾏执⾏

的任务数
Int

Category Response.QueueList 队列类型 String

UpdateTime Response.QueueList 更新时间 String

CreateTime Response.QueueList 创建时间 String

Container 节点 NotifyConfig 的内容：

节点名称（关键字） ⽗节点 描述 类型

Url Response.QueueList.NotifyConfig 回调地址 String

State Response.QueueList.NotifyConfig 开关状态，On 或者 
Off

String

Type Response.QueueList.NotifyConfig 回调类型，Url String

Event Response.QueueList.NotifyConfig

任务完成：

TaskFinish；
⼯作流完成：

WorkflowFinish

String

ResultFormat Response.QueueList.NotifyConfig 回调类型，XML 或者 
JSON

String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：搜索指定队列

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第477 共2247⻚

GET /ai_queue?queueIds=p23f69f4779e64b18aa61e70d5416c071,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应1



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第478 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x

<Response>

    <RequestId>NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x</RequestId>

    <QueueList>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第479 共2247⻚

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>queue-ai-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

请求2：查询队列列表



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第480 共2247⻚

GET /ai_queue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应2



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第481 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第482 共2247⻚

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>queue-ai-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第483 共2247⻚

更新队列
最近更新时间：2024-01-20 09:22:44

功能描述

更新 AI 内容识别队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第484 共2247⻚

PUT /ai_queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第485 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有以下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第486 共2247⻚

    <Name>My-Queue-AI</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

具体的数据内容如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选 默认值 限制

Request ⽆
保存结果的

容器
Container 是 ⽆ ⽆

Container 节点 Request 的内容：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

默认

值
限制

Name Request 队列名称，⻓度不超过128 String 是 ⽆ ⽆

State Request

1. Active 表⽰队列内的作业会被
媒体处理服务调度执⾏ 
2. Paused 表⽰队列暂停，作业
不再会被媒体处理调度执⾏，队

列内的所有作业状态维持在暂停

状态，已经执⾏中的任务不受影

响

String 是 ⽆ ⽆

NotifyConfig Request 回调配置 Container 是 ⽆ ⽆

Container 节点 NotifyConfig 的内容：

节点名称

（关键字）
⽗节点 描述 类型 是否必选

默认

值
限制

State Request.NotifyConfig
回调开

关，

Off/On
String 否 Off On/Off

Event Request.NotifyConfig 回调事

件

String 当 State=On 
时, 必选

⽆ 任务完成：

TaskFinish；⼯



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第487 共2247⻚

作流完成：

WorkflowFinish

ResultFormat Request.NotifyConfig 回调格

式
String 否 XML JSON/XML

Type Request.NotifyConfig 回调类

型
String 当 State=On 

时, 必选
⽆ Url 或 TDMQ

Url Request.NotifyConfig
回调地

址
String

当 State=On, 
且 Type=Url 
时, 必选

⽆ 不能为内⽹地址

MqMode Request.NotifyConfig
TDMQ 
使⽤模

式

String

当 State=On, 
且 
Type=TDMQ 
时, 必选

Queue

主题订阅：

Topic 
队列服务: 
Queue

MqRegion Request.NotifyConfig
TDMQ 
所属园

区

String

当 State=On, 
且 
Type=TDMQ 
时, 必选

⽆

⽬前⽀持园区 sh
（上海）、bj
（北京）、gz
（⼴州）、cd
（成都）、hk
（中国⾹港）

MqName Request.NotifyConfig
TDMQ 
主题名

称

String

当 State=On, 
且 
Type=TDMQ 
时, 必选

⽆ ⽆

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第488 共2247⻚

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>My-Queue-AI</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第489 共2247⻚

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

Queue Response 队列信息 Container

Container 节点 Queue 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueId Response.Queue 队列 ID String

Name Response.Queue 队列名字 String

State Response.Queue 当前状态，Active 或者 Paused String

NotifyConfig Response.Queue 回调配置，同 
Request.NotifyConfig

Container

MaxSize Response.Queue 队列最⼤⻓度 Int

MaxConcurrent Response.Queue 当前队列最⼤并⾏执⾏的任务数 Int

Category Response.Queue 队列类型 String

UpdateTime Response.Queue 更新时间 String

CreateTime Response.Queue 创建时间 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第490 共2247⻚

实际案例

请求

PUT /ai_queue/p23f69f4779e64b18aa61e70d5416c071 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 162

Content-Type: application/xml



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第491 共2247⻚

<Request>

    <Name>My-Queue-AI</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第492 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第493 共2247⻚

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>My-Queue-AI</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第494 共2247⻚

服务配置

开通 AI 内容识别
最近更新时间：2024-01-20 09:22:44

功能描述

开通 AI 内容识别服务并⽣成队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第495 共2247⻚

POST /ai_bucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第496 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第497 共2247⻚

<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <AiBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucket>

</Response>

具体的数据内容如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第498 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

AiBucket Response 存储桶信息 Container

Container 节点 AiBucket 的内容：

节点名称（关键字） ⽗节点 描述 类型

BucketId Response.AiBucket 存储桶 ID String

Name Response.AiBucket 存储桶名称，同 
BucketId

String

Region Response.AiBucket 所在的地域 String

CreateTime Response.AiBucket 创建时间 String

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第499 共2247⻚

POST /ai_bucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第500 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <AiBucket>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第501 共2247⻚

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucket>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第502 共2247⻚

查询 AI 内容识别
最近更新时间：2024-01-20 09:22:44

功能描述

查询 AI 内容识别服务状态。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第503 共2247⻚

GET /ai_bucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第504 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

名称 描述 类型
是否必

选

regions 地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域以“,”分隔字
符串，⽀持中国⼤陆地域，详情请参⻅ 地域与域名

string 否

bucketNames 存储桶名称，以“,”分隔，⽀持多个存储桶，精确搜索 string 否

bucketName 存储桶名称前缀，前缀搜索 string 否

pageNumber 第⼏⻚，默认值1 String 否

pageSize 每⻚个数，默认值10 String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/33423
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第505 共2247⻚

<Response>

    <RequestId>NjJmMzY1Y2NfOTBmYTUwNjRfNTA5YV8y</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>5</PageSize>

    <AiBucketList>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-08T16:23:11+0800></CreateTime>

    </AiBucketList>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第506 共2247⻚

    <AiBucketList>

        <BucketId>test-1-1234567890</BucketId>

        <Name>test-1-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucketList>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 媒体 Bucket 总数 Int

PageNumber Response 当前⻚数，同请求中的 
pageNumber

Int

PageSize Response 每⻚个数，同请求中的 
pageSize

Int

AiBucketList Response 媒体 Bucket 列表 Container

Container 节点 AiBucketList 的内容：

节点名称（关键字） ⽗节点 描述 类型

BucketId Response.AiBucketList 存储桶 ID String

Name Response.AiBucketList 存储桶名称，同 
BucketId

String

Region Response.AiBucketList 所在的地域 String

CreateTime Response.AiBucketList 创建时间 String

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第507 共2247⻚

实际案例

请求

GET /ai_bucket?regions=ap-chongqing&pageSize=5&bucketName=t HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第508 共2247⻚

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzY1Y2NfOTBmYTUwNjRfNTA5YV8y

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第509 共2247⻚

    <RequestId>NjJmMzY1Y2NfOTBmYTUwNjRfNTA5YV8y</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>5</PageSize>

    <AiBucketList>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-08T16:23:11+0800></CreateTime>

    </AiBucketList>

    <AiBucketList>

        <BucketId>test-1-1234567890</BucketId>

        <Name>test-1-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucketList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第510 共2247⻚

智能语⾳

智能语⾳接⼝列表
最近更新时间：2024-01-20 10:09:09

任务接⼝

任务是⼀个抽象的概念，智能语⾳包含多种类型的任务，如语⾳合成、⾳频降噪等。

在⼀个任务中，包含3个关键信息：输⼊、输出和参数。输⼊和输出设置任务执⾏时的输⼊⽂件以及执⾏后的⽬标⽂
件，参数则⽤来设置执⾏具体功能的详细配置。

⼯作流接⼝

智能语⾳中的⼯作流是指通过配置多个单任务操作组合对指定的上传⽂件进⾏⾃动化处理的过程，⼯作流调⽤请参

考 ⼯作流接⼝。

批量任务处理接⼝

批量任务处理是对指定的存量⽂件进⾏单任务处理或按照⼯作流中配置的操作⾃动化处理，调⽤请参考 批量数据处
理接⼝。

功能 任务接⼝

智能语⾳

⾳频降噪 提交⾳频降噪任务

⼈声分离 提交⼈声分离任务

语⾳合成 提交语⾳合成任务

语⾳识别 提交语⾳识别任务

https://www.tencentcloud.com/document/product/1045/43618
https://www.tencentcloud.com/document/product/1045/48921
https://www.tencentcloud.com/document/product/1045/48933
https://www.tencentcloud.com/document/product/1045/48946
https://www.tencentcloud.com/document/product/1045/48942
https://www.tencentcloud.com/document/product/1045/49789


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第511 共2247⻚

智能语⾳服务配置接⼝

查询语⾳识别开通状态
最近更新时间：2024-01-20 10:09:09

功能描述

DescribeSpeechBuckets 接⼝⽤于查询存储桶是否已开通语⾳识别功能。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第512 共2247⻚

GET /asrbucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第513 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

名称 类型 描述 是否必选

regions string 地域信息，以“,”分隔字符串，⽀持 All、ap-
shanghai、ap-beijing

否

bucketNames string 存储桶名称，以“,”分隔，⽀持多个存储桶，精确搜索 否

bucketName string 存储桶名称前缀，前缀搜索 否

pageNumber string 第⼏⻚ 否

pageSize string 每⻚个数 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第514 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <AsrBucketList>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </AsrBucketList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第515 共2247⻚

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 媒体 Bucket 总数 Int

PageNumber Response 当前⻚数，同请求中的 
pageNumber

Int

PageSize Response 每⻚个数，同请求中的 
pageSize

Int

AsrBucketList Response 语⾳ Bucket 列表 Container

Container 节点 AsrBucketList 的内容：

节点名称（关键字） ⽗节点 描述 类型

BucketId Response.AsrBucketList 存储桶 ID String

Name Response.AsrBucketList 存储桶名称，同 
BucketId

String

Region Response.AsrBucketList 所在的地域 String

CreateTime Response.AsrBucketList 创建时间 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第516 共2247⻚

媒体处理

媒体处理接⼝列表
最近更新时间：2024-01-20 10:09:09

任务接⼝

任务是⼀个抽象的概念，媒体处理包含多种类型的任务，如转码任务、截图任务、媒体信息任务等。

在⼀个任务中，包含3个关键信息：输⼊、输出和参数。输⼊和输出设置任务执⾏时的输⼊⽂件以及执⾏后的⽬标⽂
件，参数则⽤来设置执⾏具体功能的详细配置。

任务包含同步模式和异步模式：

同步任务：⽤户侧同步提交待处理任务。

异步任务：任务按提交顺序和优先级进⼊媒体处理队列中排队。

功能 任务接⼝

基础处理

⾳视频转码 提交⾳视频转码任务

极速⾼清转码 提交极速⾼清任务

视频转动图 提交视频转动图任务

视频截帧 提交视频截帧任务

⾳视频转封装 提交转封装任务

⾳视频拼接 提交视频拼接任务

获取媒体信息 提交获取媒体信息任务

画质增强

画质增强（包含超分辨率、插帧、⾊彩增

强等功能）
提交画质增强任务

视频质量评分 提交质量评分任务

版权保护 数字⽔印 提交添加数字⽔印任务

智能编辑

视频标签 提交视频标签任务

精彩集锦 提交精彩集锦任务

智能封⾯ 提交智能封⾯任务

智能语⾳ ⾳频降噪 提交⾳频降噪任务

https://www.tencentcloud.com/document/product/1045/48941
https://www.tencentcloud.com/document/product/1045/49782
https://www.tencentcloud.com/document/product/1045/49569
https://www.tencentcloud.com/document/product/1045/48938
https://www.tencentcloud.com/document/product/1045/48936
https://www.tencentcloud.com/document/product/1045/48929
https://www.tencentcloud.com/document/product/1045/48932
https://www.tencentcloud.com/document/product/1045/48944
https://www.tencentcloud.com/document/product/1045/48934
https://www.tencentcloud.com/document/product/1045/48930
https://www.tencentcloud.com/document/product/1045/48945
https://www.tencentcloud.com/document/product/1045/48943
https://www.tencentcloud.com/document/product/1045/48937
https://www.tencentcloud.com/document/product/1045/48933


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第517 共2247⻚

⼈声分离 提交⼈声分离任务  

语⾳合成 提交语⾳合成任务

语⾳识别 提交语⾳识别任务

同步任务

视频截图 获取媒体截图任务

获取媒体信息 获取媒体信息任务

私有m3u8 读取m3u8任务 

模板接⼝

针对媒体处理功能（例如⾳视频转码、⾳视频拼接、视频截帧和视频转动图等），您需要在数据万象创建任务或⼯

作流时，指定使⽤的模板，模板⻚为您提供了系统预设模板，您也可根据⾃⾝业务需求⾃定义模板，媒体处理模板

接⼝请参⻅ 媒体处理模板。

⼯作流接⼝

媒体处理中的⼯作流是指通过配置多个单任务操作组合对指定的上传⽂件进⾏⾃动化处理的过程，⼯作流调⽤请参

⻅ ⼯作流接⼝。

批量任务处理接⼝

批量任务处理是对指定的存量⽂件进⾏单任务处理或按照⼯作流中配置的操作⾃动化处理，调⽤请参⻅ 批量数据处
理接⼝。

https://www.tencentcloud.com/document/product/1045/48946
https://www.tencentcloud.com/document/product/1045/48942
https://www.tencentcloud.com/document/product/1045/49789
https://www.tencentcloud.com/document/product/1045/49539
https://www.tencentcloud.com/document/product/1045/49541
https://www.tencentcloud.com/document/product/1045/49542
https://www.tencentcloud.com/document/product/1045/49899
https://www.tencentcloud.com/document/product/1045/43618
https://www.tencentcloud.com/document/product/1045/47027


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第518 共2247⻚

媒体处理服务配置接⼝

查询媒体处理服务
最近更新时间：2024-01-20 10:09:09

功能描述

DescribeMediaBuckets 接⼝⽤于查询已经开通媒体处理功能的存储桶。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第519 共2247⻚

GET /mediabucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第520 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

名称 描述 类型 是否必选

regions
地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域
以“,”分隔字符串，⽀持中国⼤陆地域，详情请参⻅ 地域与
域名

string 否

bucketNames 存储桶名称，以“,”分隔，⽀持多个存储桶，精确搜索 string 否

bucketName 存储桶名称前缀，前缀搜索 string 否

pageNumber 第⼏⻚ string 否

pageSize 每⻚个数 string 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/33423
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第521 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaBucketList>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucketList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第522 共2247⻚

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 媒体 Bucket 总数 Int

PageNumber Response 当前⻚数，同请求中的 
pageNumber

Int

PageSize Response 每⻚个数，同请求中的 
pageSize

Int

MediaBucketList Response 媒体 Bucket 列表 Container

Container 节点 MediaBucketList 的内容：

节点名称（关键字） ⽗节点 描述 类型

BucketId Response.MediaBucketList 存储桶 ID String

Name Response.MediaBucketList 存储桶名称，同 
BucketId

String

Region Response.MediaBucketList 所在的地域 String

CreateTime Response.MediaBucketList 创建时间 String

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第523 共2247⻚

GET /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第524 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第525 共2247⻚

      <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

      <TotalCount>1</TotalCount>

      <PageNumber>1</PageNumber>

      <PageSize>10</PageSize>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第526 共2247⻚

绑定媒体处理服务
最近更新时间：2024-01-20 10:09:09

功能描述

CreateMediaBucket 接⼝⽤于绑定媒体存储桶操作（授权媒体处理服务⾓⾊访问存储桶）。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第527 共2247⻚

POST /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第528 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第529 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucket>

</Response>

具体的数据内容如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第530 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

MediaBucket Response 媒体 Bucket 详情，同 DescribeMediaBuckets 中的 
Response.MediaBucketList

Container

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49940
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第531 共2247⻚

POST /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第532 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第533 共2247⻚

        <BucketId>examplebucket-1250000000</BucketId>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucket>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第534 共2247⻚

解绑媒体处理服务
最近更新时间：2024-01-20 10:09:09

功能描述

DELETEMediaBucket 接⼝⽤于解绑媒体存储桶操作（不会删除存储桶内的对象）。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第535 共2247⻚

DELETE /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第536 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第537 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

</Response>

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第538 共2247⻚

请求

DELETE /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第539 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第540 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第541 共2247⻚

媒体 bucket 接⼝
查询媒体处理开通状态
最近更新时间：2024-01-20 10:09:09

功能描述

DescribeMediaBuckets 接⼝⽤于查询已经开通媒体处理功能的存储桶。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第542 共2247⻚

GET /mediabucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第543 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

名称 描述 类型 是否必选

regions
地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域
以“,”分隔字符串，⽀持中国⼤陆地域，详情请参⻅ 地域与
域名

string 否

bucketNames 存储桶名称，以“,”分隔，⽀持多个存储桶，精确搜索 string 否

bucketName 存储桶名称前缀，前缀搜索 string 否

pageNumber 第⼏⻚ string 否

pageSize 每⻚个数 string 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/33423
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第544 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaBucketList>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucketList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第545 共2247⻚

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 媒体 Bucket 总数 Int

PageNumber Response 当前⻚数，同请求中的 
pageNumber

Int

PageSize Response 每⻚个数，同请求中的 
pageSize

Int

MediaBucketList Response 媒体 Bucket 列表 Container

Container 节点 MediaBucketList 的内容：

节点名称（关键字） ⽗节点 描述 类型

BucketId Response.MediaBucketList 存储桶 ID String

Name Response.MediaBucketList 存储桶名称，同 
BucketId

String

Region Response.MediaBucketList 所在的地域 String

CreateTime Response.MediaBucketList 创建时间 String

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第546 共2247⻚

GET /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第547 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第548 共2247⻚

      <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

      <TotalCount>1</TotalCount>

      <PageNumber>1</PageNumber>

      <PageSize>10</PageSize>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第549 共2247⻚

开通媒体处理
最近更新时间：2024-01-20 10:09:09

功能描述

CreateMediaBucket 接⼝⽤于绑定媒体存储桶操作（授权媒体处理服务⾓⾊访问存储桶）。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第550 共2247⻚

POST /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第551 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第552 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucket>

</Response>

具体的数据内容如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第553 共2247⻚

节点名称（关键

字）

⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

MediaBucket Response 媒体 Bucket 详情，同 DescribeMediaBuckets 中的 
Response.MediaBucketList

Container

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43671
https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第554 共2247⻚

POST /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第555 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第556 共2247⻚

        <BucketId>examplebucket-1250000000</BucketId>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucket>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第557 共2247⻚

CreateMediaBucket
最近更新时间：2024-01-20 10:09:09

功能描述

CreateMediaBucket 接⼝⽤于绑定媒体存储桶操作（授权媒体处理服务⾓⾊访问存储桶）。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第558 共2247⻚

POST /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第559 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第560 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucket>

</Response>

具体的数据内容如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第561 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

MediaBucket Response 媒体 Bucket 详情，同 DescribeMediaBuckets 中的 
Response.MediaBucketList

Container

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43671
https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第562 共2247⻚

POST /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第563 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第564 共2247⻚

        <BucketId>examplebucket-1250000000</BucketId>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucket>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第565 共2247⻚

队列接⼝

搜索媒体处理队列
最近更新时间：2024-01-20 10:09:09

功能描述

搜索媒体处理队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第566 共2247⻚

GET /queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第567 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

参数名称（关键

字）
描述 类型

是否必

选

queueIds 队列 ID，以“,”符号分割字符串。 String 否

state

1. Active 表⽰队列内的作业会被媒体处理服务调度执⾏。 
2. Paused 表⽰队列暂停，作业不再会被媒体处理调度执⾏，
队列内的所有作业状态维持在暂停状态，已经执⾏中的任务不

受影响。

String 否

category

1. CateAll：所有类型。
2.  Transcoding：媒体处理队列。
3. SpeedTranscoding：媒体处理倍速转码队列。
4. 默认为 Transcoding。

String 否

pageNumber 第⼏⻚，默认值1。 String 否

pageSize 每⻚个数，默认值10。 String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第568 共2247⻚

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第569 共2247⻚

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <QueueList>

        <QueueId>pbf17a810dce74c18a641b663aede6803</QueueId>

        <Name>queue-speed-transcoding-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>SpeedTranscoding</Category>

    </QueueList>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前⻚数，同请求中的 pageNumber Int

PageSize Response 每⻚个数，同请求中的 pageSize Int



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第570 共2247⻚

QueueList Response 队列数组 Container数组

NonExistPIDs Response 不存在的队列 ID 列表 String数组

Container 节点 QueueList 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueId Response.QueueList 队列 ID String

Name Response.QueueList 队列名字 String

State Response.QueueList 当前状态，Active 或者 
Paused

String

NotifyConfig Response.QueueList 回调配置 Container

MaxSize Response.QueueList 队列最⼤⻓度 Int

MaxConcurrent Response.QueueList 当前队列最⼤并⾏执⾏

的任务数
Int

Category Response.QueueList 队列类型 String

UpdateTime Response.QueueList 更新时间 String

CreateTime Response.QueueList 创建时间 String

Container 节点 NotifyConfig 的内容：

节点名称（关键字） ⽗节点 描述 类型

Url Response.QueueList.NotifyConfig 回调地址 String

State Response.QueueList.NotifyConfig 开关状态，On 或者 
Off

String

Type Response.QueueList.NotifyConfig 回调类型，Url String

Event Response.QueueList.NotifyConfig

任务完成：

TaskFinish；
⼯作流完成：

WorkflowFinish

String

ResultFormat Response.QueueList.NotifyConfig 回调类型，XML 或者 
JSON

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第571 共2247⻚

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：搜索指定队列

GET /queue?queueIds=p4a17eeea29334bf499b7e20e2fbfd99d,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第572 共2247⻚

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第573 共2247⻚

Server: tencent-ci

x-ci-request-id: NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x

<Response>

    <RequestId>NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x</RequestId>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

请求2：查询队列列表



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第574 共2247⻚

GET /queue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应2



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第575 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>2</TotalCount>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第576 共2247⻚

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <QueueList>

        <QueueId>pbf17a810dce74c18a641b663aede6803</QueueId>

        <Name>queue-speed-transcoding-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>SpeedTranscoding</Category>

    </QueueList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第577 共2247⻚

更新媒体处理队列
最近更新时间：2024-01-20 10:09:09

功能描述

更新媒体处理队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第578 共2247⻚

PUT /queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第579 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有以下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第580 共2247⻚

    <Name>My-Queue-Media</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型 是否必选 默认值 限制

Request ⽆ 保存结果的容器。 Container 是 ⽆ ⽆

Container 节点 Request 的内容：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

默认

值

限

制

Name Request 队列名称，⻓度不超过128 String 是 ⽆ ⽆

State Request

1. Active 表⽰队列内的作业会被媒
体处理服务调度执⾏

2. Paused 表⽰队列暂停，作业不
再会被媒体处理调度执⾏，队列内

的所有作业状态维持在暂停状态，

已经执⾏中的任务不受影响

String 是 ⽆ ⽆

NotifyConfig Request 回调配置 Container 是 ⽆ ⽆

Container 节点 NotifyConfig 的内容：

节点名称

（关键字）
⽗节点 描述 类型 是否必选 默认值 限制

State Request.NotifyConfig
回调开

关，

Off/On
String 否 Off On/Off

Event Request.NotifyConfig 回调事

件
String 当 State=On 

时, 必选
⽆

任务完成：

TaskFinish；⼯
作流完成：

WorkflowFinish



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第581 共2247⻚

ResultFormat Request.NotifyConfig 回调格

式

String 否 XML JSON/XML

Type Request.NotifyConfig 回调类

型
String 当 State=On 

时, 必选
⽆ Url 或 TDMQ

Url Request.NotifyConfig
回调地

址
String

当 State=On, 
且 Type=Url 
时, 必选

⽆
不能为内⽹地

址

MqMode Request.NotifyConfig
TDMQ 
使⽤模

式

String

当 State=On, 
且 
Type=TDMQ 
时, 必选

Queue

主题订阅：

Topic 
队列服务: 
Queue

MqRegion Request.NotifyConfig
TDMQ 
所属园

区

String

当 State=On, 
且 
Type=TDMQ 
时, 必选

⽆

⽬前⽀持园区 
sh（上海）、bj
（北京）、gz
（⼴州）、cd
（成都）、hk
（中国⾹港）

MqName Request.NotifyConfig
TDMQ 
主题名

称

String

当 State=On, 
且 
Type=TDMQ 
时, 必选

⽆ ⽆

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第582 共2247⻚

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-Media</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第583 共2247⻚

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

Queue Response 队列信息 Container

Container 节点 Queue 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueId Response.Queue 队列 ID String

Name Response.Queue 队列名字 String

State Response.Queue 当前状态，Active 或者 
Paused

String

NotifyConfig Response.Queue 回调配置，同 
Request.NotifyConfig

Container

MaxSize Response.Queue 队列最⼤⻓度 Int

MaxConcurrent Response.Queue 当前队列最⼤并⾏执⾏的任

务数
Int

Category Response.Queue 队列类型 String

UpdateTime Response.Queue 更新时间 String

CreateTime Response.Queue 创建时间 String

错误码



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第584 共2247⻚

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

PUT /queue/p4a17eeea29334bf499b7e20e2fbfd99d HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第585 共2247⻚

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-Media</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第586 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第587 共2247⻚

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-Media</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第588 共2247⻚

同步媒体处理

获取媒体截图

获取媒体⽂件截图
最近更新时间：2024-01-20 10:09:09

功能描述

GetSnapshot 接⼝⽤于获取媒体⽂件某个时间的截图。

使⽤说明

此接⼝为同步模式，异步模式请参考 任务接⼝-截图任务。

请求⽰例

1. 通过GET请求⽅式

https://www.tencentcloud.com/document/product/1045/48938


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第589 共2247⻚

GET /<ObjectKey>?ci-process=snapshot&time=1&format=jpg HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

2. 通过URL地址添加参数⽅式



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第590 共2247⻚

https://<BucketName-APPID>.cos.<Region>.myqcloud.com/for-test.mp4?ci-process=snapsh

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

<ObjectKey>为存储桶对象。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第591 共2247⻚

请求参数

参数说明如下：

参数名称 描述 类型 是否必选

ci-process 操作类型，固定使⽤ snapshot String 是

time 截图的时间点，单位为秒 float 是

width 截图的宽。默认为0 Int 否

height
截图的⾼。默认为0
当 width 和 height 都为0时，表⽰使⽤视频的宽⾼。如果单个为
0，则以另外⼀个值按视频宽⾼⽐例⾃动适应

Int 否

format 截图的格式，⽀持 jpg 和 png，默认 jpg String 否

rotate

图⽚旋转⽅式

auto：按视频旋转信息进⾏⾃动旋转
off：不旋转
默认值为 auto

String 否

mode

截帧⽅式

keyframe：截取指定时间点之前的最近的⼀个关键帧
exactframe：截取指定时间点的帧
默认值为 exactframe

String 否

请求体

该请求⽆请求体。

响应

响应头

该响应包含公共响应头，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体为截图⽂件内容。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅错误码 ⽂档。

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第592 共2247⻚

实际案例

请求1 通过GET请求⽅式

GET /for-test.mp4?ci-process=snapshot&time=1.5 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG****-si

Content-Length: 0



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第593 共2247⻚

请求2 通过URL地址添加参数⽅式

https://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/for-test.mp4?ci-proces

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第594 共2247⻚

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 266005

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<图⽚内容>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第595 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第596 共2247⻚

获取媒体⽂件截图（万象域名）
最近更新时间：2024-01-20 10:09:09

功能描述

GenerateSnapshot 接⼝⽤于获取媒体⽂件某个时间的截图，输出的截图统⼀为 jpeg 格式。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第597 共2247⻚

POST /snapshot HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第598 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该 API 接⼝请求的请求体具体节点内容为：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第599 共2247⻚

  <Input>

    <Object></Object>

  </Input>

  <Time></Time>

  <Width></Width>

  <Height></Height>

  <Mode></Mode>

  <Rotate></Rotate>

  <Format></Format>

  <Output>

    <Region></Region>

    <Bucket></Bucket>

    <Object></Object>

  </Output>

</Request>

具体的数据内容如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆
保存 Generate Snapshot 请
求的容器

Container 是

Container 节点 Request 的内容：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

Input Request 媒体⽂件的位置信息 Container 是

Time Request 截取哪个时间点的内容，单位为秒 Float 是

Output Request 截图保存的位置信息 Container 是

Width Request 截图的宽。默认为0 Int 否

Height Request

截图的⾼。默认为0。
Width 和 Height 都为0时，表⽰使⽤视频的宽⾼。如
果单个为0，则以另外⼀个值按视频宽⾼⽐例⾃动适
应。

Int 否

Format Request 截图的格式，⽀持 jpg 和 png，默认 jpg String 否

Mode Request 截帧⽅式

keyframe：截取指定时间点之前的最近的⼀个关键
帧

exactframe：截取指定时间点的帧

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第600 共2247⻚

默认值为 exactframe

Rotate Request

图⽚旋转⽅式

auto：按视频旋转信息进⾏⾃动旋转
off：不旋转
默认值为 auto

String 否

Container 节点 Input 的内容：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input ⽂件的名称 String 是

Container 节点 Output 的内容：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Region Request.Output 存储桶所在的地域 String 是

Bucket Request.Output ⽂件所属的 COS 
存储桶

String 是

Object Request.Output ⽂件的名称 String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第601 共2247⻚

<Response>

  <Output>

    <Region></Region>

    <Bucket></Bucket>

    <Object></Object>

  </Output>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第602 共2247⻚

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

Output Request 截图保存的位置信息 Container

Container 节点 Output 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.Output 存储桶所在的地域 String

Bucket Response.Output ⽂件所属的 COS 存储桶 String

Object Response.Output ⽂件的名称 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第603 共2247⻚

POST /snapshot HTTP/1.1

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj****&q-si

Content-Length: 552

Content-Type: application/xml

<Request>

  <Input>

    <Object>video-for-test.mp4</Object>

  </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第604 共2247⻚

  <Time>10</Time>

  <Output>

    <Region>ap-beijing</Region>

    <Bucket>ci-output-1250000000</Bucket>

    <Object>snapshot/video-for-test-snapshot.jpg</Object>

  </Output>

</Request>

响应

HTTP/1.1 200 OK



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第605 共2247⻚

Content-Type: application/xml

Content-Length: 266

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-ci-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZm****

<Response>

  <Output>

    <Region>ap-beijing</Region>

    <Bucket>ci-output-1250000000</Bucket>

    <Object>snapshot/video-for-test-snapshot.jpg</Object>

  </Output>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第606 共2247⻚

GenerateSnapshot
最近更新时间：2024-01-20 10:09:09

功能描述

GenerateSnapshot 接⼝⽤于获取媒体⽂件某个时间的截图，输出的截图统⼀为 jpeg 格式。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第607 共2247⻚

POST /snapshot HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第608 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该 API 接⼝请求的请求体具体节点内容为：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第609 共2247⻚

  <Input>

    <Object></Object>

  </Input>

  <Time></Time>

  <Width></Width>

  <Height></Height>

  <Mode></Mode>

  <Rotate></Rotate>

  <Format></Format>

  <Output>

    <Region></Region>

    <Bucket></Bucket>

    <Object></Object>

  </Output>

</Request>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型 是否必选

Request ⽆ 保存 Generate Snapshot 请求的容器 Container 是

Container 节点 Request 的内容：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Input Request 媒体⽂件的位置信息 Container 是

Time Request 截取哪个时间点的内容，单位为秒 Float 是

Output Request 截图保存的位置信息 Container 是

Width Request 截图的宽。默认为0 Int 否

Height Request

截图的⾼。默认为0。
Width 和 Height 都为0时，表⽰使⽤视频的宽⾼。如
果单个为0，则以另外⼀个值按视频宽⾼⽐例⾃动适
应。

Int 否

Format Request 截图的格式，⽀持 jpg 和 png，默认 jpg String 否

Mode Request

截帧⽅式

keyframe：截取指定时间点之前的最近的⼀个关键帧
exactframe：截取指定时间点的帧
默认值为 exactframe

String 否

Rotate Request 图⽚旋转⽅式。 String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第610 共2247⻚

auto：按视频旋转信息进⾏⾃动旋转
off：不旋转
默认值为 auto

Container 节点 Input 的内容：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input ⽂件的名称 String 是

Container 节点 Output 的内容：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Region Request.Output 存储桶所在的地域 String 是

Bucket Request.Output ⽂件所属的 COS 
存储桶

String 是

Object Request.Output ⽂件的名称 String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第611 共2247⻚

<Response>

  <Output>

    <Region></Region>

    <Bucket></Bucket>

    <Object></Object>

  </Output>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第612 共2247⻚

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

Output Request 截图保存的位置信息 Container

Container 节点 Output 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.Output 存储桶所在的地域 String

Bucket Response.Output ⽂件所属的 COS 存储桶 String

Object Response.Output ⽂件的名称 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第613 共2247⻚

POST /snapshot HTTP/1.1

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj****&q-si

Content-Length: 552

Content-Type: application/xml

<Request>

  <Input>

    <Object>video-for-test.mp4</Object>

  </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第614 共2247⻚

  <Time>10</Time>

  <Output>

    <Region>ap-beijing</Region>

    <Bucket>ci-output-1250000000</Bucket>

    <Object>snapshot/video-for-test-snapshot.jpg</Object>

  </Output>

</Request>

响应

HTTP/1.1 200 OK



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第615 共2247⻚

Content-Type: application/xml

Content-Length: 266

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-ci-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZm****

<Response>

  <Output>

    <Region>ap-beijing</Region>

    <Bucket>ci-output-1250000000</Bucket>

    <Object>snapshot/video-for-test-snapshot.jpg</Object>

  </Output>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第616 共2247⻚

获取媒体信息

获取媒体⽂件信息
最近更新时间：2024-01-20 10:09:09

功能描述

GetMediainfo 接⼝⽤于获取媒体⽂件的信息。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第617 共2247⻚

GET /<ObjectKey>?ci-process=videoinfo HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。
<ObjectKey>为存储桶对象。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第618 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求参数

参数说明如下：

节点名称（关键

字）

⽗节

点
描述 类型 是否必选

ci-process ⽆ 操作类型，固定使⽤ videoinfo String 是

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/436/7728
https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第619 共2247⻚

<Response>

      <MediaInfo>

         <Stream>

            <Video>

                <Index></Index>

                <CodecName></CodecName>

                <CodecLongName></CodecLongName>

                <CodecTimeBase></CodecTimeBase>

                <CodecTagString></CodecTagString>

                <CodecTag></CodecTag>

                <ColorPrimaries></ColorPrimaries>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第620 共2247⻚

                <ColorRange></ColorRange>

                <ColorTransfer></ColorTransfer>

                <Profile></Profile>

                <Width></Width>

                <Height></Height>

                <HasBFrame></HasBFrame>

                <RefFrames></RefFrames>

                <Sar></Sar>

                <Dar></Dar>

                <PixFormat></PixFormat>

                <FieldOrder></FieldOrder>

                <Level></Level>

                <Fps></Fps>

                <AvgFps></AvgFps>

                <Timebase></Timebase>

                <StartTime></StartTime>

                <Duration></Duration>

                <Bitrate></Bitrate>

                <NumFrames></NumFrames>

                <Language></Language>

            </Video>

            <Audio>

                <Index></Index>

                <CodecName></CodecName>

                <CodecLongName></CodecLongName>

                <CodecTimeBase></CodecTimeBase>

                <CodecTagString></CodecTagString>

                <CodecTag></CodecTag>

                <SampleFmt></SampleFmt>

                <SampleRate></SampleRate>

                <Channel></Channel>

                <ChannelLayout></ChannelLayout>

                <Timebase></Timebase>

                <StartTime></StartTime>

                <Duration></Duration>

                <Bitrate></Bitrate>

                <Language></Language>

            </Audio>

            <Subtitle>

                <Index></Index>

                <Language></Language>

            </Subtitle>

         </Stream>

         <Format>

            <NumStream></NumStream>

            <NumProgram></NumProgram>

            <FormatName></FormatName>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第621 共2247⻚

            <FormatLongName></FormatLongName>

            <StartTime></StartTime>

            <Duration></Duration>

            <Bitrate></Bitrate>

            <Size></Size>

         </Format>

      </MediaInfo>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

MediaInfo Response 媒体的详细信息 Container

Container 节点 MediaInfo 的内容：

节点名称（关键字） ⽗节点 描述 类型

Stream Response.MediaInfo 流信息 Container

Format Response.MediaInfo 格式信息 Container

Container 节点 Stream 的内容：

节点名称（关键字） ⽗节点 描述 类型

Video Response.MediaInfo.Stream 视频信息 Container

Audio Response.MediaInfo.Stream ⾳频信息 Container

Subtitle Response.MediaInfo.Stream 字幕信息 Container

Container 节点 Format 的内容（查询视频信息时，可能部分字段未返回）：

节点名称（关键

字）
⽗节点 描述 类型

NumStream Response.MediaInfo.Format Stream（包含 Video、Audio、Subtitle）的
数量

Int



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第622 共2247⻚

NumProgram Response.MediaInfo.Format 节⽬的数量 Int

FormatName Response.MediaInfo.Format 容器格式名字 String

FormatLongName Response.MediaInfo.Format 容器格式的详细名字 String

StartTime Response.MediaInfo.Format 起始时间，单位为秒 Float

Duration Response.MediaInfo.Format 时⻓，单位为秒 Float

Bitrate Response.MediaInfo.Format ⽐特率，单位为 kbps Int

Size Response.MediaInfo.Format ⼤⼩，单位为 Byte Int

Container 节点 Video 的内容（查询视频信息时，可能部分字段未返回）：

节点名称（关键

字）
⽗节点 描述 类型

Index Response.MediaInfo.Stream.Video 该流的编号 Int

CodecName Response.MediaInfo.Stream.Video 编解码格式名字 String

CodecLongName Response.MediaInfo.Stream.Video 编解码格式的详细名

字
String

CodecTimeBase Response.MediaInfo.Stream.Video 编码时基 String

CodecTagString Response.MediaInfo.Stream.Video 编码标签名 String

CodecTag Response.MediaInfo.Stream.Video 编码标签 String

ColorPrimaries Response.MediaInfo.Stream.Video ⾊原 String

ColorRange Response.MediaInfo.Stream.Video ⾊彩范围 String

ColorTransfer Response.MediaInfo.Stream.Video ⾊彩通道 String

Profile Response.MediaInfo.Stream.Video 视频编码档位 String

Height Response.MediaInfo.Stream.Video 视频⾼，单位 px Int

Width Response.MediaInfo.Stream.Video 视频宽，单位 px Int

HasBFrame Response.MediaInfo.Stream.Video 是否有B帧。1表⽰
有，0表⽰⽆

Int

RefFrames Response.MediaInfo.Stream.Video 视频编码的参考帧个

数

Int
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Sar Response.MediaInfo.Stream.Video 采样宽⾼⽐ String

Dar Response.MediaInfo.Stream.Video 显⽰宽⾼⽐ String

PixFormat Response.MediaInfo.Stream.Video 像素格式 String

FieldOrder Response.MediaInfo.Stream.Video 场的顺序 String

Level Response.MediaInfo.Stream.Video 视频编码等级 Int

Fps Response.MediaInfo.Stream.Video 视频帧率 Float

AvgFps Response.MediaInfo.Stream.Video 平均帧率 String

Timebase Response.MediaInfo.Stream.Video 时基 String

StartTime Response.MediaInfo.Stream.Video 视频开始时间，单位

为秒
Float

Duration Response.MediaInfo.Stream.Video 视频时⻓，单位为秒 Float

Bitrate Response.MediaInfo.Stream.Video ⽐特率，单位为 kbps Float

NumFrames Response.MediaInfo.Stream.Video 总帧数 Int

Language Response.MediaInfo.Stream.Video 语⾔ String

Container 节点 Audio 的内容（查询视频信息时，可能部分字段未返回）：

节点名称（关键

字）
⽗节点 描述 类型

Index Response.MediaInfo.Stream.Audio 该流的编号 Int

CodecName Response.MediaInfo.Stream.Audio 编解码格式名字 String

CodecLongName Response.MediaInfo.Stream.Audio 编解码格式的详细名

字
String

CodecTimeBase Response.MediaInfo.Stream.Audio 编码时基 String

CodecTagString Response.MediaInfo.Stream.Audio 编码标签名 String

CodecTag Response.MediaInfo.Stream.Audio 编码标签 String

SampleFmt Response.MediaInfo.Stream.Audio 采样格式 String

SampleRate Response.MediaInfo.Stream.Audio 采样率 Int
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Channel Response.MediaInfo.Stream.Audio 通道数量 Int

ChannelLayout Response.MediaInfo.Stream.Audio 通道格式 String

Timebase Response.MediaInfo.Stream.Audio 时基 String

StartTime Response.MediaInfo.Stream.Audio ⾳频开始时间，单位

秒
Float

Duration Response.MediaInfo.Stream.Audio ⾳频时⻓，单位秒 Float

Bitrate Response.MediaInfo.Stream.Audio ⽐特率，单位 kbps Float

Language Response.MediaInfo.Stream.Audio 语⾔ String

Container 节点 Subtitle 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Index Response.MediaInfo.Stream.Subtitle 该流的编号 Int

Language Response.MediaInfo.Stream.Subtitle 语⾔，und 表⽰⽆查
询结果

String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅错误码⽂档。

实际案例

请求
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GET /for-test.mp4?ci-process=videoinfo HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG****-si

Content-Length: 0

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第626 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Response>
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        <MediaInfo>

                <Format>

                        <Bitrate>1014.950000</Bitrate>

                        <Duration>10.125000</Duration>

                        <FormatLongName>QuickTime / MOV</FormatLongName>

                        <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                        <NumProgram>0</NumProgram>

                        <NumStream>2</NumStream>

                        <Size>1284547</Size>

                        <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                        <Audio>

                                <Bitrate>70.451000</Bitrate>

                                <Channel>1</Channel>

                                <ChannelLayout>mono</ChannelLayout>

                                <CodecLongName>AAC (Advanced Audio Coding)</CodecLo

                                <CodecName>aac</CodecName>

                                <CodecTag>0x6134706d</CodecTag>

                                <CodecTagString>mp4a</CodecTagString>

                                <CodecTimeBase>1/44100</CodecTimeBase>

                                <Duration>0.440294</Duration>

                                <Index>1</Index>

                                <Language>und</Language>

                                <SampleFmt>fltp</SampleFmt>

                                <SampleRate>44100</SampleRate>

                                <StartTime>0.000000</StartTime>

                                <Timebase>1/44100</Timebase>

                        </Audio>

                        <Subtitle/>

                        <Video>

                                <AvgFps>24/1</AvgFps>

                                <Bitrate>938.164000</Bitrate>

                                <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 pa

                                <CodecName>h264</CodecName>

                                <CodecTag>0x31637661</CodecTag>

                                <CodecTagString>avc1</CodecTagString>

                                <CodecTimeBase>1/12288</CodecTimeBase>

                                <ColorPrimaries>unknown</ColorPrimaries>

                                <ColorRange>unknown</ColorRange>

                                <ColorTransfer>unknown</ColorTransfer>

                                <Dar>40:53</Dar>

                                <Duration>0.124416</Duration>

                                <Fps>24.500000</Fps>

                                <HasBFrame>2</HasBFrame>

                                <Height>1280</Height>

                                <Index>0</Index>
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                                <Language>und</Language>

                                <Level>32</Level>

                                <NumFrames>243</NumFrames>

                                <PixFormat>yuv420p</PixFormat>

                                <Profile>High</Profile>

                                <RefFrames>1</RefFrames>

                                <Sar>25600:25599</Sar>

                                <StartTime>0.000000</StartTime>

                                <Timebase>1/12288</Timebase>

                                <Width>966</Width>

                        </Video>

                </Stream>

        </MediaInfo>

</Response>
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读取私有 M3U8
获取私有 m3u8
最近更新时间：2024-01-20 10:09:09

功能描述

GetPrivateM3U8 接⼝⽤于获取私有 M3U8 ts 资源的下载授权。（此⽅式通过对象存储转发请求⾄数据万象）。

请求

请求⽰例
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GET /<ObjectKey>?ci-process=pm3u8&expires= HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
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<ObjectKey>为存储桶对象。

请求参数

参数的具体内容如下：

参数名称 描述 类型 是否必选

ci-process 操作类型，固定使⽤ pm3u8 String 是

expires 私有 ts 资源 url 下载凭证的相对有效期，单位为秒，范围为[3600, 
43200]

String 是

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体为截图⽂件内容。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352
https://www.tencentcloud.com/document/product/1045/49353
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GET /for-test.pm3u8?ci-process=pm3u8&expires=3600 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG****-si

Content-Length: 0

响应
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HTTP/1.1 200 OK

Content-Type: application/x-mpegURL

Content-Length: 266005

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZm****

<M3U8⽂件内容>
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内容审核

⾳频审核

提交⾳频审核任务
最近更新时间：2024-01-20 11:24:09

功能描述

本接⼝⽤于提交⼀个⾳频审核任务。⾳频审核功能为异步任务⽅式，您可以通过提交⾳频审核任务审核您的⾳频⽂

件，然后通过 查询⾳频审核任务接⼝ 或 ⾳频审核回调 查询审核结果。
该接⼝⽀持情况如下：

说明

⽀持审核腾讯云 COS 上的⾳频⽂件。
⽀持审核第三⽅云存储⼚商的⾳频 URL。
⽀持对⾳频⽂件进⾏⾃动检测，从 ASR 语⾳⽂本识别、⾊情呻吟两个维度，通过深度学习技术识别⾳频中的违规内
容。

⽀持设置回调地址 Callback 获取检测结果，或通过 查询⾳频审核任务结果接⼝ 主动轮询获取审核结果详情。
⽀持识别多种违规场景，包括：⾊情、⼴告等场景。

⽀持根据不同的业务场景 配置⾃定义的审核策略。

授权说明

授权策略中 action 设置为  ci:CreateAuditingAudioJob  。查看所有 action。

服务开通

使⽤该功能需提前开通数据万象，并绑定存储桶。详情请参⻅ 绑定存储桶。

使⽤限制

使⽤该接⼝时，请先确认相关限制条件。详情请参⻅ 使⽤限制。

⾳频⽂件⼤⼩⽀持：⽂件 < 600MB。
⾳频⽂件时⻓⽀持：**< 3⼩时**。

https://www.tencentcloud.com/document/product/1045/48267
https://www.tencentcloud.com/document/product/1045/48268
https://www.tencentcloud.com/document/product/1045/48267
https://www.tencentcloud.com/document/product/1045/52107
https://www.tencentcloud.com/document/product/598/57084
https://www.tencentcloud.com/document/product/1045/33436
https://www.tencentcloud.com/document/product/1045/33425
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⾳频码率类型⽀持：128Kbps - 256Kbps。
⾳频⽂件⽀持格式：mp3、wav、aac、flac、amr、3gp、m4a、wma、ogg、ape。
接⼝默认并发数量：10。

⾳频⽂件内容语⾔⽀持：普通话、英语、粤语。

当输⼊为视频⽂件时，⽀持分离视频⽂件⾳轨，并对⾳频内容进⾏独⽴审核。

费⽤说明

每个审核场景单独计费，例如您选择审核涉⻩、⼴告两种场景，则审核1个⾳频，计2次审核费⽤。
调⽤接⼝会产⽣ ⾳频审核费⽤ 和 COS 读请求费⽤。
如果⾳频属于 COS 上的低频存储类型，调⽤审核会产⽣ COS 低频数据取回费⽤。

不⽀持审核 COS 上的归档存储类型和深度归档存储类型的⾳频，如果需要审核此类型⾳频，请先 恢复归档⽂件。

推荐使⽤ SDK

数据万象 SDK 提供了完整的 Demo、⾃动集成、计算签名等能⼒。您可通过 SDK ⽅便快捷地调⽤接⼝。点此查看 
SDK ⽂档。

请求

请求⽰例

https://www.tencentcloud.com/document/product/1045/49488
https://www.tencentcloud.com/zh/document/product/436/40100
https://www.tencentcloud.com/zh/document/product/436/40097
https://www.tencentcloud.com/document/product/436/12633
https://www.tencentcloud.com/document/product/1045/45578
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POST /audio/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778
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通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

    <Input>

https://www.tencentcloud.com/document/product/1045/58195
https://www.tencentcloud.com/document/product/1045/43609
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        <Object></Object>

        <Url></Url>

        <DataId></DataId>

    </Input>

    <Conf>

        <Callback></Callback>

        <BizType></BizType>

    </Conf>

</Request>

具体的数据描述如下：

节点名称（关键字） ⽗节点 描述 类型 是否必选

Request ⽆ ⾳频审核的具体配置项。 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型 是否必选

Input Request 需要审核的内容。 Container 是

Conf Request 审核规则配置。 Container 是

Container 类型 Input 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

Object Request.Input
存储在 COS 存储桶中的⾳频⽂件名称，例如在⽬录 
test 中的⽂件 audio.mp3，则⽂件名称为 
test/audio.mp3。Object 和 Url 只能选择其中⼀种。

String 否

Url Request.Input

⾳频⽂件的链接地址，例如 http://examplebucket-
1250000000.cos.ap-
shanghai.myqcloud.com/audio.mp3。Object 和 Url 只
能选择其中⼀种。

String 否

DataId Request.Input
该字段在审核结果中会返回原始内容，⻓度限制为

512字节。您可以使⽤该字段对待审核的数据进⾏唯
⼀业务标识。

String 否

UserInfo Request.Input ⽤户业务字段。 Container 否
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Container 节点 UserInfo 的内容：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

TokenId Request.Input.UserInfo ⽤户业务 TokenId，⻓度不超过
128字节。

String 否

Nickname Request.Input.UserInfo ⽤户业务 Nickname，⻓度不超
过128字节。

String 否

DeviceId Request.Input.UserInfo ⽤户业务 DeviceId，⻓度不超过
128字节。

String 否

AppId Request.Input.UserInfo ⽤户业务 AppId，⻓度不超过
128字节。

String 否

Room Request.Input.UserInfo ⽤户业务 Room，⻓度不超过
128字节。

String 否

IP Request.Input.UserInfo ⽤户业务 IP，⻓度不超过128字
节。

String 否

Type Request.Input.UserInfo ⽤户业务 Type，⻓度不超过128
字节。

String 否

ReceiveTokenId Request.Input.UserInfo ⽤户业务 ReceiveTokenId，⻓
度不超过128字节。

String 否

Gender Request.Input.UserInfo ⽤户业务 Gender，⻓度不超过
128字节。

String 否

Level Request.Input.UserInfo ⽤户业务 Level，⻓度不超过128
字节。

String 否

Role Request.Input.UserInfo ⽤户业务 Role，⻓度不超过128
字节。

String 否

Container 类型 Conf 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是

否

必

选

BizType Request.Conf 表⽰审核策略的唯⼀标识，您可以通过控制台

上的审核策略⻚⾯，配置您希望审核的场景，

如⾊情、⼴告等，配置指引： 设置公共审核策

String 否

https://www.tencentcloud.com/document/product/1045/52107
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略。您可以在控制台上获取到 BizType。
BizType 填写时，此条审核请求将按照该审核策
略中配置的场景进⾏审核。BizType 不填写时，
将⾃动使⽤默认的审核策略。

Callback Request.Conf

审核结果以回调形式发送⾄您的回调地址，⽀

持以  http://  或者  https://  开头的地
址，例

如：  http://www.callback.com 。

String 否

CallbackVersion Request.Conf
回调内容的结构，有效值：Simple（回调内容
包含基本信息）、Detail（回调内容包含详细信
息）。默认为 Simple。

string 否

CallbackType Request.Conf 回调⽚段类型，有效值：1（回调全部⾳频⽚
段）、2（回调违规⾳频⽚段）。默认为 1。

Integer 否

Freeze Request.Conf

可通过该字段，设置根据审核结果给出的不同

分值，对⾳频⽂件进⾏⾃动冻结，仅

当  input 中审核的⾳频为  object 时有

效。

Container 否

Container 类型 Freeze 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

PornScore Request.Conf.Freeze
取值为[0,100]，表⽰当⾊情审核结果⼤于
或等于该分数时，⾃动进⾏冻结操作。不

填写则表⽰不⾃动冻结，默认值为空。

Integer 否

AdsScore Request.Conf.Freeze
取值为[0,100]，表⽰当⼴告审核结果⼤于
或等于该分数时，⾃动进⾏冻结操作。不

填写则表⽰不⾃动冻结，默认值为空。

Integer 否

其他审核场景的冻结参数，请 联系服务⼈员咨询。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

https://www.tencentcloud.com/document/product/1045/52107
https://console.tencentcloud.com/workorder/category
https://www.tencentcloud.com/document/product/1045/43610
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <JobsDetail>

        <DataId></DataId>

        <JobId></JobId>

        <State></State>

        <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>
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具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ ⾳频审核返回的具体响应内容。 Container

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

JobsDetail Response ⾳频审核任务的详细信息。 Container

RequestId Response 每次请求发送时，服务端将会⾃动为请求⽣成⼀个 
ID，遇到问题时，该 ID 能更快地协助定位问题。

String

Container 节点 JobsDetail 的内容：

节点名称（关键字） ⽗节点 描述 类型

DataId Response.JobsDetail 请求中添加的唯⼀业务标识。 String

JobId Response.JobsDetail 本次⾳频审核任务的 ID。 String

State Response.JobsDetail
⾳频审核任务的状态，值为 Submitted（已提交
审核）、Success（审核成功）、Failed（审核
失败）、Auditing（审核中）其中⼀个。

String

CreationTime Response.JobsDetail ⾳频审核任务的创建时间。 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700
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POST /audio/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Input>

        <Object>a.mp3</Object>

        <DataId>123-fdrsg-123</DataID>

    </Input>
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    <Conf>

        <DetectType>Porn,Ads</DetectType>

        <Callback>http://callback.com/</Callback>

    </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230
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Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <DataId>123-fdrsg-123</DataID>

        <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    </JobsDetail>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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⽂本审核

⽂本内容同步审核
最近更新时间：2024-01-20 11:24:09

功能描述

本接⼝⽤于进⾏⽂本内容的直接审核，请求⽅式为同步请求。

该接⼝的⽀持情况如下：

说明

直接审核纯⽂本信息，需要先经过 base64 编码（仅⽀持 UTF8 编码）。
⽀持识别多种违规场景，包括：⾊情、违法、⼴告等场景。

⽀持根据不同的业务场景 配置⾃定义的审核策略。

授权说明

授权策略中 action 设置为  ci:CreateAuditingTextJob  。查看所有 action。

服务开通

使⽤该功能需提前开通数据万象，并绑定存储桶。详情请参⻅ 绑定存储桶。

使⽤限制

使⽤该接⼝时，请先确认相关限制条件。详情请参⻅ 使⽤限制。

费⽤说明

每个审核场景单独计费，例如您选择审核⾊情、⼴告两种场景，则审核1条⽂本，计2次审核费⽤。
⻓度限制：当审核的内容为纯⽂本信息，需要先经过 base64 编码，⽂本编码前的原⽂⻓度不能超过10000个 UTF8 
编码字符。

⽂本审核语⾔⽀持：⽬前⽀持中⽂、中英混合、阿拉伯数字的检测。

接⼝默认并发数量：100。

https://www.tencentcloud.com/document/product/1045/52107
https://www.tencentcloud.com/document/product/598/57084
https://www.tencentcloud.com/document/product/1045/33436
https://www.tencentcloud.com/document/product/1045/33425
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推荐使⽤ SDK

数据万象 SDK 提供了完整的 Demo、⾃动集成、计算签名等能⼒。您可通过 SDK ⽅便快捷地调⽤接⼝。点此查看 
SDK ⽂档。

请求

请求⽰例

https://www.tencentcloud.com/document/product/1045/45578
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POST /text/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/58195
https://www.tencentcloud.com/document/product/1045/43609
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<Request>

  <Input>

    <Content></Content>

    <DataId></DataId>

  </Input>

  <Conf>

    <Callback></Callback>

    <CallbackVersion></CallbackVersion>

    <CallbackType></CallbackType>

    <BizType></BizType>

    <Freeze>
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      <PornScore></PornScore>

    </Freeze>

  </Conf>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆
⽂本审核的具体配

置项。
Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Input Request 需要审核的内容。 Container 是

Conf Request 审核规则配置。 Container 是

Container 类型 Input 的具体数据描述如下：

节点名

称（关

键字）

⽗节点 描述 类型 是否必选

Content Request.Input

当传⼊的内容为纯⽂本信息，需要先经过 base64 编
码，⽂本编码前的原⽂⻓度不能超过 10000 个 UTF8 
编码字符。若超出⻓度限制，接⼝将会报错。

注意：⽬前⽀持中⽂、中英混合、阿拉伯数字的检测

与审核。如有其他语⾔需要，请 联系我们。

String 否

DataId Request.Input
该字段在审核结果中会返回原始内容，⻓度限制为

512字节。您可以使⽤该字段对待审核的数据进⾏唯
⼀业务标识。

String 否

UserInfo Request.Input ⽤户业务字段。 Container 否

Container 节点 UserInfo 的内容：

节点名称（关键字） 描述 类型 是否必选

TokenId ⼀般⽤于表⽰账号信息，⻓度不超过128字节。 String 否

Nickname ⼀般⽤于表⽰昵称信息，⻓度不超过128字节。 String 否

https://console.tencentcloud.com/workorder/category
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DeviceId ⼀般⽤于表⽰设备信息，⻓度不超过128字节。 String 否

AppId ⼀般⽤于表⽰ App 的唯⼀标识，⻓度不超过128字节。 String 否

Room ⼀般⽤于表⽰房间号信息，⻓度不超过128字节。 String 否

IP ⼀般⽤于表⽰ IP 地址信息，⻓度不超过128字节。 String 否

Type ⼀般⽤于表⽰业务类型，⻓度不超过128字节。 String 否

ReceiveTokenId ⼀般⽤于表⽰接收消息的⽤户账号，⻓度不超过128字节。 String 否

Gender ⼀般⽤于表⽰性别信息，⻓度不超过128字节。 String 否

Level ⼀般⽤于表⽰等级信息，⻓度不超过128字节。 String 否

Role ⼀般⽤于表⽰⾓⾊信息，⻓度不超过128字节。 String 否

Container 类型 Conf 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

BizType Request.Conf

表⽰审核策略的唯⼀标识，您可以通过控制台

上的审核策略⻚⾯，配置您希望审核的场景，

如⾊情、⼴告、违法等，配置指引： 设置公共
审核策略。您可以在控制台上获取到 
BizType。BizType 填写时，此条审核请求将按
照该审核策略中配置的场景进⾏审核。BizType 
不填写时，将⾃动使⽤默认的审核策略。

String 否

Callback Request.Conf

审核结果可以回调形式发送⾄您的回调地址，

⽀持以  http://  或者  https://  开头的
地址，例

如：  http://www.callback.com 。当 
Input 使⽤ Content 时，该参数不⽣效，结果会
直接返回。

String 否

CallbackVersion Request.Conf
回调内容的结构，有效值：Simple（回调内容
包含基本信息）、Detail（回调内容包含详细信
息）。默认为 Simple。

String 否

CallbackType Request.Conf 回调⽚段类型，有效值：1（回调全部⽂本⽚
段）、2（回调违规⽂本⽚段）。默认为 1。

Integer 否

Freeze Request.Conf 可通过该字段，设置根据审核结果给出的不同

分值，对⽂本⽂件进⾏⾃动冻结，仅当 
Container 否

https://www.tencentcloud.com/document/product/1045/52107
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 input  中审核的⽂本为  object 时有效。

Container 类型 Freeze 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否

必选

PornScore Request.Conf.Freeze
取值为[0,100]，表⽰当⾊情审核结果⼤于或等
于该分数时，⾃动进⾏冻结操作。不填写则表

⽰不⾃动冻结，默认值为空。

Integer 否

AdsScore Request.Conf.Freeze
取值为[0,100]，表⽰当⼴告审核结果⼤于或等
于该分数时，⾃动进⾏冻结操作。不填写则表

⽰不⾃动冻结，默认值为空。

Integer 否

IllegalScore Request.Conf.Freeze
取值为[0,100]，表⽰当违法审核结果⼤于或等
于该分数时，⾃动进⾏冻结操作。不填写则表

⽰不⾃动冻结，默认值为空。

Integer 否

AbuseScore Request.Conf.Freeze
取值为[0,100]，表⽰当谩骂审核结果⼤于或等
于该分数时，⾃动进⾏冻结操作。不填写则表

⽰不⾃动冻结，默认值为空。

Integer 否

其他审核场景的冻结参数，请 联系服务⼈员 咨询。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://console.tencentcloud.com/workorder/category
https://www.tencentcloud.com/document/product/1045/43610
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<Response>

  <JobsDetail>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Code>Success</Code>

    <Message>Success</Message>

    <SectionCount></SectionCount>

    <Result>1</Result>

    <ContextText></ContextText>
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    <PornInfo>

      <HitFlag></HitFlag>

      <Count></Count>

    </PornInfo>

    <Section>

      <StartByte></StartByte>

      <PornInfo>

        <HitFlag></HitFlag>

        <Score></Score>

        <Keywords></Keywords>

      </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ ⽂本审核返回的具体响应内容。 Container

Container 节点 Response 的内容：

节点名称（关

键字）
⽗节点 描述 类型

JobsDetail Response ⽂本审核的详细信息。 Container

RequestId Response 每次请求发送时，服务端将会⾃动为请求⽣成⼀个 ID，遇到问
题时，该 ID 能更快地协助定位问题。

String

Container 节点 JobsDetail 的内容：

节点名称

（关键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时返回，详情请查看 错
误码列表。

String

DataId Response.JobsDetail 请求中添加的唯⼀业务标识。 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时返回。 String

JobId Response.JobsDetail 本次⽂本审核的任务ID。 String

CreationTime Response.JobsDetail ⽂本审核的创建时间。 String

https://www.tencentcloud.com/document/product/1045/33700
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State Response.JobsDetail ⽂本审核的状态，值为 Success（审核成功）或者 
Failed（审核失败）。

String

Content Response.JobsDetail 本次提交审核的⽂本内容，以 Base64 编码形式返
回。

String

ContextText Response.JobsDetail

当启⽤了⽂本上下⽂关联审核能⼒时，会返回该字

段，同时返回当前审核的⽂本内容及关联的⽂本内

容，以原⽂形式返回。

注意：使⽤上下⽂关联能⼒，在发起⽂本审核时需要

结合UserInfo字段来使⽤，表⽰关联的上下⽂仅属于
某个⽤户ID，不同⽤户ID上传的⽂本内容不会互相关
联。

如需开启上下⽂关联能⼒，请 联系服务⼈员 开通。

String

Label Response.JobsDetail

该字段⽤于返回检测结果中所对应的优先级最⾼的恶

意标签，表⽰模型推荐的审核结果，建议您按照业务

所需，对不同违规类型与建议值进⾏处理。 返回值：
Normal：正常，Porn：⾊情，Ads：⼴告，以及其
他不安全或不适宜的类型。

String

Result Response.JobsDetail

该字段表⽰本次判定的审核结果，您可以根据该结

果，进⾏后续的操作；建议您按照业务所需，对不同

的审核结果进⾏相应处理。有效值：0（审核正
常），1 （判定为违规敏感⽂件），2（疑似敏感，
建议⼈⼯复核）。

Integer

SectionCount Response.JobsDetail 审核的⽂本内容分⽚数，固定为1。 Integer

PornInfo Response.JobsDetail 审核场景为⾊情的审核结果信息。 Container

AdsInfo Response.JobsDetail 审核场景为⼴告的审核结果信息。 Container

IllegalInfo Response.JobsDetail 审核场景为违法的审核结果信息。 Container

AbuseInfo Response.JobsDetail 审核场景为谩骂的审核结果信息。 Container

Section Response.JobsDetail ⽂本审核的具体结果信息。
Container 
Array

UserInfo Response.JobsDetail ⽤户业务字段。 Container

ListInfo Response.JobsDetail 账号⿊⽩名单结果。 Container

Container 节点 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的内容：

节点名称 ⽗节点 描述 类型

https://console.tencentcloud.com/workorder/category
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（关键

字）

HitFlag Response.JobsDetail.*Info
⽤于返回该审核场景的审核结果，返回值：0：正
常。1：确认为当前场景的违规内容。2：疑似为当
前场景的违规内容。

Integer

Count Response.JobsDetail.*Info 命中该审核分类的分⽚数。 Integer

Container 节点 Section 的内容：

节点名称

（关键

字）

⽗节点 描述 类型

StartByte Response.JobsDetail.Section 该分⽚位于⽂本中的起始位置信息（即10代表第
11个utf8⽂字）。从0开始。

Integer

Label Response.JobsDetail.Section

该字段⽤于返回检测结果中所对应的优先级最⾼

的恶意标签，表⽰模型推荐的审核结果，建议您

按照业务所需，对不同违规类型与建议值进⾏处

理。 返回值：Normal：正常，Porn：⾊情，
Ads：⼴告，以及其他不安全或不适宜的类型。

String

Result Response.JobsDetail.Section

该字段表⽰本次判定的审核结果，您可以根据该

结果，进⾏后续的操作；建议您按照业务所需，

对不同的审核结果进⾏相应处理。有效值：0
（审核正常），1 （判定为违规敏感⽂件），2
（疑似敏感，建议⼈⼯复核）。

Integer

PornInfo Response.JobsDetail.Section 审核场景为⾊情的审核结果信息。 Container

AdsInfo Response.JobsDetail.Section 审核场景为⼴告的审核结果信息。 Container

IllegalInfo Response.JobsDetail.Section 审核场景为违法的审核结果信息。 Container

AbuseInfo Response.JobsDetail.Section 审核场景为谩骂的审核结果信息。 Container

Container 节点 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的内容：

节点名称

（关键

字）

⽗节点 描述 类型

HitFlag Response.JobsDetail.Section.*Info ⽤于返回该审核场景的审核结果，返回

值：0：正常。1：确认为当前场景的违规
内容。2：疑似为当前场景的违规内容。

Integer
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Score Response.JobsDetail.Section.*Info 该分⽚中审核的结果分数，分数越⾼表⽰

越敏感。
Integer

Keywords Response.JobsDetail.Section.*Info
在当前审核场景下命中的关键词，多关键

词以  , 分隔。
String

LibResults Response.JobsDetail.Section.*Info
该字段⽤于返回基于⻛险库识别的结果。

注意：未命中⻛险库中样本时，此字段不

返回。

Container 
Array

SubLabel Response.JobsDetail.Section.*Info

该字段表⽰审核命中的具体⼦标签，例

如：Porn 下的 SexBehavior ⼦标签。注
意：该字段可能返回空，表⽰未命中具体

的⼦标签

String

Container 节点 LibResults 的内容：

节点名称

（关键

字）

⽗节点 描述 类型

LibType Response.JobsDetail.Section.*Info.LibResults
命中的⻛险库类型，取值为1
（预设⿊⽩库）和2（⾃定义⻛
险库）。

Integer

LibName Response.JobsDetail.Section.*Info.LibResults 命中的⻛险库名称。 String

Keywords Response.JobsDetail.Section.*Info.LibResults
命中的库中关键词。该参数可

能会有多个返回值，代表命中

的多个关键词。

String 
Array

Container 节点 UserInfo 的内容：

节点名称（关键字） 描述 类型 是否必选

TokenId ⼀般⽤于表⽰账号信息，⻓度不超过128字节。 String 否

Nickname ⼀般⽤于表⽰昵称信息，⻓度不超过128字节。 String 否

DeviceId ⼀般⽤于表⽰设备信息，⻓度不超过128字节。 String 否

AppId ⼀般⽤于表⽰ App 的唯⼀标识，⻓度不超过128字节。 String 否

Room ⼀般⽤于表⽰房间号信息，⻓度不超过128字节。 String 否

IP ⼀般⽤于表⽰ IP 地址信息，⻓度不超过128字节。 String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第658 共2247⻚

Type ⼀般⽤于表⽰业务类型，⻓度不超过128字节。 String 否

ReceiveTokenId ⼀般⽤于表⽰接收消息的⽤户账号，⻓度不超过128字
节。

String 否

Gender ⼀般⽤于表⽰性别信息，⻓度不超过128字节。 String 否

Level ⼀般⽤于表⽰等级信息，⻓度不超过128字节。 String 否

Role ⼀般⽤于表⽰⾓⾊信息，⻓度不超过128字节。 String 否

Container 节点 ListInfo 的内容：

节点名称（关键字） ⽗节点 描述 类型

ListResults Response.JobsDetail.ListInfo 命中的所有名单结果。 Container Array

Container 节点 ListResults 的内容：

节点名称（关

键字）
⽗节点 描述 类型

ListType Response.JobsDetail.ListInfo.ListResults 命中的名单类型，取值为0（⽩名
单）和1（⿊名单）。

Integer

ListName Response.JobsDetail.ListInfo.ListResults 命中的名单名称。 String

Entity Response.JobsDetail.ListInfo.ListResults 命中了名单中的哪条内容。 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第659 共2247⻚

POST /text/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Content>54uZ5Ye75omL</Content>

  </Input>

  <Conf>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第660 共2247⻚

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第661 共2247⻚

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <Content>54uZ5Ye75omL</Content>

    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <SectionCount>1</SectionCount>

    <Label>Illegal</Label>

    <Result>2</Result>

    <PornInfo>

      <HitFlag>0</HitFlag>

      <Count>0</Count>

    </PornInfo>

    <Section>

      <StartByte>0</StartByte>

      <Label>Illegal</Label>

      <Result>2</Result>

      <PornInfo>

        <HitFlag>0</HitFlag>

        <Score>0</Score>

        <Keywords/>

      </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第662 共2247⻚

⽂档预览

查询⽂档预览开通状态
最近更新时间：2024-01-20 11:39:30

功能描述

DescribeDocProcessBuckets 接⼝⽤于查询已经开通⽂档预览功能的 Bucket。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第663 共2247⻚

GET /docbucket?pageNumber=1&pageSize=2 HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第664 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

名称 描述 类型 是否必选

regions 地域信息，以“,”分隔字符串，⽀持 All、ap-shanghai、ap-beijing string 否

bucketNames 存储桶名称，以“,”分隔，⽀持多个存储桶，精确搜索 string 否

bucketName 存储桶名称前缀，前缀搜索 string 否

pageNumber 第⼏⻚ string 否

pageSize 每⻚个数 string 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第665 共2247⻚

<Response>

        <TotalCount>1</TotalCount>

        <RequestId>RequestId</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <DocBucketList>

                <Name>BucketName-APPID</Name>

                <CreateTime>Time</CreateTime>

                <Region>Region</Region>

                <AliasBucketId/>

                <BucketId>BucketName-APPID</BucketId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第666 共2247⻚

        </DocBucketList>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response ⽂档预览 Bucket 总数 Int

PageNumber Response 当前⻚数，同请求中的 
pageNumber

Int

PageSize Response 每⻚个数，同请求中的 
pageSize

Int

DocBucketList Response ⽂档预览 Bucket 列表 Container

Container 节点 DocBucketList 的内容：

节点名称（关键字） ⽗节点 描述 类型

BucketId Response.DocBucketList 存储桶 ID String

Name Response.DocBucketList 存储桶名称，同 
BucketId

String

Region Response.DocBucketList 所在的地域 String

CreateTime Response.DocBucketList 创建时间 String

AliasBucketId Response.DocBucketList 存储桶别名 String

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第667 共2247⻚

请求

GET /docbucket?regions=ap-chongqing HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Authorization: Authorization



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第668 共2247⻚

响应

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:00:43 GMT

Content-Type: application/xml

Content-Length: 843

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTdiOWJfYzc2OTQzNjRfM2Qz****

<?xml version="1.0" encoding="utf-8"?>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第669 共2247⻚

<Response>

        <TotalCount>3</TotalCount>

        <RequestId>NWYxZTdiOWJfYzc2OTQzNjRfM2Qz****</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>10</PageSize>

        <DocBucketList>

                <Name>examplebucket-1250000000</Name>

                <CreateTime>2020-07-27T10:54:42+0800</CreateTime>

                <Region>ap-chongqing</Region>

                <AliasBucketId/>

                <BucketId>examplebucket-1250000000</BucketId>

        </DocBucketList>

        <DocBucketList>

                <Name>examplebucket-1250000000</Name>

                <CreateTime>2020-07-24T22:42:26+0800</CreateTime>

                <Region>ap-chongqing</Region>

                <AliasBucketId/>

                <BucketId>examplebucket-1250000000</BucketId>

        </DocBucketList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第670 共2247⻚

⽂档转码

同步请求接⼝
最近更新时间：2024-01-20 11:39:30

功能描述

⽂档预览功能⽀持对多种⽂件类型⽣成图⽚格式预览，并可对转换后的图⽚同步进⾏基础处理操作，可以解决⽂档

内容的⻚⾯展⽰问题，满⾜ PC、App 等多个⽤户端的⽂档在线浏览需求，适⽤于在线教育、企业 OA、⽹站转码等
业务场景。

说明

使⽤时您需要在 数据万象控制台 相应的存储桶管理⻚⾯下，单击⽂档处理，找到⽂档预览配置项，并通过开启按钮
开通服务。开通服务后，对于当前存储桶中的⽂档资源，使⽤相应的⽂档预览 API 接⼝即可实现同步或异步⽂档预
览请求。

⽂档预览为付费功能，具体费⽤请参⻅ ⽂档处理费⽤。数据万象在每个账户在⾸次产⽣⽂档预览转图⽚⽤量后，将

发放⼀个⽤量为6000⻚，有效期为2个⽉的⽂档预览转图⽚免费额度资源包，超出⽤量或资源包到期后将正常计费。
⽂档转码的转换逻辑与本地的打印逻辑相同，如果您需要改变转换⽅向（例如将列数较多的 excel ⽂件横向输出到⼀
⻚），需要更改源⽂件打印设置。

请求

请求⽰例

https://console.tencentcloud.com/ci
https://www.tencentcloud.com/document/product/1045/49490


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第671 共2247⻚

GET /<ObjectKey>?ci-process=doc-preview&page=<page>&srcType=<srcType>&ImageParams=<

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。
私有存储桶需要携带下载⽂件的签名。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第672 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

通⽤请求参数

名称 描述 类型
是否必

选

ObjectKey 对象⽂件名，例如 folder/document.pdf String 是

ci-process 数据万象处理能⼒，⽂档预览固定为 doc-preview String 是

srcType 源数据的后缀类型，当前⽂档转换根据 COS 对象的后缀名来确定源
数据类型。当 COS 对象没有后缀名时，可以设置该值

String 否

page 需转换的⽂档⻚码，默认从1开始计数；表格⽂件中 page 表⽰转换的
第 X 个 sheet 的第 X 张图

Int 否

dstType

转换输出⽬标⽂件类型：

png，转成 png 格式的图⽚⽂件
jpg，转成 jpg 格式的图⽚⽂件
pdf，转成 pdf 格式⽂件。 ⽆法选择⻚码，page 参数不⽣效
如果传⼊的格式未能识别，默认使⽤ jpg 格式

String 否

password Office ⽂档的打开密码，如果需要转换有密码的⽂档，请设置该字段 String 否

comment
是否隐藏批注和应⽤修订，默认为0
0：隐藏批注，应⽤修订
1：显⽰批注和修订

Int 否

适⽤于表格⽂件（Excel）的参数

名称 描述 类型
是否必

选

sheet 表格⽂件参数，转换第 X 个表，默认为1 Int 否

excelPaperDirection 表格⽂件转换纸张⽅向，0代表垂直⽅向，⾮0代表⽔平⽅
向，默认为0

Int 否

excelPaperSize
设置纸张（画布）⼤⼩，对应信息为：  0 → A4  、  1 → 
A2  、  2 → A0  ，默认 A4 纸张 （需配合   excelRow   
或   excelCol   ⼀起使⽤）

Int 否

适⽤于转码成  png/jpg 图⽚的参数

https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第673 共2247⻚

名称 描述 类型 是否必

选

ImageParams
转换后的图⽚处理参数，⽀持 基础图⽚处理 所有处理参数，多
个处理参数可通过 管道操作符 分隔，从⽽实现在⼀次访问中按
顺序对图⽚进⾏不同处理

String 否

quality ⽣成预览图的图⽚质量，取值范围为 [1, 100]，默认值100。 例
如取值为100，代表⽣成图⽚质量为100%

Int 否

scale 预览图⽚的缩放参数，取值范围为 [10, 200]， 默认值100。 例
如取值为200，代表图⽚缩放⽐例为200% 即放⼤两倍

Int 否

imageDpi
按指定 dpi 渲染图⽚，该参数与   scale   共同作⽤，取值范
围   96-600  ，默认值为   96  。转码后的图⽚单边宽度需
⼩于65500像素

Int 否

注意

⽬前⽀持的输⼊⽂件类型包含如下格式：

演⽰⽂件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。
⽂字⽂件：doc、dot、wps、wpt、docx、dotx、docm、dotm。
表格⽂件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。 
表格⽂件，⼀张表可能分割为多⻚转换，⽣成多张图⽚。

其他格式⽂件： pdf、 lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 prg、 cmd、 rtf、 txt、 log、 xml、 

htm、 html。
输⼊⽂件⼤⼩限制在200MB 之内。
输⼊⽂件⻚数限制在5000⻚之内。
同步接⼝适⽤于百⻚内的PDF⽂件或预览少数⻚的情况，若⽂件较⼤建议使⽤异步接⼝。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应参数说明

参数名称 描述 类型

https://www.tencentcloud.com/document/product/1045/33694
https://www.tencentcloud.com/document/product/1045/33727
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第674 共2247⻚

X-Total-Page 在 http header 中返回⽂档总⻚数（表格⽂件表⽰当前 sheet 转换后的总图⽚
数），异常时为空

Int

Content-Type 根据图⽚实际的格式，返回不同的值，例如 image/jpeg、image/webp，异常
时保持现有值即可

String

X-ErrNo 当异常时返回错误码，可在 http header 中查看 String

X-Total-Sheet 表格⽂件返回参数，在 http header 中返回⽂档中总表数 Int

X-Sheet-Name 表格⽂件返回参数，在 http header 中返回当前 sheet 名 String

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

案例⼀：普通⽂档预览

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第675 共2247⻚

GET /sample.pdf?ci-process=doc-preview&page=1 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

响应1：成功预览



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第676 共2247⻚

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

X-Total-Page: 100

[转码后图⽚ data]

响应2：⽂件不存在



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第677 共2247⻚

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3004

响应3：指定⻚码不存在



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第678 共2247⻚

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3013

案例⼆：⽂档预览并进⾏缩放和添加⽂字⽔印的图⽚处理

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第679 共2247⻚

GET /sample.pdf?ci-process=doc-preview&page=1&ImageParams=imageMogr2/thumbnail/!50p

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

响应1：成功预览



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第680 共2247⻚

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

X-Total-Page: 100

[转码后图⽚ data]

响应2：⽂件不存在



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第681 共2247⻚

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3004

响应3：指定⻚码不存在



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第682 共2247⻚

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3013



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第683 共2247⻚

异步处理任务接⼝

提交⽂档转码任务
最近更新时间：2024-01-20 11:39:30

功能描述

CreateDocProcessJobs 接⼝⽤于提交⼀个⽂档转码任务。
注意：

⽬前⽀持的输⼊⽂件类型包含如下格式：

演⽰⽂件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。
⽂字⽂件：doc、dot、wps、wpt、docx、dotx、docm、dotm。
表格⽂件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。 
   表格⽂件，⼀张表可能分割为多⻚转换，⽣成多张图⽚。
其他格式⽂件： pdf、 lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 prg、 cmd、 rtf、 txt、 log、 xml、 

htm、 html。
输⼊⽂件⼤⼩限制在200M 之内。
输⼊⽂件⻚数限制在5000⻚之内。
任务记录保留⼀个⽉，请及时保存任务记录。建议配置回调进⾏任务结果查询。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第684 共2247⻚

POST /doc_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第685 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第686 共2247⻚

  <Tag></Tag>

  <Input>

    <Object></Object>

  </Input>

  <Operation>

    <Output>

      <Region></Region>

      <Bucket></Bucket>

      <Object></Object>

    </Output>

    <DocProcess>

       <StartPage></StartPage>

       <EndPage></EndPage>

       <TgtType></TgtType>

    </DocProcess>

  </Operation>

  <QueueId></QueueId>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Tag Request 创建任务的 Tag，⽬前仅⽀持：
DocProcess

String 是

Input Request 待操作的⽂件对象 Container 是

Operation Request 操作规则 Container 是

QueueId Request
任务所在的队列 ID，开通预览服务后
⾃动⽣成，请使⽤ 查询队列 获取或前
往 万象控制台 在存储桶中查询 

String 是

Container 类型 Input 的具体数据描述如下：

节点名称（关键 ⽗节点 描述 类型 是否必选

https://www.tencentcloud.com/document/product/1045/47935
https://console.tencentcloud.com/ci


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第687 共2247⻚

字）

Object Request.Input ⽂件在 COS 上的⽂件路径，Bucket 
由 Host 指定

String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

DocProcess Request.Operation 当 Tag 为 DocProcess 时有效，指定该
任务的参数

Container 是

Output Request.Operation 结果输出地址 Container 是

Container 类型 DocProcess 的具体数据描述如下：

通⽤请求参数

节点名称

（关键

字）

⽗节点 描述 类型
是否

必选

SrcType Request.Operation.DocProcess

源数据的后缀类型，当前⽂档转换根据 
cos 对象的后缀名来确定源数据类型，
当 cos 对象没有后缀名时，可以设置该
值

String 否

TgtType Request.Operation.DocProcess

转换输出⽬标⽂件类型：

jpg，转成 jpg 格式的图⽚⽂件；如果传
⼊的格式未能识别，默认使⽤ jpg 格式
png，转成 png 格式的图⽚⽂件
pdf，转成 pdf 格式⽂件（暂不⽀持指定
⻚数）

String 否

StartPage Request.Operation.DocProcess

从第 X ⻚开始转换；在表格⽂件中，⼀
张表可能分割为多⻚转换，⽣成多张图

⽚。StartPage 表⽰从指定 SheetId 的第 
X ⻚开始转换。默认为1

Int 否

EndPage Request.Operation.DocProcess

转换⾄第 X ⻚；在表格⽂件中，⼀张表
可能分割为多⻚转换，⽣成多张图⽚。

EndPage 表⽰转换⾄指定 SheetId 的第 
X ⻚。默认为-1，即转换全部⻚

Int 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第688 共2247⻚

适⽤于表格⽂件（Excel）的参数

节点名称（关

键字）
⽗节点 描述

类

型

是否

必选

SheetId Request.Operation.DocProcess
表格⽂件参数，转换第 X 个表，默认
为0；设置 SheetId 为0，即转换⽂档
中全部表

Int 否

PaperDirection Request.Operation.DocProcess 表格⽂件转换纸张⽅向，0代表垂直⽅
向，⾮0代表⽔平⽅向，默认为0

Int 否

PaperSize Request.Operation.DocProcess
设置纸张（画布）⼤⼩，对应信息

为：  0 → A4  、  1 → A2  、  2 
→ A0  ，默认 A4 纸张

Int 否

适⽤于转码成  png/jpg 图⽚的参数

节点名称（关

键字）
⽗节点 描述 类型

是

否

必

选

ImageParams Request.Operation.DocProcess

转换后的图⽚处理参数，⽀持 基础图
⽚处理 所有处理参数，多个处理参数
可通过 管道操作符 分隔，从⽽实现在
⼀次访问中按顺序对图⽚进⾏不同处理

String 否

Quality Request.Operation.DocProces
⽣成预览图的图⽚质量，取值范围 [1-
100]，默认值100。 例：值为100，代
表⽣成图⽚质量为100%

Int 否

Zoom Request.Operation.DocProces
预览图⽚的缩放参数，取值范围[10-
200]， 默认值100。 例：值为200，代
表图⽚缩放⽐例为200% 即放⼤两倍

Int 否

ImageDpi Request.Operation.DocProcess

按指定 dpi 渲染图⽚，该参数与  
 Zoom   共同作⽤，取值范围   96-
600  ，默认值为   96  。转码后的图
⽚单边宽度需⼩于65500像素

Int 否

PicPagination Request.Operation.DocProcess 是否转换成单张⻓图，设置为  1  
时，最多仅⽀持将 20 标准⻚⾯合成单
张⻓图，超过可能会报错，分⻚范围可

以通过 StartPage、EndPage 控制。默
认值为  0  ，按⻚导出图

Int 否

https://www.tencentcloud.com/document/product/1045/33694
https://www.tencentcloud.com/document/product/1045/33727


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第689 共2247⻚

⽚，  TgtType="png"/"jpg"  时⽣
效

Container 类型 Output 的具体数据描述如下：

节点名

称（关

键字）

⽗节点 描述 类型
是否

必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output

输出⽂件路径。

⾮表格⽂件输出⽂件名需包含 ${Number} 或 
${Page} 参数。多个输出⽂件，${Number} 表⽰
序号从1开始，${Page} 表⽰序号与预览⻚码⼀
致。

${Number} 表⽰多个输出⽂件，序号从1开始，
例如输⼊ abc_${Number}.jpg，预览某⽂件5 - 6
⻚，则输出⽂件名为 abc_1.jpg，abc_2.jpg
${Page} 表⽰多个输出⽂件，序号与预览⻚码⼀
致，例如输⼊ abc_${Page}.jpg，预览某⽂件5-6
⻚，则输出⽂件名为 abc_5.jpg，abc_6.jpg
表格⽂件输出路径需包含 ${SheetID} 占位符，
输出⽂件名必须包含 ${Number} 参数。
例如 /${SheetID}/abc_${Number}.jpg，先根据 
excel 转换的表格数，⽣成对应数量的⽂件夹，
再在对应的⽂件夹下，⽣成对应数量的图⽚⽂件

String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第690 共2247⻚

<Response>

        <JobsDetail>

                <Code></Code>

                <CreationTime></CreationTime>

                <EndTime></EndTime>

                <Input>

                    <Object></Object>

                </Input>

                <JobId></JobId>

                <Message/>

                <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第691 共2247⻚

                    <DocProcess>

                        <SrcType></SrcType>

                        <TgtType></TgtType>

                        <StartPage></StartPage>

                        <EndPage></EndPage>

                        <ImageParams></ImageParams>

                    </DocProcess>

                    <Output>

                        <Bucket></Bucket>

                        <Object></Object>

                        <Region></Region>

                    </Output>

                </Operation>

                <QueueId></QueueId>

                <State></State>

                <Tag></Tag>

        </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：DocProcess String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第692 共2247⻚

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊⽂件路径 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容： 
同上⾯请求中的 Request.Input 节点。
Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

DocProcess Response.JobsDetail.Operation ⽂档预览任务参数 Container

Output Response.JobsDetail.Operation ⽂件的输出地址 Container

Container 节点 DocProcess 的内容： 

同上⾯请求中的 Request.Operation.DocProcess 节点。
Container 节点 Output 的内容： 
同上⾯请求中的 Request.Operation.Output 节点。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第693 共2247⻚

POST /doc_jobs HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Content-Length: 546

Authorization: Authorization

<?xml version="1.0" encoding="UTF-8" ?>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第694 共2247⻚

<Request>

    <Input>

        <Object>1.doc</Object>

    </Input>

    <Operation>

      <Output>

          <Region>ap-chongqing</Region>

          <Object>big/test-${Number}</Object>

          <Bucket>examplebucket-1250000000</Bucket>

      </Output>

      <DocProcess>

          <TgtType>png</TgtType>

          <StartPage>1</StartPage>

          <EndPage>-1</EndPage>

          <ImageParams>watermark/1/image/aHR0cDovL3Rlc3QwMDUtMTI1MTcwNDcwOC5jb3MuYX

      </DocProcess>

    </Operation>

    <Tag>DocProcess</Tag>

    <QueueId>p532fdead78444e649e1a4467c1cd19d3</QueueId>

</Request>[!http]

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第695 共2247⻚

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:20:08 GMT

Content-Type: application/xml

Content-Length: 863

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTgwMjhfYzc2OTQzNjRfMzUx****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <JobsDetail>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第696 共2247⻚

                <Code>Success</Code>

                <CreationTime>2020-07-27T15:20:08+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>1.doc</Object>

                </Input>

                <JobId>d99b3127ecfd911eab5e60dedb7c395dd</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>5001</EndPage>

                                <ImageParams>watermark/1/image/aHR0cDovL3Rlc3QwMDUt

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>examplebucket-1250000000</Bucket>

                                <Object>big/test-${Number}</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p532fdead78444e649e1a4467c1cd19d3</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第697 共2247⻚

查询指定的⽂档转码任务
最近更新时间：2024-01-20 11:39:30

功能描述

DescribeDocProcessJob ⽤于查询指定的⽂档转码任务。

请求

注意：

⽂档预览任务记录保留⼀个⽉，请及时保存任务记录。建议配置回调进⾏任务结果查询。

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第698 共2247⻚

GET /doc_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第699 共2247⻚

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第700 共2247⻚

<Response>

        <JobsDetail>

                <Code></Code>

                <CreationTime></CreationTime>

                <EndTime></EndTime>

                <Input>

                        <Object></Object>

                </Input>

                <JobId></JobId>

                <Message> </Message>

                <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第701 共2247⻚

                        <DocProcess>

                                <EndPage></EndPage>

                                <ImageParams></ImageParams>

                                <SrcType></SrcType>

                                <StartPage></StartPage>

                                <TgtType></TgtType>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount></FailPageCount>

                                <PageInfo>

                                        <PageNo></PageNo>

                                        <TgtUri></TgtUri>

                                </PageInfo>

                                <SuccPageCount></SuccPageCount>

                                <TaskId></TaskId>

                                <TgtType></TgtType/>

                                <TotalPageCount></TotalPageCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket></Bucket>

                                <Object></Object>

                                <Region></Region>

                        </Output>

                </Operation>

                <QueueId></QueueId>

                <State></State>

                <Tag></Tag>

        </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

JobsDetail Response 任务的详细信息，同 CreateDocProcessJobs 接⼝的 
Response.JobsDetail 节点

Container

NonExistJobIds Response 查询的 ID 中不存在的任务，所有任务都存在时不返回 String

https://www.tencentcloud.com/document/product/1045/47932


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第702 共2247⻚

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

DocProcess Response.JobsDetail.Operation
⽂档预览任务参数，同 
CreateDocProcessJobs 接⼝的 
Request.Operation.DocProcess 节点

Container

DocProcessResult Response.JobsDetail.Operation
在 job 的类型为 DocProcess 且 job 状
态为 success 时，返回⽂档预览任务
结果详情

Container

Output Response.JobsDetail.Operation
结果输出地址，同 
CreateDocProcessJobs 接⼝的 
Request.Operation.Output 节点

Container

Container 节点 DocProcessResult 节点的内容

节点名称（关键

字）
⽗节点 描述 类型

PageInfo Response.JobsDetail.Operation.DocProcessResult 预览任务产物详情 Container

TgtType Response.JobsDetail.Operation.DocProcessResult 预览产物⽬标格式 String

TotalPageCount Response.JobsDetail.Operation.DocProcessResult 预览任务产物的总数 Int

SuccPageCount Response.JobsDetail.Operation.DocProcessResult 预览任务产物的成功

数
Int

FailPageCount Response.JobsDetail.Operation.DocProcessResult 预览任务产物的失败

数
Int

TotalSheetCount Response.JobsDetail.Operation.DocProcessResult
预览任务的 Sheet 总
数（源⽂件为 Excel 
特有参数）

Int

Container 节点 PageInfo 节点的内容

节点名称

（关键

字）

⽗节点 描述 类型

PageNo Response.JobsDetail.Operation.DocProcessResult.PageInfo
预览产物⻚码,源
⽂件为 Excel 格式
时表⽰ SheetId

Container

https://www.tencentcloud.com/document/product/1045/47932
https://www.tencentcloud.com/document/product/1045/47932


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第703 共2247⻚

TgtUri Response.JobsDetail.Operation.DocProcessResult.PageInfo 预览产物⽣成的 
cos 桶路径

Int

X-
SheetPics

Response.JobsDetail.Operation.DocProcessResult.PageInfo

当前 Sheet ⽣成
的图⽚总数（源⽂

件为 Excel 特有参
数）

Int

PicIndex Response.JobsDetail.Operation.DocProcessResult.PageInfo

当前预览产物在整

个源⽂件中的序号

（源⽂件为 Excel 
特有参数）

Int

PicNum Response.JobsDetail.Operation.DocProcessResult.PageInfo

当前预览产物在 
Sheet 中的序号
（源⽂件为 Excel 
特有参数）

Int

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第704 共2247⻚

GET /doc_jobs/d13cfd584cd9011ea820b597ad1785a2f HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

1.⾮ Excel ⽂档请求响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第705 共2247⻚

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-24T17:28:47+0800</CreationTime>

                <EndTime>2020-07-24T17:28:49+0800</EndTime>

                <Input>

                        <Object>1.doc</Object>

                </Input>

                <JobId>d13cfd584cd9011ea820b597ad1785a2f</JobId>

                <Message/>

                <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第706 共2247⻚

                        <DocProcess>

                                <EndPage>0</EndPage>

                                <ImageParams/>

                                <SrcType/>

                                <StartPage>2</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount>0</FailPageCount>

                                <PageInfo>

                                        <PageNo>2</PageNo>

                                        <TgtUri>big/test-1</TgtUri>

                                </PageInfo>

                                <SuccPageCount>1</SuccPageCount>

                                <TaskId/>

                                <TgtType/>

                                <TotalPageCount>2</TotalPageCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket>examplebucket-1250000000</Bucket>

                                <Object>big/test-${Number}</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p50882922b848464fadd222d771438328</QueueId>

                <State>Success</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>

2. Excel 格式响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第707 共2247⻚

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-12-03T19:54:10+0800</CreationTime>

                <EndTime>2020-12-03T19:54:13+0800</EndTime>

                <Input>

                        <Object>1.xlsx</Object>

                </Input>

                <JobId>d13cfd584cd9011ea820b597ad1785a2f</JobId>

                <Message/>

                <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第708 共2247⻚

                        <DocProcess>

                                <Comments>0</Comments>

                                <DocPassword/>

                                <EndPage>2</EndPage>

                                <ImageParams/>

                                <PaperDirection>0</PaperDirection>

                                <PaperSize>0</PaperSize>

                                <Quality>100</Quality>

                                <SheetId>0</SheetId>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType/>

                                <Zoom>100</Zoom>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount>0</FailPageCount>

                                <PageInfo>

                                        <PageNo>1</PageNo>

                                        <PicIndex>1</PicIndex>

                                        <PicNum>1</PicNum>

                                        <TgtUri>mark2/1/test-1.jpg</TgtUri>

                                        <X-SheetPics>2</X-SheetPics>

                                </PageInfo>

                                <PageInfo>

                                        <PageNo>1</PageNo>

                                        <PicIndex>2</PicIndex>

                                        <PicNum>2</PicNum>

                                        <TgtUri>mark2/1/test-2.jpg</TgtUri>

                                        <X-SheetPics>2</X-SheetPics>

                                </PageInfo>

                                <SuccPageCount>6</SuccPageCount>

                                <TaskId/>

                                <TgtType/>

                                <TotalPageCount>6</TotalPageCount>

                                <TotalSheetCount>3</TotalSheetCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket>markjrzhang-1251704708</Bucket>

                                <Object>mark/${SheetID}/pic-${Page}.jpg</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p5fdbba9a9b83479f84538d5beb*****</QueueId>

                <State>Success</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第709 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第710 共2247⻚

拉取符合条件的⽂档转码任务
最近更新时间：2024-01-20 11:39:30

功能描述

DescribeDocProcessJobs ⽤于拉取符合条件（状态、创建时间等）的⽂档转码任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第711 共2247⻚

GET /doc_jobs?queueId=<queueId>&tag=DocProcess HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第712 共2247⻚

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

请求参数

参数的具体内容如下：

节点名称（关键

字）

⽗

节

点

描述 类型
是否必

选

queueId ⽆ 拉取该队列 ID 下的任务。 String 是

tag ⽆ 任务的 Tag：DocProcess。 String 是

orderByTime ⽆ Desc 或者 Asc。默认为 Desc。 String 否

nextToken ⽆ 请求的上下⽂，⽤于翻⻚。上次返回的值。 String 否

size ⽆ 拉取的最⼤任务数。默认为10。最⼤为100。 Integer 否

states ⽆

拉取该状态的任务，以  , 分割，⽀持多状态：All、
Submitted、Running、Success、Failed、Pause、
Cancel。默认为 All。

String 否

startCreationTime ⽆
拉取创建时间⼤于等于该时间的任务。格式为：  %Y-%m-

%dT%H:%m:%S%z 
String 否

endCreationTime ⽆
拉取创建时间⼩于等于该时间的任务。格式为：  %Y-%m-

%dT%H:%m:%S%z 
String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第713 共2247⻚

<Response>

  <JobsDetail></JobsDetail>

  <NextToken></NextToken>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第714 共2247⻚

Container 节点 Response 的内容：

节点名称（关

键字）
⽗节点 描述 类型

JobsDetail Response 任务的详细信息，同 CreateDocProcessJobs 接⼝中的 
Response.JobsDetail 节点

Container

NextToken Response 翻⻚的上下⽂ Token String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/47932
https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第715 共2247⻚

GET /doc_jobs/queueId=QueueId&tag=DocProcess HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第716 共2247⻚

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-20T10:43:17+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>1.docx</Object>

                </Input>

                <JobId>JobId</JobId>

                <Message/>

                <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第717 共2247⻚

                        <DocProcess>

                                <EndPage>1</EndPage>

                                <ImageParams>ImageParams</ImageParams>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>BucketId</Bucket>

                                <Object>file/test-${Page}.jpg</Object>

                                <Region>Region</Region>

                        </Output>

                </Operation>

                <QueueId>QueueId</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-20T10:43:17+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>test.docx</Object>

                </Input>

                <JobId>JobId</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>1</EndPage>

                                <ImageParams>ImageParams</ImageParams>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>BucketId</Bucket>

                                <Object>file/test-${Page}.jpg</Object>

                                <Region>Region</Region>

                        </Output>

                </Operation>

                <QueueId>QueueId</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

        <NextToken>19193</NextToken>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第718 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第719 共2247⻚

异步处理队列接⼝

查询⽂档转码队列
最近更新时间：2024-01-20 11:39:30

功能描述

DescribeDocProcessQueues 接⼝⽤于查询⽂档转码队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第720 共2247⻚

GET /docqueue?pageNumber=1&pageSize=2 HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第721 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅授权粒度详情⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

名称 描述 类型
是否必

选

queueIds 队列 ID，以“,”符号分割字符串 string 否

state

1. Active 表⽰队列内的作业会被⽂档预览服务调度执⾏
2. Paused  表⽰队列暂停，作业不再会被⽂档预览服务调度执⾏，队列
内的所有作业状态维持在暂停状态，已经处于执⾏中的任务将继续执

⾏，不受影响

string 否

pageNumber 第⼏⻚，默认第⼀⻚ string 否

pageSize 每⻚个数，默认10个 string 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据。
响应体1：当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展⽰如下。

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第722 共2247⻚

<Response>

        <TotalCount>1</TotalCount>

        <RequestId>RequestId</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <QueueList>

                <QueueId>QueueId</QueueId>

                <Name>QueueName</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url>url</Url>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第723 共2247⻚

                        <Event>Event</Event>

                        <Type/></Type>

                        <State>Off</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>CreateTime</CreateTime>

                <UpdateTime>UpdateTime</UpdateTime>

                <BucketId>BucketId</BucketId>

                <Category>DocProcess</Category>

        </QueueList>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前⻚数，同请求中的 
pageNumber

Int

PageSize Response 每⻚个数，同请求中的 
pageSize

Int

QueueList Response 队列数组 Container

Container 节点 QueueList 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueId Response.QueueList 队列 ID String

Name Response.QueueList 队列名字 String

State Response.QueueList 当前状态，Active 或者 Paused String

NotifyConfig Response.QueueList 回调配置 Container

MaxSize Response.QueueList 队列最⼤⻓度 Int



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第724 共2247⻚

MaxConcurrent Response.QueueList 当前队列最⼤并⾏执⾏的任务数 Int

UpdateTime Response.QueueList 更新时间 String

CreateTime Response.QueueList 创建时间 String

Container 节点 NotifyConfig 的内容：

节点名称（关键字） ⽗节点 描述 类型

Url Response.QueueList.NotifyConfig 回调地址 String

State Response.QueueList.NotifyConfig 开关状态，On 或者 Off String

Type Response.QueueList.NotifyConfig 回调类型，Url String

Event Response.QueueList.NotifyConfig 触发回调的事件 String

响应体2：当指定 queueIds 时包含完整节点数据的内容展⽰如下。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第725 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url></Url>

        </NotifyConfig>

    </QueueList>

    <NonExistPIDs>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第726 共2247⻚

        <QueueID>B</QueueID>

        <QueueID>C</QueueID>

    </NonExistPIDs>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

QueueList Response 队列数组，同上⾯解释的 
QueueList

Container

NonExistPIDs Response 不存在的队列 ID 列表 Container

Container 节点 NonExistPIDs 的内容：

节点名称（关键字） ⽗节点 描述 类型

QueueID Response.NonExistPIDs 队列 ID String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43611


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第727 共2247⻚

GET /docqueue?pageNumber=1&pageSize=2 HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Authorization: Authorization

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第728 共2247⻚

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:29:28 GMT

Content-Type: application/xml

Content-Length: 677

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTgyNTdfYzc2OTQzNjRfMzUx****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <TotalCount>1</TotalCount>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第729 共2247⻚

        <RequestId>NWYxZTgyNTdfYzc2OTQzNjRfMzUx****</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <QueueList>

                <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

                <Name>queue-doc-process-1</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url/>

                        <Event/>

                        <Type/>

                        <State>Off</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>2020-07-24T22:42:27+0800</CreateTime>

                <UpdateTime>2020-07-24T22:42:27+0800</UpdateTime>

                <BucketId>examplebucket-1250000000.</BucketId>

                <Category>DocProcessing</Category>

        </QueueList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第730 共2247⻚

更新⽂档转码队列
最近更新时间：2024-01-20 11:39:30

功能描述

UpdateDocProcessQueue 接⼝⽤于更新⽂档转码队列。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第731 共2247⻚

PUT /docqueue/p8eb46b8cc1a94bc09512d16c5c4f4d3a HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第732 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有以下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第733 共2247⻚

    <Name>Queue Name</Name>

    <QueueID></QueueID>

    <State></State>

    <NotifyConfig>

        <Type></Type>

        <Url></Url>

        <Event></Event>

    </NotifyConfig>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选
限制

Name Request 队列名称 String 是 ⻓度限制100字符

QueueID Request 队列 ID String 是 ⽆

State Request 队列状态 String 是

1. Active 表⽰队列内的作业会被⽂档预
览服务调度转码执⾏

2. Paused 表⽰队列暂停，作业不再会
被⽂档预览服务调度执⾏，队列内的所

有作业状态维持在已提交状态，已经处

于执⾏中的任务将继续执⾏，不受影响

NotifyConfig Request 通知渠道 Container 是 第三⽅回调 Url

Container 类型 NotifyConfig 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选 限制

Url Request.NotifyConfig 回调配置 String 否
⻓度限制100
字符

Type Request.NotifyConfig 回调类型，普通回调：

Url
String 否 ⻓度限制100

字符



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第734 共2247⻚

Event Request.NotifyConfig 回调事件，⽂档预览任

务完成
String 否

⻓度限制100
字符

State Request.NotifyConfig 回调开关，Off，On String 否
⻓度限制100
字符

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。 

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第735 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Queue>

        <QueueId></QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>mts-topic-1</Url>

            <Type></Type>

            <Event></Event>

        </NotifyConfig>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第736 共2247⻚

        <CreateTime></CreateTime>

        <UpdateTime></UpdateTime>

    </Queue>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

Queue Response 队列信息，详情请参⻅ DescribeDocProcessQueues 中的 
Response.QueueList

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/47935
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第737 共2247⻚

PUT /docqueue/p2505d57bdf4c4329804b58a6a5fb1572 HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Content-Length: 279

Authorization: Authorization

<?xml version="1.0" encoding="UTF-8" ?>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第738 共2247⻚

<Request>

    <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

    <State>Active</State>

    <Name>markjrzhang4</Name>

    <NotifyConfig>

        <Url>http://google.com/</Url>

    <State>On</State>

        <Type>Url</Type>

        <Event>TransCodingFinish</Event>

    </NotifyConfig>

</Request>[!http]

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第739 共2247⻚

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 08:22:41 GMT

Content-Type: application/xml

Content-Length: 641

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZThlZDBfYzc2OTQzNjRfMzUxYV8x****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <RequestId>NWYxZThlZDBfYzc2OTQzNjRfMzUxYV8x****</RequestId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第740 共2247⻚

        <Queue>

                <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

                <Name>markjrzhang4</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url>http://example.com/</Url>

                        <Event>TransCodingFinish</Event>

                        <Type>Url</Type>

                        <State>On</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>2020-07-24T22:42:27+0800</CreateTime>

                <UpdateTime>2020-07-27T16:22:40+0800</UpdateTime>

                <BucketId>test007-1251704708</BucketId>

                <Category>DocProcessing</Category>

        </Queue>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第741 共2247⻚

⽂档转 HTML
快速⼊门
最近更新时间：2024-01-20 11:39:30

功能描述

⽂档转 HTML 功能⽀持对多种⽂档类型的⽂件⽣成 HTML 格式预览，满⾜ PC、App 等多个⽤户端的⽂档在线浏览
需求，适⽤于在线教育、企业 OA、在线知识库、⽹盘⽂档预览等业务场景。
说明：

数据万象封装预览 JS SDK，只需要⼀条 URL 即可接⼊ HTML 预览服务。
如需在⼩程序内使⽤，请参考 ⼩程序配置业务域名。
如需接⼊ CDN 域名，需要打开 CDN 的⾼级缓存过期设置，详情请参⻅ 节点缓存过期配置 CDN ⽂档。

请求

请求⽰例

https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/228/35317


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第742 共2247⻚

GET /<ObjectKey>?ci-process=doc-preview&dstType=html HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求参数

名称 描述 类型 是否必选

https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第743 共2247⻚

ObjectKey 对象⽂件名，例如 folder/document.pdf String 是

ci-process 数据万象处理能⼒，⽂档 HTML  预览固定为 doc-preview String 是

dstType 转换输出⽬标⽂件类型，⽂档 HTML 预览固定为 html（需
为⼩写字⺟）

String 是

srcType 指定⽬标⽂件类型，⽀持的⽂件类型请⻅下⽅ String 否

sign
对象下载签名，如果预览的对象为私有读时，需要传⼊签

名，详情请参⻅ 请求签名 ⽂档
注意：需要进⾏ urlencode

String 否

copyable 是否可复制。默认为可复制，填⼊值为1；不可复制，填⼊
值为0

String 否

htmlParams

⾃定义配置参数，json结构，需要经过 URL 安全 的 
Base64 编码，默认配置为：{ commonOptions: { 
isShowTopArea: true, isShowHeader: true } }，⽀持的配置
参考 ⾃定义配置项说明

String 否

htmlwaterword ⽔印⽂字，需要经过 URL 安全 的 Base64 编码，默认为空 String 否

htmlfillstyle ⽔印 RGBA（颜⾊和透明度），需要经过 URL 安全 的 
Base64 编码，默认为：rgba(192,192,192,0.6)

String 否

htmlfront ⽔印⽂字样式，需要经过 URL 安全 的 Base64 编码，默认
为：bold 20px Serif

String 否

htmlrotate ⽔印⽂字旋转⾓度，0 - 360，默认315度 String 否

htmlhorizontal ⽔印⽂字⽔平间距，单位 px，默认为50 String 否

htmlvertical ⽔印⽂字垂直间距，单位 px，默认为100 String 否

注意：

⽬前⽀持的输⼊⽂件类型包含如下格式：

演⽰⽂件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。
⽂字⽂件：doc、dot、wps、wpt、docx、dotx、docm、dotm。
表格⽂件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。
其他格式⽂件： pdf、 lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 prg、 cmd、 rtf、 txt、 log、 xml、 
htm、 html。

输⼊⽂件⼤⼩限制在200MB之内。
输⼊⽂件⻚数限制在5000⻚之内。

https://www.tencentcloud.com/document/product/1045/33452
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/436/49416
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/1045/33430


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第744 共2247⻚

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

此接⼝请求的响应体为html预览内容，展⽰效果可参⻅下⽅实际案例。

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

案例⼀：简单预览

将存储桶 examples-1258125638 中的 ObjectKey 为 test.pptx 的 PPT ⽂件进⾏在线预览，最终 URL 如下：

https://www.tencentcloud.com/document/product/1045/43610
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第745 共2247⻚

https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.pptx?ci-process=doc-

说明：

您还可通过 JS-SDK 实现更多功能的定制，详情请参⻅ ⾃定义配置概述。
直接在浏览器中打开链接，⽣成的预览⻚⾯如下图所⽰，对于幻灯⽚⽂档，还可进⾏全屏的幻灯⽚放映，⽀持动

画、触发器等效果，并提供虚拟激光笔、演讲者模式等功能。

案例⼆：⽔印 + ⾃定义配置预览

将存储桶 examples-1258125638 中的 ObjectKey 为 test.pptx 的 PPT ⽂件进⾏在线预览。

https://www.tencentcloud.com/document/product/1045/47939


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第746 共2247⻚

1. 设置不可复制（copyable=0）
2. 设置test ⽔印（通过 URL 安全的 Base64编码得到 htmlwaterword=dGVzdAog）
3. 设置⾃定义配置参数（htmlParams为 {"mode":"normal","commonOptions":

{"isShowHeader":false,"isShowTopArea":true},"pptOptions":{"isSlidesStatusPlay": true}}，通过 URL 安全的 Base64编
码得到 
htmlParams=eyJtb2RlIjoibm9ybWFsIiwiY29tbW9uT3B0aW9ucyI6eyJpc1Nob3dIZWFkZXIiOmZhbHNlLCJpc1Nob3
dUb3BBcmVhIjp0cnVlfSwicHB0T3B0aW9ucyI6eyJpc1NsaWRlc1N0YXR1c1BsYXkiOiB0cnVlfX0=）。
则最终 URL 如下：

https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.pptx?ci-process=doc-



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第747 共2247⻚

直接在浏览器中打开链接，⽣成的预览⻚⾯如下图所⽰，对于幻灯⽚⽂档，还可进⾏全屏的幻灯⽚放映，⽀持动

画、触发器等效果，并提供虚拟激光笔、演讲者模式等功能。

预览链接也可以作为iframe嵌⼊到业务⻚⾯中，如下所⽰：

<!DOCTYPE html>

<html>

<head>

    <meta charset="utf-8">

    <meta name="viewport"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第748 共2247⻚

        content="width=device-width, initial-scale=1.0, maximum-scale=1.0, minimum-

    <meta http-equiv="Content-Type" content="text/html; charset=UTF-8">

    <meta http-equiv="X-UA-Compatible" content="IE=edge,chrome=1">

    <meta http-equiv="Content-Security-Policy" content="upgrade-insecure-requests">

    <meta name="keywords" content="对象存储,⽂档预览">

    <meta name="description" content="">

    <title>腾讯云-对象存储-⽂档预览</title>

    <style>

        html,

        body {

            padding: 0;

            margin: 0;

            height: 100%;

            touch-action: manipulation;

        }

    </style>

</head>

<body>

    <iframe src="https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.ppt

</body>

</html>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第749 共2247⻚

⾃定义配置概述
最近更新时间：2024-01-20 11:39:30

功能说明

通过使⽤ JS-SDK，⽹⻚开发者可以⾃定义界⾯显⽰、⻚⾯状态、监听事件等能⼒，为⽤户提供更优质的⽹⻚体验。

架构图

使⽤环境



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第750 共2247⻚

平台 ⽀持浏览器

iOS Safari、QQ 内置浏览器、QQ ⼩程序、微信内置浏览器、微信⼩程序

Android QQ 内置浏览器、QQ ⼩程序、微信内置浏览器、微信⼩程序

Windows Chrome、QQ 浏览器（⾮兼容模式）、EDGE、⽕狐、IE11

Mac OS X Chrome、Safari、QQ 浏览器、EDGE、⽕狐

使⽤说明

1. 下载

请下载最新版本的 JS-SDK 包。历史版本前往 更新⽇志。

2. 引⼊ JS-SDK

在需要调⽤的⻚⾯引⼊如下 JS-SDK。⽰例中  ${version} 表⽰版本号，请根据下载的实际版本号填写。

https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.1.1.zip
https://www.tencentcloud.com/document/product/1045/47943


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第751 共2247⻚

<script src="sdk-${version}.js"></script>

3. 获取在线⽂档预览地址

⽅法⼀：使⽤ JS-SDK 获取（⽀持 sdk-v0.1.1及以上版本）

通过 JS-SDK（v0.1.1及以上版本）获取在线⽂档预览地址，⽰例如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第752 共2247⻚

var url = await COSDocPreviewSDK.getPreviewUrl( {

      objectUrl: 'https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/tes

      credentials: {      // 如果预览⽂件是私有的，则需要携带访问凭证。

          secretId: '',

          secretKey: '',

          authorization: 'q-sign-algorithmxxxxxxxxxxxxxxx',

      },

      copyable: 0,  // 是否可以复制⽂件内容

      htmlwaterword: ''  // ⽔印内容

})

console.log(url)



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第753 共2247⻚

配置项说明如下：

配置项 说明
是否

必选

objectUrl 需要预览的对象地址，例如：https://examplebucket-
1250000000.cos.ap-shanghai.myqcloud.com/test.pptx

是

credentials
如果预览的对象是私有，则需要传⼊ credentials 作为访问凭证。可以传
⼊计算好的 请求签名 authorization，也可以传⼊⽤户的 secretId 和 
secretKey（固定密钥放在前端会有安全⻛险，不推荐此⽅式）

否

credentials.authorization 对象下载签名，详情请参⻅ 请求签名 ⽂档 否

credentials.secretId ⽤户的 secretId，可前往访问管理控制台中的 API 密钥管理 ⻚⾯获取 否

credentials.secretKey ⽤户的 secretKey，可前往访问管理控制台中的 API 密钥管理 ⻚⾯获取 否

copyable 是否可复制。默认为可复制，填⼊值为1；不可复制，填⼊值为0 否

htmlwaterword ⽔印⽂字，需要经过 URL 安全 的 Base64 编码，默认为空 否

htmlfillstyle ⽔印 RGBA（颜⾊和透明度），需要经过 URL 安全 的 Base64 编码，
默认为：rgba(192,192,192,0.6)

否

htmlfront ⽔印⽂字样式，需要经过 URL 安全 的 Base64 编码，默认为：bold 
20px Serif

否

htmlrotate 旋转⾓度，0 - 360，默认315度 否

htmlhorizontal ⽔印⽂字⽔平间距，单位 px，默认为50 否

htmlvertical ⽔印⽂字垂直间距，单位 px，默认为100 否

⽅法⼆：直接请求获取

请求⽰例

https://www.tencentcloud.com/document/product/1045/33452
https://www.tencentcloud.com/document/product/1045/33452
https://console.tencentcloud.com/cam/capi
https://console.tencentcloud.com/cam/capi
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/1045/33430


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第754 共2247⻚

GET /<ObjectKey>?ci-process=doc-preview&dstType=html&weboffice_url=1&sign=AuthStrin

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

请求参数

参数名称 描述
是否必

选

ci-process 预览固定参数，值为 doc-preview 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第755 共2247⻚

dstType 预览类型，如需预览⽣成类型为 html 则填⼊ html 是

weboffice_url 是否获取预览链接。填⼊值为1会返回预览链接和Token信息；填⼊值为2只返
回Token信息；不传会直接预览

否

tokenuid 是否获取token。根据传⼊的tokenuid、⽂件信息等⽣成Token，返回Token和有
效期；如果不传则不会返回Token信息

否

sign
对象下载签名，如果预览的对象为私有读时，需要传⼊签名，详情请参⻅ 请求
签名 ⽂档
注意：需要进⾏ urlencode

否

copyable 是否可复制。默认为可复制，填⼊值为1；不可复制，填⼊值为0 否

htmlwaterword ⽔印⽂字，需要经过 URL 安全 的 Base64 编码，默认为空 否

htmlfillstyle ⽔印 RGBA（颜⾊和透明度），需要经过 URL 安全 的 Base64 编码，默认为：
rgba(192,192,192,0.6)

否

htmlfront ⽔印⽂字样式，需要经过 URL 安全 的 Base64 编码，默认为：bold 20px Serif 否

htmlrotate 旋转⾓度，0 - 360，默认315度 否

htmlhorizontal ⽔印⽂字⽔平间距，单位 px，默认为50 否

htmlvertical ⽔印⽂字垂直间距，单位 px，默认为100 否

响应⽰例

https://www.tencentcloud.com/document/product/1045/33452
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/1045/33430
https://www.tencentcloud.com/document/product/1045/33430


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第756 共2247⻚

HTTP/1.1 200 OK

Content-Type: text/html

Content-Length: 478

Date: Thu, 25 Feb 2021 07:44:37 GMT

Status: 200 OK

x-cos-request-id: NjAzNzU1NjVfY2MxZTIzMDlfNzc5NF8yMDQ5****

{

        "PreviewUrl": "https://prvsh.myqcloud.com/office/p/xxxx?_w_provider=XXX"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第757 共2247⻚

}

4. 初始化

通过初始化配置，JS-SDK 会在配置的 mount 节点下创建⼀个 iframe，并⾃动初始化相关数据和事件。

var demo = COSDocPreviewSDK.config({

    url: '在线⽂档预览地址',  // 步骤3中获取到的在线⽂档预览地址

})

// 如果需要对 iframe 进⾏特殊的处理，可以通过以下⽅式拿到 iframe 的 dom 对象

console.log(demo.iframe)



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第758 共2247⻚

// 打开⽂档结果

demo.on('fileOpen', function(data) {

    console.log(data.success)

})

5. 挂载节点

挂载节点指 JS-SDK 插⼊ iframe 时挂载的节点。在初始化时，JS-SDK 挂载节点为可配置项。

<div class="custom-mount"></div>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第759 共2247⻚

var demo = COSDocPreviewSDK.config({

    url: '在线⽂档预览地址',    // 步骤3中获取到的在线⽂档预览地址

    mount: document.querySelector('.custom-mount')    // 挂载节点，默认会挂载到 body 下

})

JS-SDK 初始化完成后会⾃动在挂载节点下⾯插⼊⼀个 iframe。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第760 共2247⻚

<div class="custom-mount">

    <iframe src="..."></iframe>

</div>

6. Token 鉴权

不使⽤ Token 时，默认使⽤⽂档的签名有效期鉴权，过期则⽆法预览⽂件。 
使⽤ Token 鉴权可以在预览期间持续进⾏ Token 鉴权和 Token 续期，由业务侧⾃主控制预览授权。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第761 共2247⻚

Token 鉴权与续期分为以下三个步骤，详情请参⻅ demo ⽰例 。
1. 获取 Token 

请求⽰例

https://github.com/tencentyun/cos-demo/blob/main/doc-preview/token-refresh-preview.html


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第762 共2247⻚

GET /<ObjectKey>?ci-process=doc-preview&dstType=html&weboffice_url=2&tokenuid=test&

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

响应⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第763 共2247⻚

HTTP/1.1 200 OK

Content-Type: text/html

Content-Length: 108

Date: Tue, 21 Jun 2022 10:41:10 GMT

Status: 200 OK

x-cos-request-id: NjJiMWEwNDZfMTgyMjYyNjRfYmRlYl9iNTAw****

{

 Token: "ChAJj2vNRiHTc8reToMmJ7T2EJ7FxpUGGhS1mPJanpN03u8PSB17/YKBA/Vo****"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第764 共2247⻚

 TokenExpireTime: "1655808670"

}

2. 设置 Token
说明：

 避免 Token 刷新过于频繁，推荐设置的超时时间（timeout）为 10 分钟以上。为避免 refresh 请求超时，JS-SDK 会
提前⼏分钟去更新 Token。

var demo = COSDocPreviewSDK.config({

    url: '在线⽂档预览地址',  // 步骤3中获取到的在线⽂档预览地址

})



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第765 共2247⻚

// 设置Token

demo.setToken({

  token: 'yourToken', // 填⼊获取到的token

  timeout: 10 * 60 * 1000, // token超时时间，单位为毫秒，避免频繁续期，建议设置 10 分钟及以上

});

3. 配置 refreshToken ⽅法，超时⾃动续期 Token 
refreshToken ⽅法需要请求您的服务端封装的更新 Token 的⽅法，服务端可以封装上述的获取 Token 的⽅法（参考 
获取 Token）。 
以服务端⽅法  http://your.server.com/refreshToken 为例，配置 refreshToken 函数如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第766 共2247⻚

// 获取 Token 函数

const refreshToken = () => {

  // 调⽤服务端封装的⽅法，获取token信息

  const tokenInfo = await $.get('http://your.server.com/refreshToken')

  // 可以返回 Promise 或者 return { token, timeout }

  return {

    token: tokenInfo.token, // 必需：你需要设置的 Token

    timeout: 10 * 60 * 1000, //  必需：Token 超时时间，单位毫秒

  };

};

var demo = COSDocPreviewSDK.config({

    url: '在线⽂档预览地址',  

    refreshToken    // Token⾃动更新⽅法

})

// 设置Token

demo.setToken({

  token: 'yourToken', // 填⼊获取到的token

  timeout: 10 * 60 * 1000   // token超时时间，单位为毫秒

});

实际案例

⽂字⽂件在线预览案例，参考 DOC 预览案例 。
演⽰⽂件在线预览案例，参考 PPT 预览案例 。
表格⽂件在线预览案例，参考 Excel 预览案例 。
PDF ⽂件在线预览案例，参考 PDF 预览案例 。
Token 鉴权与续期案例，参考 Token 鉴权与续期案例 。

https://github.com/tencentyun/cos-demo/blob/main/doc-preview/doc-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/ppt-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/xls-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/pdf-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/token-refresh-preview.html


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第767 共2247⻚

配置项说明
最近更新时间：2024-01-20 11:39:30

显⽰模式

通过初始化配置选项类，开启不同的显⽰模式：

var demo = COSDocPreviewSDK.config({



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第768 共2247⻚

    mode: 'normal', 

})

配置选项说明如下：

mode 选项值 说明 是否默认选项

normal 普通模式，展⽰所有功能界⾯ 是

simple 极简模式，不显⽰头部和⼯具栏 否

⾃定义配置选项

初始化 JS-SDK 时，通过分别配置不同⽂档对应的配置选项，可以开启或关闭⽂档中的特定配置以及控制⽂档打开
时的状态。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第769 共2247⻚

COSDocPreviewSDK.config({

    //通⽤选项，适⽤于所有类型的⽂档。

    commonOptions: {

      isShowTopArea: false, //隐藏顶部区域（头部和⼯具栏）。

      isShowHeader: false //隐藏头部区域。

    },

    //WORD⽂档相关配置。

    wordOptions: {

      isShowDocMap: false,

      isBestScale: true



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第770 共2247⻚

    },

    //PDF⽂档相关配置。

    pdfOptions: {

      isShowComment: true,

      isInSafeMode: false

    },

    //演⽰⽂档相关配置。

    pptOptions: {

      isShowBottomStatusBar: true

    }

})

通⽤配置项：commonOptions

配置项 说明 默认值

isShowTopArea 是否显⽰顶部区域（头部和⼯具栏） false

isShowHeader 是否显⽰头部区域 false

isBrowserViewFullscreen 是否在浏览器区域全屏 false

isIframeViewFullscreen 是否在 iframe 区域内全屏 false

⽂字⽂件配置项：wordOptions

配置项 说明 默认值

isShowDocMap 是否开启⽬录功能，默认开启 true

isBestScale 打开⽂档时，默认以最佳⽐例显⽰（适⽤于 
PC）

true

isShowBottomStatusBar 是否展⽰底部状态栏（适⽤于 PC） false

PDF 配置项：pdfOptions

配置项 说明 默认值

isShowComment 是否显⽰注解，默认显⽰ true

isInSafeMode
是否处于安全模式（安全模式下不能划选⽂

字，不能复制以及不能通过链接跳转），默

认不是安全模式

false

isShowBottomStatusBar 是否展⽰底部状态栏（适⽤于 PC） false



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第771 共2247⻚

演⽰⽂件配置项：pptOptions

配置项 说明 默认值

isShowBottomStatusBar 是否展⽰底部状态栏（适⽤于 PC） false

组件状态设置

可以通过 commandBars 选项来隐藏或禁⽤⻚⾯的组件。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第772 共2247⻚

COSDocPreviewSDK.config({

    //通⽤选项，适⽤于所有类型的⽂档。

    commandBars: [

      {

        cmbId: 'Print', // 组件ID

        attributes: {

          visible: false, // 组件是否显⽰，默认为true。false：隐藏组件；true：显⽰组件

          enable: false, // 禁⽤或者开启组件，默认为true

        },

      },

    ]

})

⽬前可⽤的组件列表如下：

组件ID 说明 适⽤范围

Print 打印功能，和 ctrl+P 打印快捷键 所有⽂档

MobileHeader 客户端的顶部⼯具栏 所有⽂档

WriterHoverToolbars 客户端的底部⼯具栏 ⽂字⽂件

DownloadImg 双击图⽚下载按钮图标 演⽰⽂件

PlayComponentToolbar 全屏播放时右上⾓⼯具栏 演⽰⽂件

PlayContextCheckImage 播放时右键 - 查看原图 演⽰⽂件

FloatMenuCheckImage 选中图⽚时浮动菜单栏 - 查看原图 演⽰⽂件

WPPMobileCommentButton 客户端底部⼯具栏的评论按钮 演⽰⽂件

PDFMobilePageBar 客户端的⻚码 PDF⽂件



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第773 共2247⻚

⾼级功能
最近更新时间：2024-01-20 11:39:30

JS-SDK 提供了⾼级功能可直接对⽂档进⾏操作，以下是⾼级功能的调⽤流程。

1. 等待⽂档加载完成



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第774 共2247⻚

await demo.ready() // 务必等待 demo ready 之后再调⽤⾼级 api，demo 对象是指 JS-SDK 实例化后

2. 获取⽂档对象

// ⽂字

const wordApp = demo.WordApplication()

// 表格



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第775 共2247⻚

const excelApp = demo.ExcelApplication()

// 演⽰

const pptApp = demo.PPTApplication()

// PDF

const pdfApp = demo.PDFApplication()

// ⾃动识别

const app = demo.Application

3. 使⽤⾼级功能

以下对⽂字⽂件、表格⽂件、演⽰⽂件、PDF ⽂件等类型使⽤⾼级功能进⾏列举介绍，如需了解上述类型⽀持的⽂

件格式，请参⻅ 规则与限制。

⽂字⽂件

获取总⻚数

https://www.tencentcloud.com/document/product/1045/33425


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第776 共2247⻚

  /*

  * @param: WdInformation: {

  *      wdNumberOfPagesInDocument: 4

  *  }

  * @return: {PagesCount: number, End: boolean}

  */

  const app = demo.WordApplication()

  const {Enum} = app

  let totalPages = await app.ActiveDocument.Range.Information(Enum.WdInformation.wd

  if (totalPages.End) {

    // 获取总⻚数是异步过程，仅当totalPages.End为true时，获取到的总⻚数才是准确的



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第777 共2247⻚

    console.log("加载完了！⼀共", totalPages.PagesCount, "⻚")

  }

获取当前⻚

  /*

  * @param: WdInformation: {

  *      wdActiveEndPageNumber: 3

  *  }

  * @return: number

  */

  const app = demo.WordApplication()



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第778 共2247⻚

  const {Enum} = app

  let currentPage = await app.ActiveDocument.Selection.Information(Enum.WdInformati

跳转到指定⻚

  /*

  * @param: { What?: WdGoToItem, Which?: WdGoToDirection.wdGoToAbsolute, Count?: nu

  * WdGoToItem: {

  *      wdGoToPage: 1,

  *  }

  *  WdGoToDirection: {

  *      wdGoToAbsolute: 1



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第779 共2247⻚

  *  }

  * @return: number 返回跳转⻚

  */

  const app = demo.WordApplication()

  const {Enum} = app

  const page = await app.ActiveDocument.Selection.GoTo(Enum.WdGoToItem.wdGoToPage, 

  // 或者

  const page = await app.ActiveDocument.Selection.GoTo({

    What: Enum.WdGoToItem.wdGoToPage,

    Which: Enum.WdGoToDirection.wdGoToAbsolute,

    Count: 10

  })

设置评论显⽰



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第780 共2247⻚

  /*

  * @param: bool

  * true 为显⽰， false 为隐藏

  */

  // 隐藏评论

  demo.WordApplication().ActiveDocument.ActiveWindow.View.ShowComments = false

设置⽬录显⽰



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第781 共2247⻚

  /*

  * @param: bool

  * true 为显⽰， false 为隐藏

  */

  // 隐藏⽬录

  demo.WordApplication().ActiveDocument.ActiveWindow.DocumentMap = false

视图缩放



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第782 共2247⻚

  /*

  * @return: number

  */

  await demo.WordApplication().ActiveDocument.ActiveWindow.View.Zoom.Percentage  //

  /*

  * @param : 50 <= number <= 300 (缩放属性值在50%到 300%之间)

  */

  demo.WordApplication().ActiveDocument.ActiveWindow.View.Zoom.Percentage = 100  //



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第783 共2247⻚

表格⽂件

获取所有 sheet 名称

const app = demo.ExcelApplication()

const Names = []

const count = await app.Sheets.Count;

for(let index = 1; index <= count; index++) {

  Names.push(await app.Sheets.Item(index).Name);

}

console.log(Names)



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第784 共2247⻚

获取当前 sheet 名称

const app = demo.ExcelApplication()

const name = await app.ActiveSheet.Name

切换到指定 sheet



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第785 共2247⻚

const app = demo.ExcelApplication()

const sheetIndex = 1 // sheets序号， 从1开始

app.Sheets.Item(sheetIndex).Activate() // 切换sheet

视图缩放



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第786 共2247⻚

  /*

  * @return: number

  */

  await demo.ExcelApplication().ActiveWorkbook.ActiveSheetView.Zoom // 读取视图缩

  /*

  * @param : 10 <= number <= 500 (缩放属性值在10%到500%之间)

  */

  demo.ExcelApplication().ActiveWorkbook.ActiveSheetView.Zoom = 100 // 设置视图缩

演⽰⽂件



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第787 共2247⻚

获取总⻚数

  /*

  * @return: number

  */

  let totalPages = await demo.PPTApplication().ActivePresentation.Slides.Count

获取当前⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第788 共2247⻚

  /*

  * @return: number

  */

  let totalPages = await demo.PPTApplication().ActivePresentation.SlideShowWindow.V

跳转到指定⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第789 共2247⻚

  /*

  * @param: number

  */

  await demo.PPTApplication().ActivePresentation.SlideShowWindow.View.GotoSlide(3) 

播放幻灯⽚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第790 共2247⻚

await demo.PPTApplication().ActivePresentation.SlideShowSettings.Run()

退出播放



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第791 共2247⻚

await demo.PPTApplication().ActivePresentation.SlideShowWindow.View.Exit()

幻灯⽚下⼀步动画



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第792 共2247⻚

  await demo.PPTApplication().ActivePresentation.SlideShowWindow.View.GotoNextClick

幻灯⽚上⼀步动画



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第793 共2247⻚

  await demo.PPTApplication().ActivePresentation.SlideShowWindow.View.GotoPreClick(

获取播放状态



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第794 共2247⻚

  /*

  * @return: string ('preview' | 'play')

  */

  let currentState = await demo.PPTApplication().ActivePresentation.SlideShowWindow

视图缩放



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第795 共2247⻚

  /*

  * @return: number

  */

  await demo.PPTApplication().ActivePresentation.View.Zoom // 读取视图缩放⽐例

  /*

  * @param : 1 <= number <= 400 (缩放属性值在1%到400%之间)

  */

  demo.PPTApplication().ActivePresentation.View.Zoom = 100 // 设置视图缩放⽐例（⾮

PDF ⽂件



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第796 共2247⻚

获取总⻚数

  /*

  * @return: number

  */

  let totalPages = await demo.PDFApplication().ActivePDF.PagesCount

获取当前⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第797 共2247⻚

  /*

  * @return: number

  */

  let totalPages = await demo.PDFApplication().ActivePDF.CurrentPage

跳转到指定⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第798 共2247⻚

  /*

  * @param : { PageNum: number }

  */

  let PageNum = 10

  await demo.PDFApplication().ActivePDF.JumpToPage({PageNum})

设置⻚⾯渲染模式



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第799 共2247⻚

  /*

  * 1：单⻚模式

  * 0：多⻚模式

  */

  demo.PDFApplication().ActivePDF.PageMode = 1   // 设置为单⻚模式

设置⽬录显⽰



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第800 共2247⻚

  /*

  * true：显⽰⽬录

  * false：隐藏⽬录

  */

  demo.PDFApplication().ActivePDF.DocumentMap = true // 显⽰⽬录

视图缩放



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第801 共2247⻚

  /*

  * @return: number

  */

  await demo.PDFApplication().ActivePDF.Zoom  // 读取视图缩放⽐例

  /*

  * @param : 1 <= number <= 400 (缩放属性值在1%到400%之间)

  */

  demo.PDFApplication().ActivePDF.Zoom = 100  // 设置视图缩放⽐例

事件监听



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第802 共2247⻚

可以通过实例的 on ⽅法监听事件。

demo.on('事件名', function(data) {

    // do something...

})

事件名 说明

fileOpen ⽂件打开成功或者失败时的事件回调

error 错误发⽣时的事件回调，会返回错误码



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第803 共2247⻚

fileStatus ⽂件保存的事件回调，会返回状态 status  值：0表⽰⽂档⽆更新，1表⽰版本保存成功，2表⽰
暂不⽀持保存空⽂件，3表⽰空间已满，4表⽰保存中请勿频繁操作，5表⽰保存失败，6表⽰⽂
件更新保存中，触发场景：修改⽂档内容触发的保存，7表⽰⽂档内容修改保存成功



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第804 共2247⻚

更新⽇志
最近更新时间：2024-01-20 11:39:30

V0.2.1

下载地址：sdk-v0.2.1.zip
⽀持 COS V5 签名鉴权
⽀持 token 鉴权和续期

⽀持监听 PPT 中的视频播放状态

V0.1.1

下载地址：sdk-v0.1.1.zip
⽀持在线预览

⽀持 COS V4 签名鉴权

https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.2.1.zip
https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.1.1.zip


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第805 共2247⻚

⽂件处理

⽂件哈希值计算

哈希值计算同步请求
最近更新时间：2024-01-20 11:52:52

功能描述

以同步请求的⽅式进⾏⽂件哈希值计算，实时返回计算得到的哈希值，该接⼝属于 GET 请求。

费⽤说明

调⽤接⼝会产⽣哈希值计算费⽤和 COS 读请求费⽤。
如果⽂件为 COS 上的低频存储类型，调⽤会产⽣ COS 低频数据取回费⽤。

不⽀持处理 COS 上的归档存储类型和深度归档存储类型的⽂件，如果需要处理此类型⽂件，请先 恢复归档⽂件。

限制说明

⽂件⼤⼩：⽀持计算⼩于 128 MB ⼤⼩的⽂件，更⼤⽂件请使⽤ 哈希值计算异步接⼝。
请求超时时间：10秒
调⽤接⼝需携带签名，具体规则请参⻅ 请求签名 ⽂档。

请求

请求⽰例

https://www.tencentcloud.com/document/product/436/40100
https://www.tencentcloud.com/document/product/436/40097
https://www.tencentcloud.com/document/product/436/12633
https://www.tencentcloud.com/document/product/1045/52867
https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第806 共2247⻚

GET /for-test.mp4?ci-process=filehash&type=md5 HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第807 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求参数

参数说明如下：

节点名称（关

键字）
描述 类型

是否必

选

ci-process 操作类型，哈希值计算固定为：filehash String 是

type ⽀持的哈希算法类型，有效值：md5、sha1、sha256 String 是

addtoheader
是否将计算得到的哈希值，⾃动添加⾄⽂件的⾃定义header，格式
为：x-cos-meta-md5/sha1/sha256;
有效值： true、false，不填则默认为false。

String 否

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/436/7728
https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第808 共2247⻚

<Response>

    <FileHashCodeResult>

        <MD5>0fe771ba515b0525552f59290a50c0ef</MD5>

        <FileSize>1048576</FileSize>

    </FileHashCodeResult>

    <Input>

        <Bucket>test-1234567890</Bucket>

        <Object>wg.txt</Object>

        <Region>ap-chongqing</Region>

    </Input>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第809 共2247⻚

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

FileHashCodeResult Response ⽂件哈希值的结果。 Container

Input Response 输⼊⽂件的基本信息。 Container

Container 节点 FileHashCodeResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

MD5 Response.FileHashCodeResult
请求时  type 为 md5 
时返回

String

SHA1 Response.FileHashCodeResult
请求时  type 为 sha1 
时返回

String

SHA256 Response.FileHashCodeResult
请求时  type 为 
sha256 时返回

String

FileSize Response.FileHashCodeResult ⽂件的⼤⼩。 Int

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶所在地域。 String

Bucket Response.JobsDetail.Input 输⼊⽂件所在的存储

桶。
String

Object Response.JobsDetail.Input 输⼊⽂件在存储桶中的

名称。
String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

https://www.tencentcloud.com/document/product/436/46214


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第810 共2247⻚

实际案例

请求

GET /for-test.mp4?ci-process=filehash&type=md5 HTTP/1.1

Host: test-1234567890.cos.ap-beijing.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG****-si

Content-Length: 0

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第811 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-cos

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Response>

    <FileHashCodeResult>

        <MD5>0fe771ba515b0525552f59290a50c0ef</MD5>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第812 共2247⻚

        <FileSize>1048576</FileSize>

        <LastModified>2022-06-27T15:23:12+0800</LastModified>

        <Etag>"ee8de918d05640145b18f70f4c3aa602"</Etag>

    </FileHashCodeResult>

    <Input>

        <Bucket>test-1234567890</Bucket>

        <Object>wg.txt</Object>

        <Region>ap-chongqing</Region>

    </Input>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第813 共2247⻚

提交哈希值计算任务
最近更新时间：2024-01-20 11:52:52

功能描述

以提交任务的⽅式进⾏⽂件哈希值计算，异步返回计算得到的哈希值，该接⼝属于 POST 请求。

费⽤说明

调⽤接⼝会产⽣哈希值计算费⽤和 COS 读请求费⽤。
如果⽂件为 COS 上的低频存储类型，调⽤会产⽣ COS 低频数据取回费⽤。

不⽀持计算 COS 上的归档存储类型和深度归档存储类型的⽂件哈希值，如果需要计算此类型⽂件的哈希值，请先 恢
复归档⽂件。

限制说明

⽂件⼤⼩⽀持：⽀持计算⼩于 50 GB ⼤⼩的⽂件。
调⽤接⼝需携带签名，具体规则请参⻅ 请求签名 ⽂档。
本接⼝当前⽀持以下地域：北京、上海、⼴州、成都、中国⾹港、新加坡、硅⾕。

请求

请求⽰例

https://www.tencentcloud.com/document/product/436/40100
https://www.tencentcloud.com/document/product/436/40097
https://www.tencentcloud.com/document/product/436/12633
https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第814 共2247⻚

POST /file_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第815 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第816 共2247⻚

    <Tag>FileHashCode</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <FileHashCodeConfig>

            <Type>MD5</Type>

            <AddToHeader>true</AddToHeader>

        </FileHashCodeConfig>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://test.test.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器。 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 表⽰任务的类型，哈希值计算默认为：

FileHashCode。
String 是

Input Request 包含待操作的⽂件信息。 Container 是

Operation Request 包含哈希值计算的处理规则。 Container 是

QueueId Request 任务所在的队列 ID。 String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式。

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型。

String 否

CallBack Request 任务回调的地址，优先级⾼于队列的回调地址。 String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第817 共2247⻚

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input ⽂件名，取值为⽂件在当前存储桶中的完整

名称。
String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型
是否必

选

FileHashCodeConfig Request.Operation 指定哈希值计算的处理规则。 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, 
⻓度不超过1024

String 否

Container 类型 FileHashCodeConfig 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是

否

必

选

Type Request.Operation.FileHashCodeConfig
哈希值的算法类型，有效

值：MD5、SHA1、
SHA256。

String 是

AddToHeader Request.Operation.FileHashCodeConfig

是否将计算得到的哈希值添

加⾄⽂件⾃定义header, 有
效值：true、false，默认值
为 false。
⾃定义header根
据  Type 的值变化，例

如  Type 值为MD5时，⾃
定义header为 x-cos-meta-
md5。

String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第818 共2247⻚

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第819 共2247⻚

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器。 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息。 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义。 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义。 String

JobId Response.JobsDetail 新创建任务的 ID。 String

Tag Response.JobsDetail 表⽰任务的类型，哈希值计算默认为：

FileHashCode。
String

State Response.JobsDetail
任务的状态，为 Submitted(已提交)、Running(进⾏
中)、Success(成功)、Failed(失败)、Pause(已暂
停)、Cancel(已取消) 其中⼀个

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第820 共2247⻚

CreationTime Response.JobsDetail 任务的创建时间。 String

StartTime Response.JobsDetail 任务的开始时间。 String

EndTime Response.JobsDetail 任务的结束时间。 String

QueueId Response.JobsDetail 任务所属的队列 ID。 String

Input Response.JobsDetail 被计算哈希值的⽂件信息。 Container

Operation Response.JobsDetail 哈希值计算的处理规则。 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶所在地域。 String

Bucket Response.JobsDetail.Input ⽂件所在的存储桶。 String

Object Response.JobsDetail.Input 被计算哈希值的⽂件

名。
String

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

UserData Response.JobsDetail.Operation 透传⽤户信息。 String

FileHashCodeConfig Response.JobsDetail.Operation 同请求中的 
Request.Operation.FileHashCodeConfig。

Contai

FileHashCodeResult Response.JobsDetail.Operation 计算得到的⽂件 hash 值信息，任务未完
成时不返回。

Contai

Container 节点 FileHashCodeResult 的内容：

节点名称（关键

字）
⽗节点 描述 类型

MD5 Response.JobsDetail.Operation.FileHashCodeResult MD5 计算结果。 String

SHA1 Response.JobsDetail.Operation.FileHashCodeResult SHA1 计算结果。 String

SHA256 Response.JobsDetail.Operation.FileHashCodeResult SHA256 计算结
果。

String

FileSize Response.JobsDetail.Operation.FileHashCodeResult ⽂件⼤⼩。 Int



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第821 共2247⻚

LastModified Response.JobsDetail.Operation.FileHashCodeResult ⽂件的最后修改时

间。
String

Etag Response.JobsDetail.Operation.FileHashCodeResult ⽂件的Etag。 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/436/46214


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第822 共2247⻚

POST /file_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileHashCode</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第823 共2247⻚

    <Operation>

        <FileHashCodeConfig>

            <Type>MD5</Type>

            <AddToHeader>true</AddToHeader>

        </FileHashCodeConfig>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第824 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第825 共2247⻚

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第826 共2247⻚

查询哈希值计算结果
最近更新时间：2024-01-20 11:52:52

功能描述

本接⼝⽤于主动查询指定的⽂件哈希值计算任务结果。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第827 共2247⻚

GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第828 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第829 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第830 共2247⻚

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <FileHashCodeResult>

                <MD5>xxxxxxxx</MD5>

                <FileSize>123</FileSize>

                <LastModified>2022-06-27T15:23:11+0800</LastModified>

                <Etag>xxxxxx</Etag>

            </FileHashCodeResult>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器。 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息。 Container

NonExistJobIds Response 查询的 ID 中不存在任务，所有任务都存在时不返回。 String

具体参数值，请前往 ⽂件哈希值计算  JobsDetail 查看。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/52867
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第831 共2247⻚

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第832 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第833 共2247⻚

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <FileHashCodeResult>

                <MD5>xxxxxxxx</MD5>

                <FileSize>123</FileSize>

                <LastModified>2022-06-27T15:23:11+0800</LastModified>

                <Etag>xxxxxx</Etag>

            </FileHashCodeResult>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第834 共2247⻚

⽂件解压

提交⽂件解压任务
最近更新时间：2024-01-20 11:52:52

功能描述

以提交任务的⽅式进⾏⽂件解压缩，异步返回压缩包内被解压出来的⽂件，该接⼝属于 POST 请求。

费⽤说明

调⽤接⼝会产⽣⽂件解压费⽤和 COS 读请求费⽤。
如果⽂件为 COS 上的低频存储类型，调⽤会产⽣ COS 低频数据取回费⽤。

不⽀持解压 COS 上的归档存储类型和深度归档存储类型的⽂件，如果解压需要此类型⽂件，请先 恢复归档⽂件。

限制说明

⽂件⼤⼩⽀持：⽀持解压⼩于 5 TB 的压缩包⽂件。
⽂件解压的处理⽅式为流式解压，会边解压边输出解压⽂件，如果解压过程中有部分⽂件损坏导致解压操作中⽌，

会保留已解压的部分⽂件。

调⽤接⼝需携带签名，具体规则请参⻅ 请求签名 ⽂档。

本接⼝当前⽀持以下地域：北京、上海、⼴州、成都、中国⾹港、新加坡、硅⾕。

请求

请求⽰例

https://www.tencentcloud.com/document/product/436/40100
https://www.tencentcloud.com/document/product/436/40097
https://www.tencentcloud.com/document/product/436/12633
https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第835 共2247⻚

POST /file_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第836 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第837 共2247⻚

    <Tag>FileUncompress</Tag>

    <Input>

        <Object>input/test.zip</Object>

    </Input>

    <Operation>

        <FileUncompressConfig>

            <Prefix>output/</Prefix>

            <PrefixReplaced>1</PrefixReplaced>

        </FileUncompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器。 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 表⽰任务的类型，⽂件解压默认为：

FileUncompress。
String 是

Input Request 包含待操作的⽂件信息。 Container 是

Operation Request 包含⽂件解压的处理规则。 Container 是

QueueId Request 任务所在的队列 ID。 String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式。

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型。

String 否

CallBack Request 任务回调的地址，优先级⾼于队列的回调地址。 String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第838 共2247⻚

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input ⽂件名，取值为⽂件在当前存储桶中的完整

名称。
String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型
是否必

选

FileUncompressConfig Request.Operation 指定⽂件解压的处理规则。 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 
码, ⻓度不超过1024

String 否

Output Request.Operation 指定解压后的⽂件保存的存储桶

信息。
Container 是

Container 类型 FileUncompressConfig 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选

Prefix Request.Operation.FileUncompressConfig
指定解压后输出⽂件的前

缀，不填则默认保存在存

储桶根路径。

String 否

PrefixReplaced Request.Operation.FileUncompressConfig 指定解压后的⽂件路径是

否需要替换前缀，有效

值：

- 0：不添加额外的前缀，
解压缩将保存在Prefix指
定的路径下（不会保留压

缩包的名称，仅将压缩包

内的⽂件保存⾄指定的路

径）。

- 1：以压缩包本⾝的名称
作为前缀，解压缩将保存

在Prefix指定的路径下。

String 否

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第839 共2247⻚

- 2：以压缩包完整路径作
为前缀，此时如果不指定

Prefix，就是解压到压缩
包所在的当前路径（包含

压缩包本⾝名称）。

- 默认值为0。

说明：

⽰例：

假设压缩包名为 test.zip，压缩包内的⽂件为“图⽚.jpg”，存储在了存储桶 A 的 123 ⽬录下，则压缩包的完整路径
为：123/test.zip。 
对该压缩包进⾏解压缩，指定解压缩到存储桶A，并指定  Prefix  为 456，则不同的  PrefixReplaced 值对应

解压后的⽂件保存情况如下：

0：“图⽚.jpg”会保存在 456 ⽬录下，“图⽚.jpg”的完整路径为 456/图⽚.jpg； 
1：“图⽚.jpg”会以 test 为前缀保存在 456 ⽬录下，“图⽚.jpg”的完整路径为 456/test/图⽚.jpg； 
2：“图⽚.jpg”会以 123/test 为前缀保存在 456 ⽬录下，“图⽚.jpg”的完整路径为 456/123/test/图⽚.jpg。
Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域。 String 是

Bucket Request.Operation.Output 保存解压后⽂件的存

储桶。
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第840 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第841 共2247⻚

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器。 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息。 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义。 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义。 String

JobId Response.JobsDetail 新创建任务的 ID。 String

Tag Response.JobsDetail 表⽰任务的类型，⽂件解压默认为：

FileUncompress。
String

State Response.JobsDetail 任务的状态，为 Submitted(已提交)、Running(进⾏
中)、Success(成功)、Failed(失败)、Pause(已暂

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第842 共2247⻚

停)、Cancel(已取消) 其中⼀个

CreationTime Response.JobsDetail 任务的创建时间。 String

StartTime Response.JobsDetail 任务的开始时间。 String

EndTime Response.JobsDetail 任务的结束时间。 String

QueueId Response.JobsDetail 任务所属的队列 ID。 String

Input Response.JobsDetail 被解压⽂件的信息。 Container

Operation Response.JobsDetail ⽂件解压的处理规则。 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶所在地域。 String

Bucket Response.JobsDetail.Input ⽂件所在的存储桶。 String

Object Response.JobsDetail.Input 被解压⽂件的⽂件名。 String

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类

UserData Response.JobsDetail.Operation 透传⽤户信息。 St

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Co

FileUncompressConfig Response.JobsDetail.Operation 同请求中的 
Request.Operation.FileUncompressConfig。

Co

FileUncompressResult Response.JobsDetail.Operation ⽂件解压的结果，任务未完成时不返回。 Co

Container 节点 FileUncompressResult 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Region Response.JobsDetail.Operation.FileUncompressResult 解压后⽂件保存的存

储桶的地域
String

Bucket Response.JobsDetail.Operation.FileUncompressResult 解压后⽂件保存的存

储桶
String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第843 共2247⻚

FileCount Response.JobsDetail.Operation.FileUncompressResult 解压后⽂件的个数 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/436/46214


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第844 共2247⻚

POST /file_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileUncompress</Tag>

    <Input>

        <Object>input/test.zip</Object>

    </Input>

    <Operation>

        <FileUncompressConfig>

            <Prefix>output/</Prefix>

            <PrefixReplaced>1</PrefixReplaced>

        </FileUncompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第845 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第846 共2247⻚

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第847 共2247⻚

查询⽂件解压结果
最近更新时间：2024-01-20 11:52:52

功能描述

本接⼝⽤于主动查询指定的⽂件解压任务结果。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第848 共2247⻚

GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第849 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第850 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第851 共2247⻚

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器。 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息。 Container

NonExistJobIds Response 查询的 ID 中不存在任务，所有任务都存在时不返回。 String

具体参数值，请前往 ⽂件解压  JobsDetail 查看。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/52870
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第852 共2247⻚

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第853 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第854 共2247⻚

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第855 共2247⻚

多⽂件打包压缩

提交多⽂件打包压缩任务
最近更新时间：2024-01-20 11:52:52

功能描述

多⽂件打包压缩功能可以将您的多个⽂件，打包为 zip 等压缩包格式，以提交任务的⽅式进⾏多⽂件打包压缩，异步
返回打包后的⽂件，该接⼝属于 POST 请求。

费⽤说明

调⽤接⼝会产⽣多⽂件打包压缩费⽤和 COS 读请求费⽤。

如果⽂件为 COS 上的低频存储类型，调⽤会产⽣ COS 低频数据取回费⽤。
不⽀持打包 COS 上的归档存储类型和深度归档存储类型的⽂件，如果打包需要此类型⽂件，请先 恢复归档⽂件。

限制说明

⽂件数量⽀持：最多⽀持打包 1 万个⽂件；
⽂件⼤⼩⽀持：打包压缩后总⼤⼩⼩于 50GB；
调⽤接⼝需携带签名，具体规则请参⻅ 请求签名 ⽂档。

本接⼝当前⽀持以下地域：北京、上海、⼴州、成都、中国⾹港、新加坡、硅⾕。

请求

请求⽰例

https://www.tencentcloud.com/document/product/436/40100
https://www.tencentcloud.com/document/product/436/40097
https://www.tencentcloud.com/document/product/436/12633
https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第856 共2247⻚

POST /file_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第857 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/436/7728


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第858 共2247⻚

    <Tag>FileCompress</Tag>

    <Operation>

        <FileCompressConfig>

            <Prefix>test/</Prefix>

            <Format>zip</Format>

            <Flatten>0</Flatten>

        </FileCompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/test.zip</Object>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器。 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 表⽰任务的类型，多⽂件打包压缩默认为：

FileCompress。
String 是

Operation Request 包含⽂件打包压缩的处理规则。 Container 是

QueueId Request 任务所在的队列 ID。 String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式。

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型。

String 否

CallBack Request 任务回调的地址，优先级⾼于队列的回调地址。 String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情请参⻅ CallBackMqConfig

Container 否

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第859 共2247⻚

Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

FileCompressConfig Request.Operation 指定⽂件打包压缩的处理规则。 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, 
⻓度不超过1024

String 否

Output Request.Operation 指定打包压缩后的⽂件保存的地址信

息。
Container 是

Container 类型 FileCompressConfig 的具体数据描述如下：

节点名

称（关

键字）

⽗节点 描述 类型

是

否

必

选

Flatten Request.Operation.FileCompressConfig

⽂件打包时，是否需要去除源⽂件已

有的⽬录结构，有效值：

0：不需要去除⽬录结构，打包后压
缩包中的⽂件会保留原有的⽬录结

构；

1：需要，打包后压缩包内的⽂件会
去除原有的⽬录结构，所有⽂件都在

同⼀层级。

例如：源⽂件 URL 为 
https://domain/source/test.mp4, 则源
⽂件路径为 source/test.mp4，如果为 
1，则 ZIP 包中该⽂件路径为 
test.mp4；如果为0， ZIP 包中该⽂
件路径为 source/test.mp4。

String 是

Format Request.Operation.FileCompressConfig 打包压缩的类型，有效值：zip、
tar、tar.gz。

String 是

UrlList Request.Operation.FileCompressConfig ⽀持将需要打包的⽂件整理成索引⽂

件，后台将根据索引⽂件内提供的⽂

件 url，打包为⼀个压缩包⽂件。
索引⽂件需要保存在当前存储桶中，

本字段需要提供索引⽂件的对象地

址，例如：/test/index.csv。

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第860 共2247⻚

索引⽂件格式：仅⽀持 CSV ⽂件，
⼀⾏⼀条 URL（仅⽀持本存储桶⽂
件），如有多列字段，默认取第⼀列

作为URL。最多不超过10000个⽂件, 
总⼤⼩不超过50G, 否则会导致任务
失败。

Prefix Request.Operation.FileCompressConfig

⽀持对存储桶中的某个前缀进⾏打

包，如果需要对某个⽬录进⾏打包，

需要加/，例如test⽬录打包，则值
为：test/。最多不超过10000个⽂
件，总⼤⼩不超过50G，否则会导致
任务失败。

String 否

Key Request.Operation.FileCompressConfig
⽀持对存储桶中的多个⽂件进⾏打

包，个数不能超过 1000, 总⼤⼩不超
过50G，否则会导致任务失败。

String
数组

否

注意：

UrlList、Prefix、Key三者仅能选择⼀个，不能都为空，也不会同时⽣效。如果填了多个，会按优先级UrlList > Prefix 
> Key取最⾼优先级执⾏。

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域。 String 是

Bucket Request.Operation.Output 保存压缩后⽂件的存储

桶。
String 是

Object Request.Operation.Output 压缩后⽂件的⽂件名 String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/436/7729


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第861 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第862 共2247⻚

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器。 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息。 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义。 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义。 String

JobId Response.JobsDetail 新创建任务的 ID。 String

Tag Response.JobsDetail 表⽰任务的类型，多⽂件打包压缩默认为：

FileCompress。
String

State Response.JobsDetail
任务的状态，为 Submitted(已提交)、Running(进⾏
中)、Success(成功)、Failed(失败)、Pause(已暂
停)、Cancel(已取消) 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间。 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第863 共2247⻚

StartTime Response.JobsDetail 任务的开始时间。 String

EndTime Response.JobsDetail 任务的结束时间。 String

QueueId Response.JobsDetail 任务所属的队列 ID。 String

Operation Response.JobsDetail 多⽂件打包压缩的处理规则。 Container

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

UserData Response.JobsDetail.Operation 透传⽤户信息。 String

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Contain

FileCompressConfig Response.JobsDetail.Operation 同请求中的 
Request.Operation.FileCompressConfig。

Contain

FileCompressResult Response.JobsDetail.Operation 多⽂件打包压缩的结果，任务未完成时不

返回。
Contain

Container 节点 FileCompressResult 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Region Response.JobsDetail.Operation.FileCompressResult 打包压缩后⽂件保存的

存储桶的地域。
String

Bucket Response.JobsDetail.Operation.FileCompressResult 打包压缩后⽂件保存的

存储桶。
String

Object Response.JobsDetail.Operation.FileCompressResult 打包压缩后⽂件的名

称。
String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/436/46214


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第864 共2247⻚

POST /file_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileCompress</Tag>

    <Operation>

        <FileCompressConfig>

            <Prefix>test/</Prefix>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第865 共2247⻚

            <Format>zip</Format>

            <Flatten>0</Flatten>

        </FileCompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/test.zip</Object>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第866 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第867 共2247⻚

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第868 共2247⻚

查询多⽂件打包压缩结果
最近更新时间：2024-01-20 11:52:52

功能描述

本接⼝⽤于主动查询指定的多⽂件打包压缩任务结果。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第869 共2247⻚

GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第870 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第871 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第872 共2247⻚

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器。 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息。 Container

NonExistJobIds Response 查询的 ID 中不存在任务，所有任务都存在时不返回。 String

具体参数值，请前往 多⽂件打包压缩  JobsDetail 查看。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/52873
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第873 共2247⻚

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第874 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第875 共2247⻚

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第876 共2247⻚

任务与⼯作流

⼯作流接⼝

创建⼯作流
最近更新时间：2024-01-20 16:26:09

功能描述

创建⼯作流。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第877 共2247⻚

POST /workflow HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第878 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

请求体1
请求体2
对于输⼊的视频⽂件进⾏截图和转码处理。视频转码后, 同时进⾏转封装处理和⽣成智能封⾯, 然后对⽣成的封⾯进
⾏图⽚处理。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第879 共2247⻚

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第880 共2247⻚

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第881 共2247⻚

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

⾃适应码流



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第882 共2247⻚

<Request>

    <MediaWorkflow>

        <Name>workflow-2</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第883 共2247⻚

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第884 共2247⻚

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

MediaWorkflow Request ⼯作流节点 Container 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第885 共2247⻚

Container 类型 MediaWorkflow 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选
限制

Name Request.MediaWorkflow
⼯作流名

称
String 是

⽀持中⽂、英⽂、数

字、—和_，⻓度限
制128字符

State Request.MediaWorkflow ⼯作流状

态
String 否 Paused/Active

Topology Request.MediaWorkflow 拓扑信息 Container 是 ⽆

Container 类型 Topology 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选
限制

Dependencies Request.MediaWorkflow.Topology 节点依赖

关系
Container 是 ⽆

Nodes Request.MediaWorkflow.Topology 节点列表 Container 是 ⽆

Container 类型 Nodes 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型
是否

必选
限

Start Request.MediaWorkflow.Topology.Nodes 开始节点 Container 是
只

节

Animation_*** Request.MediaWorkflow.Topology.Nodes 动图类型节

点
Container 否

节

A
可

点

Snapshot_*** Request.MediaWorkflow.Topology.Nodes 截图类型节

点
Container 否

节

S
可

点

SmartCover_*** Request.MediaWorkflow.Topology.Nodes 智能封⾯节

点
Container 否

节

S
缀

能



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第886 共2247⻚

Transcode_*** Request.MediaWorkflow.Topology.Nodes 转码节点 Container 否 节

T
缀

码

Concat_*** Request.MediaWorkflow.Topology.Nodes
⾳视频拼接

节点
Container 否

节

为

个

VoiceSeparate_*** Request.MediaWorkflow.Topology.Nodes ⼈声节点 Container 否

节

V
前

⼈

VideoMontage_*** Request.MediaWorkflow.Topology.Nodes 精彩集锦节

点
Container 否

节

V
缀

彩

StreamPackConfig_*** Request.MediaWorkflow.Topology.Nodes
⾃适应码流

节点
Container 否

节

S
为

个

点

点

是

可

流

VideoStream_*** Request.MediaWorkflow.Topology.Nodes
视频⼦流节

点
Container 否

节

V
缀

频

在

S
节

能

节

StreamPack_*** Request.MediaWorkflow.Topology.Nodes
⾃适应码流

打包节点
Container 否

节

S
缀

适

，

节

能



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第887 共2247⻚

SDRtoHDR_*** Request.MediaWorkflow.Topology.Nodes SDRtoHDR 
节点

Container 否 节

S
缀

S

VideoProcess_*** Request.MediaWorkflow.Topology.Nodes 视频处理节

点
Container 否

节

V
缀

频

SCF_*** Request.MediaWorkflow.Topology.Nodes
SCF 函数
节点

Container 否

节

前

S

SuperResolution_*** Request.MediaWorkflow.Topology.Nodes 超分辨率节

点
Container 否

节

S
前

超

Segment_*** Request.MediaWorkflow.Topology.Nodes ⾳视频转封

装节点
Container 否

节

S
可

转

PicProcess_*** Request.MediaWorkflow.Topology.Nodes 图⽚处理节

点
Container 否

节

P
缀

⽚

Tts_*** Request.MediaWorkflow.Topology.Nodes
语⾳合成节

点
Container 否

节

前

语

SpeechRecognition_*** Request.MediaWorkflow.Topology.Nodes 语⾳识别节

点
Container 否

节

S
为

个

VideoEnhance_*** Request.MediaWorkflow.Topology.Nodes 画质增强节

点
Container 否

节

V
缀

⾳

Condition_*** Request.MediaWorkflow.Topology.Nodes 条件判断节

点
Container 否

节

C
可

断



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第888 共2247⻚

MediaInfo_*** Request.MediaWorkflow.Topology.Nodes 媒体信息获

取节点

Container 否 节

M
可

息

AIRecognition_*** Request.MediaWorkflow.Topology.Nodes AI识别节点 Container 否

节

A
缀

SegmentVideoBody_*** Request.MediaWorkflow.Topology.Nodes
视频⼈像抠

图
Container 否

节

S
为

Container 类型 Start 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型
是否

必选
限制

Type Request.MediaWorkflow.Topology.Nodes.Start 节点类型 String 是 Start

Input Request.MediaWorkflow.Topology.Nodes.Start
输⼊信息, 
详情⻅ 
Input

Container 是 ⽆

Container 类型 Animation_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topology.Nodes.Animation_*** 节点类型 String 是 Anim

Operation Request.MediaWorkflow.Topology.Nodes.Animation_***
操作规则, 
详情⻅ 
Animation

Container 是 ⽆

Container 类型 Snapshot_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

限制

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第889 共2247⻚

Type Request.MediaWorkflow.Topology.Nodes.Snapshot_*** 节点类型 String 是 Snap

Operation Request.MediaWorkflow.Topology.Nodes.Snapshot_***

操作规

则, 详情
⻅ 
Snapshot

Container 是 ⽆

Container 类型 SmartCover_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

Type Request.MediaWorkflow.Topology.Nodes.SmartCover_*** 节点类型 String 是 S

Operation Request.MediaWorkflow.Topology.Nodes.SmartCover_***
操作规则, 
详情⻅ 
SmartCover

Container 是 ⽆

Container 类型 Transcode_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topology.Nodes.Transcode_*** 节点类型 String 是 Tra

Operation Request.MediaWorkflow.Topology.Nodes.Transcode_***
操作规则, 
详情⻅ 
Transcode

Container 是 ⽆

Container 类型 Concat_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topology.Nodes.Concat_*** 节点类

型
String 是 Concat

Operation Request.MediaWorkflow.Topology.Nodes.Concat_*** 操作规

则, 详
Container 是 ⽆

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第890 共2247⻚

情⻅ 
Concat

Container 类型 VoiceSeparate_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

Type Request.MediaWorkflow.Topology.Nodes.VoiceSeparate_*** 节点类型 String 是

Operation Request.MediaWorkflow.Topology.Nodes.VoiceSeparate_***
操作规则, 详
情⻅ 
VoiceSeparate

Container 是

Container 类型 VideoMontage_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

Type Request.MediaWorkflow.Topology.Nodes.VideoMontage_*** 节点类型 String 是

Operation Request.MediaWorkflow.Topology.Nodes.VideoMontage_***
操作规则, 详
情⻅ 
VideoMontage

Container 是

Container 类型 StreamPackConfig_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

Type Request.MediaWorkflow.Topology.Nodes.StreamPackConfig_*** 节点类型 String

Operation Request.MediaWorkflow.Topology.Nodes.StreamPackConfig_*** 操作规则, 详情⻅ 
StreamPackConfig

Contain

Container 类型 VideoStream_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型 是

否

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945
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必

选

Type Request.MediaWorkflow.Topology.Nodes.VideoStream_*** 节点类型 String 是

Operation Request.MediaWorkflow.Topology.Nodes.VideoStream_***
操作规则, 详
情⻅ 
VideoStream

Container 是

Container 类型 StreamPack_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

Type Request.MediaWorkflow.Topology.Nodes.StreamPack_*** 节点类型 String 是

Operation Request.MediaWorkflow.Topology.Nodes.StreamPack_***
操作规则, 
详情⻅ 
StreamPack

Container 是

Container 类型 SDRtoHDR_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

限

Type Request.MediaWorkflow.Topology.Nodes.SDRtoHDR_*** 节点类型 String 是 S

Operation Request.MediaWorkflow.Topology.Nodes.SDRtoHDR_***
操作规则, 
详情⻅ 
SDRtoHDR

Container 是 ⽆

Container 类型 VideoProcess_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

Type Request.MediaWorkflow.Topology.Nodes.VideoProcess_*** 节点类型 String 是

Operation Request.MediaWorkflow.Topology.Nodes.VideoProcess_*** 操作规则, 详
情⻅ 

Container 是

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945
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VideoProcess

Container 类型 SCF_*** 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topology.Nodes.SCF_*** 节点类型 String 是 SCF

Operation Request.MediaWorkflow.Topology.Nodes.SCF_***
操作规

则, 详情
⻅ SCF

Container 是 ⽆

Container 类型 SuperResolution_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

Type Request.MediaWorkflow.Topology.Nodes.SuperResolution_*** 节点类型 String

Operation Request.MediaWorkflow.Topology.Nodes.SuperResolution_***
操作规则, 详情
⻅ 
SuperResolution

Container

Container 类型 Segment_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topology.Nodes.Segment_*** 节点类

型
String 是 Segme

Operation Request.MediaWorkflow.Topology.Nodes.Segment_***

操作规

则, 详情
⻅ 
Segment

Container 是 ⽆

Container 类型 PicProcess_*** 的具体数据描述如下：

节点名称 ⽗节点 描述 类型 是 限

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945
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（关键

字）

否

必

选

Type Request.MediaWorkflow.Topology.Nodes.PicProcess_*** 节点类型 String 是 P

Operation Request.MediaWorkflow.Topology.Nodes.PicProcess_***
操作规则, 
详情⻅ 
PicProcess

Container 是 ⽆

Container 类型 Tts_*** 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是

否

必

选

限

制

Type Request.MediaWorkflow.Topology.Nodes.Tts_*** 节点类型 String 是 Tts

Operation Request.MediaWorkflow.Topology.Nodes.Tts_*** 操作规则, 
详情⻅ Tts

Container 是 ⽆

Container 类型 SpeechRecognition_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

Type Request.MediaWorkflow.Topology.Nodes.SpeechRecognition_*** 节点类型 String

Operation Request.MediaWorkflow.Topology.Nodes.SpeechRecognition_*** 操作规则, 详情⻅ 
SpeechRecognition

Contai

Container 类型 VideoEnhance_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

Type Request.MediaWorkflow.Topology.Nodes.VideoEnhance_*** 节点类型 String 是

Operation Request.MediaWorkflow.Topology.Nodes.VideoEnhance_***
操作规则, 详
情⻅ 
VideoEnhance

Container 是

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49945
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Container 类型 Condition_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topology.Nodes.Condition_*** 节点类型 String 是 Cond

Operation Request.MediaWorkflow.Topology.Nodes.Condition_***

操作规

则, 详情
⻅ 
Condition

Container 是 ⽆

Container 类型 MediaInfo_*** 的具体数据描述如下：

节点名称

（关键字）
⽗节点

描

述
类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topology.Nodes.MediaInfo_***

节

点

类

型

String 是 MediaInfo

Container 类型 AIRecognition_*** 的具体数据描述如下：

节点

名称

（关

键

字）

⽗节点
描

述
类型

是

否

必

选

限制

Type Request.MediaWorkflow.Topology.Nodes.AIRecognition_***

节

点

类

型

String 是 AIRecognition

Container 类型 SegmentVideoBody_*** 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型

https://www.tencentcloud.com/document/product/1045/49945
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Type Request.MediaWorkflow.Topology.Nodes.SegmentVideoBody_*** 节点类型 String

Operation Request.MediaWorkflow.Topology.Nodes.SegmentVideoBody_***
操作规则, 详
情⻅ 
VideoEnhance

Container

⼯作流节点依赖关系如下：

⼯作流节点类型 后⾯可连接的节点类型

Start Snapshot,Animation,SmartCover,Transcode,Concat,VoiceSeparate,VideoMontage,Stream

Snapshot PicProcess,SCF,End

Animation SCF,End

SmartCover PicProcess,SCF,End

Transcode Snapshot,Animation,SmartCover,Concat,VideoMontage,SDRtoHDR,VideoProcess,SCF,Se

Concat Transcode,Snapshot,Animation,SmartCover,SDRtoHDR,VideoProcess,SCF,Segment,Vide

VoiceSeparate SCF,SpeechRecognition,End

VideoMontage Snapshot,Animation,SDRtoHDR,VideoProcess,SCF,SuperResolution,VideoEnhance,Segm

StreamPackConfig VideoStream

VideoStream StreamPack

StreamPack End

SDRtoHDR Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Animation,VideoProcess,SC

VideoProcess Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Animation,SDRtoHDR,SCF,

SCF SDRtoHDR,Snapshot,Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Anima

SuperResolution VideoMontage,Transcode,SmartCover,Animation,Snapshot,SCF,Segment,SDRtoHDR,Vide

Segment VideoEnhance,SegmentVideoBody, End

PicProcess SCF,End

Tts SCF,Transcode,End

SpeechRecognition SCF,Tts,End

VideoEnhance Transcode,VideoMontage,SmartCover,Animation,Snapshot,SCF,Segment,SpeechRecogni

https://www.tencentcloud.com/document/product/1045/49945
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MediaInfo Condition,End

Condition Transcode,HighSpeedHd,SuperResolution,VideoProcess,Animation,Snapshot,VideoMonta

AIRecognition End

SegmentVideoBody End

⼯作流⽀持的通配符：

通配符 含义

${InputPath} 输⼊⽂件的路径(不包括⽂件名)

${InputName} 输⼊⽂件的⽂件名(不包括后缀)

${InputNameAndExt} 输⼊⽂件的⽂件名(包括后缀)

${RunId} 实例 Id

${Ext} 封装格式后缀

${Jobid} 任务Id

${Number} 产物索引, 从0开始计数, 仅⽀持 Snapshot、SmartCover、Segment 节点

${Time} 截图时间点(单位:毫秒), 仅⽀持 Snapshot 节点

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

响应体1
响应体2
对于输⼊的视频⽂件进⾏截图和转码处理。视频转码后, 同时进⾏转封装处理和⽣成智能封⾯, 然后对⽣成的封⾯进
⾏图⽚处理。

https://www.tencentcloud.com/document/product/1045/49945
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<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第898 共2247⻚

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>
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                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>
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⾃适应码流

<Response>

    <MediaWorkflow>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>
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            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>
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                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：
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节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

MediaWorkflow Response ⼯作流数组 Container

Container节点 MediaWorkflow 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Name Response.MediaWorkflow ⼯作流名称 String

WorkflowId Response.MediaWorkflow ⼯作流 ID String

State Response.MediaWorkflow ⼯作流状态 String

CreateTime Response.MediaWorkflow 创建时间 String

UpdateTime Response.MediaWorkflow 更新时间 String

Topology Response.MediaWorkflow 拓扑信息，同请求中的 
Request.MediaWorkflow.Topology

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1
响应1
请求2

响应2
对于输⼊的视频⽂件进⾏截图和转码处理。视频转码后, 同时进⾏转封装处理和⽣成智能封⾯, 然后对⽣成的封⾯进
⾏图⽚处理。

https://www.tencentcloud.com/document/product/1045/33700
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POST /workflow HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>
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            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第906 共2247⻚

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第907 共2247⻚

</Request>

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第908 共2247⻚

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第909 共2247⻚

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第910 共2247⻚

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

⾃适应码流



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第911 共2247⻚

POST /workflow HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-2</Name>

        <State>Active</State>

        <Topology>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第912 共2247⻚

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第913 共2247⻚

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第914 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf95s=

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf95s=</RequestId>

    <MediaWorkflow>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第915 共2247⻚

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第916 共2247⻚

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第917 共2247⻚

查询⼯作流
最近更新时间：2024-01-20 16:26:09

功能描述

查询⼯作流。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第918 共2247⻚

GET /workflow HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第919 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

参数名称（关键字） 描述 类型 是否必选

ids ⼯作流 ID，以  , 符号分割字符串 string 否

name ⼯作流名称 string 否

pageNumber 第⼏⻚ string 否

pageSize 每⻚个数 string 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第920 共2247⻚

<Response>

    <RequestId>NjJmMWZiZTFfOTBmYTUwNjRfNjVmNl8x</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第921 共2247⻚

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第922 共2247⻚

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第923 共2247⻚

        </Topology>

    </MediaWorkflowList>

    <MediaWorkflowList>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第924 共2247⻚

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflowList>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第925 共2247⻚

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response ⼯作流总数 Int

PageNumber Response 当前⻚数，同请求中的 pageNumber Int

PageSize Response 每⻚个数，同请求中的 pageSize Int

MediaWorkflowList Response ⼯作流数组 Container

Container节点 MediaWorkflowList 的内容：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选
限制

Name Response.MediaWorkflowList
⼯作流

名称
String 是

⽀持中⽂、英⽂、数

字、—和_，⻓度限制
128字符

WorkflowId Response.MediaWorkflowList ⼯作流 
ID

String 是 ⼯作流唯⼀ ID

State Response.MediaWorkflowList ⼯作流

状态
String 是

1. Active
2. Paused

CreateTime Response.MediaWorkflowList 创建时

间
String 是 ⽆

UpdateTime Response.MediaWorkflowList 更新时

间
String 是 ⽆

Topology Response.MediaWorkflowList 拓扑信

息
Container 是

同创建⼯作流接⼝的 
Topology 

错误码

https://www.tencentcloud.com/document/product/1045/43733


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第926 共2247⻚

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：⼯作流 ID

GET /workflow?ids=wc666d0b9f9dd47ae9137a096252d49f7,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第927 共2247⻚

Content-Length: 0

Content-Type: application/xml

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第928 共2247⻚

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

        <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第929 共2247⻚

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第930 共2247⻚

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <NonExistIDs>A</NonExistIDs>

    <NonExistIDs>B</NonExistIDs>

</Response>

请求2：⼯作流列表



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第931 共2247⻚

GET /workflow?pageNumber=1&pageSize=10 HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应2



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第932 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>2</TotalCount>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第933 共2247⻚

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第934 共2247⻚

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第935 共2247⻚

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <MediaWorkflowList>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第936 共2247⻚

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第937 共2247⻚

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第938 共2247⻚

删除⼯作流
最近更新时间：2024-01-20 16:26:09

功能描述

删除⼯作流。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第939 共2247⻚

DELETE /workflow/<WorkflowId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第940 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第941 共2247⻚

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <WorkflowId>A</WorkflowId>

<Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第942 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

WorkflowId Response 被删除的⼯作流 ID String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第943 共2247⻚

DELETE /workflow/we59a9648e62e48ffb25e4b41f3721799 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第944 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <WorkflowId>we59a9648e62e48ffb25e4b41f3721799</WorkflowId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第945 共2247⻚

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第946 共2247⻚

更新⼯作流
最近更新时间：2024-01-20 16:26:09

功能描述

更新⼯作流。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第947 共2247⻚

PUT /workflow/<WorkflowId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第948 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体: 

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第949 共2247⻚

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第950 共2247⻚

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第951 共2247⻚

        </Topology>

    </MediaWorkflow>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆
同创建⼯作流接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43733
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第952 共2247⻚

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第953 共2247⻚

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第954 共2247⻚

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第955 共2247⻚

具体的数据内容如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Response ⽆
同创建⼯作流接⼝的 
Response 

Container 是

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：更新⼯作流配置

https://www.tencentcloud.com/document/product/1045/43733
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第956 共2247⻚

PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第957 共2247⻚

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第958 共2247⻚

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第959 共2247⻚

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第960 共2247⻚

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第961 共2247⻚

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第962 共2247⻚

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

请求2：停⽤⼯作流



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第963 共2247⻚

PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7?paused HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应2



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第964 共2247⻚

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWRiMDlfOTBmYTUwNjRfNWYzMl80

请求3：启⽤⼯作流



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第965 共2247⻚

PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7?active HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应3



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第966 共2247⻚

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWRiMDlfOTBmYTUwNjRfNWYzMl80



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第967 共2247⻚

测试⼯作流
最近更新时间：2024-01-20 16:26:09

功能描述

测试⼯作流。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第968 共2247⻚

POST /triggerworkflow?workflowId=xxx&object=xxx HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第969 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求参数

名称 描述 类型
是否必

选

workflowId 需要触发的⼯作流 ID String 是

object 需要进⾏⼯作流处理的对象名称, 需要进⾏ url 编码 String 是

name 存量触发任务名称，⽀持中⽂、英⽂、数字、—和_，⻓度限制128字符，
默认为空

String 否

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第970 共2247⻚

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <InstanceId>i6fc78ca77d6011eba0ac5254008618d9=</InstanceId>

<Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第971 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

InstanceId Response 实例 ID String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第972 共2247⻚

POST /triggerworkflow?workflowId=we59a9648e62e48ffb25e4b41f3721799&object=test.mp4 

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第973 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <InstanceId>i6fc78ca77d6011eba0ac5254008618d9=</InstanceId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第974 共2247⻚

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第975 共2247⻚

⼯作流回调
最近更新时间：2024-01-20 16:26:09

功能说明

数据万象⽀持⾃定义设置回调 URL，在⼯作流开启状态下，每执⾏⼀个实例后，系统会向该 URL 发送 HTTP POST 
请求，请求体中包含通知内容。您可通过配置的回调地址及时了解⼯作流实例处理的进展和状态，以便进⾏其他业

务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据
的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第976 共2247⻚

<Response>

    <EventName>WorkflowFinish</EventName>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <WorkflowName>workflow-3</WorkflowName>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <State>Success</State>

        <BucketId>test-1234567890</BucketId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09 14:54:17+0800</CreateTime>

        <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第977 共2247⻚

            <Key>Content-Type</Key>

            <Value>video/mp4</Value>

        </CosHeaders>

        <CosHeaders>

            <Key>x-cos-request-id</Key>

            <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

        </CosHeaders>

        <Tasks>

            <Type>Snapshot</Type>

            <CreateTime>2022-08-09 14:54:40+0800</CreateTime>

            <EndTime>2022-08-09 14:54:42+0800</EndTime>

            <State>Success</State>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <Name>Snapshot_1581665960536</Name>

            <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

            <TemplateName>snapshot_1280*720_3</TemplateName>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <CreateTime>2022-08-09 14:54:18+0800</CreateTime>

            <EndTime>2022-08-09 14:54:39+0800</EndTime>

            <State>Success</State>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <Name>Transcode_1581665960537</Name>

            <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

            <TemplateName>MP4-265-SD</TemplateName>

        </Tasks>

    </WorkflowExecution>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 
WorkflowFinish

String

WorkflowExecution Response ⼯作流的详细信息 Container

Container 节点 WorkflowExecution 的内容：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第978 共2247⻚

节点名称（关

键字）

⽗节点 描述 类型

WorkflowId Response.WorkflowExecution ⼯作流 ID String

WorkflowName Response.WorkflowExecution ⼯作流的名称 String

RunId Response.WorkflowExecution ⼯作流实例的 ID String

State Response.WorkflowExecution
实例的状态，值为 Success、Failed 其中
⼀个。Tasks 存在⼀个 Failed，则此实例
视为 Failed

String

BucketId Response.WorkflowExecution 被处理⽂件所属的存储桶 String

Object Response.WorkflowExecution 该实例处理的⽂件名 String

CreateTime Response.WorkflowExecution 实例的创建时间 String

CosHeaders Response.WorkflowExecution 该 Object 上传时设定的⾃定义 Header 列
表，没有设置时⽆此内容

Container 
数组

Tasks Response.WorkflowExecution 任务信息列表
Container 
数组

Container 节点 CosHeaders 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Key Response.WorkflowExecution.CosHeaders ⾃定义 Header 的名称 String

Value Response.WorkflowExecution.CosHeaders ⾃定义 Header 的值 String

Container 节点 Tasks 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Type Response.WorkflowExecution.Tasks 任务类型 String

Createtime Response.WorkflowExecution.Tasks 任务的创建时间 String

StartTime Response.WorkflowExecution.Tasks 任务开始时间 String

EndTime Response.WorkflowExecution.Tasks 任务的完成时间 String

State Response.WorkflowExecution.Tasks 任务的状态，值为 Success、 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第979 共2247⻚

Failed 等

JobId Response.WorkflowExecution.Tasks 任务的 ID String

Name Response.WorkflowExecution.Tasks 任务在⼯作流中的节点名称 String

TemplateId Response.WorkflowExecution.Tasks 任务使⽤的模板 ID String

TemplateName Response.WorkflowExecution.Tasks 任务使⽤的模板名称 String

实际案例

案例 1 (XML)



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第980 共2247⻚

<Response>

    <EventName>WorkflowFinish</EventName>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <WorkflowName>workflow-3</WorkflowName>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <State>Success</State>

        <BucketId>test-1234567890</BucketId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09 14:54:17+0800</CreateTime>

        <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第981 共2247⻚

            <Key>Content-Type</Key>

            <Value>video/mp4</Value>

        </CosHeaders>

        <CosHeaders>

            <Key>x-cos-request-id</Key>

            <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

        </CosHeaders>

        <Tasks>

            <Type>Snapshot</Type>

            <CreateTime>2022-08-09 14:54:40+0800</CreateTime>

            <EndTime>2022-08-09 14:54:42+0800</EndTime>

            <State>Success</State>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <Name>Snapshot_1581665960536</Name>

            <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

            <TemplateName>snapshot_1280*720_3</TemplateName>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <CreateTime>2022-08-09 14:54:18+0800</CreateTime>

            <EndTime>2022-08-09 14:54:39+0800</EndTime>

            <State>Success</State>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <Name>Transcode_1581665960537</Name>

            <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

            <TemplateName>MP4-265-SD</TemplateName>

        </Tasks>

    </WorkflowExecution>

</Response>

案例 2 (JSON)



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第982 共2247⻚

{

    "EventName": "WorkflowFinish",

    "WorkflowExecution": {

        "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

        "WorkflowName": "workflow-3",

        "RunId": "i166ee19017b011eda8a5525400c540df",

        "State": "Success",

        "BucketId": "test-1234567890",

        "Object": "wk-test/game.mp4",

        "CreateTime": "2022-08-09 14:54:17+0800",

        "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第983 共2247⻚

                "Key": "Content-Type",

                "Value": "video/mp4"

            },

            {

                "Key": "x-cos-request-id",

                "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

            }

        ],

        "Tasks": [{

                "Type": "Snapshot",

                "CreateTime": "2022-08-09 14:54:40+0800",

                "EndTime": "2022-08-09 14:54:42+0800",

                "State": "Success",

                "JobId": "j23c11e1e17b011edaab4ab15ec33d076",

                "Name": "Snapshot_1581665960536",

                "TemplateId": "t07740e32081b44ad7a0aea03adcffd54a",

                "TemplateName": "snapshot_1280*720_3"

            },

            {

                "Type": "Transcode",

                "CreateTime": "2022-08-09 14:54:18+0800",

                "EndTime": "2022-08-09 14:54:39+0800",

                "State": "Success",

                "JobId": "j168668b217b011ed8efb27bb229e2d11",

                "Name": "Transcode_1581665960537",

                "TemplateId": "t01e57db1c2d154d2fb57aa5de9313a897",

                "TemplateName": "MP4-265-SD"

            }

        ]

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第984 共2247⻚

⼯作流实例

获取⼯作流实例详情
最近更新时间：2024-01-20 16:26:09

功能描述

获取⼯作流实例详情。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第985 共2247⻚

GET /workflowexecution/<RunId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第986 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第987 共2247⻚

<Response>

    <RequestId>NjJmMjA5MjZfZWM0YTYyNjRfN2U3ZF8yNzk1</RequestId>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Name>workflow-1</Name>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <Object>wk-test/game.mp4</Object>

        <State>Success</State>

        <Topology>

            <Dependencies>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第988 共2247⻚

                <Start>Transcode_1581665960537</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960537>Snapshot_1581665960536</Transcode_15816659

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>/wk-test</ObjectPrefix>

                        <ExtFilter>

                            <State>On</State>

                            <Video>false</Video>

                            <Audio>false</Audio>

                            <ContentType>false</ContentType>

                            <Custom>true</Custom>

                            <CustomExts>mp4</CustomExts>

                            <AllFile>false</AllFile>

                            <Image>false</Image>

                        </ExtFilter>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>snapshot-${number}.jpg</Object>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960537>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>trans1.mp4</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960537>

            </Nodes>

        </Topology>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第989 共2247⻚

        <Tasks>

            <Type>Snapshot</Type>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <CreateTime>2022-08-09T14:54:40+08:00</CreateTime>

            <Name>Snapshot_1581665960536</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:40+08:00</StartTime>

            <EndTime>2022-08-09T14:54:42+08:00</EndTime>

            <Code>Success</Code>

            <Message></Message>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <CreateTime>2022-08-09T14:54:18+08:00</CreateTime>

            <Name>Transcode_1581665960537</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:18+08:00</StartTime>

            <EndTime>2022-08-09T14:54:39+08:00</EndTime>

            <Code>Success</Code>

            <Message>success</Message>

        </Tasks>

    </WorkflowExecution>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求 ID String

WorkflowExecution Response ⼯作流实例详细信息 Container

Container 节点 WorkflowExecution 的内容：

节点名称（关键字） ⽗节点 描述 类型

WorkflowId Response.WorkflowExecution ⼯作流 ID String

WorkflowName Response.WorkflowExecution ⼯作流名称 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第990 共2247⻚

RunId Response.WorkflowExecution ⼯作流实例 ID String

CreateTime Response.WorkflowExecution 创建时间 String

Object Response.WorkflowExecution COS 对象地址 String

State Response.WorkflowExecution ⼯作流实例状态 String

Topology Response.WorkflowExecution 同创建⼯作流接⼝的 
Topology 

Container

Tasks Response.WorkflowExecution ⼯作流实例任务 Container 数组

Container 节点 Tasks 的内容：

节点名称（关键字） ⽗节点 描述 类型

Type Response.WorkflowExecution.Tasks 任务所属节点类

型
String

State Response.WorkflowExecution.Tasks 任务状态 String

JobId Response.WorkflowExecution.Tasks 任务 ID String

CreateTime Response.WorkflowExecution.Tasks 任务创建时间 String

StartTime Response.WorkflowExecution.Tasks 任务开始时间 String

EndTime Response.WorkflowExecution.Tasks 任务结束时间 String

Code Response.WorkflowExecution.Tasks 任务的错误码 String

Message Response.WorkflowExecution.Tasks 任务的错误信息 String

Name Response.WorkflowExecution.Tasks ⼯作流节点的节

点名称
String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43733
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第991 共2247⻚

GET /workflowexecution/i166ee19017b011eda8a5525400c540df HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第992 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjJmMjA5MjZfZWM0YTYyNjRfN2U3ZF8yNzk1</RequestId>

    <WorkflowExecution>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第993 共2247⻚

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Name>workflow-1</Name>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <Object>wk-test/game.mp4</Object>

        <State>Success</State>

        <Topology>

            <Dependencies>

                <Start>Transcode_1581665960537</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960537>Snapshot_1581665960536</Transcode_15816659

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>/wk-test</ObjectPrefix>

                        <ExtFilter>

                            <State>On</State>

                            <Video>false</Video>

                            <Audio>false</Audio>

                            <ContentType>false</ContentType>

                            <Custom>true</Custom>

                            <CustomExts>mp4</CustomExts>

                            <AllFile>false</AllFile>

                            <Image>false</Image>

                        </ExtFilter>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>snapshot-${number}.jpg</Object>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960537>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

                        <Output>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第994 共2247⻚

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>trans1.mp4</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960537>

            </Nodes>

        </Topology>

        <Tasks>

            <Type>Snapshot</Type>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <CreateTime>2022-08-09T14:54:40+08:00</CreateTime>

            <Name>Snapshot_1581665960536</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:40+08:00</StartTime>

            <EndTime>2022-08-09T14:54:42+08:00</EndTime>

            <Code>Success</Code>

            <Message></Message>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <CreateTime>2022-08-09T14:54:18+08:00</CreateTime>

            <Name>Transcode_1581665960537</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:18+08:00</StartTime>

            <EndTime>2022-08-09T14:54:39+08:00</EndTime>

            <Code>Success</Code>

            <Message>success</Message>

        </Tasks>

    </WorkflowExecution>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第995 共2247⻚

获取⼯作流实例详情列表
最近更新时间：2024-01-20 16:26:09

功能描述

获取⼯作流实例列表。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第996 共2247⻚

GET /workflowexecution HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第997 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

参数名称（关键

字）
描述 类型 是否必选

workflowId ⼯作流 ID String 是

name ⽂件名称 String 否

orderByTime Desc 或者 Asc。默认为 Desc String 否

size 拉取的最⼤任务数。默认为10。最⼤为100 String 否

states
⼯作流实例状态，以  , 分割⽀持多状态All，Success，
Failed，Running，Cancel。默认为 All

String 否

startCreationTime
拉取创建时间⼤于等于该时间。格式为：  %Y-%m-

%dT%H:%m:%S%z 
String 否

endCreationTime
拉取创建时间⼩于等于该时间。格式为：  %Y-%m-

%dT%H:%m:%S%z 
String 否

nextToken 请求的上下⽂，⽤于翻⻚。下⼀⻚输⼊ token String 否

jobId 批量触发⼯作流任务 ID，⽤于扫描出批量触发任务 ID 对
应执⾏的⼯作流实例

String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第998 共2247⻚

<Response>

    <RequestId>NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0</RequestId>

    <WorkflowExecutionList>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <WorkflowExecutionList>

        <RunId>i769bd26517af11ed917f525400a3c59f</RunId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第999 共2247⻚

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:49:49+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <NextToken>115716</NextToken>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

WorkflowExecutionList Response ⼯作流实例详细信息 Container

RequestId Response 请求 ID String

NextToken Response 翻⻚的上下⽂ Token String

Container 节点 WorkflowExecutionList 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.WorkflowExecutionList ⼯作流实例 ID String

WorkflowId Response.WorkflowExecutionList ⼯作流 ID String

State Response.WorkflowExecutionList ⼯作流实例状态 String

CreateTime Response.WorkflowExecutionList 创建时间 String

Object Response.WorkflowExecutionList COS 对象地址 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1000 共2247⻚

GET /workflowexecution?workflowId=web6ac56c1ef54dbfa44d7f4103203be9 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1001 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0

<Response>

    <RequestId>NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0</RequestId>

    <WorkflowExecutionList>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1002 共2247⻚

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <WorkflowExecutionList>

        <RunId>i769bd26517af11ed917f525400a3c59f</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:49:49+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <NextToken>115716</NextToken>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1003 共2247⻚

任务接⼝

媒体处理

提交媒体处理任务

提交视频转动图任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个动图任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1004 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1005 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1006 共2247⻚

    <Tag>Animation</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.gif</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag：Animation String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1007 共2247⻚

CallBackMqConfig Request 任务回调TDMQ配置，当 CallBackType 为 TDMQ 
时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

Animation Request.Operation 指定该任务的参数 Container 否

TemplateId Request.Operation 指定的模板 ID String 否

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度不
超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级别
越⼤任务优先级越⾼，默认为0

String 否

注意：

优先使⽤ TemplateId，⽆ TemplateId 时使⽤ Animation。

Container 类型 Animation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Container Request.Operation.Animation
同动图模板 
CreateMediaTemplate 接⼝中
的 Request.Container

Container 否

Video Request.Operation.Animation
同动图模板 
CreateMediaTemplate 接⼝中
的 Request.Video 

Container 否

TimeInterval Request.Operation.Animation Container 否

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49906
https://www.tencentcloud.com/document/product/1045/49906


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1008 共2247⻚

同动图模板 
CreateMediaTemplate 接⼝中
的 Request.TimeInterval 

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49906
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1009 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Animation</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1010 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：Animation String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1011 共2247⻚

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存在
时返回

String

Animation Response.JobsDetail.Operation 同请求中的 
Request.Operation.Animation

Container

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container

MediaInfo Response.JobsDetail.Operation 输出⽂件的媒体信息，任务未完成时

不返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时

不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1012 共2247⻚

Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。
Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

使⽤动图模板 ID

请求

https://www.tencentcloud.com/document/product/1045/48569
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1013 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1014 共2247⻚

    <Operation>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.gif</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1015 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1016 共2247⻚

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Animation</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

使⽤动图处理参数

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1017 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1018 共2247⻚

    <Operation>

        <Animation>

            <Container>

                <Format>gif</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height>960</Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </Animation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.gif</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1019 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1020 共2247⻚

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Animation</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Animation>

                <Container>

                    <Format>gif</Format>

                </Container>

                <Video>

                    <Codec>gif</Codec>

                    <Width>1280</Width>

                    <Height>960</Height>

                    <Fps>15</Fps>

                    <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

                </Video>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

            </Animation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1021 共2247⻚

提交视频拼接任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个拼接任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1022 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1023 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1024 共2247⻚

    <Tag>Concat</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：Concat String 是

Input Request 待操作的媒体信息 Container 否

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1025 共2247⻚

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

ConcatTemplate Request.Operation 指定拼接参数 Container 否

TemplateId Request.Operation 指定的模板 ID String 否

Output Request.Operation 结果输出地址 Container 是

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级
别越⼤任务优先级越⾼，默认为0

String 否

注意：

优先使⽤ TemplateId，⽆ TemplateId 时使⽤ ConcatTemplate。
Container 类型 ConcatTemplate 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

ConcatFragment Request.Operation.ConcatTemplate 拼接节点
Container 
数组

Audio Request.Operation.ConcatTemplate ⾳频参数，同创建拼接模板 
CreateMediaTemplate 接⼝中的 
Request.ConcatTemplate.Audio

Container

Video Request.Operation.ConcatTemplate
视频参数，同创建拼接模板 
CreateMediaTemplate 接⼝中的  

Container

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49907
https://www.tencentcloud.com/document/product/1045/49907


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1026 共2247⻚

Request.ConcatTemplate.Video 

Container Request.Operation.ConcatTemplate 封装格式，同创建拼接模板 
CreateMediaTemplate 接⼝中的 
Request.ConcatTemplate.Container

Container

AudioMix Request.Operation.ConcatTemplate 混⾳参数, 详情⻅ AudioMix 
Container
数组

Index Request.Operation.ConcatTemplate
Input 节点位于 ConcatFragment 序
列索引

String

DirectConcat Request.Operation.ConcatTemplate 简单拼接⽅式（不转码直接拼

接），其他的视频和⾳频参数失效
String

Container 类型 ConcatFragment 的具体数据描述如下：

节点名称（关

键字）
⽗节点

描

述
类型

是

否

必

选

默

认

值

限制

Url Request.Operation.ConcatTemplate.ConcatFragment

拼

接

对

象

地

址

String 是 ⽆

同 
bucket
对象⽂

件

FragmentIndex Request.Operation.ConcatTemplate.ConcatFragment

拼

接

对

象

的

索

引

位

置

String 否 0
⼤于等

于0的
整数

StartTime Request.Operation.ConcatTemplate.ConcatFragment 开

始

String 否 视

频

[0 视
频时

⻓] 

https://www.tencentcloud.com/document/product/1045/49907
https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1027 共2247⻚

时

间

开

始

单位为

秒 

EndTime Request.Operation.ConcatTemplate.ConcatFragment

结

束

时

间

String 否

视

频

结

束

[0 视
频时

⻓] 
单位为

秒 

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1028 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1029 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>concat_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：Concat String

State Response.JobsDetail
任务的状态，为 Submitted、Running、
Success、Failed、Pause、Cancel 其中
⼀个

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1030 共2247⻚

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存在时
返回

String

ConcatTemplate Response.JobsDetail.Operation 同请求中的 
Request.Operation.ConcatTemplate

Container

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container

MediaInfo Response.JobsDetail.Operation 输出⽂件的媒体信息，任务未完成时不

返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时不

返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1031 共2247⻚

Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。
Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

错误码

常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：使⽤拼接模板 ID

请求

https://www.tencentcloud.com/document/product/1045/48569
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1032 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:test-123456789.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1033 共2247⻚

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1034 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1035 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>concat_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使⽤拼接参数

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1036 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:test-123456789.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1037 共2247⻚

    <Operation>

        <ConcatTemplate>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.mp4<

            </ConcatFragment>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp4</U

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height>720</Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1038 共2247⻚

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1039 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c5d</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ConcatTemplate>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.

                </ConcatFragment>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp

                </ConcatFragment>

                <Audio>

                    <Codec>mp3</Codec>

                </Audio>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Height>720</Height>

                    <Fps>30</Fps>

                </Video>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <AudioMix>

                    <AudioSource>https://test-123456789.cos.ap-chongqing.myqcloud.c

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1040 共2247⻚

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMix>

                <Index>1</Index>

            </ConcatTemplate>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求3：多⽂件拼接

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1041 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:test-123456789.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Operation>

        <ConcatTemplate>

            <ConcatFragment>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1042 共2247⻚

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.mp4<

                <FragmentIndex>0</FragmentIndex>

                <StartTime>0</StartTime>

                <EndTime>6</EndTime>

            </ConcatFragment>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/middle.mp4

                <FragmentIndex>1</FragmentIndex>

            </ConcatFragment>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp4</U

                <FragmentIndex>2</FragmentIndex>

                <StartTime>5</StartTime>

                <EndTime>10</EndTime>

            </ConcatFragment>

            <Container>

                <Format>mp4</Format>

            </Container>

        </ConcatTemplate>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1043 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1044 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c5d</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ConcatTemplate>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.

                    <StartTime>0</StartTime>

                    <EndTime>6</EndTime>

                </ConcatFragment>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/middle

                </ConcatFragment>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp

                    <StartTime>5</StartTime>

                    <EndTime>10</EndTime>

                </ConcatFragment>

                <Container>

                    <Format>mp4</Format>

                </Container>

            </ConcatTemplate>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1045 共2247⻚

提交添加数字⽔印任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个添加数字⽔印任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1046 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1047 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1048 共2247⻚

    <Tag>DigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：DigitalWatermark String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优
先级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1049 共2247⻚

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设

置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Output Request.Operation 结果输出地址 Container 是

DigitalWatermark Request.Operation 数字⽔印配置 Container 是

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级
别越⼤任务优先级越⾼，默认为0

String 否

UserData Request.Operation 透传⽤户信息，可打印的 ASCII 码, ⻓度
不超过1024

String 否

Container 类型 DigitalWatermark 的具体数据类型描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否

必选
限制

Message Request.Operation.DigitalWatermark

数字⽔

印嵌⼊

的字符

串信息

string 是

⻓度不超过64个
字符，仅⽀持中

⽂、英⽂、数

字、_、-和*

Type Request.Operation.DigitalWatermark ⽔印类

型
String 是 Text

Version Request.Operation.DigitalWatermark ⽔印版

本
String 是 V1

Container 类型 Output 的具体数据描述如下：

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1050 共2247⻚

节点名称（关

键字）

⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1051 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>DigitalWatermark</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1052 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：DigitalWatermark String

State Response.JobsDetail 任务的状态，为 Submitted、Running、 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1053 共2247⻚

Success、Failed、Pause、Cancel 其中⼀个

CreationTime Response.JobsDetail 任务的创建时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的操作规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container

DigitalWatermark Response.JobsDetail.Operation 同请求中的 
Request.Operation.DigitalWatermark

Container

MediaInfo Response.JobsDetail.Operation 输出⽂件的媒体信息，任务未完成时不

返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时不

返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。

Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1054 共2247⻚

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1055 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>DigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1056 共2247⻚

    <Operation>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1057 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1058 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>DigitalWatermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1059 共2247⻚

提交提取数字⽔印任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个提取数字⽔印任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1060 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1061 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1062 共2247⻚

    <Tag>ExtractDigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <ExtractDigitalWatermark>

            <Type>Text</Type>

            <Version>V1</Version>

        </ExtractDigitalWatermark>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：ExtractDigitalWatermark String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设

置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1063 共2247⻚

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型
是否必

选

ExtractDigitalWatermark Request.Operation 提取数字⽔印配置 Container 是

JobLevel Request.Operation
任务优先级，级别限制：0 、1 、
2。级别越⼤任务优先级越⾼，默
认为0

String 否

UserData Request.Operation 透传⽤户信息，可打印的 ASCII 
码, ⻓度不超过1024

String 否

Container 类型 ExtractDigitalWatermark 的具体数据类型描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选
限制

Type Request.Operation.ExtractDigitalWatermark ⽔印类

型
String 是 Text

Version Request.Operation.ExtractDigitalWatermark ⽔印版

本
String 是 V1

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1064 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>ExtractDigitalWatermark</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1065 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ExtractDigitalWatermark>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：ExtractDigitalWatermark String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

EndTime Response.JobsDetail 任务的结束时间 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1066 共2247⻚

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的操作规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

ExtractDigitalWatermark Response.JobsDetail.Operation 数字⽔印配置 Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 类型 ExtractDigitalWatermark 的具体数据类型描述如下：

节点名称（关

键字）
⽗节点 描述 类型

Message Response.JobsDetail.Operation.ExtractDigitalWatermark 提取出的数字⽔印

字符串信息
string

Type Response.JobsDetail.Operation.ExtractDigitalWatermark ⽔印类型 String

Version Response.JobsDetail.Operation.ExtractDigitalWatermark ⽔印版本 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1067 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>ExtractDigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1068 共2247⻚

    <Operation>

        <ExtractDigitalWatermark>

            <Type>Text</Type>

            <Version>V1</Version>

        </ExtractDigitalWatermark>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1069 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1070 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>ExtractDigitalWatermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ExtractDigitalWatermark>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1071 共2247⻚

提交获取媒体信息任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个获取媒体信息任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1072 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1073 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1074 共2247⻚

    <Tag>MediaInfo</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag：MediaInfo String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优
先级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先
级⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。

设置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Operation 的具体数据描述如下：

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1075 共2247⻚

节点名称

（关键

字）

⽗节点 描述 类型 是否必选

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度不超过
1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2 。级别越⼤
任务优先级越⾼，默认为0

String 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1076 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>MediaInfo</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1077 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：MediaInfo String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1078 共2247⻚

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

MediaInfo Response.JobsDetail.Operation 输出视频的信息，任务

未完成时不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaInfo 的内容： 

同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求：

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1079 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>MediaInfo</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1080 共2247⻚

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1081 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>MediaInfo</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1082 共2247⻚

提交⾳频降噪任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个⾳频降噪任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1083 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1084 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1085 共2247⻚

    <Tag>NoiseReduction</Tag>

    <Input>

        <Object>input/demo.mp3</Object>

    </Input>

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.wav</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag：NoiseReduction String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 Container 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1086 共2247⻚

TDMQ 时必填。详情⻅ CallBackMqConfig

Container 类型 Input 的具体数据描述如下：

节点名

称（关

键字）

⽗节点 描述 类型
是否必

选

Object Request.Input

执⾏⾳频降噪任务的媒体⽂件名 
1. ⽬前只⽀持⽂件⼤⼩在10M之内的⾳频 
2. 如果输⼊为视频⽂件或者多通道的⾳频，只会保留
单通道的⾳频流

3. ⽬前暂不⽀持m3u8格式输⼊

String 是

Container 类型 Operation 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型
是否必

选

Output Request.Operation 结果输出地址 Container 是

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2 。级别越⼤
任务优先级越⾼，默认为0

String 否

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度不超过
1024

String 否

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1087 共2247⻚

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1088 共2247⻚

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>NoiseReduction</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.wav</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1089 共2247⻚

Tag Response.JobsDetail 新创建任务的 Tag：NoiseReduction String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的操作规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Output Response.JobsDetail.Operation 同请求中的 
Request.Operation.Output

Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1090 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>NoiseReduction</Tag>

    <Input>

        <Object>input/demo.mp3</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1091 共2247⻚

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.wav</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1092 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1093 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>NoiseReduction</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.wav</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1094 共2247⻚

提交视频质量评分任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个视频质量分析任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1095 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1096 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1097 共2247⻚

    <Tag>QualityEstimate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：QualityEstimate String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Operation 的具体数据描述如下：

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1098 共2247⻚

节点名称

（关键

字）

⽗节点 描述 类型 是否必

选

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度不超过
1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2 。级别越⼤任
务优先级越⾼，默认为0

String 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1099 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>QualityEstimate</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1100 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：QualityEstimate String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1101 共2247⻚

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

MediaInfo Response.JobsDetail.Operation 输出视频的信息，任务未

完成时不返回
Container

QualityEstimate Response.JobsDetail.Operation 视频分析结果，任务未完

成时不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

Container 节点 QualityEstimate 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Score Response.JobsDetail.Operation.QualityEstimate

视频质量得分, 
满分为10分, 达
到6分就可以认
为视频质量良好

String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1102 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>QualityEstimate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1103 共2247⻚

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1104 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>QualityEstimate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1105 共2247⻚

提交 SDRtoHDR 任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个 SDR to HDR 任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1106 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1107 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1108 共2247⻚

    <Tag>SDRtoHDR</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <SDRtoHDR>

            <HdrMode>HLG</HdrMode>

        </SDRtoHDR>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplateI

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemplateI

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTemplateI

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag：SDRtoHDR String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级 String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1109 共2247⻚

⾼于队列的回调类型

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型
是否

必选

SDRtoHDR Request.Operation 指定 SDRtoHDR 参数 Container 是

Transcode Request.Operation 指定转码模板参数，不能与 
TranscodeTemplateId 同时为空

Container 否

TranscodeTemplateId Request.Operation 指定的转码模板 ID，优先使⽤模板 
ID，不能与 Transcode 同时为空

String 否

Watermark Request.Operation
指定⽔印模板参数，同创建⽔印模板 
CreateMediaTemplate 接⼝中的 
Request.Watermark, 最多传3个

Container 
数组

否

WatermarkTemplateId Request.Operation
指定的⽔印模板 ID，可以传多个⽔印
模板 ID，最多传3个，优先使⽤模板 
ID

String 数
组

否

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓
度不超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。
级别越⼤任务优先级越⾼，默认为0

String 否

说明：

https://www.tencentcloud.com/document/product/1045/49945#CallBackMqConfig
https://www.tencentcloud.com/document/product/1045/49917


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1110 共2247⻚

 提交 SDRtoHDR 任务必须传⼊转码参数。对于转码参数，优先使⽤ TranscodeTemplateId，⽆ 
TranscodeTemplateId 时使⽤ Transcode；对于⽔印参数，可以使⽤ WatermarkTemplateId 或Watermark 设置，
WatermarkTemplateId 优先级更⾼。

Container 类型 SDRtoHDR 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选
限制

HdrMode Request.Operation.SDRtoHDR HDR 标
准

String 是
1. HLG
2. HDR10

Container 类型 Transcode 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

必

选

TimeInterval Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Timeİnterval

Container 否

Container Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Container

Container 否

Video Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Video

Container 否

Audio Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Audio

Container 否

TransConfig Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.TransConfig

Container 否

AudioMix Request.Operation.Transcode 混⾳参数, 详情⻅ AudioMix 
Container 
数组

否

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1111 共2247⻚

Bucket Request.Operation.Output 存储结果的存储

桶

String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1112 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SDRtoHDR</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1113 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1114 共2247⻚

Tag Response.JobsDetail 新创建任务的 Tag：SDRtoHDR String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

SDRtoHDR Response.JobsDetail.Operation 同请求中的 
Request.Operation.SDRtoHDR

Container

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container

MediaInfo Response.JobsDetail.Operation 输出⽂件的媒体信息，任务未完成时

不返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时

不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1115 共2247⻚

Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。
Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1116 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SDRtoHDR</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1117 共2247⻚

    <Operation>

        <SDRtoHDR>

            <HdrMode>HLG</HdrMode>

        </SDRtoHDR>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplateI

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemplateI

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTemplateI

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1118 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1119 共2247⻚

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SDRtoHDR</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1120 共2247⻚

提交转封装任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个转封装任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1121 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1122 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1123 共2247⻚

    <Tag>Segment</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Segment>

            <Format>hls</Format>

            <Duration>5</Duration>

            <HlsEncrypt>

                <IsHlsEncrypt>true</IsHlsEncrypt>

                <UriKey>test-key</UriKey>

            </HlsEncrypt>

        </Segment>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out-${Number}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：Segment String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1124 共2247⻚

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设

置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

Segment Request.Operation 指定转封装参数 Container 是

Output Request.Operation 结果输出地址 Container 是

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级别
越⼤任务优先级越⾼，默认为0

String 否

Container 类型 Segment 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

Format Request.Operation.Segment 封装格式 String

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1125 共2247⻚

Duration Request.Operation.Segment 转封装时⻓，单位：秒 String

TranscodeIndex Request.Operation.Segment

指定处理的流编号，对应媒体信息中的 
Response.MediaInfo.Stream.Video.Index 
和 
Response.MediaInfo.Stream.Audio.Index，
详⻅ 获取媒体信息接⼝ 

String

HlsEncrypt Request.Operation.Segment hls 加密配置 Container

Container 类型 HlsEncrypt 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

必

选

默认

值
限制

IsHlsEncrypt Request.Operation.Segment.HlsEncrypt

是否

开启

HLS 
加密

String 否 false

1. true/false 
2. 
Segment.Format 
为 HLS 时⽀持
加密

UriKey Request.Operation.Segment.HlsEncrypt

HLS 
加密

的 
key

String 否 ⽆

当 IsHlsEncrypt 
为 true 时，该参
数才有意义

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output 输出结果的⽂件名，如果设置了

Duration, 且 Format 不为 HLS 或 
m3u8 时, ⽂件名必须包含${Number}

String 是

https://www.tencentcloud.com/document/product/1045/49541


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1126 共2247⻚

参数作为⾃定义转封装后每⼀⼩段⾳/
视频流的输出序号

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1127 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Segment</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1128 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Segment>

                <Format>hls</Format>

                <Duration>5</Duration>

                <HlsEncrypt>

                    <IsHlsEncrypt>true</IsHlsEncrypt>

                    <UriKey>test-key</UriKey>

                </HlsEncrypt>

            </Segment>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out-${Number}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <CallBack>http://callback.demo.com</CallBack>

        <CallBackFormat>JSON<CallBackFormat>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1129 共2247⻚

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：Segment String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

Segment Response.JobsDetail.Operation 同请求中的 
Request.Operation.Segment

Container

Output Response.JobsDetail.Operation 同请求中的 
Request.Operation.Output

Container

MediaInfo Response.JobsDetail.Operation 转码输出视频的信息，没有时不

返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完

成时不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1130 共2247⻚

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。

Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关

键字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 MD5 
值

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：mp4转封装

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1131 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Segment</Tag>

    <Input>

        <Object>input/demo.mkv</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1132 共2247⻚

    <Operation>

        <Segment>

            <Format>mp4</Format>

            <Duration>15</Duration>

        </Segment>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out-${Number}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1133 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1134 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Segment</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mkv</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Segment>

                <Format>mp4</Format>

                <Duration>15</Duration>

            </Segment>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out-${Number}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <CallBack>http://callback.demo.com</CallBack>

        <CallBackFormat>JSON<CallBackFormat>

    </JobsDetail>

</Response>

请求2：hls转封装并加密



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1135 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Segment</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1136 共2247⻚

    <Operation>

        <Segment>

            <Format>hls</Format>

            <Duration>5</Duration>

            <HlsEncrypt>

                <IsHlsEncrypt>true</IsHlsEncrypt>

                <UriKey>test-key</UriKey>

            </HlsEncrypt>

        </Segment>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out-${Number}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1137 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1138 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Segment</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Segment>

                <Format>hls</Format>

                <Duration>5</Duration>

                <HlsEncrypt>

                    <IsHlsEncrypt>true</IsHlsEncrypt>

                    <UriKey>test-key</UriKey>

                </HlsEncrypt>

            </Segment>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <CallBack>http://callback.demo.com</CallBack>

        <CallBackFormat>JSON<CallBackFormat>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1139 共2247⻚

提交智能封⾯任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个智能封⾯任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1140 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1141 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1142 共2247⻚

    <Tag>SmartCover</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：SmartCover String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1143 共2247⻚

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

TemplateId Request.Operation 智能封⾯模板 ID String 否

SmartCover Request.Operation 封⾯配置 Container 否

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度不
超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级别
越⼤任务优先级越⾼，默认为0

String 否

说明：

 如果同时设置了 TemplateId 和 SmartCover，则优先使⽤ TemplateId

Container 类型 SmartCover 的具体数据类型描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是

否

必

选

默认

值
限制

Format Request.Operation.SmartCover 封⾯图

⽚类型
String 是 ⽆

png、jpg、
webp

Width Request.Operation.SmartCover
封⾯图

⽚宽度
String 是 ⽆

1. 值范围：
[128，4096]
2. 单位：px

Height Request.Operation.SmartCover 封⾯图

⽚⾼度

String 是 ⽆ 1. 值范围：
[128，4096]

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1144 共2247⻚

2. 单位：px

Count Request.Operation.SmartCover
封⾯数

量
String 否 3

1. 值范围：
[1，10]
2. 单位：px

DeleteDuplicates Request.Operation.SmartCover 封⾯是

否去重
String 否 false true/false

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output

输出结果的⽂件名。

必须包含 ${Number} 参数。
如 Object 为 my-new-
cover-${Number}.jpg，对应实际3张
输出结果时，分别为

my-new-cover-0.jpg
my-new-cover-1.jpg
my-new-cover-2.jpg

String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1145 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SmartCover</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1146 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：SmartCover String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1147 共2247⻚

CreationTime Response.JobsDetail 任务的创建时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

SmartCover Response.JobsDetail.Operation 同请求中的 
Request.Operation.SmartCover

String

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时

不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关键

字）
⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1148 共2247⻚

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶所

在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多个 String 数组

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：使⽤智能封⾯模板 ID

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1149 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1150 共2247⻚

    <Operation>

        <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1151 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1152 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SmartCover</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使⽤智能封⾯参数



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1153 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1154 共2247⻚

    <Operation>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1155 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1156 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SmartCover</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel> 

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1157 共2247⻚

提交视频截帧任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个截图任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1158 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1159 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1160 共2247⻚

    <Tag>Snapshot</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/snapshot-${Number}.jpg</Object>

            <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：Snapshot String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1161 共2247⻚

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Snapshot Request.Operation
指定该任务的参数，同创建截图模板 
CreateMediaTemplate 接⼝中的 
Request.Snapshot

Container 否

TemplateId Request.Operation 指定的模板 ID String 否

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度
不超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级
别越⼤任务优先级越⾼，默认为0

String 否

注意：

优先使⽤ TemplateId，⽆ TemplateId 时使⽤ Snapshot。
Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output 结果⽂件的名字。

必须包含 ${Number} 参
数。

String 否

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49909


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1162 共2247⻚

如 Object 为 
snapshot-${Number}.jpg

SpriteObject Request.Operation.Output

雪碧图的名字。

必须包含 ${Number} 参
数。

如 Object 为 
sprite-${Number}.jpg
仅⽀持 jpg 格式

String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1163 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Snapshot</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1164 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>snapshot_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：Snapshot String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1165 共2247⻚

Failed、Pause、Cancel 其中⼀个

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存在
时返回

String

Snapshot Response.JobsDetail.Operation 同请求中的 
Request.Operation.Snapshot

Container

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时

不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaResult 的内容：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1166 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：使⽤截图模板 ID

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1167 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1168 共2247⻚

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/snapshot-${Number}.jpg</Object>

            <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1169 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1170 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Snapshot</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>snapshot_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使⽤截图处理参数



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1171 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1172 共2247⻚

    <Operation>

        <Snapshot>

            <BlackLevel>0</BlackLevel>

            <Count>10</Count>

            <IsCheckBlack>false</IsCheckBlack>

            <IsCheckCount>false</IsCheckCount>

            <Mode>Interval</Mode>

            <PixelBlackThreshold>0</PixelBlackThreshold>

            <SnapshotOutMode>SnapshotAndSprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Azure</Color>

                <Columns>3</Columns>

                <Lines>2</Lines>

            </SpriteSnapshotConfig>

            <Start>1</Start>

            <TimeInterval>2</TimeInterval>

        </Snapshot>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/snapshot-${Number}.jpg</Object>

            <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1173 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1174 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Snapshot</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Snapshot>

                <BlackLevel>0</BlackLevel>

                <Count>10</Count>

                <IsCheckBlack>false</IsCheckBlack>

                <IsCheckCount>false</IsCheckCount>

                <Mode>Interval</Mode>

                <PixelBlackThreshold>0</PixelBlackThreshold>

                <SnapshotOutMode>SnapshotAndSprite</SnapshotOutMode>

                <SpriteSnapshotConfig>

                    <Color>Azure</Color>

                    <Columns>3</Columns>

                    <Lines>2</Lines>

                </SpriteSnapshotConfig>

                <Start>1</Start>

                <TimeInterval>2</TimeInterval>

            </Snapshot>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1175 共2247⻚

提交流分离任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个⾳视频流分离任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1176 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1177 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1178 共2247⻚

    <Tag>StreamExtract</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <StreamExtract>

                <Index>0</Index>

                <Object>output/out0.mp4</Object>

            </StreamExtract>

            <StreamExtract>

                <Index>1</Index>

                <Object>output/out1.mp4</Object>

            </StreamExtract>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Output>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：StreamExtract String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1179 共2247⻚

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设

置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度不
超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级别
越⼤任务优先级越⾼，默认为0

String 否

Container 类型 Output 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

StreamExtract Request.Operation.Output 结果⽂件配置信息，最多⽀持

10个流配置
Container 是

Container 类型 StreamExtract 的具体数据描述如下：

节点

名称

⽗节点 描述 类型

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1180 共2247⻚

（关

键

字）

Index Request.Operation.Output.StreamExtract

流的编号，对应媒体信息中的 
Response.MediaInfo.Stream.Video.Index 
和 
Response.MediaInfo.Stream.Audio.Index，
详⻅ 获取媒体信息接⼝，当输⼊媒体格式
为 mxf 格式时，只⽀持提取 video 流

String

Object Request.Operation.Output.StreamExtract 结果输出⽂件名 String

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49541
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1181 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>StreamExtract</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>  

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String
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Tag Response.JobsDetail 新创建任务的 Tag：StreamExtract String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时

不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container
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Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>StreamExtract</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1186 共2247⻚

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <StreamExtract>

                <Index>0</Index>

                <Object>output/out0.mp4</Object>

            </StreamExtract>

            <StreamExtract>

                <Index>1</Index>

                <Object>output/out1.mp4</Object>

            </StreamExtract>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Output>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>StreamExtract</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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提交超分辨率任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个超分辨率任务。

请求

请求⽰例
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：
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Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351
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    <Tag>SuperResolution</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplateI

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemplateI

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：SuperResolution String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是
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CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型
是否

必选

SuperResolution Request.Operation 指定超分辨率模板参数，不能与 
TemplateId 同时为空

Container 否

TemplateId Request.Operation
指定的超分辨率模 ID，优先使⽤模
板 ID，不能与 SuperResolution 同时
为空

String 否

Transcode Request.Operation 指定转码模板参数，不能与 
TranscodeTemplateId 同时为空

Container 否

TranscodeTemplateId Request.Operation 指定的转码模板 ID，优先使⽤模板 
ID，不能与 Transcode 同时为空

String 否

Watermark Request.Operation
指定⽔印模板参数，同创建⽔印模板 
CreateMediaTemplate 接⼝中的 
Request.Watermark，最多传3个

Container 
数组

否

WatermarkTemplateId Request.Operation
指定的⽔印模板 ID，可以传多个⽔
印模板 ID，最多传3个，优先使⽤模
板 ID

String 数
组

否

DigitalWatermark Request.Operation 指定数字⽔印参数 Container 否

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49917
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Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, 
⻓度不超过1024

String 否

JobLevel Request.Operation
任务优先级，级别限制：0 、1 、
2。级别越⼤任务优先级越⾼，默认
为0

String 否

说明：

 提交超分辨率任务必须传⼊转码参数。对于超分辨率参数，优先使⽤ TemplateId，⽆ TemplateId 时使⽤ 
SuperResolution；对于转码参数，优先使⽤ TranscodeTemplateId，⽆ TranscodeTemplateId 时使⽤ Transcode；
对于⽔印参数，可以使⽤ WatermarkTemplateId 或 Watermark 设置，WatermarkTemplateId 优先级更⾼。

Container 类型 SuperResolution 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

必

选

Resolution Request.Operation.SuperResolution
同创建超分辨率模板 
CreateMediaTemplate 接⼝中
的 Request.Resolution

String 是

EnableScaleUp Request.Operation.SuperResolution
同创建超分辨率模板 
CreateMediaTemplate 接⼝中
的 Request.EnableScaleUp

String 否

Version Request.Operation.SuperResolution
同创建超分辨率模板 
CreateMediaTemplate 接⼝中
的 Request.Version

String 否

Container 类型 Transcode 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

必

选

TimeInterval Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.TimeInterval

Container 否

Container Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Container

Container 否

Video Request.Operation.Transcode 同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Video

Container 否

https://www.tencentcloud.com/document/product/1045/49910
https://www.tencentcloud.com/document/product/1045/49910
https://www.tencentcloud.com/document/product/1045/49910
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
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Audio Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Audio

Container 否

TransConfig Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.TransConfig

Container 否

AudioMix Request.Operation.Transcode 混⾳参数，详情⻅ AudioMix Container 
数组

否

Container 类型 DigitalWatermark 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型
必

选

Message Request.Operation.DigitalWatermark
数字⽔印嵌⼊的字符串信息，⻓度

不超过64个字符，仅⽀持中⽂、
英⽂、数字、_、-和*

String 是

Type Request.Operation.DigitalWatermark ⽔印类型，当前仅可设置为 Text String 是

Version Request.Operation.DigitalWatermark ⽔印版本，当前仅可设置为 V1 String 是

IgnoreError Request.Operation.DigitalWatermark
当添加⽔印失败是否忽略错误继续

执⾏任务，限制为 true/false，默
认 false

string 否

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49945
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响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://www.tencentcloud.com/document/product/1045/49352
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        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SuperResolution</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

              <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

              <TemplateName>superresolution_demo</TemplateName>

              <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTem

              <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTem

              <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTem

              <DigitalWatermark>

                  <Type>Text</Type>

                  <Message>123456789ab</Message>

                  <State>Running</State>

                  <Version>V1</Version>

                  <IgnoreError>false</IgnoreError>

              </DigitalWatermark>

              <Output>

                  <Region>ap-chongqing</Region>

                  <Bucket>test-123456789</Bucket>

                  <Object>output/out.mp4</Object>

              </Output>

              <UserData>This is my data.</UserData>

              <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container
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Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：SuperResolution String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

SuperResolution Response.JobsDetail.Operation 同请求中的 
Request.Operation.SuperResolution

Container

TemplateId Response.JobsDetail.Operation 任务的模板 ID String
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TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存
在时返回

String

Transcode Response.JobsDetail.Operation 同请求中的 
Request.Operation.Transcode

Container

TranscodeTemplateId Response.JobsDetail.Operation 指定的转码模板 ID String

Watermark Response.JobsDetail.Operation 同请求中的 
Request.Operation.Watermark

Container 
数组

WatermarkTemplateId Response.JobsDetail.Operation 指定的⽔印模板 ID String 数
组

Output Response.JobsDetail.Operation 同请求中的 
Request.Operation.Output

Container

MediaInfo Response.JobsDetail.Operation 输出⽂件的媒体信息，任务未完成

时不返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成

时不返回
Container

DigitalWatermark Response.JobsDetail.Operation 指定数字⽔印参数 Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。
Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1200 共2247⻚

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个

String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

Container 类型 DigitalWatermark 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

Message Response.Operation.DigitalWatermark
成功嵌⼊视频的数字⽔印的字符串信

息，⻓度不超过64个字符，仅⽀持中
⽂、英⽂、数字、_、-和*

string

Type Response.Operation.DigitalWatermark ⽔印类型，当前仅可设置为 Text String

Version Response.Operation.DigitalWatermark ⽔印版本，当前仅可设置为 V1 String

IgnoreError Response.Operation.DigitalWatermark 当添加⽔印失败是否忽略错误继续执⾏

任务，限制为 true/false，默认 false
string

State Response.Operation.DigitalWatermark
添加⽔印是否成功，执⾏中为

Running，成功为 Success，失败为 
Failed

string

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：使⽤超分辨率模板 ID

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1201 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SuperResolution</Tag>

    <Input>

        <Object>test.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1202 共2247⻚

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplateI

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemplateI

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/sr.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1203 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1204 共2247⻚

        <Message/>

        <JobId>je8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SuperResolution</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>superresolution_demo</TemplateName>

            <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTempl

            <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

            <DigitalWatermark>

                <State>Running</State>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/sr.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使⽤超分辨率处理参数



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1205 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SuperResolution</Tag>

    <Input>

        <Object>test.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1206 共2247⻚

    <Operation>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>⽔印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1207 共2247⻚

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/sr.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1208 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1209 共2247⻚

        <Message/>

        <JobId>je8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SuperResolution</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>

                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

            </Transcode>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1210 共2247⻚

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>⽔印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType>simfang.ttf</FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <DigitalWatermark>

                <State>Running</State>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/sr.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1211 共2247⻚

提交⾳视频转码任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个转码任务

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1212 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1213 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1214 共2247⻚

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemplateI

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag：Transcode String 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1215 共2247⻚

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优
先级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先
级⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。

设置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型
是否

必选

TemplateId Request.Operation 指定的模板 ID String 否

Transcode Request.Operation 指定转码模板参数 Container 否

WatermarkTemplateId Request.Operation 指定的⽔印模板 ID，可以传多个⽔
印模板 ID

String 否

Watermark Request.Operation
指定⽔印模板参数，同创建⽔印模

板 CreateMediaTemplate 接⼝中的 
Request.Watermark

Container 否

RemoveWatermark Request.Operation 指定去除⽔印参数, H265暂不⽀持
次参数

Container 否

DigitalWatermark Request.Operation 指定数字⽔印参数 Container 否

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49917


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1216 共2247⻚

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, 
⻓度不超过1024

String 否

JobLevel Request.Operation
任务优先级，级别限制：0 、1 、
2。级别越⼤任务优先级越⾼，默认
为0

String 否

说明：

 对于转码参数，优先使⽤优先使⽤ TemplateId，⽆ TemplateId 时使⽤ Transcode；对于⽔印参数，可以使⽤ 
WatermarkTemplateId 或 Watermark 设置，WatermarkTemplateId 优先级更⾼。

Container 类型 Transcode 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 必选

TimeInterval Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.TimeInterval

Container 否

Container Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Container

Container 否

Video Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Video

Container 否

Audio Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Audio

Container 否

TransConfig Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.TransConfig

Container 否

AudioMix Request.Operation.Transcode 混⾳参数，详情⻅AudioMix Container
数组

否

Container 类型 RemoveWatermark 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 必选

https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1217 共2247⻚

Dx Request.Operation.RemoveWatermark 距离左上⾓原点 x 偏移，范
围为[1, 4096]

string 是

Dy Request.Operation.RemoveWatermark 距离左上⾓原点 y 偏移，范
围为[1, 4096]

string 是

Width Request.Operation.RemoveWatermark 宽，范围为[1, 4096] string 是

Height Request.Operation.RemoveWatermark ⾼，范围为[1, 4096] string 是

Container 类型 DigitalWatermark 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

必

选

Message Request.Operation.DigitalWatermark
数字⽔印嵌⼊的字符串信息，⻓

度不超过64个字符，仅⽀持中
⽂、英⽂、数字、_、-和*

string 是

Type Request.Operation.DigitalWatermark ⽔印类型，当前仅可设置为 Text String 是

Version Request.Operation.DigitalWatermark ⽔印版本，当前仅可设置为 V1 String 是

IgnoreError Request.Operation.DigitalWatermark
当添加⽔印失败是否忽略错误继

续执⾏任务，限制为 true/false，
默认为false

string 是

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1218 共2247⻚

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1219 共2247⻚

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：
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版权所有：腾讯云计算（北京）有限责任公司 第1220 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：Transcode String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

Progress Response.JobsDetail
任务进度百分⽐，只有在State为 Submitted、
Running、Success、Pause 时有意义，范围为[0, 
100]

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String
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Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存在
时返回

String

Transcode Response.JobsDetail.Operation 同请求中的 
Request.Operation.Transcode

Containe

Watermark Response.JobsDetail.Operation 同请求中的 
Request.Operation.Watermark

Containe
数组

RemoveWatermark Response.JobsDetail.Operation 同请求中的 
Request.Operation.RemoveWatermark

Containe

WatermarkTemplateId Response.JobsDetail.Operation 指定的⽔印模板 ID String 数
组

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Containe

MediaInfo Response.JobsDetail.Operation 输出⽂件的媒体信息，任务未完成时

不返回
Containe

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时

不返回
Containe

DigitalWatermark Response.JobsDetail.Operation 指定数字⽔印参数 Containe

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。

Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型
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Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

Container 类型 DigitalWatermark 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

Message Response.Operation.DigitalWatermark
成功嵌⼊视频的数字⽔印的字符串信息，

⻓度不超过64个字符，仅⽀持中⽂、英
⽂、数字、_、-和*

string

Type Response.Operation.DigitalWatermark ⽔印类型，当前仅可设置为 Text String

Version Response.Operation.DigitalWatermark ⽔印版本，当前仅可设置为 V1 String

IgnoreError Response.Operation.DigitalWatermark 当添加⽔印失败是否忽略错误继续执⾏任

务，限制为 true/false，默认false
string

State Response.Operation.DigitalWatermark 添加⽔印是否成功，执⾏中为 Running，
成功为 Success，失败为 Failed

string

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1223 共2247⻚

请求1：使⽤转码模板 ID

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>
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        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemplateI

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1
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版权所有：腾讯云计算（北京）有限责任公司 第1225 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使⽤转码处理参数
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>
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版权所有：腾讯云计算（北京）有限责任公司 第1229 共2247⻚

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>⽔印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2
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版权所有：腾讯云计算（北京）有限责任公司 第1230 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>

                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

                <AudioMix>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>
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                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMix>

            </Transcode>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>⽔印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType></FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>
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</Response>



数据万象
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提交语⾳合成任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个语⾳合成任务。

请求

请求⽰例
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版权所有：腾讯云计算（北京）有限责任公司 第1235 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：
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Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351
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    <Tag>Tts</Tag>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TtsConfig>

            <Input>床前明⽉光，疑是地上霜</Input>

            <InputType>Text</InputType>

        </TtsConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>demo.mp3</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：Tts String 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优
先级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先
级⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。

设置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 Container 否
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TDMQ 时必填。详情⻅ CallBackMqConfig

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

TtsTpl Request.Operation 语⾳合成参数 Container 否

TemplateId Request.Operation 指定的模板 ID String 否

TtsConfig Request.Operation 语⾳合成任务参数 Container 是

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度不
超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级别
越⼤任务优先级越⾼，默认为0

String 否

注意：

 优先使⽤ TemplateId，⽆ TemplateId 时使⽤ TtsTpl。

Container 类型 TtsTpl 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型
是否必

选

Mode Request.Operation.TtsTpl 创建语⾳合成模板 CreateMediaTemplate 
中 Request.Mode

String 否

Codec Request.Operation.TtsTpl 创建语⾳合成模板 CreateMediaTemplate 
中 Request.Codec

String 否

VoiceType Request.Operation.TtsTpl 创建语⾳合成模板 CreateMediaTemplate 
中 Request.VoiceType

String 否

Volume Request.Operation.TtsTpl 创建语⾳合成模板 CreateMediaTemplate 
中 Request.Volume

String 否

Speed Request.Operation.TtsTpl 创建语⾳合成模板 CreateMediaTemplate 
中 Request.Speed

String 否

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49913
https://www.tencentcloud.com/document/product/1045/49913
https://www.tencentcloud.com/document/product/1045/49913
https://www.tencentcloud.com/document/product/1045/49913
https://www.tencentcloud.com/document/product/1045/49913


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1239 共2247⻚

Container 类型 TtsConfig 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选

InputType Request.Operation.TtsConfig 输⼊类型，Url/Text String 是

Input Request.Operation.TtsConfig

1. 当 InputType 为 Url 时， 必须是合
法的 COS 地址，⽂件必须是utf-8编
码，且⼤⼩不超过10M。如果模板中
指定的合成⽅式为同步处理，则⽂件

内容不超过300个utf-8字符；如果模
板中指定的合成⽅式为异步处理，则

⽂件内容不超过10000个utf-8字符。
2. 当 InputType为Text 时, 输⼊必须是
utf-8字符, 且不超过300个字符。

String 是

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 结果⽂件名 String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1240 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Tts</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1241 共2247⻚

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>tts_demo</TemplateName>

            <TtsConfig>

                <Input>床前明⽉光，疑是地上霜</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/tts.mp3</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：Tts String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1242 共2247⻚

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存在
时返回

String

TtsTpl Response.JobsDetail.Operation 请求中的 Request.Operation.TtsTpl Container

TtsConfig Response.JobsDetail.Operation 请求中的 
Request.Operation.TtsConfig

Container

Output Response.JobsDetail.Operation 请求中的 Request.Operation.Output Container

MediaInfo Response.JobsDetail.Operation 输出⽂件的媒体信息，任务未完成时

不返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时

不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaInfo 的内容： 
 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。
Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1243 共2247⻚

节点名称（关

键字）

⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：使⽤语⾳合成模板 ID

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1244 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TtsConfig>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1245 共2247⻚

            <Input>床前明⽉光，疑是地上霜</Input>

            <InputType>Text</InputType>

        </TtsConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>demo.mp3</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1246 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1247 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Tts</Tag>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>tts_demo</TemplateName>

            <TtsConfig>

                <Input>床前明⽉光，疑是地上霜</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/tts.mp3</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求1：使⽤语⾳合成参数



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1248 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Operation>

        <TtsTpl>

            <Codec>mp3</Codec>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1249 共2247⻚

            <Mode>Sync</Mode>

            <Speed>100</Speed>

            <VoiceType>aixiaonan</VoiceType>

            <Volume>0</Volume>

        </TtsTpl>

        <TtsConfig>

            <Input>床前明⽉光，疑是地上霜</Input>

            <InputType>Text</InputType>

        </TtsConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>demo.mp3</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1250 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1251 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Tts</Tag>

        <Operation>

            <TtsTpl>

                <Codec>mp3</Codec>

                <Mode>Sync</Mode>

                <Speed>100</Speed>

                <VoiceType>aixiaonan</VoiceType>

                <Volume>0</Volume>

            </TtsTpl>

            <TtsConfig>

                <Input>床前明⽉光，疑是地上霜</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/tts.mp3</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1252 共2247⻚

提交精彩集锦任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个精彩集锦任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1253 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1254 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1255 共2247⻚

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：VideoMontage String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1256 共2247⻚

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

VideoMontage Request.Operation 指定精彩集锦模板参数 Container 否

TemplateId Request.Operation 指定的模板 ID String 否

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度
不超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级
别越⼤任务优先级越⾼，默认为0

String 否

注意：

优先使⽤ TemplateId，⽆ TemplateId 时使⽤ VideoMontage。

Container 类型 VideoMontage 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

必

选

TimeInterval Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.TimeInterval

Container 否

Container Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Container

Container 否

Video Request.Operation.Transcode 同创建转码模板 
CreateMediaTemplate 接⼝中的 

Container 否

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1257 共2247⻚

Request.Video

Audio Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Audio

Container 否

TransConfig Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.TransConfig

Container 否

AudioMix Request.Operation.Transcode 混⾳参数，详情⻅ AudioMix Container 
数组

否

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1258 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1259 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>videomontage_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：VideoMontage String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1260 共2247⻚

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

VideoMontage Response.JobsDetail.Operation 同请求中的 
Request.Operation.VideoMontage

Container

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存在
时返回

String

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container

MediaInfo Response.JobsDetail.Operation 转码输出视频的信息，任务未完成时

不返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时

不返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1261 共2247⻚

Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。
Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

案例⼀：使⽤精彩集锦模板 ID

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1262 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1263 共2247⻚

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1264 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1265 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>videomontage_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

案例⼆：使⽤精彩集锦处理参数

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1266 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1267 共2247⻚

    <Operation>

        <VideoMontage>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

            <Duration>15</Duration>

        </VideoMontage>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1268 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1269 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoMontage>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Height></Height>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <AudioMix>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                </AudioMix>

                <Duration>15</Duration>

            </VideoMontage>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1270 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1271 共2247⻚

提交视频增强任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个视频增强任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1272 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1273 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1274 共2247⻚

    <Tag>VideoProcess</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t156c107210e7243c5817354565d81b578</TemplateId>

        <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：VideoProcess String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1275 共2247⻚

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优
先级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设

置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型
是否

必选

VideoProcess Request.Operation 指定视频增强模板参数，不能与 
TemplateId 同时为空

Container 否

TemplateId Request.Operation 指定的模板 ID ，不能与 
VideoProcess 同时为空

String 否

Transcode Request.Operation 指定转码模板参数，不能与 
TranscodeTemplateId 同时为空

Container 否

TranscodeTemplateId Request.Operation 指定的转码模板 ID，优先使⽤模板 
ID，不能与 Transcode 同时为空

String 数
组

否

Watermark Request.Operation
指定⽔印模板参数，同创建⽔印模板 
CreateMediaTemplate 接⼝的 
Request.Watermark, 最多传3个

Container 
数组

否

WatermarkTemplateId Request.Operation
指定的⽔印模板 ID，可以传多个⽔印
模板 ID，最多传3个，优先使⽤模板 
ID

String 否

DigitalWatermark Request.Operation 指定数字⽔印参数 Container 否

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49917


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1276 共2247⻚

Output Request.Operation 结果输出地址 Container 是

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。
级别越⼤任务优先级越⾼，默认为0

String 否

说明：

 提交视频增强任务必须传⼊转码参数。对于视频增强参数，优先使⽤ TemplateId，⽆ TemplateId 时使⽤ 
VideoProcess；对于转码参数，优先使⽤ TranscodeTemplateId，⽆ TranscodeTemplateId时使⽤ Transcode；对于

⽔印参数，可以使⽤ WatermarkTemplateId 或 Watermark 设置，WatermarkTemplateId 优先级更⾼。

Container 类型 VideoProcess 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述

ColorEnhance Request.Operation.VideoProcess 同创建视频增强模板 CreateMediaTemplate 接⼝中的 
Request.ColorEnhance

MsSharpen Request.Operation.VideoProcess 同创建视频增强模板 CreateMediaTemplate 接⼝中的 
Request.MsSharpen

Container 类型 Transcode 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

必

选

TimeInterval Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.TimeInterval

Container 否

Container Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Container

Container 否

Video Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Video

Container 否

Audio Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.Audio

Container 否

TransConfig Request.Operation.Transcode
同创建转码模板 
CreateMediaTemplate 接⼝中的 
Request.TransConfig

Container 否

https://www.tencentcloud.com/document/product/1045/49915
https://www.tencentcloud.com/document/product/1045/49915
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49911


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1277 共2247⻚

AudioMix Request.Operation.Transcode 混⾳参数，详情⻅ AudioMix Container 
数组

否

Container 类型 DigitalWatermark 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 必选

Message Request.Operation.DigitalWatermark
数字⽔印嵌⼊的字符串信息，

⻓度不超过64个字符，仅⽀持
中⽂、英⽂、数字、_、-和*

string 是

Type Request.Operation.DigitalWatermark ⽔印类型，当前仅可设置为 
Text

String 是

Version Request.Operation.DigitalWatermark ⽔印版本，当前仅可设置为 
V1

String 是

IgnoreError Request.Operation.DigitalWatermark
当添加⽔印失败是否忽略错误

继续执⾏任务，限制为 
true/false，默认为 false

string 是

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1278 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoProcess</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1279 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t156c107210e7243c5817354565d81b578</TemplateId>

            <TemplateName>videoprocess_demo</TemplateName>

            <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1280 共2247⻚

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：VideoProcess String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

VideoProcess Response.JobsDetail.Operation 同请求中的 
Request.Operation.VideoProcess

String

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存在
时返回

String

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1281 共2247⻚

DigitalWatermark Response.JobsDetail.Operation 指定数字⽔印参数 Container

MediaInfo Response.JobsDetail.Operation 输出⽂件的媒体信息，任务未完成时

不返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时

不返回
Container

DigitalWatermark Response.JobsDetail.Operation 指定数字⽔印参数 Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaInfo 的内容： 

同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。
Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1282 共2247⻚

Container 类型 DigitalWatermark 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

Message Response.Operation.DigitalWatermark
成功嵌⼊视频的数字⽔印的字符串信息，

⻓度不超过64个字符，仅⽀持中⽂、英
⽂、数字、_、-和*

string

Type Response.Operation.DigitalWatermark ⽔印类型，当前仅可设置为 Text String

Version Response.Operation.DigitalWatermark ⽔印版本，当前仅可设置为 V1 String

IgnoreError Response.Operation.DigitalWatermark 当添加⽔印失败是否忽略错误继续执⾏任

务，限制为 true/false，默认 false
string

State Response.Operation.DigitalWatermark 添加⽔印是否成功，执⾏中为 Running，
成功为 Success，失败为 Failed

string

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：使⽤视频增强模板 ID

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1283 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoProcess</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1284 共2247⻚

    <Operation>

        <TemplateId>t156c107210e7243c5817354565d81b578</TemplateId>

        <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1285 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1286 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoProcess</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t156c107210e7243c5817354565d81b578</TemplateId>

            <TemplateName>videoprocess_demo</TemplateName>

            <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使⽤视频增强处理参数



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1287 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoProcess</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1288 共2247⻚

    <Operation>

        <VideoProcess>

            <ColorEnhance>

                <Contrast>50</Contrast>

                <Correction>100</Correction>

                <Enable>true</Enable>

                <Saturation>100</Saturation>

            </ColorEnhance>

            <MsSharpen>

                <Enable>true</Enable>

                <SharpenLevel>5</SharpenLevel>

            </MsSharpen>

        </VideoProcess>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1289 共2247⻚

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>⽔印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1290 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1291 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoProcess</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoProcess>

                <ColorEnhance>

                    <Contrast>50</Contrast>

                    <Correction>100</Correction>

                    <Enable>true</Enable>

                    <Saturation>100</Saturation>

                </ColorEnhance>

                <MsSharpen>

                    <Enable>true</Enable>

                    <SharpenLevel>5</SharpenLevel>

                </MsSharpen>

            </VideoProcess>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1292 共2247⻚

                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

            </Transcode>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>⽔印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType>simfang.ttf</FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1293 共2247⻚

提交视频标签任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个视频标签任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1294 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1295 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1296 共2247⻚

    <Tag>VideoTag</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <VideoTag>

            <Scenario>Stream</Scenario>

        </VideoTag>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag：VideoTag String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优
先级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先
级⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。

设置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1297 共2247⻚

Container 类型 Input 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

Object Request.Input
执⾏视频标签任务的媒体⽂件名，⽬前⽀持 mp4、
avi、mkv、wmv、rmvb、flv、mov 封装格式，视
频时⻓超过30min的视频请 提交⼯单 处理

String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选

VideoTag Request.Operation 指定该 VideoTag 任务参数 Container 是

JobLevel Request.Operation
任务优先级，级别限制：0 
、1 、2。级别越⼤任务优
先级越⾼，默认为0

String 否

UserData Response.JobsDetail.Operation 透传⽤户信息 String 否

Container 类型 VideoTag 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否

必选
限制

Scenario Request.Operation.VideoTag

场景类型，可选择视

频标签的运⽤场景，

不同的运⽤场景使⽤

的算法、输⼊输出等

都会有所差异

string 是

当前版本只

适配 Stream 
场景

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://console.tencentcloud.com/workorder/category
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1298 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoTag</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1299 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：VideoTag String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1300 共2247⻚

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

VideoTag Response.JobsDetail.Operation 同请求中的 
Request.Operation.VideoTag

Container

VideoTagResult Response.JobsDetail.Operation 视频标签分析结果,任务未完成时不
返回

Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 VideoTagResult 的内容：

节点名称（关键

字）
⽗节点 描述 类型

StreamData Response.JobsDetail.Operation.VideoTagResult Stream 场景下视频标签
任务的结果

Container

Container 节点 StreamData 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Data Response.JobsDetail.Operation.VideoTagResult.StreamData Stream 场景 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1301 共2247⻚

视频标签任

务的结果列

表

SubErrCode Response.JobsDetail.Operation.VideoTagResult.StreamData
算法状态

码，成功为

0，⾮0异常
String

SubErrMsg Response.JobsDetail.Operation.VideoTagResult.StreamData

算法错误描

述，成功为 
ok , 不成功返
回对应错误

String

Container 节点 Data 的内容：

节点名称

（关键字）
⽗节点 描述 类型

Tags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data

视频标

签、视

频分类

信息

Container

PersonTags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data ⼈物标

签信息

Container
数组

PlaceTags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data 场景标

签信息

Container
数组

ActionTags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data 动作标

签信息

Container
数组

ObjectTags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data 物体标

签信息

Container
数组

Container 节点 Tags （视频标签）的内容：

节点名称

（关键字）
⽗节点 描述 类型

Tag Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags 标签名

称
String

TagCls Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags 标签分

类名称
String

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags 标签模 Float



数据万象
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型预测

分数，

取值范

围[0,1]

Container 节点 Tags （视频分类）的内容：

节点名称

（关键字）
⽗节点 描述 类型

Tag Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags 视频分

类名称
String

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags

标签模

型预测

分数，

取值范

围[0,1]

Float

Container 节点 PersonTags 的内容：

节点名称（关键

字）
⽗节点

描

述
类型

Name Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags

⼈

物

名

字

Stri

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags

标

签

模

型

预

测

分

数

Flo

Count Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags

任

务

出

现

频

次

Stri

DetailPerSecond Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags 具 Con



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1303 共2247⻚

体

识

别

到

⼈

物

出

现

的

位

置

和

时

间

信

息

数组

Container 节点 DetailPerSecond 的内容：

节点名称

（关键字）
⽗节点

TimeStamp Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond

BBox Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond

Container 节点 BBox 的内容：

节点 ⽗节点



数据万象
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名称

（关

键

字）

X1 Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond.BBox

Y1 Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond.BBox

X2 Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond.BBox

Y2 Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond.BBox

Container 节点 PlaceTags 的内容：

节点名称（关键

字）
⽗节点 描述



数据万象
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Tags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags 视频场景标

Response.J

StartTime Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags ⽚段起始时

EndTime Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags ⽚段结束时

StartIndex Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags ⽚段起始帧

EndIndex Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags ⽚段结束帧

ClipFrameResult Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags 单帧识别结

Container 节点 ActionTags 的内容：

节点名称

（关键

字）

⽗节点 描述

Tags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ActionTags 视频动作标签信息

Response.JobsDe

StartTime Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ActionTags ⽚段起始时间，单

EndTime Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ActionTags ⽚段结束时间，单

Container 节点 ObjectTags 的内容：

节点名称

（关键字）
⽗节点 描述

Objects Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags 视频物体标签信

Response.Jobs

TimeStamp Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags 识别物体时间戳

Container 节点 Object 的内容：

节点名称

（关键

字）

⽗节点 描述

Name Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags.Objects 物体名称

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags.Objects 标签模型

BBox Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags.Objects 左上⾓为



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1306 共2247⻚

Respon

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1307 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoTag</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <VideoTag>

            <Scenario>Stream</Scenario>

        </VideoTag>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1308 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1309 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoTag</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1310 共2247⻚

提交⼈声分离任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个⼈声分离任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1311 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1312 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1313 共2247⻚

    <Tag>VoiceSeparate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/backgroud.mp3</Object>

            <AuObject>output/audio.mp3</AuObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag：VoiceSeparate String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优
先级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先
级⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设

置为 no 时，表⽰队列的回调地址不产⽣回调
String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1314 共2247⻚

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

VoiceSeparate Request.Operation 指定转码模板参数 Container 否

TemplateId Request.Operation 指定的模板 ID String 否

Output Request.Operation 结果输出地址 Container 是

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级别
越⼤任务优先级越⾼，默认为0

String 否

注意：

 优先使⽤ TemplateId，⽆ TemplateId 时使⽤ VoiceSeparate。

Container 类型 VoiceSeparate 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选

AudioMode Request.Operation.VoiceSeparate
同创建⼈声分离模板 
CreateMediaTemplate 接⼝中
的 Request.AudioMode

Container 否

AudioConfig Request.Operation.VoiceSeparate
同创建⼈声分离模板 
CreateMediaTemplate 接⼝中
的 Request.AudioConfig

Container 否

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）

⽗节点 描述 类型 是否必选

https://www.tencentcloud.com/document/product/1045/49945#CallBackMqConfig
https://www.tencentcloud.com/document/product/1045/49916
https://www.tencentcloud.com/document/product/1045/49916


数据万象
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Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output 背景⾳结果⽂件名，不能与 
AuObject 同时为空

String 否

AuObject Request.Operation.AuObject ⼈声结果⽂件名，不能与 Object 
同时为空

String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1316 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VoiceSeparate</Tag>



数据万象
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>voiceseparate_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <AuObject>output/audio.mp3</AuObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：VoiceSeparate String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、 String



数据万象
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Failed、Pause、Cancel 其中⼀个

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存在时
返回

String

VoiceSeparate Response.JobsDetail.Operation 同请求中的 
Request.Operation.VoiceSeparate

Container

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Container

MediaInfo Response.JobsDetail.Operation 转码输出视频的信息，任务未完成时不

返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完成时不

返回
Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String



数据万象
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Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo  接⼝中的 Response.MediaInfo 节点。
Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：使⽤⼈声分离模板 ID

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1320 共2247⻚

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象
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    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/backgroud.mp3</Object>

            <AuObject>output/audio.mp3</AuObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1322 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VoiceSeparate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>voiceseparate_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <AuObject>output/audio.mp3</AuObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使⽤⼈声分离参数



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1324 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1325 共2247⻚

    <Operation>

        <VoiceSeparate>

            <AudioConfig>

                    <Bitrate>500</Bitrate>

                    <Channels>2</Channels>

                    <Codec>mp3</Codec>

                    <Samplerate>44100</Samplerate>

            </AudioConfig>

            <AudioMode>AudioAndBackground</AudioMode>

        </VoiceSeparate>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/backgroud.mp3</Object>

            <AuObject>output/audio.mp3</AuObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1326 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1327 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VoiceSeparate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VoiceSeparate>

                <AudioConfig>

                    <Bitrate>500</Bitrate>

                    <Channels>2</Channels>

                    <Codec>mp3</Codec>

                    <Samplerate>44100</Samplerate>

                </AudioConfig>

                <AudioMode>AudioAndBackground</AudioMode>

            </VoiceSeparate>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <AuObject>output/audio.mp3</AuObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1328 共2247⻚

提交极速⾼清任务
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个极速⾼清转码任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1329 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1330 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1331 共2247⻚

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的Tag：Transcode String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1332 共2247⻚

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型
是否

必选

TemplateId Request.Operation 指定的模板 ID, 此处需要传⼊极速⾼
清模板

String 否

WatermarkTemplateId Request.Operation 指定的⽔印模板 ID，可以传多个⽔印
模板 ID

String 否

Watermark Request.Operation
指定⽔印模板参数，同创建⽔印模板 
CreateMediaTemplate 接⼝中的 
Request.Watermark

Container 否

DigitalWatermark Request.Operation 指定数字⽔印参数 Container 否

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓
度不超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。
级别越⼤任务优先级越⾼，默认为0

String 否

说明：

https://www.tencentcloud.com/document/product/1045/49945
https://www.tencentcloud.com/document/product/1045/49917


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1333 共2247⻚

 对于⽔印参数，可以使⽤ WatermarkTemplateId 或 Watermark 设置，WatermarkTemplateId 优先级更⾼。
Container 类型 DigitalWatermark 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

必

选

Message Request.Operation.DigitalWatermark
数字⽔印嵌⼊的字符串信息，⻓

度不超过64个字符，仅⽀持中
⽂、英⽂、数字、_、-和*

string 是

Type Request.Operation.DigitalWatermark ⽔印类型，当前仅可设置为 
Text

String 是

Version Request.Operation.DigitalWatermark ⽔印版本，当前仅可设置为 V1 String 是

IgnoreError Request.Operation.DigitalWatermark
当添加⽔印失败是否忽略错误继

续执⾏任务，限制为 
true/false，默认为false

string 是

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1334 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1335 共2247⻚

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）

⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1336 共2247⻚

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：Transcode String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

Progress Response.JobsDetail
任务进度百分⽐，只有在State为 Submitted、
Running、Success、Pause 时有意义，范围为[0, 
100]

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 
存在时返回

String

Watermark Response.JobsDetail.Operation 同请求中的 
Request.Operation.Watermark

Container 
数组



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1337 共2247⻚

WatermarkTemplateId Response.JobsDetail.Operation 指定的⽔印模板 ID String 数组

Output Response.JobsDetail.Operation 同请求中的 
Request.Operation.Output

Container

MediaInfo Response.JobsDetail.Operation 输出⽂件的媒体信息，任务未完

成时不返回
Container

MediaResult Response.JobsDetail.Operation 输出⽂件的基本信息，任务未完

成时不返回
Container

DigitalWatermark Response.JobsDetail.Operation 指定数字⽔印参数 Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

Container 节点 MediaInfo 的内容： 
同 GenerateMediaInfo 接⼝中的 Response.MediaInfo 节点。
Container 节点 MediaResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

OutputFile Response.Operation.MediaResult 输出⽂件的基本信息 Container

Container 节点 OutputFile 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Bucket Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶 String

Region Response.Operation.MediaResult.OutputFile 输出⽂件所在的存储桶

所在的园区
String

ObjectName Response.Operation.MediaResult.OutputFile 输出⽂件名，可能有多

个
String 数组

Md5Info Response.Operation.MediaResult.OutputFile 输出⽂件的 MD5 信息 Container 数
组

Container 节点 Md5Info 的内容：

节点名称（关键

字）
⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1338 共2247⻚

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件名 String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info 输出⽂件的 
MD5 值

Container

Container 类型 DigitalWatermark 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

Message Response.Operation.DigitalWatermark
成功嵌⼊视频的数字⽔印的字符串信

息，⻓度不超过64个字符，仅⽀持中
⽂、英⽂、数字、_、-和*

string

Type Response.Operation.DigitalWatermark ⽔印类型，当前仅可设置为 Text String

Version Response.Operation.DigitalWatermark ⽔印版本，当前仅可设置为 V1 String

IgnoreError Response.Operation.DigitalWatermark 当添加⽔印失败是否忽略错误继续执⾏

任务，限制为 true/false，默认false
string

State Response.Operation.DigitalWatermark
添加⽔印是否成功，执⾏中为

Running，成功为 Success，失败为 
Failed

string

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1339 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1340 共2247⻚

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1341 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1342 共2247⻚

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1343 共2247⻚

取消媒体处理任务

CancelMediaJob
最近更新时间：2024-01-20 16:30:33

功能描述

取消⼀个任务，只有未执⾏的任务才可以被取消。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1344 共2247⻚

PUT /jobs/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1345 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该请求⽆响应体。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1346 共2247⻚

PUT /jobs/jb57da17e29c111eda218713081fe2b05?cancel HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1347 共2247⻚

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjY=



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1348 共2247⻚

查询媒体处理任务

DescribeMediaJob
最近更新时间：2024-01-20 16:30:33

功能描述

查询指定的任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1349 共2247⻚

GET /jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1350 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1351 共2247⻚

<Response>

    <JobsDetail>

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1352 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container 数组

NonExistJobIds Response 查询的 ID 中不存在任务，所有任务都存在时不返回 String

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：
⾳视频转码

极速⾼清转码

视频转动图

视频截帧

智能封⾯

⾳视频拼接

⼈声分离

精彩集锦

SDR to HDR 
视频增强

超分辨率

⾳视频转封装

数字⽔印

提取数字⽔印

视频标签

获取媒体信息

⾳视频流分离

视频质量分析

语⾳合成

⾳频降噪

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：查询⼀个任务，该任务正在执⾏中

https://www.tencentcloud.com/document/product/1045/48941
https://www.tencentcloud.com/document/product/1045/49782
https://www.tencentcloud.com/document/product/1045/49569
https://www.tencentcloud.com/document/product/1045/48938
https://www.tencentcloud.com/document/product/1045/48937
https://www.tencentcloud.com/document/product/1045/48929
https://www.tencentcloud.com/document/product/1045/48946
https://www.tencentcloud.com/document/product/1045/48943
https://www.tencentcloud.com/document/product/1045/48935
https://www.tencentcloud.com/document/product/1045/48944
https://www.tencentcloud.com/document/product/1045/48940
https://www.tencentcloud.com/document/product/1045/48936
https://www.tencentcloud.com/document/product/1045/48930
https://www.tencentcloud.com/document/product/1045/48931
https://www.tencentcloud.com/document/product/1045/48945
https://www.tencentcloud.com/document/product/1045/48932
https://www.tencentcloud.com/document/product/1045/48939
https://www.tencentcloud.com/document/product/1045/48934
https://www.tencentcloud.com/document/product/1045/48942
https://www.tencentcloud.com/document/product/1045/48933
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1353 共2247⻚

GET /jobs/j8d121820f5e411ec926ef19d53ba9c6f HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1354 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1355 共2247⻚

        </Message>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <Progress>30</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：查询⼀个任务，该任务执⾏成功



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1356 共2247⻚

GET /jobs/j9c0a4726f6ac11ec96aaa9b64ab18d00 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1357 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:25:22 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjY=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1358 共2247⻚

        </Message>

        <JobId>j9c0a4726f6ac11ec96aaa9b64ab18d00</JobId>

        <State>Success</State>

        <Progress>100</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>2022-06-27T15:24:33+0800</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1359 共2247⻚

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1360 共2247⻚

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Region>ap-chongqing</Region>

                    <ObjectName>output/out.mp4</ObjectName>

                    <Md5Info>

                            <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                            <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                </OutputFile>

            </MediaResult>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1361 共2247⻚

DescribeMediaJobs
最近更新时间：2024-03-01 17:15:28

功能描述

拉取符合条件的任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1362 共2247⻚

GET /jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1363 共2247⻚

请求参数

参数的具体内容如下：

节点名称（关键字）

⽗

节

点

描述 类型
是否必

选

queueId ⽆ 拉取该队列 ID 下的任务 String 是

tag ⽆ 任务的 Tag String 是

workflowId ⽆ 触发该任务的⼯作流ID String 否

inventoryTriggerJobId ⽆ 触发该任务的存量触发任务 ID String 否

inputObject ⽆ 该任务的输⼊⽂件名，暂仅⽀持精确匹配 String 否

orderByTime ⽆ Desc 或者 Asc。默认为 Desc String 否

nextToken ⽆ 请求的上下⽂，⽤于翻⻚。上次返回的值 String 否

size ⽆ 拉取的最⼤任务数。默认为10。最⼤为100 Integer 否

states ⽆

拉取该状态的任务，以  , 分割，⽀持多状态：

All、Submitted、Running、Success、Failed、
Pause、Cancel。默认为 All

String 否

startCreationTime ⽆

拉取创建时间⼤于该时间的任务。格式为：  %Y-

%m-%dT%H:%m:%S%z ，⽰例：2001-01-
01T00:00:00+0800

String 否

endCreationTime ⽆

拉取创建时间⼩于该时间的任务。格式为：  %Y-

%m-%dT%H:%m:%S%z ，⽰例：2001-01-
01T23:59:59+0800

String 否

tag ⽀持以下⼏种类型:

任务类型 tag

⾳视频转码 Transcode

视频转动图 Animation

视频截图 Snapshot

智能封⾯ SmartCover

⾳视频拼接 Concat



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1364 共2247⻚

⼈声分离 VoiceSeparate

精彩集锦 VideoMontage

SDR to HDR SDRtoHDR

视频增强 VideoProcess

超级分辨率 SuperResolution

⾳视频转封装 Segment

数字⽔印 DigitalWatermark

提取数字⽔印 ExtractDigitalWatermark

视频标签 VideoTag

获取媒体信息 MediaInfo

⾳视频流分离 StreamExtract

视频质量分析 QualityEstimate

语⾳合成 Tts

⾳频降噪 NoiseReduction

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1365 共2247⻚

<Response>

    <JobsDetail>

        ...

    </JobsDetail>

    <NextToken></NextToken>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1366 共2247⻚

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container数组

NextToken Response 翻⻚的上下⽂ Token String

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：

⾳视频转码

极速⾼清转码

视频转动图

视频截帧

智能封⾯

⾳视频拼接

⼈声分离

精彩集锦

SDR to HDR 
视频增强

超分辨率

⾳视频转封装

数字⽔印

提取数字⽔印

视频标签

获取媒体信息

⾳视频流分离

视频质量分析

语⾳合成

⾳频降噪

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/48941
https://www.tencentcloud.com/document/product/1045/49782
https://www.tencentcloud.com/document/product/1045/49569
https://www.tencentcloud.com/document/product/1045/48938
https://www.tencentcloud.com/document/product/1045/48937
https://www.tencentcloud.com/document/product/1045/48929
https://www.tencentcloud.com/document/product/1045/48946
https://www.tencentcloud.com/document/product/1045/48943
https://www.tencentcloud.com/document/product/1045/48935
https://www.tencentcloud.com/document/product/1045/48944
https://www.tencentcloud.com/document/product/1045/48940
https://www.tencentcloud.com/document/product/1045/48936
https://www.tencentcloud.com/document/product/1045/48930
https://www.tencentcloud.com/document/product/1045/48931
https://www.tencentcloud.com/document/product/1045/48945
https://www.tencentcloud.com/document/product/1045/48932
https://www.tencentcloud.com/document/product/1045/48939
https://www.tencentcloud.com/document/product/1045/48934
https://www.tencentcloud.com/document/product/1045/48942
https://www.tencentcloud.com/document/product/1045/48933
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1367 共2247⻚

GET /jobs?queueId=p2242ab62c7c94486915508540933a2c6&tag=Transcode HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1368 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1369 共2247⻚

        </Message>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <Progress>30</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        </Message>

        <JobId>j9c0a4726f6ac11ec96aaa9b64ab18d00</JobId>

        <State>Success</State>

        <Progress>100</Progress>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1370 共2247⻚

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>2022-06-27T15:24:33+0800</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1371 共2247⻚

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1372 共2247⻚

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Region>ap-chongqing</Region>

                    <ObjectName>output/out.mp4</ObjectName>

                    <Md5Info>

                            <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                            <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                </OutputFile>

            </MediaResult>

        </Operation>

    </JobsDetail>

    <NextToken>225508</NextToken>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1373 共2247⻚

媒体处理任务回调

视频转动图
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1374 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1375 共2247⻚

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</F

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1376 共2247⻚

                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：
同提交动图任务接⼝中的 Response.JobsDetail 

如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数组。
Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

https://www.tencentcloud.com/document/product/1045/49569


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1377 共2247⻚

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1378 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1379 共2247⻚

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</F

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1380 共2247⻚

                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1381 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1382 共2247⻚

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</F

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1383 共2247⻚

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

        <Workflow>

            <Name>Animation_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1384 共2247⻚

案例 3：通过⼯作流触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T15:29:42+0800",

        "EndTime": "2022-06-30T15:29:48+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1385 共2247⻚

            "Region": "ap-chongqing",

            "CosHeaders": [{

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j682b9662f84611ecb8546d80f2baf56f",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "97624.424000",

                    "Duration": "0.870000",

                    "FormatLongName": "CompuServe Graphics Interchange Format (GIF)

                    "FormatName": "gif",

                    "NumProgram": "0",

                    "NumStream": "1",

                    "Size": "10616656",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Video": {

                        "AvgFps": "14.666667",

                        "CodecLongName": "CompuServe GIF (Graphics Interchange Form

                        "CodecName": "gif",

                        "CodecTag": "0x0000",

                        "CodecTagString": "[0][0][0][0]",

                        "CodecTimeBase": "1/100",

                        "ColorPrimaries": "unknown",

                        "ColorRange": "unknown",

                        "ColorTransfer": "unknown",

                        "Duration": "0.870000",

                        "Fps": "15.083333",

                        "HasBFrame": "0",

                        "Height": "2258",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1386 共2247⻚

                        "Index": "0",

                        "Level": "-99",

                        "NumFrames": "7",

                        "PixFormat": "bgra",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/100",

                        "Width": "1280"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "3df1f845d2ffd20a525a93ec40014d90",

                        "ObjectName": "output/animation.gif"

                    },

                    "ObjectName": "output/animation.gif",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/animation.gif",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1f16e1dfbdc994105b31292d45710642a",

            "TemplateName": "template_name1512456",

            "UserData": "This is my Animation job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T15:29:43+0800",

        "State": "Success",

        "Tag": "Animation",

        "Workflow": {

            "Name": "Animation_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1387 共2247⻚

⾳视频拼接
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1388 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:33:07+0800</CreationTime>

        <EndTime>2022-06-30T18:33:20+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1389 共2247⻚

        <JobId>j07f6263af86011ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>830.482000</Bitrate>

                    <Duration>70.413000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>7309593</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>32.020000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>70.412857</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.990016</AvgFps>

                        <Bitrate>803.112000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Dar>4:3</Dar>

                        <Duration>69.779778</Duration>

                        <Fps>15.000000</Fps>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1390 共2247⻚

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>32</Level>

                        <NumFrames>1046</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <Sar>1:1</Sar>

                        <StartTime>0.046000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>96322f8638d38480683e069e6b2ba1e9</Md5>

                        <ObjectName>output/concat.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/concat.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/concat.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

            <TemplateName>template_name3544697</TemplateName>

            <UserData>This is my Concat job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:33:08+0800</StartTime>

        <State>Success</State>

        <Tag>Concat</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1391 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

同提交拼接任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数组。
Container 节点 CosHeaders 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名
称

String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48929


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1392 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:33:07+0800</CreationTime>

        <EndTime>2022-06-30T18:33:20+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1393 共2247⻚

        <JobId>j07f6263af86011ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>830.482000</Bitrate>

                    <Duration>70.413000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>7309593</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>32.020000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>70.412857</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.990016</AvgFps>

                        <Bitrate>803.112000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Dar>4:3</Dar>

                        <Duration>69.779778</Duration>

                        <Fps>15.000000</Fps>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1394 共2247⻚

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>32</Level>

                        <NumFrames>1046</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <Sar>1:1</Sar>

                        <StartTime>0.046000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>96322f8638d38480683e069e6b2ba1e9</Md5>

                        <ObjectName>output/concat.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/concat.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/concat.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

            <TemplateName>template_name3544697</TemplateName>

            <UserData>This is my Concat job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:33:08+0800</StartTime>

        <State>Success</State>

        <Tag>Concat</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1395 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:33:07+0800</CreationTime>

        <EndTime>2022-06-30T18:33:20+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1396 共2247⻚

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j07f6263af86011ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>830.482000</Bitrate>

                    <Duration>70.413000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>7309593</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>32.020000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>70.412857</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1397 共2247⻚

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.990016</AvgFps>

                        <Bitrate>803.112000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Dar>4:3</Dar>

                        <Duration>69.779778</Duration>

                        <Fps>15.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>32</Level>

                        <NumFrames>1046</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <Sar>1:1</Sar>

                        <StartTime>0.046000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>96322f8638d38480683e069e6b2ba1e9</Md5>

                        <ObjectName>output/concat.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/concat.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1398 共2247⻚

                <Object>output/concat.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

            <TemplateName>template_name3544697</TemplateName>

            <UserData>This is my Concat job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:33:08+0800</StartTime>

        <State>Success</State>

        <Tag>Concat</Tag>

        <Workflow>

            <Name>Concat_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1399 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:33:07+0800",

        "EndTime": "2022-06-30T18:33:20+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1400 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j07f6263af86011ecbdf419856486c0ab",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "830.482000",

                    "Duration": "70.413000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "7309593",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "32.020000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "70.412857",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1401 共2247⻚

                    },

                    "Video": {

                        "AvgFps": "14.990016",

                        "Bitrate": "803.112000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/90000",

                        "ColorPrimaries": "unknown",

                        "ColorRange": "unknown",

                        "ColorTransfer": "unknown",

                        "Dar": "4:3",

                        "Duration": "69.779778",

                        "Fps": "15.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "32",

                        "NumFrames": "1046",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "Sar": "1:1",

                        "StartTime": "0.046000",

                        "Timebase": "1/90000",

                        "Width": "1280"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "96322f8638d38480683e069e6b2ba1e9",

                        "ObjectName": "output/concat.mp4"

                    },

                    "ObjectName": "output/concat.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/concat.mp4",

                "Region": "ap-chongqing"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1402 共2247⻚

            },

            "TemplateId": "t140325e8918ac423da53b7d78dbbab564",

            "TemplateName": "template_name3544697",

            "UserData": "This is my Concat job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:33:08+0800",

        "State": "Success",

        "Tag": "Concat",

        "Workflow": {

            "Name": "Concat_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1403 共2247⻚

添加数字⽔印
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1404 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:37:37+0800</CreationTime>

        <EndTime>2022-06-30T18:39:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1405 共2247⻚

        <JobId>ja8de3b46f86011ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>2533.526000</Bitrate>

                    <Duration>215.638000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>68290577</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.050000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2272.528000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1406 共2247⻚

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>043221daee3f4e15ff13f42329f15eb1</Md5>

                        <ObjectName>output/digital.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/digital.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/digital.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my DigitalWatermark job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:37:38+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>DigitalWatermark</Tag>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1407 共2247⻚

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

同提交数字⽔印任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数组。
Container 节点 CosHeaders 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名
称

String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48930#jobsDetail


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1408 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:37:37+0800</CreationTime>

        <EndTime>2022-06-30T18:39:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1409 共2247⻚

        <JobId>ja8de3b46f86011ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>2533.526000</Bitrate>

                    <Duration>215.638000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>68290577</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.050000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2272.528000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1410 共2247⻚

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>043221daee3f4e15ff13f42329f15eb1</Md5>

                        <ObjectName>output/digital.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/digital.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/digital.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my DigitalWatermark job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:37:38+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>DigitalWatermark</Tag>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1411 共2247⻚

案例 2：通过任务接⼝触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:37:37+0800",

        "EndTime": "2022-06-30T18:39:08+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1412 共2247⻚

            "Region": "ap-chongqing"

        },

        "JobId": "ja8de3b46f86011ec9452c1c27f56a659",

        "Operation": {

            "DigitalWatermark": {

                "Message": "123456789ab",

                "Type": "Text",

                "Version": "V1"

            },

            "MediaInfo": {

                "Format": {

                    "Bitrate": "2533.526000",

                    "Duration": "215.638000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "68290577",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "256.050000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/48000",

                        "Duration": "215.637000",

                        "Index": "1",

                        "Language": "eng",

                        "SampleFmt": "fltp",

                        "SampleRate": "48000",

                        "StartTime": "0.000000",

                        "Timebase": "1/48000"

                    },

                    "Video": {

                        "AvgFps": "24.000000",

                        "Bitrate": "2272.528000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/12288",

                        "ColorPrimaries": "unknown",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1413 共2247⻚

                        "ColorRange": "unknown",

                        "ColorTransfer": "unknown",

                        "Duration": "215.583333",

                        "Fps": "24.000000",

                        "HasBFrame": "2",

                        "Height": "1080",

                        "Index": "0",

                        "Language": "und",

                        "Level": "40",

                        "NumFrames": "5174",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12288",

                        "Width": "1920"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "043221daee3f4e15ff13f42329f15eb1",

                        "ObjectName": "output/digital.mp4"

                    },

                    "ObjectName": "output/digital.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/digital.mp4",

                "Region": "ap-chongqing"

            },

            "UserData": "This is my DigitalWatermark job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:37:38+0800",

        "State": "Success",

        "SubTag": "DigitalWatermark",

        "Tag": "DigitalWatermark"

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1414 共2247⻚

提取数字⽔印
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1415 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:42:20+0800</CreationTime>

        <EndTime>2022-06-30T18:42:54+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>output/digital.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1416 共2247⻚

        <JobId>j515a494af86111ecb8546d80f2baf56f</JobId>

        <Message>done</Message>

        <Operation>

            <ExtractDigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my ExtractDigitalWatermark job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:42:21+0800</StartTime>

        <State>Success</State>

        <Tag>ExtractDigitalWatermark</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：
同提交提取数字⽔印任务接⼝中的 Response.JobsDetail 

如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数组。
Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

https://www.tencentcloud.com/document/product/1045/48931#jobsDetail


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1417 共2247⻚

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1418 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:42:20+0800</CreationTime>

        <EndTime>2022-06-30T18:42:54+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>output/digital.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1419 共2247⻚

        <JobId>j515a494af86111ecb8546d80f2baf56f</JobId>

        <Message>done</Message>

        <Operation>

            <ExtractDigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my ExtractDigitalWatermark job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:42:21+0800</StartTime>

        <State>Success</State>

        <Tag>ExtractDigitalWatermark</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接⼝触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1420 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:42:20+0800",

        "EndTime": "2022-06-30T18:42:54+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "output/digital.mp4",

            "Region": "ap-chongqing"

        },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1421 共2247⻚

        "JobId": "j515a494af86111ecb8546d80f2baf56f",

        "Message": "done",

        "Operation": {

            "ExtractDigitalWatermark": {

                "Message": "123456789ab",

                "Type": "Text",

                "Version": "V1"

            },

            "UserData": "This is my ExtractDigitalWatermark job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:42:21+0800",

        "State": "Success",

        "Tag": "ExtractDigitalWatermark"

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1422 共2247⻚

获取媒体信息
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1423 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:45:14+0800</CreationTime>

        <EndTime>2022-06-30T18:45:15+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1424 共2247⻚

        <JobId>jb976c9e0f86111ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1425 共2247⻚

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <UserData>This is my MediaInfo job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:45:15+0800</StartTime>

        <State>Success</State>

        <Tag>MediaInfo</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：
同提交获取媒体信息任务接⼝中的 Response.JobsDetail 

如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

https://www.tencentcloud.com/document/product/1045/48932


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1426 共2247⻚

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1427 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:45:14+0800</CreationTime>

        <EndTime>2022-06-30T18:45:15+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1428 共2247⻚

        <JobId>jb976c9e0f86111ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1429 共2247⻚

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <UserData>This is my MediaInfo job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:45:15+0800</StartTime>

        <State>Success</State>

        <Tag>MediaInfo</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接⼝触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1430 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:45:14+0800",

        "EndTime": "2022-06-30T18:45:15+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing"

        },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1431 共2247⻚

        "JobId": "jb976c9e0f86111ec9452c1c27f56a659",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "834.736000",

                    "Duration": "13.654000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "1424687",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "104.047000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.653311",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    },

                    "Video": {

                        "AvgFps": "25.000000",

                        "Bitrate": "763.774000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/12800",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960000",

                        "Fps": "25.000000",

                        "HasBFrame": "0",

                        "Height": "960",

                        "Index": "0",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1432 共2247⻚

                        "Language": "und",

                        "Level": "10",

                        "NumFrames": "324",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "544"

                    }

                }

            },

            "UserData": "This is my MediaInfo job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:45:15+0800",

        "State": "Success",

        "Tag": "MediaInfo"

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1433 共2247⻚

降噪
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1434 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:47:18+0800</CreationTime>

        <EndTime>2022-06-30T18:47:30+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1435 共2247⻚

        <JobId>j035aca66f86211ec8a5a87e016101404</JobId>

        <Message>SUCCESS</Message>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/nr.wav</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my NoiseReduction job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:47:20+0800</StartTime>

        <State>Success</State>

        <Tag>NoiseReduction</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：
同提交⾳频降噪任务接⼝中的 Response.JobsDetail 

如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

https://www.tencentcloud.com/document/product/1045/48933


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1436 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1437 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:47:18+0800</CreationTime>

        <EndTime>2022-06-30T18:47:30+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1438 共2247⻚

        <JobId>j035aca66f86211ec8a5a87e016101404</JobId>

        <Message>SUCCESS</Message>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/nr.wav</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my NoiseReduction job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:47:20+0800</StartTime>

        <State>Success</State>

        <Tag>NoiseReduction</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接⼝触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1439 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:47:18+0800",

        "EndTime": "2022-06-30T18:47:30+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp3",

            "Region": "ap-chongqing"

        },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1440 共2247⻚

        "JobId": "j035aca66f86211ec8a5a87e016101404",

        "Message": "SUCCESS",

        "Operation": {

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/nr.wav",

                "Region": "ap-chongqing"

            },

            "UserData": "This is my NoiseReduction job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:47:20+0800",

        "State": "Success",

        "Tag": "NoiseReduction"

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1441 共2247⻚

视频质量评分
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1442 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:06:27+0800</CreationTime>

        <EndTime>2022-06-30T19:06:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1443 共2247⻚

        <JobId>jb01fe2f2f86411ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834736</Bitrate>

                    <Duration>13.654</Duration>

                    <NumStream>1</NumStream>

                    <Size>1424687</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104047</Bitrate>

                        <Channel>2</Channel>

                        <CodecName>aac</CodecName>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000</AvgFps>

                        <Bitrate>763774</Bitrate>

                        <CodecName>h264</CodecName>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <Fps>25.000</Fps>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Level>1.000</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <Rotation>0</Rotation>

                        <StartTime>0.000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile/>

            </MediaResult>

            <QualityEstimate>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1444 共2247⻚

                <Score>6.460358</Score>

            </QualityEstimate>

            <UserData>This is my QualityEstimate job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:06:28+0800</StartTime>

        <State>Success</State>

        <Tag>QualityEstimate</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

同提交视频质量分析任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

https://www.tencentcloud.com/document/product/1045/48934#jobsDetail


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1445 共2247⻚

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1446 共2247⻚

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:06:27+0800</CreationTime>

        <EndTime>2022-06-30T19:06:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>jb01fe2f2f86411ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834736</Bitrate>

                    <Duration>13.654</Duration>

                    <NumStream>1</NumStream>

                    <Size>1424687</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104047</Bitrate>

                        <Channel>2</Channel>

                        <CodecName>aac</CodecName>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000</AvgFps>

                        <Bitrate>763774</Bitrate>

                        <CodecName>h264</CodecName>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <Fps>25.000</Fps>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Level>1.000</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <Rotation>0</Rotation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1447 共2247⻚

                        <StartTime>0.000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile/>

            </MediaResult>

            <QualityEstimate>

                <Score>6.460358</Score>

            </QualityEstimate>

            <UserData>This is my QualityEstimate job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:06:28+0800</StartTime>

        <State>Success</State>

        <Tag>QualityEstimate</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接⼝触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1448 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T19:06:27+0800",

        "EndTime": "2022-06-30T19:06:34+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing"

        },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1449 共2247⻚

        "JobId": "jb01fe2f2f86411ec9ca1073b78d316d3",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "834736",

                    "Duration": "13.654",

                    "NumStream": "1",

                    "Size": "1424687"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "104047",

                        "Channel": "2",

                        "CodecName": "aac",

                        "Duration": "13.653",

                        "Index": "1",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100"

                    },

                    "Video": {

                        "AvgFps": "25.000",

                        "Bitrate": "763774",

                        "CodecName": "h264",

                        "ColorPrimaries": "unknown",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960",

                        "Fps": "25.000",

                        "Height": "960",

                        "Index": "0",

                        "Level": "1.000",

                        "NumFrames": "324",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "Rotation": "0",

                        "StartTime": "0.000",

                        "Timebase": "1/12800",

                        "Width": "544"

                    }

                }

            },

            "MediaResult": {

            },

            "QualityEstimate": {

                "Score": "6.460358"

            },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1450 共2247⻚

            "UserData": "This is my QualityEstimate job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:06:28+0800",

        "State": "Success",

        "Tag": "QualityEstimate"

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1451 共2247⻚

SDRtoHDR
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1452 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:20:45+0800</CreationTime>

        <EndTime>2022-06-30T19:21:06+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1453 共2247⻚

        <JobId>jafa709a2f86611ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>9514.268000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>16238478</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>9878.900000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt2020</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte2084</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1454 共2247⻚

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>ed8b5615687d789d6293bd58fa1ea1c0</Md5>

                        <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/sdr2hdr.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SDRtoHDR job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:20:46+0800</StartTime>

        <State>Success</State>

        <Tag>SDRtoHDR</Tag>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1455 共2247⻚

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：

同提交SDR to HDR任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48935


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1456 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:20:45+0800</CreationTime>

        <EndTime>2022-06-30T19:21:06+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1457 共2247⻚

        <JobId>jafa709a2f86611ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>9514.268000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>16238478</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>9878.900000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt2020</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte2084</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1458 共2247⻚

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>ed8b5615687d789d6293bd58fa1ea1c0</Md5>

                        <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/sdr2hdr.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SDRtoHDR job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:20:46+0800</StartTime>

        <State>Success</State>

        <Tag>SDRtoHDR</Tag>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1459 共2247⻚

案例 2：通过⼯作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:20:45+0800</CreationTime>

        <EndTime>2022-06-30T19:21:06+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1460 共2247⻚

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>jafa709a2f86611ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>9514.268000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>16238478</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1461 共2247⻚

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>9878.900000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt2020</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte2084</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>ed8b5615687d789d6293bd58fa1ea1c0</Md5>

                        <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1462 共2247⻚

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/sdr2hdr.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SDRtoHDR job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:20:46+0800</StartTime>

        <State>Success</State>

        <Tag>SDRtoHDR</Tag>

        <Workflow>

            <Name>SDRtoHDR_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1463 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:20:45+0800",

        "EndTime": "2022-06-30T19:21:06+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1464 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "jafa709a2f86611ec9452c1c27f56a659",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "9514.268000",

                    "Duration": "13.654000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "16238478",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128.726000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.652993",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1465 共2247⻚

                    },

                    "Video": {

                        "AvgFps": "24.922840",

                        "Bitrate": "9878.900000",

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31637668",

                        "CodecTagString": "hvc1",

                        "CodecTimeBase": "1/12800",

                        "ColorPrimaries": "bt2020",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte2084",

                        "Duration": "12.960000",

                        "FieldOrder": "progressive",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "93",

                        "NumFrames": "323",

                        "PixFormat": "yuv420p",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "544"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "ed8b5615687d789d6293bd58fa1ea1c0",

                        "ObjectName": "output/sdr2hdr.mp4"

                    },

                    "ObjectName": "output/sdr2hdr.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/sdr2hdr.mp4",

                "Region": "ap-chongqing"

            },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1466 共2247⻚

            "SDRtoHDR": {

                "HdrMode": "HDR10"

            },

            "TranscodeTemplateId": "t156c107210e7243c5817354565d81b578",

            "UserData": "This is my SDRtoHDR job.",

            "WatermarkTemplateId": [

                "t143ae6e040af6431aa772c9ec3f0a3f36",

                "t12a74d11687d444deba8a6cc52051ac27"

            ]

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:20:46+0800",

        "State": "Success",

        "Tag": "SDRtoHDR",

        "Workflow": {

            "Name": "SDRtoHDR_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1467 共2247⻚

转封装（⾳视频分段）
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1468 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:14:31+0800</CreationTime>

        <EndTime>2022-06-30T19:14:36+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1469 共2247⻚

        <JobId>jd0c0da74f86511ec8a5a87e016101404</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>2629.749000</Bitrate>

                    <Duration>215.680000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>70898041</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2369.296000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1470 共2247⻚

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>59a4edd95c6ddca43277d82cf33edc0d</Md5>

                        <ObjectName>output/segment-0</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7fdacd7f2e2dbdc1dc3ccc00f96893b5</Md5>

                        <ObjectName>output/segment-1</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4c377ddb6f65021f6741dbd45bbff654</Md5>

                        <ObjectName>output/segment-2</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>59317dbc9db6d4d6fb723e3005809c01</Md5>

                        <ObjectName>output/segment-3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a81091e57005eece211b5f60bfbddea1</Md5>

                        <ObjectName>output/segment-4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7b87e88264a983a06b17558c8a3a2bd8</Md5>

                        <ObjectName>output/segment-5</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>607b2abc29ed11ad1d2f678b594c6ffa</Md5>

                        <ObjectName>output/segment-6</ObjectName>

                    </Md5Info>

                    <Md5Info>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1471 共2247⻚

                        <Md5>4fe2d33dc9d08a5ea9d5d6db0f724008</Md5>

                        <ObjectName>output/segment-7</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a84dd4f738ce81f4e3da55b393b2fae4</Md5>

                        <ObjectName>output/segment-8</ObjectName>

                    </Md5Info>

                    <ObjectName>0</ObjectName>

                    <ObjectName>1</ObjectName>

                    <ObjectName>2</ObjectName>

                    <ObjectName>3</ObjectName>

                    <ObjectName>4</ObjectName>

                    <ObjectName>5</ObjectName>

                    <ObjectName>6</ObjectName>

                    <ObjectName>7</ObjectName>

                    <ObjectName>8</ObjectName>

                    <ObjectPrefix>output/segment-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/segment-${number}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <Segment>

                <Duration>25</Duration>

                <Format>mp4</Format>

                <HlsEncrypt>

                    <IsHlsEncrypt>false</IsHlsEncrypt>

                    <UriKey/>

                </HlsEncrypt>

            </Segment>

            <UserData>This is my Segment job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:14:32+0800</StartTime>

        <State>Success</State>

        <Tag>Segment</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1472 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：
同提交转封装任务接⼝中的 Response.JobsDetail 

如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48936


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1473 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:14:31+0800</CreationTime>

        <EndTime>2022-06-30T19:14:36+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1474 共2247⻚

        <JobId>jd0c0da74f86511ec8a5a87e016101404</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>2629.749000</Bitrate>

                    <Duration>215.680000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>70898041</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2369.296000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1475 共2247⻚

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>59a4edd95c6ddca43277d82cf33edc0d</Md5>

                        <ObjectName>output/segment-0</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7fdacd7f2e2dbdc1dc3ccc00f96893b5</Md5>

                        <ObjectName>output/segment-1</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4c377ddb6f65021f6741dbd45bbff654</Md5>

                        <ObjectName>output/segment-2</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>59317dbc9db6d4d6fb723e3005809c01</Md5>

                        <ObjectName>output/segment-3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a81091e57005eece211b5f60bfbddea1</Md5>

                        <ObjectName>output/segment-4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7b87e88264a983a06b17558c8a3a2bd8</Md5>

                        <ObjectName>output/segment-5</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>607b2abc29ed11ad1d2f678b594c6ffa</Md5>

                        <ObjectName>output/segment-6</ObjectName>

                    </Md5Info>

                    <Md5Info>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1476 共2247⻚

                        <Md5>4fe2d33dc9d08a5ea9d5d6db0f724008</Md5>

                        <ObjectName>output/segment-7</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a84dd4f738ce81f4e3da55b393b2fae4</Md5>

                        <ObjectName>output/segment-8</ObjectName>

                    </Md5Info>

                    <ObjectName>0</ObjectName>

                    <ObjectName>1</ObjectName>

                    <ObjectName>2</ObjectName>

                    <ObjectName>3</ObjectName>

                    <ObjectName>4</ObjectName>

                    <ObjectName>5</ObjectName>

                    <ObjectName>6</ObjectName>

                    <ObjectName>7</ObjectName>

                    <ObjectName>8</ObjectName>

                    <ObjectPrefix>output/segment-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/segment-${number}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <Segment>

                <Duration>25</Duration>

                <Format>mp4</Format>

                <HlsEncrypt>

                    <IsHlsEncrypt>false</IsHlsEncrypt>

                    <UriKey/>

                </HlsEncrypt>

            </Segment>

            <UserData>This is my Segment job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:14:32+0800</StartTime>

        <State>Success</State>

        <Tag>Segment</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1477 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:14:31+0800</CreationTime>

        <EndTime>2022-06-30T19:14:36+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1478 共2247⻚

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>jd0c0da74f86511ec8a5a87e016101404</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>2629.749000</Bitrate>

                    <Duration>215.680000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>70898041</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1479 共2247⻚

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2369.296000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>59a4edd95c6ddca43277d82cf33edc0d</Md5>

                        <ObjectName>output/segment-0</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7fdacd7f2e2dbdc1dc3ccc00f96893b5</Md5>

                        <ObjectName>output/segment-1</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4c377ddb6f65021f6741dbd45bbff654</Md5>

                        <ObjectName>output/segment-2</ObjectName>

                    </Md5Info>

                    <Md5Info>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1480 共2247⻚

                        <Md5>59317dbc9db6d4d6fb723e3005809c01</Md5>

                        <ObjectName>output/segment-3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a81091e57005eece211b5f60bfbddea1</Md5>

                        <ObjectName>output/segment-4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7b87e88264a983a06b17558c8a3a2bd8</Md5>

                        <ObjectName>output/segment-5</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>607b2abc29ed11ad1d2f678b594c6ffa</Md5>

                        <ObjectName>output/segment-6</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4fe2d33dc9d08a5ea9d5d6db0f724008</Md5>

                        <ObjectName>output/segment-7</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a84dd4f738ce81f4e3da55b393b2fae4</Md5>

                        <ObjectName>output/segment-8</ObjectName>

                    </Md5Info>

                    <ObjectName>0</ObjectName>

                    <ObjectName>1</ObjectName>

                    <ObjectName>2</ObjectName>

                    <ObjectName>3</ObjectName>

                    <ObjectName>4</ObjectName>

                    <ObjectName>5</ObjectName>

                    <ObjectName>6</ObjectName>

                    <ObjectName>7</ObjectName>

                    <ObjectName>8</ObjectName>

                    <ObjectPrefix>output/segment-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/segment-${number}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <Segment>

                <Duration>25</Duration>

                <Format>mp4</Format>

                <HlsEncrypt>

                    <IsHlsEncrypt>false</IsHlsEncrypt>

                    <UriKey/>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1481 共2247⻚

                </HlsEncrypt>

            </Segment>

            <UserData>This is my Segment job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:14:32+0800</StartTime>

        <State>Success</State>

        <Tag>Segment</Tag>

        <Workflow>

            <Name>Segment_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1482 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:14:31+0800",

        "EndTime": "2022-06-30T19:14:36+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1483 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "jd0c0da74f86511ec8a5a87e016101404",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "2629.749000",

                    "Duration": "215.680000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "70898041",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "256.000000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/48000",

                        "Duration": "215.637000",

                        "Index": "1",

                        "Language": "eng",

                        "SampleFmt": "fltp",

                        "SampleRate": "48000",

                        "StartTime": "0.000000",

                        "Timebase": "1/48000"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1484 共2247⻚

                    },

                    "Video": {

                        "AvgFps": "24.000000",

                        "Bitrate": "2369.296000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/12288",

                        "ColorPrimaries": "unknown",

                        "ColorRange": "unknown",

                        "ColorTransfer": "unknown",

                        "Duration": "215.583333",

                        "Fps": "24.000000",

                        "HasBFrame": "2",

                        "Height": "1080",

                        "Index": "0",

                        "Language": "und",

                        "Level": "40",

                        "NumFrames": "5174",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12288",

                        "Width": "1920"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                            "Md5": "59a4edd95c6ddca43277d82cf33edc0d",

                            "ObjectName": "output/segment-0"

                        },

                        {

                            "Md5": "7fdacd7f2e2dbdc1dc3ccc00f96893b5",

                            "ObjectName": "output/segment-1"

                        },

                        {

                            "Md5": "4c377ddb6f65021f6741dbd45bbff654",

                            "ObjectName": "output/segment-2"

                        },

                        {

                            "Md5": "59317dbc9db6d4d6fb723e3005809c01",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1485 共2247⻚

                            "ObjectName": "output/segment-3"

                        },

                        {

                            "Md5": "a81091e57005eece211b5f60bfbddea1",

                            "ObjectName": "output/segment-4"

                        },

                        {

                            "Md5": "7b87e88264a983a06b17558c8a3a2bd8",

                            "ObjectName": "output/segment-5"

                        },

                        {

                            "Md5": "607b2abc29ed11ad1d2f678b594c6ffa",

                            "ObjectName": "output/segment-6"

                        },

                        {

                            "Md5": "4fe2d33dc9d08a5ea9d5d6db0f724008",

                            "ObjectName": "output/segment-7"

                        },

                        {

                            "Md5": "a84dd4f738ce81f4e3da55b393b2fae4",

                            "ObjectName": "output/segment-8"

                        }

                    ],

                    "ObjectName": [

                        "0",

                        "1",

                        "2",

                        "3",

                        "4",

                        "5",

                        "6",

                        "7",

                        "8"

                    ],

                    "ObjectPrefix": "output/segment-",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/segment-${number}",

                "Region": "ap-chongqing"

            },

            "Segment": {

                "Duration": "25",

                "Format": "mp4",

                "HlsEncrypt": {
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版权所有：腾讯云计算（北京）有限责任公司 第1486 共2247⻚

                    "IsHlsEncrypt": "false"

                }

            },

            "UserData": "This is my Segment job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:14:32+0800",

        "State": "Success",

        "Tag": "Segment",

        "Workflow": {

            "Name": "Segment_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1487 共2247⻚

智能封⾯
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1488 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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版权所有：腾讯云计算（北京）有限责任公司 第1489 共2247⻚

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>output/smartcover-0.jpg</ObjectName>

                    <ObjectName>output/smartcover-1.jpg</ObjectName>

                    <ObjectName>output/smartcover-2.jpg</ObjectName>

                    <ObjectName>output/smartcover-3.jpg</ObjectName>

                    <ObjectName>output/smartcover-4.jpg</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SmartCover>

                <Count>5</Count>

                <DeleteDuplicates>false</DeleteDuplicates>

                <Format>jpg</Format>

                <Height>960</Height>

                <Width>1280</Width>

            </SmartCover>

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>SmartCover</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：
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版权所有：腾讯云计算（北京）有限责任公司 第1490 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：

同提交智能封⾯任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48937


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1491 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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版权所有：腾讯云计算（北京）有限责任公司 第1492 共2247⻚

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>output/smartcover-0.jpg</ObjectName>

                    <ObjectName>output/smartcover-1.jpg</ObjectName>

                    <ObjectName>output/smartcover-2.jpg</ObjectName>

                    <ObjectName>output/smartcover-3.jpg</ObjectName>

                    <ObjectName>output/smartcover-4.jpg</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SmartCover>

                <Count>5</Count>

                <DeleteDuplicates>false</DeleteDuplicates>

                <Format>jpg</Format>

                <Height>960</Height>

                <Width>1280</Width>

            </SmartCover>

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>SmartCover</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调
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版权所有：腾讯云计算（北京）有限责任公司 第1493 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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版权所有：腾讯云计算（北京）有限责任公司 第1494 共2247⻚

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>output/smartcover-0.jpg</ObjectName>

                    <ObjectName>output/smartcover-1.jpg</ObjectName>

                    <ObjectName>output/smartcover-2.jpg</ObjectName>

                    <ObjectName>output/smartcover-3.jpg</ObjectName>

                    <ObjectName>output/smartcover-4.jpg</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SmartCover>

                <Count>5</Count>
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                <DeleteDuplicates>false</DeleteDuplicates>

                <Format>jpg</Format>

                <Height>960</Height>

                <Width>1280</Width>

            </SmartCover>

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>SmartCover</Tag>

        <Workflow>

            <Name>SmartCover_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON
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版权所有：腾讯云计算（北京）有限责任公司 第1496 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T15:29:42+0800",

        "EndTime": "2022-06-30T15:29:48+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1497 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j6842765cf84611ecb8546d80f2baf56f",

        "Operation": {

            "MediaInfo": {

                "Stream": {

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "ObjectName": [

                        "output/smartcover-0.jpg",

                        "output/smartcover-1.jpg",

                        "output/smartcover-2.jpg",

                        "output/smartcover-3.jpg",

                        "output/smartcover-4.jpg"

                    ],

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/smartcover-${Number}.jpg",

                "Region": "ap-chongqing"

            },

            "SmartCover": {

                "Count": "5",

                "DeleteDuplicates": "false",

                "Format": "jpg",

                "Height": "960",
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                "Width": "1280"

            },

            "UserData": "This is my SmartCover job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T15:29:43+0800",

        "State": "Success",

        "Tag": "SmartCover",

        "Workflow": {

            "Name": "SmartCover_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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版权所有：腾讯云计算（北京）有限责任公司 第1499 共2247⻚

截帧
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：
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版权所有：腾讯云计算（北京）有限责任公司 第1500 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:25:11+0800</CreationTime>

        <EndTime>2022-06-30T19:25:14+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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版权所有：腾讯云计算（北京）有限责任公司 第1501 共2247⻚

        <JobId>j4e431ba0f86711ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>0.jpg</ObjectName>

                    <ObjectName>1.jpg</ObjectName>

                    <ObjectName>2.jpg</ObjectName>

                    <ObjectName>3.jpg</ObjectName>

                    <ObjectName>4.jpg</ObjectName>

                    <ObjectName>5.jpg</ObjectName>

                    <ObjectPrefix>output/snapshot-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                    <SpriteOutputFile>

                        <Bucket>test-123456789</Bucket>

                        <Md5Info/>

                        <ObjectName>0.jpg</ObjectName>

                        <ObjectPrefix>output/sprite-</ObjectPrefix>

                        <Region>ap-chongqing</Region>

                    </SpriteOutputFile>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <TemplateId>t1f16e1dfbdc9ds4105b31632d45710642a</TemplateId>

            <TemplateName>template_snapshot</TemplateName>

            <UserData>This is my Snapshot job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:25:12+0800</StartTime>

        <State>Success</State>

        <Tag>Snapshot</Tag>

    </JobsDetail>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1502 共2247⻚

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：
同提交截图任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48938


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1503 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:25:11+0800</CreationTime>

        <EndTime>2022-06-30T19:25:14+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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版权所有：腾讯云计算（北京）有限责任公司 第1504 共2247⻚

        <JobId>j4e431ba0f86711ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>0.jpg</ObjectName>

                    <ObjectName>1.jpg</ObjectName>

                    <ObjectName>2.jpg</ObjectName>

                    <ObjectName>3.jpg</ObjectName>

                    <ObjectName>4.jpg</ObjectName>

                    <ObjectName>5.jpg</ObjectName>

                    <ObjectPrefix>output/snapshot-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                    <SpriteOutputFile>

                        <Bucket>test-123456789</Bucket>

                        <Md5Info/>

                        <ObjectName>0.jpg</ObjectName>

                        <ObjectPrefix>output/sprite-</ObjectPrefix>

                        <Region>ap-chongqing</Region>

                    </SpriteOutputFile>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <TemplateId>t1f16e1dfbdc9ds4105b31632d45710642a</TemplateId>

            <TemplateName>template_snapshot</TemplateName>

            <UserData>This is my Snapshot job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:25:12+0800</StartTime>

        <State>Success</State>

        <Tag>Snapshot</Tag>

    </JobsDetail>
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</Response>

案例 2：通过⼯作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:25:11+0800</CreationTime>

        <EndTime>2022-06-30T19:25:14+0800</EndTime>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j4e431ba0f86711ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>0.jpg</ObjectName>

                    <ObjectName>1.jpg</ObjectName>

                    <ObjectName>2.jpg</ObjectName>

                    <ObjectName>3.jpg</ObjectName>

                    <ObjectName>4.jpg</ObjectName>

                    <ObjectName>5.jpg</ObjectName>

                    <ObjectPrefix>output/snapshot-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                    <SpriteOutputFile>

                        <Bucket>test-123456789</Bucket>

                        <Md5Info/>
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                        <ObjectName>0.jpg</ObjectName>

                        <ObjectPrefix>output/sprite-</ObjectPrefix>

                        <Region>ap-chongqing</Region>

                    </SpriteOutputFile>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <TemplateId>t1f16e1dfbdc9ds4105b31632d45710642a</TemplateId>

            <TemplateName>template_snapshot</TemplateName>

            <UserData>This is my Snapshot job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:25:12+0800</StartTime>

        <State>Success</State>

        <Tag>Snapshot</Tag>

        <Workflow>

            <Name>Snapshot_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1508 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:25:11+0800",

        "EndTime": "2022-06-30T19:25:14+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1509 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j4e431ba0f86711ecb8546d80f2baf56f",

        "Operation": {

            "MediaInfo": {

                "Stream": {

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "ObjectName": [

                        "0.jpg",

                        "1.jpg",

                        "2.jpg",

                        "3.jpg",

                        "4.jpg",

                        "5.jpg"

                    ],

                    "ObjectPrefix": "output/snapshot-",

                    "Region": "ap-chongqing",

                    "SpriteOutputFile": {

                        "Bucket": "test-123456789",

                        "ObjectName": "0.jpg",

                        "ObjectPrefix": "output/sprite-",

                        "Region": "ap-chongqing"

                    }

                }

            },

            "Output": {

                "Bucket": "test-123456789",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1510 共2247⻚

                "Object": "output/snapshot-${Number}.jpg",

                "Region": "ap-chongqing",

                "SpriteObject": "output/sprite-${Number}.jpg"

            },

            "TemplateId": "t1f16e1dfbdc9ds4105b31632d45710642a",

            "TemplateName": "template_snapshot",

            "UserData": "This is my Snapshot job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:25:12+0800",

        "State": "Success",

        "Tag": "Snapshot",

        "Workflow": {

            "Name": "Snapshot_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1511 共2247⻚

流分离
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1512 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:27:39+0800</CreationTime>

        <EndTime>2022-06-30T19:27:42+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1513 共2247⻚

        <JobId>ja66d6204f86711ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>e8c802ed78ba7f4c6a2fb5144cba7cbc</Md5>

                        <ObjectName>output/out0.mp4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>f5883c1380524eecd1a925657ab17b4c</Md5>

                        <ObjectName>output/out1.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/out0.mp4</ObjectName>

                    <ObjectName>output/out1.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>2</Index>

                    <Output>output/out2.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my StreamExtract job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:27:40+0800</StartTime>

        <State>Success</State>

        <Tag>StreamExtract</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1514 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：

同提交流分离任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48939


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1515 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:27:39+0800</CreationTime>

        <EndTime>2022-06-30T19:27:42+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1516 共2247⻚

        <JobId>ja66d6204f86711ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>e8c802ed78ba7f4c6a2fb5144cba7cbc</Md5>

                        <ObjectName>output/out0.mp4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>f5883c1380524eecd1a925657ab17b4c</Md5>

                        <ObjectName>output/out1.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/out0.mp4</ObjectName>

                    <ObjectName>output/out1.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>2</Index>

                    <Output>output/out2.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my StreamExtract job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:27:40+0800</StartTime>

        <State>Success</State>

        <Tag>StreamExtract</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接⼝触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1517 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:27:39+0800",

        "EndTime": "2022-06-30T19:27:42+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing"

        },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1518 共2247⻚

        "JobId": "ja66d6204f86711ec9ca1073b78d316d3",

        "Operation": {

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                            "Md5": "e8c802ed78ba7f4c6a2fb5144cba7cbc",

                            "ObjectName": "output/out0.mp4"

                        },

                        {

                            "Md5": "f5883c1380524eecd1a925657ab17b4c",

                            "ObjectName": "output/out1.mp4"

                        }

                    ],

                    "ObjectName": [

                        "output/out0.mp4",

                        "output/out1.mp4"

                    ],

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Region": "ap-chongqing",

                "StreamExtract": [{

                        "Index": "0",

                        "Output": "output/out0.mp4"

                    },

                    {

                        "Index": "1",

                        "Output": "output/out1.mp4"

                    },

                    {

                        "Index": "2",

                        "Output": "output/out2.mp4"

                    }

                ]

            },

            "UserData": "This is my StreamExtract job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:27:40+0800",

        "State": "Success",

        "Tag": "StreamExtract"

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1519 共2247⻚



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1520 共2247⻚

超分辨率
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1521 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:30:20+0800</CreationTime>

        <EndTime>2022-06-30T19:31:56+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1522 共2247⻚

        <JobId>j06668dc0f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <IgnoreError>false</IgnoreError>

                <Message>123456789ab</Message>

                <State>Failed</State>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>8867.172000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>15134046</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>9197.180000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1523 共2247⻚

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1920</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>120</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>1088</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>852883012a6ba726e6ed8d9b984edfdf</Md5>

                        <ObjectName>output/super_resolution.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/super_resolution.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/super_resolution.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d45710642a</TemplateId>

            <TemplateName>template_superresolution</TemplateName>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SuperResolution job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1524 共2247⻚

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:30:21+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>SuperResolution</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：

同提交超级分辨率任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

https://www.tencentcloud.com/document/product/1045/48940


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1525 共2247⻚

实际案例

案例 1：通过任务接⼝触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:30:20+0800</CreationTime>

        <EndTime>2022-06-30T19:31:56+0800</EndTime>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1526 共2247⻚

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j06668dc0f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <IgnoreError>false</IgnoreError>

                <Message>123456789ab</Message>

                <State>Failed</State>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>8867.172000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>15134046</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1527 共2247⻚

                        <Bitrate>9197.180000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1920</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>120</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>1088</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>852883012a6ba726e6ed8d9b984edfdf</Md5>

                        <ObjectName>output/super_resolution.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/super_resolution.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/super_resolution.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d45710642a</TemplateId>

            <TemplateName>template_superresolution</TemplateName>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1528 共2247⻚

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SuperResolution job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:30:21+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>SuperResolution</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1529 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:30:20+0800</CreationTime>

        <EndTime>2022-06-30T19:31:56+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1530 共2247⻚

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j06668dc0f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <IgnoreError>false</IgnoreError>

                <Message>123456789ab</Message>

                <State>Failed</State>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>8867.172000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>15134046</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1531 共2247⻚

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>9197.180000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1920</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>120</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>1088</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>852883012a6ba726e6ed8d9b984edfdf</Md5>

                        <ObjectName>output/super_resolution.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/super_resolution.mp4</ObjectName>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1532 共2247⻚

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/super_resolution.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d45710642a</TemplateId>

            <TemplateName>template_superresolution</TemplateName>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SuperResolution job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:30:21+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>SuperResolution</Tag>

        <Workflow>

            <Name>SuperResolution_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1533 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:30:20+0800",

        "EndTime": "2022-06-30T19:31:56+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1534 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j06668dc0f86811ecb90d0b03267ce0e5",

        "Operation": {

            "DigitalWatermark": {

                "IgnoreError": "false",

                "Message": "123456789ab",

                "State": "Failed",

                "Type": "Text",

                "Version": "V1"

            },

            "MediaInfo": {

                "Format": {

                    "Bitrate": "8867.172000",

                    "Duration": "13.654000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "15134046",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128.726000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1535 共2247⻚

                        "Duration": "13.652993",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    },

                    "Video": {

                        "AvgFps": "25.000000",

                        "Bitrate": "9197.180000",

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31766568",

                        "CodecTagString": "hev1",

                        "CodecTimeBase": "1/12800",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960000",

                        "FieldOrder": "progressive",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "1920",

                        "Index": "0",

                        "Language": "und",

                        "Level": "120",

                        "NumFrames": "324",

                        "PixFormat": "yuv420p",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "1088"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "852883012a6ba726e6ed8d9b984edfdf",

                        "ObjectName": "output/super_resolution.mp4"

                    },

                    "ObjectName": "output/super_resolution.mp4",

                    "Region": "ap-chongqing"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1536 共2247⻚

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/super_resolution.mp4",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1f1ae1dfsdc9ds41dsb31632d45710642a",

            "TemplateName": "template_superresolution",

            "TranscodeTemplateId": "t156c107210e7243c5817354565d81b578",

            "UserData": "This is my SuperResolution job.",

            "WatermarkTemplateId": [

                "t143ae6e040af6431aa772c9ec3f0a3f36",

                "t12a74d11687d444deba8a6cc52051ac27"

            ]

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:30:21+0800",

        "State": "Success",

        "SubTag": "DigitalWatermark",

        "Tag": "SuperResolution",

        "Workflow": {

            "Name": "SuperResolution_1581665960537_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1537 共2247⻚

⾳视频转码
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1538 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1539 共2247⻚

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1540 共2247⻚

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1541 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：
同提交转码任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数

组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48941


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1542 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1543 共2247⻚

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</F

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1544 共2247⻚

                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1545 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1546 共2247⻚

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1547 共2247⻚

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1548 共2247⻚

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

        <Workflow>

            <Name>Transcode_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1549 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T15:29:42+0800",

        "EndTime": "2022-06-30T15:30:08+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1550 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j68427030f84611ecb8546d80f2baf56f",

        "Message": "success",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Duration": "13",

                    "NumStream": "1",

                    "Size": "1909389"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.653",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    },

                    "Video": {

                        "AvgFps": "50.000",

                        "Bitrate": "1031968",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1551 共2247⻚

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31637668",

                        "CodecTagString": "hvc1",

                        "CodecTimeBase": "1/50",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960",

                        "FieldOrder": "Unknown",

                        "Fps": "50/1",

                        "HasBFrame": "4",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "4",

                        "NumFrames": "648",

                        "PixFormat": "hvc1",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "540"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "2db78d168edf2f883adce89a1b4ca033",

                        "ObjectName": "output/transcode.mp4"

                    },

                    "ObjectName": "output/transcode.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/transcode.mp4",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1995d523e42df4c5e858f244b4174360c",

            "TemplateName": "trans_993874",

            "UserData": "This is my Transcode job."

        },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1552 共2247⻚

        "Progress": "100",

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T15:29:42+0800",

        "State": "Success",

        "Tag": "Transcode",

        "Workflow": {

            "Name": "Transcode_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1553 共2247⻚

语⾳合成
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1554 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:33:18+0800</CreationTime>

        <EndTime>2022-06-30T19:33:24+0800</EndTime>

        <JobId>j707f4864f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>
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版权所有：腾讯云计算（北京）有限责任公司 第1555 共2247⻚

                <Stream>

                    <Audio>

                        <CodecName>mp3</CodecName>

                        <SampleRate>16000</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>5b2ca33cd7357abb1e0ea29f57544df9</Md5>

                        <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/aixiaonan.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TtsConfig>

                <Input>你好，我是爱晓楠，很⾼兴认识你。</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d457ds6s2a</TemplateId>

            <TemplateName>template_tts</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:33:19+0800</StartTime>

        <State>Success</State>

        <Tag>Tts</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：
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节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：
同提交语⾳合成任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数

组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48942


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1557 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:33:18+0800</CreationTime>

        <EndTime>2022-06-30T19:33:24+0800</EndTime>

        <JobId>j707f4864f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>
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                <Stream>

                    <Audio>

                        <CodecName>mp3</CodecName>

                        <SampleRate>16000</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>5b2ca33cd7357abb1e0ea29f57544df9</Md5>

                        <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/aixiaonan.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TtsConfig>

                <Input>你好，我是爱晓楠，很⾼兴认识你。</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d457ds6s2a</TemplateId>

            <TemplateName>template_tts</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:33:19+0800</StartTime>

        <State>Success</State>

        <Tag>Tts</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1559 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:33:18+0800</CreationTime>

        <EndTime>2022-06-30T19:33:24+0800</EndTime>

        <JobId>j707f4864f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <Input>

                <CosHeaders>
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                    <Key>Content-Type</Key>

                    <Value>application/octet-stream</Value>

                </CosHeaders>

                <CosHeaders>

                    <Key>x-cos-request-id</Key>

                    <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

                </CosHeaders>

                <CosHeaders>

                    <Key>EventName</Key>

                    <Value>cos:ObjectCreated:Put</Value>

                </CosHeaders>

                <CosHeaders>

                    <Key>Size</Key>

                    <Value>265</Value>

                </CosHeaders>

            </Input>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio>

                        <CodecName>mp3</CodecName>

                        <SampleRate>16000</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>5b2ca33cd7357abb1e0ea29f57544df9</Md5>

                        <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/aixiaonan.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TtsConfig>

                <Input>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/t

                <InputType>Url</InputType>
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            </TtsConfig>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d457ds6s2a</TemplateId>

            <TemplateName>template_tts</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:33:19+0800</StartTime>

        <State>Success</State>

        <Tag>Tts</Tag>

        <Workflow>

            <Name>Tts_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1562 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:33:18+0800",

        "EndTime": "2022-06-30T19:33:24+0800",

        "JobId": "j707f4864f86811ecb90d0b03267ce0e5",

        "Operation": {

            "Input": {

                "CosHeaders": [{

                        "Key": "Content-Type",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1563 共2247⻚

                        "Value": "application/octet-stream"

                    },

                    {

                        "Key": "x-cos-request-id",

                        "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                    },

                    {

                        "Key": "EventName",

                        "Value": "cos:ObjectCreated:Put"

                    },

                    {

                        "Key": "Size",

                        "Value": "265"

                    }

                ]

            },

            "MediaInfo": {

                "Stream": {

                    "Audio": {

                        "CodecName": "mp3",

                        "SampleRate": "16000"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "5b2ca33cd7357abb1e0ea29f57544df9",

                        "ObjectName": "/output/aixiaonan.mp3"

                    },

                    "ObjectName": "/output/aixiaonan.mp3",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/aixiaonan.mp3",

                "Region": "ap-chongqing"

            },

            "TtsConfig": {

                "Input": "https://test-123456789.cos.ap-chongqing.myqcloud.com/inpu

                "InputType": "Url"

            },

            "TemplateId": "t1f1ae1dfsdc9ds41dsb31632d457ds6s2a",

            "TemplateName": "template_tts"

        },
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        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:33:19+0800",

        "State": "Success",

        "Tag": "Tts",

        "Workflow": {

            "Name": "Tts_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1565 共2247⻚

精彩集锦
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1566 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象
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        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>
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                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1569 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：
同提交精彩集锦任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48943


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1570 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1571 共2247⻚

        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1572 共2247⻚

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1573 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1574 共2247⻚

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1575 共2247⻚

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.mp4</Object>

                <Region>ap-chongqing</Region>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1576 共2247⻚

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

        <Workflow>

            <Name>VideoMontage_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1577 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:55:05+0800",

        "EndTime": "2022-06-30T19:55:19+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1578 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j7b0dfbe2f86b11ec995acf5cffaf6664",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "14044.868000",

                    "Duration": "2.067000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "3628843",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "126.400000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "2.066576",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1579 共2247⻚

                    },

                    "Video": {

                        "AvgFps": "25.000000",

                        "Bitrate": "14664.836000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/90000",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "1.960000",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "41",

                        "NumFrames": "49",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.086000",

                        "Timebase": "1/90000",

                        "Width": "544"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "6080b31ea94defa6c19cc4def539a291",

                        "ObjectName": "output/videoMontage.mp4"

                    },

                    "ObjectName": "output/videoMontage.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/videoMontage.mp4",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t164ac18da8bdc403fa27ac4b077a962a1",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1580 共2247⻚

            "TemplateName": "videoMontage",

            "UserData": "This is my VideoMontage job."

        },

        "QueueId": "p09d709939fef48a0a5c247ef39d90cec",

        "StartTime": "2022-06-30T19:55:05+0800",

        "State": "Success",

        "Tag": "VideoMontage",

        "Workflow": {

            "Name": "VideoMontage_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1581 共2247⻚

视频增强
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1582 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1583 共2247⻚

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1584 共2247⻚

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>videoProcess_12654</TemplateName>

            <UserData>This is my VideoProcess job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Tag>VideoProcess</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1585 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：

同提交视频增强任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48944


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1586 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1587 共2247⻚

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1588 共2247⻚

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>videoProcess_12654</TemplateName>

            <UserData>This is my VideoProcess job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Tag>VideoProcess</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1589 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1590 共2247⻚

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1591 共2247⻚

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.mp4</Object>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1592 共2247⻚

                <Region>ap-chongqing</Region>

            </Output>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>videoProcess_12654</TemplateName>

            <UserData>This is my VideoProcess job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Tag>VideoProcess</Tag>

        <Workflow>

            <Name>VideoProcess_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1593 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T20:02:17+0800",

        "EndTime": "2022-06-30T20:02:34+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1594 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j7d0eafdaf86c11ecbdf419856486c0ab",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "10269.090000",

                    "Duration": "13.654000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "17526771",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128.726000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.652993",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1595 共2247⻚

                    },

                    "Video": {

                        "AvgFps": "24.922840",

                        "Bitrate": "10674.365000",

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31766568",

                        "CodecTagString": "hev1",

                        "CodecTimeBase": "1/12800",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960000",

                        "FieldOrder": "progressive",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "93",

                        "NumFrames": "323",

                        "PixFormat": "yuv420p",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "544"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "a825aa6c59371509995a47b570c29297",

                        "ObjectName": "output/video-process.mp4"

                    },

                    "ObjectName": "output/video-process.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/video-process.mp4",

                "Region": "ap-chongqing"

            },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1596 共2247⻚

            "TranscodeTemplateId": "t156c107210e7243c5817354565d81b578",

            "TemplateId": "t1f4ac18da8bdc403fa27ac4bfn77a62a1",

            "TemplateName": "videoProcess_12654",

            "UserData": "This is my VideoProcess job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T20:02:18+0800",

        "State": "Success",

        "Tag": "VideoProcess",

        "Workflow": {

            "Name": "VideoProcess_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1597 共2247⻚

视频标签
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1598 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:05:48+0800</CreationTime>

        <EndTime>2022-07-01T10:06:02+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1599 共2247⻚

        <JobId>j535b10a4f8e211ec9452c1c27f56a659</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my VideoTag job.</UserData>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <VideoTagResult>

                <StreamData>

                    <Data>

                        <ActionTags>

                            <EndTime>11</EndTime>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.421531</Confidence>

                                <Tag>说话</Tag>

                                <TagCls>说话</TagCls>

                            </Tags>

                        </ActionTags>

                        <ActionTags>

                            <EndTime>12.88</EndTime>

                            <StartTime>11.04</StartTime>

                            <Tags/>

                        </ActionTags>

                        <ObjectTags>

                            <Objects>

                                <BBox>

                                    <X1>0.10181817412376404</X1>

                                    <X2>0.8069194555282593</X2>

                                    <Y1>0.6880248785018921</Y1>

                                    <Y2>0.8779844045639038</Y2>

                                </BBox>

                                <Confidence>0.808393</Confidence>

                                <Name>电脑键盘</Name>

                            </Objects>

                            <TimeStamp>11</TimeStamp>

                        </ObjectTags>

                        <PersonTags/>

                        <PlaceTags>

                            <ClipFrameResult>办公室:0.55</ClipFrameResult>

                            <ClipFrameResult>办公室:0.55</ClipFrameResult>

                            <ClipFrameResult>办公室:0.59</ClipFrameResult>

                            <ClipFrameResult>办公室:0.54</ClipFrameResult>

                            <ClipFrameResult>办公室:0.42</ClipFrameResult>

                            <ClipFrameResult>办公室:0.43</ClipFrameResult>

                            <ClipFrameResult>办公室:0.33</ClipFrameResult>

                            <ClipFrameResult>办公室:0.29</ClipFrameResult>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1600 共2247⻚

                            <ClipFrameResult>办公室:0.15</ClipFrameResult>

                            <ClipFrameResult>娱乐场:0.42</ClipFrameResult>

                            <ClipFrameResult>办公室:0.33</ClipFrameResult>

                            <EndIndex>275</EndIndex>

                            <EndTime>11</EndTime>

                            <StartIndex>0</StartIndex>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.591724</Confidence>

                                <Tag>办公室</Tag>

                                <TagCls>办公</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.175342</Confidence>

                                <Tag>超市/便利店/商店</Tag>

                                <TagCls>商业</TagCls>

                            </Tags>

                        </PlaceTags>

                        <PlaceTags>

                            <ClipFrameResult>其他:0.09</ClipFrameResult>

                            <ClipFrameResult>其他:0.21</ClipFrameResult>

                            <ClipFrameResult>其他:0.19</ClipFrameResult>

                            <ClipFrameResult>天空:0.28</ClipFrameResult>

                            <ClipFrameResult>天空:0.25</ClipFrameResult>

                            <ClipFrameResult>其他:0.30</ClipFrameResult>

                            <ClipFrameResult>其他:0.28</ClipFrameResult>

                            <ClipFrameResult>其他:0.49</ClipFrameResult>

                            <ClipFrameResult>其他:0.56</ClipFrameResult>

                            <ClipFrameResult>其他:0.58</ClipFrameResult>

                            <EndIndex>322</EndIndex>

                            <EndTime>12.88</EndTime>

                            <StartIndex>276</StartIndex>

                            <StartTime>11.04</StartTime>

                            <Tags>

                                <Confidence>0.581444</Confidence>

                                <Tag>其他</Tag>

                                <TagCls>其他</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.283301</Confidence>

                                <Tag>天空</Tag>

                                <TagCls>⾃然/户外</TagCls>

                            </Tags>

                        </PlaceTags>

                        <Tags>

                            <Confidence>0.355083</Confidence>

                            <Tag>MOBA类-王者荣耀</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1601 共2247⻚

                        </Tags>

                        <Tags>

                            <Confidence>0.587103</Confidence>

                            <Tag>游戏</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.544651</Confidence>

                            <Tag>办公室</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.182886</Confidence>

                            <Tag>超市/便利店/商店</Tag>

                        </Tags>

                    </Data>

                    <SubErrCode>0</SubErrCode>

                    <SubErrMsg>ok</SubErrMsg>

                </StreamData>

            </VideoTagResult>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:05:50+0800</StartTime>

        <State>Success</State>

        <Tag>VideoTag</Tag>

        <VideoTag/>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：
同提交视频标签接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input还会包含 CosHeaders 节点，类型为 Container 数

组。

Container 节点 CosHeaders 的内容：

https://www.tencentcloud.com/document/product/1045/48945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1602 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1603 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:05:48+0800</CreationTime>

        <EndTime>2022-07-01T10:06:02+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1604 共2247⻚

        <JobId>j535b10a4f8e211ec9452c1c27f56a659</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my VideoTag job.</UserData>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <VideoTagResult>

                <StreamData>

                    <Data>

                        <ActionTags>

                            <EndTime>11</EndTime>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.421531</Confidence>

                                <Tag>说话</Tag>

                                <TagCls>说话</TagCls>

                            </Tags>

                        </ActionTags>

                        <ActionTags>

                            <EndTime>12.88</EndTime>

                            <StartTime>11.04</StartTime>

                            <Tags/>

                        </ActionTags>

                        <ObjectTags>

                            <Objects>

                                <BBox>

                                    <X1>0.10181817412376404</X1>

                                    <X2>0.8069194555282593</X2>

                                    <Y1>0.6880248785018921</Y1>

                                    <Y2>0.8779844045639038</Y2>

                                </BBox>

                                <Confidence>0.808393</Confidence>

                                <Name>电脑键盘</Name>

                            </Objects>

                            <TimeStamp>11</TimeStamp>

                        </ObjectTags>

                        <PersonTags/>

                        <PlaceTags>

                            <ClipFrameResult>办公室:0.55</ClipFrameResult>

                            <ClipFrameResult>办公室:0.55</ClipFrameResult>

                            <ClipFrameResult>办公室:0.59</ClipFrameResult>

                            <ClipFrameResult>办公室:0.54</ClipFrameResult>

                            <ClipFrameResult>办公室:0.42</ClipFrameResult>

                            <ClipFrameResult>办公室:0.43</ClipFrameResult>

                            <ClipFrameResult>办公室:0.33</ClipFrameResult>

                            <ClipFrameResult>办公室:0.29</ClipFrameResult>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1605 共2247⻚

                            <ClipFrameResult>办公室:0.15</ClipFrameResult>

                            <ClipFrameResult>娱乐场:0.42</ClipFrameResult>

                            <ClipFrameResult>办公室:0.33</ClipFrameResult>

                            <EndIndex>275</EndIndex>

                            <EndTime>11</EndTime>

                            <StartIndex>0</StartIndex>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.591724</Confidence>

                                <Tag>办公室</Tag>

                                <TagCls>办公</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.175342</Confidence>

                                <Tag>超市/便利店/商店</Tag>

                                <TagCls>商业</TagCls>

                            </Tags>

                        </PlaceTags>

                        <PlaceTags>

                            <ClipFrameResult>其他:0.09</ClipFrameResult>

                            <ClipFrameResult>其他:0.21</ClipFrameResult>

                            <ClipFrameResult>其他:0.19</ClipFrameResult>

                            <ClipFrameResult>天空:0.28</ClipFrameResult>

                            <ClipFrameResult>天空:0.25</ClipFrameResult>

                            <ClipFrameResult>其他:0.30</ClipFrameResult>

                            <ClipFrameResult>其他:0.28</ClipFrameResult>

                            <ClipFrameResult>其他:0.49</ClipFrameResult>

                            <ClipFrameResult>其他:0.56</ClipFrameResult>

                            <ClipFrameResult>其他:0.58</ClipFrameResult>

                            <EndIndex>322</EndIndex>

                            <EndTime>12.88</EndTime>

                            <StartIndex>276</StartIndex>

                            <StartTime>11.04</StartTime>

                            <Tags>

                                <Confidence>0.581444</Confidence>

                                <Tag>其他</Tag>

                                <TagCls>其他</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.283301</Confidence>

                                <Tag>天空</Tag>

                                <TagCls>⾃然/户外</TagCls>

                            </Tags>

                        </PlaceTags>

                        <Tags>

                            <Confidence>0.355083</Confidence>

                            <Tag>MOBA类-王者荣耀</Tag>
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版权所有：腾讯云计算（北京）有限责任公司 第1606 共2247⻚

                        </Tags>

                        <Tags>

                            <Confidence>0.587103</Confidence>

                            <Tag>游戏</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.544651</Confidence>

                            <Tag>办公室</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.182886</Confidence>

                            <Tag>超市/便利店/商店</Tag>

                        </Tags>

                    </Data>

                    <SubErrCode>0</SubErrCode>

                    <SubErrMsg>ok</SubErrMsg>

                </StreamData>

            </VideoTagResult>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:05:50+0800</StartTime>

        <State>Success</State>

        <Tag>VideoTag</Tag>

        <VideoTag/>

    </JobsDetail>

</Response>

案例 2：通过任务接⼝触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1607 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-07-01T10:05:48+0800",

        "EndTime": "2022-07-01T10:06:02+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing"

        },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1608 共2247⻚

        "JobId": "j535b10a4f8e211ec9452c1c27f56a659",

        "Message": "Success",

        "Operation": {

            "UserData": "This is my VideoTag job.",

            "VideoTag": {

                "Scenario": "Stream"

            },

            "VideoTagResult": {

                "StreamData": {

                    "Data": {

                        "ActionTags": [{

                                "EndTime": "11",

                                "StartTime": "0",

                                "Tags": {

                                    "Confidence": "0.421531",

                                    "Tag": "说话",

                                    "TagCls": "说话"

                                }

                            },

                            {

                                "EndTime": "12.88",

                                "StartTime": "11.04"

                            }

                        ],

                        "ObjectTags": {

                            "Objects": {

                                "BBox": {

                                    "X1": "0.10181817412376404",

                                    "X2": "0.8069194555282593",

                                    "Y1": "0.6880248785018921",

                                    "Y2": "0.8779844045639038"

                                },

                                "Confidence": "0.808393",

                                "Name": "电脑键盘"

                            },

                            "TimeStamp": "11"

                        },

                        "PlaceTags": [{

                                "ClipFrameResult": [

                                    "办公室:0.55",

                                    "办公室:0.55",

                                    "办公室:0.59",

                                    "办公室:0.54",

                                    "办公室:0.42",

                                    "办公室:0.43",

                                    "办公室:0.33",

                                    "办公室:0.29",
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版权所有：腾讯云计算（北京）有限责任公司 第1609 共2247⻚

                                    "办公室:0.15",

                                    "娱乐场:0.42",

                                    "办公室:0.33"

                                ],

                                "EndIndex": "275",

                                "EndTime": "11",

                                "StartIndex": "0",

                                "StartTime": "0",

                                "Tags": [{

                                        "Confidence": "0.591724",

                                        "Tag": "办公室",

                                        "TagCls": "办公"

                                    },

                                    {

                                        "Confidence": "0.175342",

                                        "Tag": "超市/便利店/商店",

                                        "TagCls": "商业"

                                    }

                                ]

                            },

                            {

                                "ClipFrameResult": [

                                    "其他:0.09",

                                    "其他:0.21",

                                    "其他:0.19",

                                    "天空:0.28",

                                    "天空:0.25",

                                    "其他:0.30",

                                    "其他:0.28",

                                    "其他:0.49",

                                    "其他:0.56",

                                    "其他:0.58"

                                ],

                                "EndIndex": "322",

                                "EndTime": "12.88",

                                "StartIndex": "276",

                                "StartTime": "11.04",

                                "Tags": [{

                                        "Confidence": "0.581444",

                                        "Tag": "其他",

                                        "TagCls": "其他"

                                    },

                                    {

                                        "Confidence": "0.283301",

                                        "Tag": "天空",

                                        "TagCls": "⾃然/户外"

                                    }



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1610 共2247⻚

                                ]

                            }

                        ],

                        "Tags": [{

                                "Confidence": "0.355083",

                                "Tag": "MOBA类-王者荣耀"

                            },

                            {

                                "Confidence": "0.587103",

                                "Tag": "游戏"

                            },

                            {

                                "Confidence": "0.544651",

                                "Tag": "办公室"

                            },

                            {

                                "Confidence": "0.182886",

                                "Tag": "超市/便利店/商店"

                            }

                        ]

                    },

                    "SubErrCode": "0",

                    "SubErrMsg": "ok"

                }

            }

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-07-01T10:05:50+0800",

        "State": "Success",

        "Tag": "VideoTag"

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1611 共2247⻚

⼈声分离
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1612 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:12:26+0800</CreationTime>

        <EndTime>2022-07-01T10:12:32+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1613 共2247⻚

        <JobId>j40644e92f8e311ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>128.147000</Bitrate>

                    <Duration>13.688163</Duration>

                    <FormatLongName>MP2/3 (MPEG audio layer 2/3)</FormatLongName>

                    <FormatName>mp3</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>219263</Size>

                    <StartTime>0.025057</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>
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                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3b883c0462ba845acdf3eb7e30db1a1c</Md5>

                        <ObjectName>output/audio.mp3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>62de6bb513d6105eeeb1a6ab0077cb5a</Md5>

                        <ObjectName>output/backgroud.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>output/audio.mp3</ObjectName>

                    <ObjectName>output/backgroud.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <AuObject>output/audio.mp3</AuObject>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my VoiceSeparate job.</UserData>

            <TemplateId>t1f6ac18da8bdc403fa27ac4ffnd7a6sa1</TemplateId>

            <TemplateName>videoseparate_12654</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:12:27+0800</StartTime>

        <State>Success</State>

        <Tag>VoiceSeparate</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型
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EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：

同提交⼈声分离任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/48946


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1616 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:12:26+0800</CreationTime>

        <EndTime>2022-07-01T10:12:32+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1617 共2247⻚

        <JobId>j40644e92f8e311ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>128.147000</Bitrate>

                    <Duration>13.688163</Duration>

                    <FormatLongName>MP2/3 (MPEG audio layer 2/3)</FormatLongName>

                    <FormatName>mp3</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>219263</Size>

                    <StartTime>0.025057</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>
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                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3b883c0462ba845acdf3eb7e30db1a1c</Md5>

                        <ObjectName>output/audio.mp3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>62de6bb513d6105eeeb1a6ab0077cb5a</Md5>

                        <ObjectName>output/backgroud.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>output/audio.mp3</ObjectName>

                    <ObjectName>output/backgroud.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <AuObject>output/audio.mp3</AuObject>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my VoiceSeparate job.</UserData>

            <TemplateId>t1f6ac18da8bdc403fa27ac4ffnd7a6sa1</TemplateId>

            <TemplateName>videoseparate_12654</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:12:27+0800</StartTime>

        <State>Success</State>

        <Tag>VoiceSeparate</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1619 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:12:26+0800</CreationTime>

        <EndTime>2022-07-01T10:12:32+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp3</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1326515</Value>

            </CosHeaders>

        </Input>

        <JobId>j40644e92f8e311ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>128.147000</Bitrate>

                    <Duration>13.688163</Duration>

                    <FormatLongName>MP2/3 (MPEG audio layer 2/3)</FormatLongName>

                    <FormatName>mp3</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>219263</Size>

                    <StartTime>0.025057</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1621 共2247⻚

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3b883c0462ba845acdf3eb7e30db1a1c</Md5>

                        <ObjectName>output/audio.mp3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>62de6bb513d6105eeeb1a6ab0077cb5a</Md5>

                        <ObjectName>output/backgroud.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>output/audio.mp3</ObjectName>

                    <ObjectName>output/backgroud.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <AuObject>output/audio.mp3</AuObject>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my VoiceSeparate job.</UserData>

            <TemplateId>t1f6ac18da8bdc403fa27ac4ffnd7a6sa1</TemplateId>

            <TemplateName>videoseparate_12654</TemplateName>

        </Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1622 共2247⻚

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:12:27+0800</StartTime>

        <State>Success</State>

        <Tag>VoiceSeparate</Tag>

        <Workflow>

            <Name>VoiceSeparate_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1623 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-07-01T10:12:26+0800",

        "EndTime": "2022-07-01T10:12:32+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp3",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1624 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp3"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1326515"

                }

            ]

        },

        "JobId": "j40644e92f8e311ecb90d0b03267ce0e5",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "128.147000",

                    "Duration": "13.688163",

                    "FormatLongName": "MP2/3 (MPEG audio layer 2/3)",

                    "FormatName": "mp3",

                    "NumProgram": "0",

                    "NumStream": "1",

                    "Size": "219263",

                    "StartTime": "0.025057"

                },

                "Stream": {

                    "Audio": [{

                            "Bitrate": "128.000000",

                            "Channel": "2",

                            "ChannelLayout": "stereo",

                            "CodecLongName": "MP3 (MPEG audio layer 3)",

                            "CodecName": "mp3",

                            "CodecTag": "0x0000",

                            "CodecTagString": "[0][0][0][0]",

                            "CodecTimeBase": "1/14112000",

                            "Duration": "13.688163",

                            "Index": "0",

                            "SampleFmt": "fltp",

                            "SampleRate": "44100",

                            "StartTime": "0.025057",

                            "Timebase": "1/14112000"

                        },



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1625 共2247⻚

                        {

                            "Bitrate": "128.000000",

                            "Channel": "2",

                            "ChannelLayout": "stereo",

                            "CodecLongName": "MP3 (MPEG audio layer 3)",

                            "CodecName": "mp3",

                            "CodecTag": "0x0000",

                            "CodecTagString": "[0][0][0][0]",

                            "CodecTimeBase": "1/14112000",

                            "Duration": "13.688163",

                            "Index": "0",

                            "SampleFmt": "fltp",

                            "SampleRate": "44100",

                            "StartTime": "0.025057",

                            "Timebase": "1/14112000"

                        }

                    ]

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                            "Md5": "3b883c0462ba845acdf3eb7e30db1a1c",

                            "ObjectName": "output/audio.mp3"

                        },

                        {

                            "Md5": "62de6bb513d6105eeeb1a6ab0077cb5a",

                            "ObjectName": "output/backgroud.mp3"

                        }

                    ],

                    "ObjectName": [

                        "output/audio.mp3",

                        "output/backgroud.mp3"

                    ],

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "AuObject": "output/audio.mp3",

                "Bucket": "test-123456789",

                "Object": "output/backgroud.mp3",

                "Region": "ap-chongqing"

            },

            "UserData": "This is my VoiceSeparate job.",

            "TemplateId": "t1f6ac18da8bdc403fa27ac4ffnd7a6sa1",

            "TemplateName": "videoseparate_12654"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1626 共2247⻚

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-07-01T10:12:27+0800",

        "State": "Success",

        "Tag": "VoiceSeparate",

        "Workflow": {

            "Name": "VoiceSeparate_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1627 共2247⻚

极速⾼清转码
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1628 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1629 共2247⻚

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1630 共2247⻚

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/high_speed.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/high_speed.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/high_speed.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <UserData>This is my HighSpeedHd job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1631 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：
同提交极速⾼清转码任务接⼝中的 Response.JobsDetail 

如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/49782


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1632 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1633 共2247⻚

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1634 共2247⻚

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/high_speed.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/high_speed.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/high_speed.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <UserData>This is my HighSpeedHd job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1635 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1636 共2247⻚

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1637 共2247⻚

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/high_speed.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/high_speed.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/high_speed.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <UserData>This is my HighSpeedHd job.</UserData>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1638 共2247⻚

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

        <Workflow>

            <Name>Transcode_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1639 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T15:29:42+0800",

        "EndTime": "2022-06-30T15:30:08+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1640 共2247⻚

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j68427030f84611ecb8546d80f2baf56f",

        "Message": "success",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Duration": "13",

                    "NumStream": "1",

                    "Size": "1909389"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.653",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    },

                    "Video": {

                        "AvgFps": "50.000",

                        "Bitrate": "1031968",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1641 共2247⻚

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31637668",

                        "CodecTagString": "hvc1",

                        "CodecTimeBase": "1/50",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960",

                        "FieldOrder": "Unknown",

                        "Fps": "50/1",

                        "HasBFrame": "4",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "4",

                        "NumFrames": "648",

                        "PixFormat": "hvc1",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "540"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "2db78d168edf2f883adce89a1b4ca033",

                        "ObjectName": "output/high_speed.mp4"

                    },

                    "ObjectName": "output/high_speed.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/high_speed.mp4",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1995d523e42df4c5e858f244b4174360c",

            "TemplateName": "high_993874",

            "UserData": "This is my HighSpeedHd job.",

            "JobLevel": 0



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1642 共2247⻚

        },

        "Progress": "100",

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T15:29:42+0800",

        "State": "Success",

        "Tag": "Transcode",

        "Workflow": {

            "Name": "HighSpeedHd_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1643 共2247⻚

图⽚处理

提交图⽚处理任务

CreatePicJobs
最近更新时间：2024-01-20 16:30:33

功能描述

提交⼀个图⽚处理任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1644 共2247⻚

POST /pic_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1645 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1646 共2247⻚

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>

        <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag：PicProcess String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1647 共2247⻚

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

PicProcess Request.Operation
指定该任务的参数，同创建图⽚处理模板 
CreateMediaTemplate 接⼝中的 
Request.PicProcess

Container 否

TemplateId Request.Operation 指定的模板 ID String 否

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓度不
超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级别
越⼤任务优先级越⾼，默认为0

String 否

注意：

优先使⽤ TemplateId，⽆ TemplateId 时使⽤对应任务类型的参数。
Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 结果⽂件的名字 String 是

响应

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1648 共2247⻚

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1649 共2247⻚

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1650 共2247⻚

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：PicProcess String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 该任务的输⼊资源地址 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Input 的内容：

节点名称（关键字） ⽗节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的⽂件名 String

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

TemplateId Response.JobsDetail.Operation 任务的模板 ID String

TemplateName Response.JobsDetail.Operation 任务的模板名称, 当 TemplateId 存在
时返回

String

PicProcess Response.JobsDetail.Operation 同请求中的 
Request.Operation.PicProcess

Container

Output Response.JobsDetail.Operation 同请求中的 
Request.Operation.Output

Container

PicProcessResult Response.JobsDetail.Operation 图⽚处理后输出图⽚的信息，没有时

不返回
Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1651 共2247⻚

UserData Response.JobsDetail.Operation 透传⽤户信息 String

Container 节点 PicProcessResult 的内容： 
同 图⽚持久化处理 接⼝中的 UploadResult 节点。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1：使⽤图⽚处理模板 ID

https://www.tencentcloud.com/document/product/1045/33695
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1652 共2247⻚

POST /pic_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1653 共2247⻚

        <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1654 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1655 共2247⻚

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使⽤图⽚处理处理参数



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1656 共2247⻚

POST /pic_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1657 共2247⻚

         <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1658 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1659 共2247⻚

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcess>

                <IsPicInfo>true</IsPicInfo>

                <ProcessRule>imageMogr2/rotate/90</ProcessRule>

            </PicProcess>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1660 共2247⻚

取消图⽚处理任务

CancelPicJob
最近更新时间：2024-01-20 16:30:33

功能描述

取消⼀个任务，只有未执⾏的任务才可以被取消。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1661 共2247⻚

PUT /jobs/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1662 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该请求⽆响应体。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1663 共2247⻚

PUT /jobs/c93984788066911ed89ed352d4d9d2084?cancel HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1664 共2247⻚

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1665 共2247⻚

查询图⽚处理任务

DescribePicJob
最近更新时间：2024-01-20 16:30:33

功能描述

查询指定的任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1666 共2247⻚

GET /pic_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1667 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1668 共2247⻚

<Response>

  <JobsDetail>

  </JobsDetail>

  <NonExistJobIds></NonExistJobIds>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1669 共2247⻚

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container 数组

NonExistJobIds Response 查询的 ID 中不存在任务，所有任务都存在时不返
回

String

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：
图⽚处理

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49947
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1670 共2247⻚

GET /pic_jobs/c93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1671 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1672 共2247⻚

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1673 共2247⻚

DescribePicJobs
最近更新时间：2024-01-20 16:30:33

功能描述

拉取符合条件的任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1674 共2247⻚

GET /pic_jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1675 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

请求参数

参数的具体内容如下：

节点名称（关键字）
⽗节

点
描述 类型

是否必

选

queueId ⽆ 拉取该队列 ID 下的任务 String 是

tag ⽆ 任务的 Tag String 是

workflowId ⽆ 触发该任务的⼯作流 ID String 否

inventoryTriggerJobId ⽆ 触发该任务的存量触发任务 ID String 否

inputObject ⽆ 该任务的输⼊⽂件名，暂仅⽀持精确匹配 String 否

orderByTime ⽆ Desc 或者 Asc。默认为 Desc String 否

nextToken ⽆ 请求的上下⽂，⽤于翻⻚。上次返回的值 String 否

size ⽆ 拉取的最⼤任务数。默认为10。最⼤为100 Integer 否

states ⽆

拉取该状态的任务，以  , 分割，⽀持多状态：

All、Submitted、Running、Success、Failed、
Pause、Cancel。默认为 All

String 否

startCreationTime ⽆

拉取创建时间⼤于该时间的任务。格式为：  %Y-

%m-%dT%H:%m:%S%z ，⽰例：2001-01-
01T00:00:00+0800

String 否

endCreationTime ⽆

拉取创建时间⼩于该时间的任务。格式为：  %Y-

%m-%dT%H:%m:%S%z ，⽰例：2001-01-
01T23:59:59+0800

String 否

tag ⽀持以下⼏种类型:

任务类型 tag

图⽚处理 PicProcess

https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1676 共2247⻚

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <JobsDetail>

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1677 共2247⻚

        ...

    </JobsDetail>

    <NextToken></NextToken>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container数组

NextToken Response 翻⻚的上下⽂ Token String

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：
图⽚处理

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49947
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1678 共2247⻚

GET /pic_jobs?queueId=p2911917386e148639319e13c285cc774&tag=PicProcess HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1679 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1680 共2247⻚

        <Message/>

        <JobId>c93984788066911e689ed352d4d9d2ghd4</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcess>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1681 共2247⻚

                <IsPicInfo>true</IsPicInfo>

                <ProcessRule>imageMogr2/rotate/90</ProcessRule>

            </PicProcess>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1682 共2247⻚

图⽚处理回调
最近更新时间：2024-01-20 16:30:33

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1683 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1684 共2247⻚

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1685 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container 数组

Container 节点 JobsDetail 的内容：
同提交图⽚处理任务接⼝中的 Response.JobsDetail 

如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调

https://www.tencentcloud.com/document/product/1045/49947


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1686 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1687 共2247⻚

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

    </JobsDetail>

</Response>

案例 2：通过⼯作流触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1688 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1689 共2247⻚

                <Key>Content-Type</Key>

                <Value>image/jpeg</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1024</Value>

            </CosHeaders>

        </Input>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1690 共2247⻚

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

        <Workflow>

            <Name>PicProcess_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过⼯作流触发的任务回调, 格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1691 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-07-18T15:16:43+0800",

        "EndTime": "2022-07-18T15:16:44+0800",

        "Input": {

            "BucketId": "test-1234567890",

            "Object": "input/deer.jpg",

            "Region": "ap-chongqing",

            "CosHeaders": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1692 共2247⻚

                    "Key": "Content-Type",

                    "Value": "image/jpeg"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1024"

                }

            ]

        },

        "JobId": "c93984788066911ed89ed352d4d9d2084",

        "Operation": {

            "Output": {

                "Bucket": "test-1234567890",

                "Object": "output/out.jpg",

                "Region": "ap-chongqing"

            },

            "PicProcessResult": {

                "ObjectName": "output/out.jpg",

                "OriginalInfo": {

                    "Etag": "\\"d5a491cd3d8d071e3212c3478e8e35a1\\"",

                    "ImageInfo": {

                        "Ave": "0xc64847",

                        "Format": "JPEG",

                        "Height": "417",

                        "Orientation": "0",

                        "Quality": "68",

                        "Width": "500"

                    }

                },

                "ProcessResult": {

                    "Format": "JPEG",

                    "Height": "500",

                    "Quality": "68",

                    "Size": "24911",

                    "Width": "417"

                }

            },

            "TemplateId": "t10461fe2bd5a649db9022452ec71e0381",

            "TemplateName": "test",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1693 共2247⻚

            "UserData": "This is my PicProcess job.",

            "JobLevel": 0,

        },

        "QueueId": "p2911917386e148639319e13c285cc774",

        "StartTime": "2022-07-18T15:16:44+0800",

        "State": "Success",

        "Tag": "PicProcess",

        "Workflow": {

            "Name": "PicProcess_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1694 共2247⻚

多任务处理

提交多任务处理

MultiJobs
最近更新时间：2024-03-01 17:21:38

功能描述

提交多个任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1695 共2247⻚

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1696 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1697 共2247⻚

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my SmartCover job.</UserData>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键 ⽗节点 描述 类型 是否必选



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1698 共2247⻚

字）

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则，个数不

超过6个
Container 是

QueueId Request 任务所在的队列 
ID

String 是

Container 类型 Input 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

对于不同的任务类型，Operation 的内容不同，请参照以下链接：

⾳视频转码

视频转动图

视频截帧

智能封⾯

⾳视频拼接

⼈声分离

精彩集锦

SDR to HDR 
视频增强

超分辨率

⾳视频转封装

数字⽔印

提取数字⽔印

视频标签

获取媒体信息

⾳视频流分离

视频质量分析

语⾳合成

https://www.tencentcloud.com/document/product/1045/48941
https://www.tencentcloud.com/document/product/1045/49569
https://www.tencentcloud.com/document/product/1045/48938
https://www.tencentcloud.com/document/product/1045/48937
https://www.tencentcloud.com/document/product/1045/48929
https://www.tencentcloud.com/document/product/1045/48946
https://www.tencentcloud.com/document/product/1045/48943
https://www.tencentcloud.com/document/product/1045/48935
https://www.tencentcloud.com/document/product/1045/48944
https://www.tencentcloud.com/document/product/1045/48940
https://www.tencentcloud.com/document/product/1045/48936
https://www.tencentcloud.com/document/product/1045/48930
https://www.tencentcloud.com/document/product/1045/48931
https://www.tencentcloud.com/document/product/1045/48945
https://www.tencentcloud.com/document/product/1045/48932
https://www.tencentcloud.com/document/product/1045/48939
https://www.tencentcloud.com/document/product/1045/48934
https://www.tencentcloud.com/document/product/1045/48942


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1699 共2247⻚

⾳频降噪

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <JobsDetail>

https://www.tencentcloud.com/document/product/1045/48933
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1700 共2247⻚

        <Code>Success</Code>

        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>transcode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1701 共2247⻚

            </Output>

            <UserData>This is my Trancode job.</UserData>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>SmartCover</Tag>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1702 共2247⻚

JobsDetail Response 任务的详细信息 Container 数组

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：
⾳视频转码

视频转动图

视频截帧

智能封⾯

⾳视频拼接

⼈声分离

精彩集锦

SDR to HDR 
视频增强

超分辨率

⾳视频转封装

数字⽔印

提取数字⽔印

视频标签

获取媒体信息

⾳视频流分离

视频质量分析

语⾳合成

⾳频降噪

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

使⽤多个模板 ID

请求

https://www.tencentcloud.com/document/product/1045/48941
https://www.tencentcloud.com/document/product/1045/49569
https://www.tencentcloud.com/document/product/1045/48938
https://www.tencentcloud.com/document/product/1045/48937
https://www.tencentcloud.com/document/product/1045/48929
https://www.tencentcloud.com/document/product/1045/48946
https://www.tencentcloud.com/document/product/1045/48943
https://www.tencentcloud.com/document/product/1045/48935
https://www.tencentcloud.com/document/product/1045/48944
https://www.tencentcloud.com/document/product/1045/48940
https://www.tencentcloud.com/document/product/1045/48936
https://www.tencentcloud.com/document/product/1045/48930
https://www.tencentcloud.com/document/product/1045/48931
https://www.tencentcloud.com/document/product/1045/48945
https://www.tencentcloud.com/document/product/1045/48932
https://www.tencentcloud.com/document/product/1045/48939
https://www.tencentcloud.com/document/product/1045/48934
https://www.tencentcloud.com/document/product/1045/48942
https://www.tencentcloud.com/document/product/1045/48933
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1703 共2247⻚

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1704 共2247⻚

        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my SmartCover job.</UserData>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1705 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1706 共2247⻚

        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trancode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

            </Output>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1707 共2247⻚

            <UserData>This is my Trancode job.</UserData>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>SmartCover</Tag>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1708 共2247⻚

AI 内容识别
提交内容识别任务

提交翻译任务
最近更新时间：2024-01-20 16:35:12

功能描述

提交⼀个翻译任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1709 共2247⻚

POST /ai_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1710 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1711 共2247⻚

    <Tag>Translation</Tag>

    <Input>

        <Object>input/en.pdf</Object>

        <Lang>en</Lang>

        <Type>pdf</Type>

        <BasicType>pptx</BasicType>

    </Input>

    <Operation>

        <Translation>

            <Lang>zh</Lang>

            <Type>pdf</Type>

        </Translation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/zh.pdf</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：Translation String 是

Input Request 待操作的对象信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优
先级⾼于队列的回调格式

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1712 共2247⻚

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先
级⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。

设置为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否必

选
限制

Object Request.Input 源⽂档⽂

件名
String 是

单⽂件

（docx/xlsx/html/markdown/txt）：800
万字符

有⻚数的（pdf/pptx）：300⻚ 
⽂本⽂件（txt）：10MB 
⼆进制⽂件（pdf\\docx\\pptx\\xlsx）：
60MB 
图⽚⽂件（jpg\\jpeg\\png）：10MB

Lang Request.Input
⽂档语⾔

类型
String 是

zh：简体中⽂ 
zh-hk：繁体中⽂ 
zh-tw：繁体中⽂ 
zh-tr：繁体中⽂ 
en：英语 
ar：阿拉伯语 
de：德语 
es：⻄班⽛语 
fr：法语 
id：印尼语 
it：意⼤利语 
ja：⽇语
pt：葡萄⽛语 
ru：俄语 
ko：韩语 
km：⾼棉语 
lo：⽼挝语

Type Request.Input ⽂档类型 String 是 pdf 
docx 
pptx 
xlsx 

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1713 共2247⻚

txt 
xml 
html：只能翻译 HTML ⾥的⽂本节点，
需要通过 JS 动态加载的不进⾏翻译 
markdown 
jpg 
jpeg 
png

BasicType Request.Input
原始⽂档

类型
String 否

仅在 Type=pdf/jpg/jpeg/png 时使⽤， 
当值为pdf时，仅⽀持 docx、pptx 
当值为jpg/jpeg/png/webp时，仅⽀持
txt，不填写此字段时，直接返回翻译结
果

Container 类型 Operation 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Translation Request.Operation 翻译参数 Container 是

Output Request.Operation 结果输出地址 Container
是（当

NoNeedOutput为true
时⾮必选）

UserData Request.Operation 透传⽤户信息, 可打印的 
ASCII 码, ⻓度不超过1024

String 否

JobLevel Request.Operation
任务优先级，级别限制：0 
、1 、2 。级别越⼤任务优先
级越⾼，默认为0

String 否

NoNeedOutput Request.Operation
仅输出结果，不⽣成结果⽂

件true/false。该参数原⽂档
类型为图⽚时有效

String 否

Container 类型 Translation 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否

必选
限制

Lang Request.Operation.Translation ⽬标语

⾔类型

String 是 源语⾔类型为

zh/zh-hk/zh-tw/zh-tr 时⽀
持：en、ar、de、es、fr、
id、it、ja、it、ru、ko、
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km、lo、pt 
en 时⽀持：zh、zh-hk、zh-
tw、zh-tr、ar、de、es、
fr、id、it、ja、it、ru、ko、
km、lo、pt 
其他类型时⽀持：zh、zh-
hk、zh-tw、zh-tr、en

Type Request.Operation.Translation
⽂档类

型
String 是

源⽂件类型与⽬标⽂件类型

映射关系如下：

docx：docx 
pptx：pptx 
xlsx：xlsx 
txt：txt
xml：xml 
html：html 
markdown：markdown 
pdf：pdf docx 
png：txt 
jpg：txt 
jpeg：txt

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 输出结果的⽂件

名
String 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>Translation</Tag>
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        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>

        </Input>

        <Operation>

            <Translation>

                <Lang>zh</Lang>

                <Type>pdf</Type>

            </Translation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：Translation String

State Response.JobsDetail 任务的状态，为 Submitted、Running、 String
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Success、Failed、Pause、Cancel 其中⼀个

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 同请求中的 Request.Input 节点。 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Operation 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Translation Response.JobsDetail.Operation 同请求中的 
Request.Operation.Translation

Container

Output Response.JobsDetail.Operation 同请求中的 
Request.Operation.Output

Container

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

AITranslateResult Response.JobsDetail.Operation 翻译结果详情 Container

Container 节点 AITranslateResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

Result Response.JobsDetail.Operation 翻译结果内容 String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700
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POST /ai_jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Translation</Tag>

    <Input>

        <Object>input/en.pdf</Object>

        <Lang>en</Lang>
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        <Type>pdf</Type>

        <BasicType>pptx</BasicType>

    </Input>

    <Operation>

        <Translation>

            <Lang>zh</Lang>

            <Type>pdf</Type>

        </Translation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/zh.pdf</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>Translation</Tag>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>

        </Input>

        <Operation>

            <Translation>

                <Lang>zh</Lang>

                <Type>pdf</Type>

            </Translation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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提交语⾳识别任务
最近更新时间：2024-01-20 16:35:12

功能描述

提交⼀个语⾳识别任务。

说明：

关于语⾳识别的限制说明，请参⻅ 规则与限制 ⽂档。

请求

请求⽰例

https://www.tencentcloud.com/document/product/1045/33425
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POST /asr_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：
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Authorization：Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609
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    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

        <Url></Url>

    </Input>

    <Operation>

        <SpeechRecognition>

            <EngineModelType>16k_zh_video</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <FilterDirty>1</ChannelNum>

            <FilterModal>1</ChannelNum>

        </SpeechRecognition>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

Tag Request 创建任务的 Tag：SpeechRecognition String 是

Input Request 待操作的对象信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否
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CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 No 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

Container 类型 Input 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 否

Url Request.Input ⽀持公⽹下载的 URL，与 Object 必须有其中⼀个，
且当两者都传⼊时，优先使⽤ Object

String 否

Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

SpeechRecognition Request.Operation 指定 语⾳识别 参数 Container 是

Output Request.Operation 结果输出地址 Container 是

UserData Request.Operation 透传⽤户信息, 可打印的 ASCII 码, ⻓
度不超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2 。
级别越⼤任务优先级越⾼，默认为0

String 否

Container 类型 SpeechRecognition 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选

EngineModelType Request.Operation.Speech 
Recognition

引擎模型类型。

电话场景：

8k_zh：电话 8k 中⽂普通话通⽤
（可⽤于双声道⾳频）。

8k_zh_s：电话 8k 中⽂普通话话者
分离（仅适⽤于单声道⾳频）。

String 是

https://www.tencentcloud.com/document/product/1045/49945
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⾮电话场景：

16k_zh：16k 中⽂普通话通⽤。
16k_zh_video：16k ⾳视频领域。
16k_en：16k 英语。
16k_ca：16k 粤语。

ChannelNum Request.Operation.Speech 
Recognition

语⾳声道数。

1：单声道。
2：双声道（仅⽀持 8k_zh 引擎模
型）。

Integer 是

ResTextFormat
Request.Operation.Speech 
Recognition

识别结果返回形式。

0： 识别结果⽂本(含分段时间戳)。
1：仅⽀持16k 中⽂引擎，含识别结
果详情(词时间戳列表，⼀般⽤于⽣
成字幕场景)。

Integer 是

FilterDirty
Request.Operation.Speech 
Recognition

是否过滤脏词（⽬前⽀持中⽂普通

话引擎）。

0：不过滤脏词。
1：过滤脏词。
2：将脏词替换为 * 。默认值为0。

Integer 否

FilterModal
Request.Operation.Speech 
Recognition

是否过语⽓词（⽬前⽀持中⽂普通

话引擎）。

0：不过滤语⽓词。
1：部分过滤。
2：严格过滤 。默认值为 0。

Integer 否

ConvertNumMode
Request.Operation.Speech 
Recognition

是否进⾏阿拉伯数字智能转换（⽬

前⽀持中⽂普通话引擎）。

0：不转换，直接输出中⽂数字。
1：根据场景智能转换为阿拉伯数
字。默认值为1。

Integer 否

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储

桶
String 是

Object Request.Operation.Output 结果⽂件的名称 String 是
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响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <JobsDetail>

https://www.tencentcloud.com/document/product/1045/43610
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        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>

        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognition>

                <ChannelNum>1</ChannelNum>

                <ConvertNumMode>0</ConvertNumMode>

                <EngineModelType>16k_zh_video</EngineModelType>

                <FilterDirty>0</FilterDirty>

                <FilterModal>0</FilterModal>

                <FilterPunc>0</FilterPunc>

                <OutputFileType>txt</OutputFileType>

                <ResTextFormat>0</ResTextFormat>

                <SpeakerDiarization>0</SpeakerDiarization>

                <SpeakerNumber>0</SpeakerNumber>

            </SpeechRecognition>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：
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节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：SpeechRecognition String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 同请求中的 Request.Input 节点 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

SpeechRecognition Response.JobsDetail.Operation 同请求中的 
Request.Operation.SpeechRecognition

Cont

Output Response.JobsDetail.Operation 同请求中的 Request.Operation.Output Cont

UserData Response.JobsDetail.Operation 透传⽤户信息 Strin

JobLevel Response.JobsDetail.Operation 任务优先级 Strin

SpeechRecognitionResult Response.JobsDetail.Operation 语⾳识别任务结果，没有时不返回 Cont
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Container 节点 SpeechRecognitionResult 的内容：

节点名称

（关键字）
⽗节点 描述 类型

AudioTime Response.JobsDetail.Operation.SpeechRecognitionResult ⾳频时⻓(秒) String

Result Response.JobsDetail.Operation.SpeechRecognitionResult 语⾳识别结果 String

FlashResult Response.JobsDetail.Operation.SpeechRecognitionResult 极速语⾳识别结果
Container 
数组

ResultDetail Response.JobsDetail.Operation.SpeechRecognitionResult

识别结果详情，包

含每个句⼦中的词

时间偏移，⼀般⽤

于⽣成字幕的场

景。(语⾳识别请
求中 
ResTextFormat=1 
时该字段不为空)
注意：此字段可能

为空，表⽰取不到

有效值。

Container 
数组

Container 节点 FlashResult 的内容：

节点名称

（关键字）
⽗节点 描述 类型

channel_id Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult

声道

标

识，

从0
开

始，

对应

⾳频

声道

数

Integer

text Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult

声道

⾳频

完整

识别

结果

String

sentence_list Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult 句 Container 
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⼦/
段落

级别

的识

别结

果列

表

数组

Container 节点 sentence_list 的内容：

节点名称

（关键

字）

⽗节点 描述

text Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list 句⼦/段落级

start_time Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list 开始时间

end_time Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list 结束时间

speaker_id Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list

说话⼈ ID
果设置了 
speaker_d
可以按照 s
来区分说话

word_list Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list 词级别的识

表

Container 节点 word_list 的内容：

节点名称

（关键

字）

⽗节点
描

述

word Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list.word_list

词

级

别

⽂

本

start_time Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list.word_list

开

始

时

间



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1733 共2247⻚

end_time Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list.word_list 结

束

时

间

Container 节点 ResultDetail 的内容：

节点名称（关

键字）
⽗节点 描述

FinalSentence Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail 单句最终识别结果

SliceSentence Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail
单句中间识别结

果，使⽤空格拆分

为多个词

StartMs Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail 单句开始时间（毫

秒）

EndMs Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail 单句结束时间（毫

秒）

WordsNum Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail 单句中词个数

SpeechSpeed Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail 单句语速，单位：

字数/秒

SpeakerId Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail

声道或说话⼈ ID
（请求中如果设置

了 
speaker_diarization
或者ChannelNum
为双声道，可区分

说话⼈或声道）

Words Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail 单句中词详情

Container 节点 Words 的内容：

节点名称（关

键字）
⽗节点

描

述
类型

Word Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail.Words
词

⽂

本

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1734 共2247⻚

OffsetStartMs Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail.Words 在

句

⼦

中

的

开

始

时

间

偏

移

量

String

OffsetEndMs Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail.Words

在

句

⼦

中

的

结

束

时

间

偏

移

量

String

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1735 共2247⻚

POST /asr_jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1736 共2247⻚

    <Operation>

        <SpeechRecognition>

            <EngineModelType>16k_zh_video</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <FilterDirty>1</ChannelNum>

            <FilterModal>1</ChannelNum>

        </SpeechRecognition>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1737 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1738 共2247⻚

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>

        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognition>

                <ChannelNum>1</ChannelNum>

                <ConvertNumMode>0</ConvertNumMode>

                <EngineModelType>16k_zh_video</EngineModelType>

                <FilterDirty>0</FilterDirty>

                <FilterModal>0</FilterModal>

                <FilterPunc>0</FilterPunc>

                <OutputFileType>txt</OutputFileType>

                <ResTextFormat>0</ResTextFormat>

                <SpeakerDiarization>0</SpeakerDiarization>

                <SpeakerNumber>0</SpeakerNumber>

            </SpeechRecognition>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1739 共2247⻚

提交分词任务
最近更新时间：2024-01-20 16:35:12

功能描述

提交⼀个分词任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1740 共2247⻚

POST /ai_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1741 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1742 共2247⻚

    <Tag>WordsGeneralize</Tag>

    <Input>

        <Object>text.txt</Object>

    </Input>

    <Operation>

        <WordsGeneralize>

            <NerMethod>DL</NerMethod>

            <SegMethod>MIX</SegMethod>

        </WordsGeneralize>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

Tag Request 创建任务的 Tag：WordsGeneralize String 是

Input Request 待操作的对象信息 Container 是

Operation Request 操作规则 Container 是

QueueId Request 任务所在的队列 ID String 是

CallBackFormat Request 任务回调格式，JSON 或 XML，默认 XML，优先
级⾼于队列的回调格式

String 否

CallBackType Request 任务回调类型，Url 或 TDMQ，默认 Url，优先级
⾼于队列的回调类型

String 否

CallBack Request 任务回调地址，优先级⾼于队列的回调地址。设置

为 no 时，表⽰队列的回调地址不产⽣回调
String 否

CallBackMqConfig Request 任务回调 TDMQ 配置，当 CallBackType 为 
TDMQ 时必填。详情⻅ CallBackMqConfig

Container 否

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1743 共2247⻚

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Object Request.Input 媒体⽂件名 String 是

Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

WordsGeneralize Request.Operation 指定分词参数 Container 是

UserData Request.Operation 透传⽤户信息，可打印的 ASCII 码，⻓
度不超过1024

String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级
别越⼤任务优先级越⾼，默认为0

String 否

Container 类型 WordsGeneralize 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选
限制

NerMethod Request.Operation.WordsGeneralize ner ⽅式，默
认值 DL

String 否
NerBasic 或 
DL

SegMethod Request.Operation.WordsGeneralize 分词粒度，

默认值 MIX
String 否

SegBasic 或 
MIX

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1744 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>WordsGeneralize</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1745 共2247⻚

        <Input>

            <Object>text.txt</Object>

        </Input>

        <Operation>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

JobId Response.JobsDetail 新创建任务的 ID String

Tag Response.JobsDetail 新创建任务的 Tag：WordsGeneralize String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1746 共2247⻚

QueueId Response.JobsDetail 任务所属的队列 ID String

Input Response.JobsDetail 同请求中的 Request.Input 节点 Container

Operation Response.JobsDetail 该任务的规则 Container

Container 节点 Operation 的内容：

节点名称（关键字） ⽗节点 描述 类型

WordsGeneralize Response.JobsDetail.Operation 同请求中的 
Request.Operation.WordsGeneralize

Containe

UserData Response.JobsDetail.Operation 透传⽤户信息 String

JobLevel Response.JobsDetail.Operation 任务优先级 String

WordsGeneralizeResult Response.JobsDetail.Operation 分词结果，任务执⾏成功时返回 Containe

Container 节点 WordsGeneralizeResult 的内容：

节点名称（关键字） ⽗节点 描述 类型

WordsGeneralizeLable Response.JobsDetail.Operation.WordsGeneralizeResult
智能

分类

结果

Container数
组

WordsGeneralizeToken Response.JobsDetail.Operation.WordsGeneralizeResult
分词

详细

结果

Container数
组

Container 节点 WordsGeneralizeLable 的内容：

节点名称

（关键

字）

⽗节点
描

述
类型

Category Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeLable 类

别
string

Word Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeLable 词

汇
string

Container 节点 WordsGeneralizeToken 的内容：

节点名 ⽗节点 描 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1747 共2247⻚

称（关

键字）

述

Word Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeToken 词

汇
string

Offset Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeToken
偏

移

量

string

Length Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeToken

词

汇

⻓

度

string

Pos Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeToken 词

性
string

词性详⻅下标：

英⽂缩写 含义

A 形容词

AD 副形词

AN 名形词

B 区别词

C 连词

D 副词

E 叹词

F ⽅位词

G 语素词

H 前接成分

I 成语

J 简称略语

K 后接成分

L 习⽤语



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1748 共2247⻚

M 数词

N 名词

NR ⼈名

NRF 姓

NRG 名

NS 地名

NT 机构团体

NZ 其他专名

NX ⾮汉字串

O 拟声词

P 介词

Q 量词

R 代词

S 处所词

T 时间词

U 助词

V 动词

VD 副动词

VN 名动词

W 标点符号

X ⾮语素字

Y 语⽓词

Z 状态词

AG 形语素

BG 区别语素



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1749 共2247⻚

DG 副语素

MG 数词性语素

NG 名语素

QG 量语素

RG 代语素

TG 动语素

VG 量语素

YG 语⽓词语素

ZG 状态词语素

UNK 未知词性

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1750 共2247⻚

POST /ai_jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>WordsGeneralize</Tag>

    <Input>

        <Object>text.txt</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1751 共2247⻚

    <Operation>

        <WordsGeneralize>

            <NerMethod>DL</NerMethod>

            <SegMethod>MIX</SegMethod>

        </WordsGeneralize>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1752 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1753 共2247⻚

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>WordsGeneralize</Tag>

        <Input>

            <Object>text.txt</Object>

        </Input>

        <Operation>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1754 共2247⻚

取消内容识别任务
最近更新时间：2024-01-20 16:35:12

功能描述

取消⼀个任务，只有未执⾏的任务才可以被取消。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1755 共2247⻚

PUT /ai_jobs/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1756 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该请求⽆响应体。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1757 共2247⻚

PUT /ai_jobs/a632d4d3429a811ed8a5fa3d8277c400f?cancel HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1758 共2247⻚

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1759 共2247⻚

查询内容识别任务

查询内容识别任务
最近更新时间：2024-01-20 16:35:12

功能描述

查询指定的任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1760 共2247⻚

GET /ai_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1761 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1762 共2247⻚

<Response>

    <JobsDetail>

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1763 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container

NonExistJobIds Response 查询的 ID 中不存在任务，所有任务都存在时不返回 String

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：
翻译

分词

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49788
https://www.tencentcloud.com/document/product/1045/49790
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1764 共2247⻚

GET /ai_jobs/a8d121820f5e411ec926ef19d53ba9c6f HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1765 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTRfMThhYTk0MGFfYmU1Nl8xNTk=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1766 共2247⻚

        <Message></Message>

        <JobId>a8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <CreationTime>2022-07-07T12:12:12+0800</CreationTime>

        <StartTime>2022-07-07T12:12:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <Tag>Translation<Tag>

        <Input>

            <Object>test.txt</Object>

            <Lang>zh</Lang>

            <Type>txt</Type>

        </Input>

        <Operation>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <Output>

                <Region>ap-beijing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>test-result.txt</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1767 共2247⻚

批量拉取内容识别任务
最近更新时间：2024-01-20 16:35:12

功能描述

拉取符合条件的任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1768 共2247⻚

GET /jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1769 共2247⻚

请求参数

参数的具体内容如下：

节点名称（关键字）
⽗节

点
描述 类型

是否必

选

queueId ⽆ 拉取该队列 ID 下的任务 String 是

tag ⽆ 任务的 Tag String 是

workflowId ⽆ 触发该任务的⼯作流 ID String 否

inventoryTriggerJobId ⽆ 触发该任务的存量触发任务 ID String 否

inputObject ⽆ 该任务的输⼊⽂件名，暂仅⽀持精确匹配 String 否

orderByTime ⽆ Desc 或者 Asc。默认为 Desc String 否

nextToken ⽆ 请求的上下⽂，⽤于翻⻚。上次返回的值 String 否

size ⽆ 拉取的最⼤任务数。默认为10。最⼤为100 Integer 否

states ⽆

拉取该状态的任务，以  , 分割，⽀持多状态：

All、Submitted、Running、Success、Failed、
Pause、Cancel。默认为 All

String 否

startCreationTime ⽆

拉取创建时间⼤于该时间的任务。格式为：  %Y-

%m-%dT%H:%m:%S%z ，⽰例：2001-01-
01T00:00:00+0800

String 否

endCreationTime ⽆

拉取创建时间⼩于该时间的任务。格式为：  %Y-

%m-%dT%H:%m:%S%z ，⽰例：2001-01-
01T23:59:59+0800

String 否

tag ⽀持以下⼏种类型:

任务类型 tag

翻译 Translation

语⾳识别 SpeechRecognition

分词 WordsGeneralize

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1770 共2247⻚

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1771 共2247⻚

<Response>

    <JobsDetail>

        ...

    </JobsDetail>

    <NextToken></NextToken>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1772 共2247⻚

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

JobsDetail Response 任务的详细信息 Container数组

NextToken Response 翻⻚的上下⽂ Token String

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：

翻译

分词

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49788
https://www.tencentcloud.com/document/product/1045/49790
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1773 共2247⻚

GET /jobs?queueId=p893bcda225bf4945a378da6662e81a89&tag=Translation HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1774 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1775 共2247⻚

        <Message></Message>

        <JobId>a8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <CreationTime>2022-07-07T12:12:12+0800</CreationTime>

        <StartTime>2022-07-07T12:12:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <Tag>Translation<Tag>

        <Input>

            <Object>test.txt</Object>

            <Lang>zh</Lang>

            <Type>txt</Type>

        </Input>

        <Operation>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <Output>

                <Region>ap-beijing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>test-result.txt</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message></Message>

        <JobId>a8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <CreationTime>2022-07-07T12:12:12+0800</CreationTime>

        <StartTime>2022-07-07T12:12:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <Tag>Translation<Tag>

        <Input>

            <Object>test.txt</Object>

            <Lang>zh</Lang>

            <Type>txt</Type>

        </Input>

        <Operation>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1776 共2247⻚

            <Output>

                <Region>ap-beijing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>test-result.txt</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <NextToken>225508</NextToken>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1777 共2247⻚

内容识别任务回调

翻译任务回调
最近更新时间：2024-01-20 16:35:12

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1778 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1779 共2247⻚

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <UserData>This is my Translation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>Translation</Tag>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：
同提交翻译任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数
组。

Container 节点 CosHeaders 的内容：

节点名称（关

键字）
⽗节点 描述 类型

https://www.tencentcloud.com/document/product/1045/49788


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1780 共2247⻚

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名
称

String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

案例 1：通过任务接⼝触发的任务回调



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1781 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1782 共2247⻚

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <UserData>This is my Translation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>Translation</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务触发的任务回调，格式为 JSON



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1783 共2247⻚

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-07-25T16:35:39+0800",

        "EndTime": "2022-07-25T16:35:43+0800",

        "Input": {

            "Object": "input/en.pdf",

            "Lang": "en",

            "Type": "pdf",

            "BasicType": "pptx"



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1784 共2247⻚

        },

        "JobId": "ac34be3aa0bf411ed9ce39d7cc972e427",

        "Message": "Success",

        "Operation": {

            "Output": {

                "Region": "ap-chongqing",

                "Bucket": "test-123456789",

                "Object": "output/zh.pdf"

            },

            "Translation": {

                "Lang": "en",

                "Type": "txt"

            },

            "UserData": "This is my Translation job.",

            "JobLevel": 0,

        },

        "QueueId": "pbde29b842b1b4e2ea4f0b20d264fcec2",

        "StartTime": "2022-07-25T16:35:39+0800",

        "State": "Success",

        "Tag": "Translation"

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1785 共2247⻚

分词任务回调
最近更新时间：2024-01-20 16:35:12

功能说明

数据万象⽀持⾃定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知内
容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进⾏其他业务操作。

回调内容

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数据

的内容展⽰如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1786 共2247⻚

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Tag>WordsGeneralize</Tag>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>text.txt</Object>

            <BucketId>test-123456789</BucketId>

            <Region>ap-chongqing</Region>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1787 共2247⻚

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my WordsGeneralize job.</UserData>

            <JobLevel>0</JobLevel>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <WordsGeneralizeResult>

                <WordsGeneralizeLable>

                    <Category>交通</Category>

                    <Word>打⻋</Word>

                </WordsGeneralizeLable>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>0</Offset>

                    <Pos>t</Pos>

                    <Word>今天</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>2</Offset>

                    <Pos>v</Pos>

                    <Word>打⻋</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>4</Offset>

                    <Pos>v</Pos>

                    <Word>花</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>5</Offset>

                    <Pos>nx</Pos>

                    <Word>60</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>7</Offset>

                    <Pos>q</Pos>

                    <Word>元</Word>

                </WordsGeneralizeToken>

            </WordsGeneralizeResult>

        </Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1788 共2247⻚

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：
同提交分词任务接⼝中的 Response.JobsDetail 
如果任务是通过⼯作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 Container 数

组。

Container 节点 CosHeaders 的内容：

节点名称（关键字） ⽗节点 描述 类型

Key Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的名称 String

Value Response.JobsDetail.Input.CosHeaders ⾃定义 Header 的值 String

如果任务是通过⼯作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。
Container 节点 Workflow 的内容：

节点名称（关键字） ⽗节点 描述 类型

RunId Response.Workflow ⼯作流实例 ID String

WorkflowId Response.Workflow ⼯作流 ID String

WorkflowName Response.Workflow ⼯作流名称 String

Name Response.Workflow ⼯作流节点名称 String

实际案例

https://www.tencentcloud.com/document/product/1045/49790


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1789 共2247⻚

案例 1：通过任务接⼝触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Tag>WordsGeneralize</Tag>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>text.txt</Object>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1790 共2247⻚

            <BucketId>test-123456789</BucketId>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my WordsGeneralize job.</UserData>

            <JobLevel>0</JobLevel>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <WordsGeneralizeResult>

                <WordsGeneralizeLable>

                    <Category>交通</Category>

                    <Word>打⻋</Word>

                </WordsGeneralizeLable>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>0</Offset>

                    <Pos>t</Pos>

                    <Word>今天</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>2</Offset>

                    <Pos>v</Pos>

                    <Word>打⻋</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>4</Offset>

                    <Pos>v</Pos>

                    <Word>花</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>5</Offset>

                    <Pos>nx</Pos>

                    <Word>60</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>7</Offset>

                    <Pos>q</Pos>

                    <Word>元</Word>

                </WordsGeneralizeToken>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1791 共2247⻚

            </WordsGeneralizeResult>

        </Operation>

    </JobsDetail>

</Response>

案例 2：通过任务触发的任务回调, 格式为 JSON

{

    "Response": {

        "EventName": "TaskFinish",



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1792 共2247⻚

        "JobsDetail": {

            "Code": "Success",

            "CreationTime": "2022-07-25T16:35:39+0800",

            "EndTime": "2022-07-25T16:35:43+0800",

            "Input": {

                "Object": "text.txt",

                "BucketId": "test-123456789",

                "Region": "ap-chongqing"

            },

            "JobId": "ac34be3aa0bf411ed9ce39d7cc972e427",

            "Message": "Success",

            "Operation": {

                "JobLevel": "0",

                "WordsGeneralize": {

                    "NerMethod": "DL",

                    "SegMethod": "MIX"

                },

                "WordsGeneralizeResult": {

                    "WordsGeneralizeLable": {

                        "Category": "交通",

                        "Word": "打⻋"

                    },

                    "WordsGeneralizeToken": [{

                            "Length": "2",

                            "Offset": "0",

                            "Pos": "t",

                            "Word": "今天"

                        },

                        {

                            "Length": "2",

                            "Offset": "2",

                            "Pos": "v",

                            "Word": "打⻋"

                        },

                        {

                            "Length": "1",

                            "Offset": "4",

                            "Pos": "v",

                            "Word": "花"

                        },

                        {

                            "Length": "2",

                            "Offset": "5",

                            "Pos": "nx",

                            "Word": "60"

                        },

                        {



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1793 共2247⻚

                            "Length": "1",

                            "Offset": "7",

                            "Pos": "q",

                            "Word": "元"

                        }

                    ]

                }

            }

        }

    }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1794 共2247⻚

模板接⼝

媒体处理

创建媒体处理模板

创建动图模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建视频转动图模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1795 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1796 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1797 共2247⻚

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <Container>

       <Format>gif</Format>

    </Container>

    <Video>

       <Codec>gif</Codec>

       <Width>1280</Width>

       <Height></Height>

       <Fps>15</Fps>

       <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

       <Start>0</Start>

       <Duration>60</Duration>

    </TimeInterval>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Tag Request 模板类型：Animation String 是

Name Request 模板名称仅⽀持中⽂、英⽂、数字、_、-
和*

String 是

Container Request 容器格式 Container 是

Video Request 视频信息 Container 否

TimeInterval Request 时间区间 Container 否

Request 节点 Container 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

Format Request.Container 容器格式：gif，hgif，webp  hgif 为⾼质量 String 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1798 共2247⻚

gif，即清晰度⽐较⾼的 gif 格式图

Request 节点 Video 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是

否

必

选

默认

值
限制

Codec Request.Video 编解码格式 String 是 ⽆ gif, webp

Width Request.Video 宽 String 否

视频

原

始宽

度

值范围：[12
单位：px
若只设置 W
频原始⽐例计

Height Request.Video ⾼ String 否

视频

原

始⾼

度

值范围：[12
单位：px
若只设置 He
频原始⽐例计

Fps Request.Video 帧率 String 否

视频

原

始帧

率

值范围：(0，
单位：fps
如果不设置，

按照原来的时

置 fps 为动图

AnimateOnly 
KeepKeyFrame

Request.Video

动图只保留

关键帧 。若 
AnimateOnlyKeepKeyFrame 设
置为 true 时，则不考虑 
AnimateTimeIntervalOfFrame、
AnimateFramesPerSecond；若 
AnimateOnlyKeepKeyFrame 设
置为 false 时，则必须填写
AnimateTimeIntervalOfFrame 
或 AnimateFramesPerSecond

String 否 false

true、false
动图保留关键

优先级：

AnimateFram
AnimateOnly
> 
AnimateTim

AnimateTime 
IntervalOfFrame Request.Video

动图抽帧间

隔时间
String 否 ⽆

（0，视频时
动图抽帧时间

若设置 
TimeInterva
于该值

AnimateFrames Request.Video Animation 每秒 String 否 ⽆ （0，视频帧



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1799 共2247⻚

PerSecond 抽帧帧数 动图抽帧频率

优先级：

AnimateFram
AnimateOnly
> 
AnimateTim

Quality Request.Video 设置相对质量 String 否 ⽆

[1, 100)
webp 图像质
没有质量参数

Request 节点 TimeInterval 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选

默认

值
限制

Start Request.TimeInterval 开始时间 String 否 0

[0 视频时⻓]
单位为秒

⽀持 float 格式，
执⾏精度精确到毫

秒

Duration Request.TimeInterval 持续时间 String 否
视频

时⻓

[0 视频时⻓]
单位为秒

⽀持 float 格式，
执⾏精度精确到毫

秒

响应

响应头

该响应包含公共响应头，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1800 共2247⻚

<Response>

    <Template>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Tag>Animation</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>gif</Format>

            </Container>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1801 共2247⻚

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height></Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Response 的具体描述：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response 模板 ID String

Name Response 模板名字 String

BucketId Response 模板所属存储桶 String

Category Response 模板属性，Custom 或者 
Official

String

Tag Response 模板 Tag String

UpdateTime Response 更新时间 String

CreateTime Response 创建时间 String

TransTpl Response 详细的模板参数 Container

TransTpl 节点 Container 的具体数据描述如下：

节点名称（关

键字）

⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1802 共2247⻚

Format Response.TransTpl.Container 容器格式： gif，hgif，webp  hgif 为⾼质量 
gif，即清晰度⽐较⾼的 gif 格式图

String

TransTpl 节点 Video 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型

Codec Response.TransTpl.Video 编解码格式 String

Width Response.TransTpl.Video 宽 String

Height Response.TransTpl.Video ⾼ String

Fps Response.TransTpl.Video 帧率 String

AnimateOnlyKeepKeyFrame Response.TransTpl.Video 动图只保留关键帧 String

AnimateTimeIntervalOfFrame Response.TransTpl.Video 动图抽帧间隔时间 String

AnimateFramesPerSecond Response.TransTpl.Video Animation 每秒抽帧
帧数

String

Quality Response.TransTpl.Video 设置相对质量 String

TransTpl 节点 TimeInterval 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型

Start Response.TransTpl.TimeInterval 开始时间 String

Duration Response.TransTpl.TimeInterval 持续时间 String

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1803 共2247⻚

POST /template HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <Container>

       <Format>gif</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1804 共2247⻚

    </Container>

    <Video>

       <Codec>gif</Codec>

       <Width>1280</Width>

       <Height></Height>

       <Fps>15</Fps>

       <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

       <Start>0</Start>

       <Duration>60</Duration>

    </TimeInterval>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1805 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYz****=

<Response>

    <Template>

        <Name>TemplateName</Name>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1806 共2247⻚

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Tag>Animation</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>gif</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height></Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1807 共2247⻚

创建拼接模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建拼接模板。

请求

请求实例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1808 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1809 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

公共头部

该请求操作的实现使⽤公共请求头，了解公共请求头详情请参⻅ 公共请求头部 ⽂档。

⾮公共头部

该请求操作⽆特殊的请求头部信息。

请求体

该请求操作的实现需要有如下请求体。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1810 共2247⻚

<Request>

    <Tag>Concat</Tag>

    <Name>TemplateName</Name>

    <ConcatTemplate>

        <ConcatFragment>

            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Ur

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1811 共2247⻚

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMix>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</Au

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMix>

    </ConcatTemplate>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 必选

Tag Request 模板类型：Concat String 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1812 共2247⻚

Name Request 模板名称仅⽀持中⽂、英⽂、数

字、_、-和*
String 是

ConcatTemplate Request 拼接模板 Container 是

Container 类型 ConcatTemplate 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

必

选

默认

值
限制

ConcatFragment Request.ConcatTemplate 拼接节点
Container 
数组

是 ⽆ ⽆

Audio Request.ConcatTemplate ⾳频参数 Container 否

媒体

原始

值

⽬标⽂件不需

要 Audio 信
息，需要设置 
Audio.Remove 
为 true

Video Request.ConcatTemplate 视频参数 Container 否

媒体

原始

值

⽬标⽂件不需

要 Video 信
息，需要设置 
Video.Remove 
为 true

Container Request.ConcatTemplate 封装格式 Container 是 ⽆ ⽆

AudioMix Request.ConcatTemplate

混⾳参

数, 详情
⻅ 
AudioMix 

Container 
数组

否 ⽆

仅在 
Audio.Remove 
为 false 时⽣效

DirectConcat Request.ConcatTemplate 只拼接不

转码
String 否 false true/ false

Container 数组 类型 ConcatFragment 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型
必

选

默

认

值

限制

Url Request.ConcatTemplate.ConcatFragment 拼接对

象地址
String 是 ⽆

同 bucket 
对象⽂件

Mode Request.ConcatTemplate.ConcatFragment 节点类

型

String 是 ⽆ Start：开
头 

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1813 共2247⻚

End：结
尾

Container 类型 Audio 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型 必选 默认值 限制

Codec Request.ConcatTemplate.Audio
编解

码格

式

String 是
⽂件原

编码
取值 aac、mp3

Samplerate Request.ConcatTemplate.Audio 采样

率
String 否

⽂件原

采样率

单位：Hz
可选 11025、
22050、32000、
44100、48000、
96000
不同的封装，mp3 
⽀持不同的采样

率，如下表所⽰

Bitrate Request.ConcatTemplate.Audio
⾳频

码率
String 否

⽂件原

⾳频码

率

单位：Kbps
值范围：[8，
1000]

Channels Request.ConcatTemplate.Audio
声道

数
String 否

⽂件原

声道数

当 Codec 设置为 
aac，⽀持1、2、
4、5、6、8
当 Codec 设置为 
mp3，⽀持1、2

Y 表⽰⽀持这种采样率，N 表⽰不⽀持。

封装格式/⾳频采样率 11025 22050 32000 44100 48000 96000

mp3 Y Y Y Y Y N

Container 类型 Container 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 必选

Format Request.ConcatTemplate.Container 容器格式：mp4，flv，hls，ts, 
mp3, aac

String 是
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Container 类型 Video 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型
必

选
默认值 限制

Codec Request.ConcatTemplate.Video 编解码

格式
String 是 H.264 H.264

Width Request.ConcatTemplate.Video 宽 String 否
视频原始

宽度

值范围：

[128，4096]
单位：px
若只设置 
Width 时，按
照视频原始

⽐例计算 
Height

Height Request.ConcatTemplate.Video ⾼ String 否
视频原始

⾼度

值范围：

[128，4096]
单位：px
若只设置 
Height 时，
按照视频原

始⽐例计算 
Width

Fps Request.ConcatTemplate.Video 帧率 String 否
视频原始

帧率

值范围：

(0，60]
单位：fps

Bitrate Request.ConcatTemplate.Video
视频输

出⽂件

的码率

String 否
视频原始

码率

值范围：

[10，50000]
单位：Kbps

Crf Request.ConcatTemplate.Video
码率-质
量控制

因⼦

String 否
视频原始

码率

值范围：(0, 
51]
如果设置了 
Crf，则 
Bitrate 的设
置失效

当 Bitrate 为
空时，默认

为25

Remove Request.ConcatTemplate.Video 是否删 String 否 false 取值 true、
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除视频

流

false

Rotate Request.ConcatTemplate.Video
旋转⾓

度
String 否 ⽆

值范围：[0, 
360)
单位：度

响应

响应头

公共响应头

该响应包含公共响应头，了解公共响应头详情请参⻅ 公共响应头部 ⽂档。

特有响应头

该响应⽆特殊的响应头。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610
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<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4
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            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：
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节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 Official String

Tag Response.Template 模板类型，Concat String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

ConcatTemplate Response.Template 同请求体中的 Request.ConcatTemplate Container

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353
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POST /template HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

   <Tag>Concat</Tag>

   <Name>TemplateName</Name>

   <ConcatTemplate>

        <ConcatFragment>
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            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Ur

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMix>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</Au

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMix>

   </ConcatTemplate>

</Request>

响应
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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创建极速⾼清转码模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建极速⾼清转码模板。

请求

请求⽰例
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：
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Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1827 共2247⻚

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选
限制

Tag Request 模板类型: HighSpeedHd String 是 ⽆

Name Request 模板名称。仅⽀持中⽂、英⽂、数字、

_、-和*
String 是 ⽆
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Container Request 容器格式 Container 是 ⽆

Video Request 视频信息 Container 是 ⽆

TimeInterval Request 时间区间 Container 否 ⽆

Audio Request ⾳频信息 Container 否 ⽆

TransConfig Request 转码配置 Container 否 ⽆

Container 类型 Container 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型 是否必选

Format Request.Container 容器格式: mp4，flv，hls，mkv String 是

ClipConfig Request.Container 分⽚配置, 当Format为hls时有
效

Container 否

Container 类型 ClipConfig 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Duration Request.Container.ClipConfig 分⽚时⻓, 默认
5s

String 否

设定 container，⾳频视频⽀持的格式如下表：

Container Audio Codecs Video Codecs

mp4/hls/mkv AAC、MP3 H.264、H.265

flv AAC、MP3 H.264

Container 类型 Video 的具体数据描述如下：

节点名

称（关

键字）

⽗节点 描述 类型
是否必

选
默认值 限制

Codec Request.Video 编解码格式 String 否 H.264 H.264、H.265

Width Request.Video 宽 String 否 视频原

始宽度

值范围：[128，4096]
单位：px
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若只设置 Width 时，按
照视频原始⽐例计算 
Height
必须为偶数

Height Request.Video ⾼ String 否
视频原

始⾼度

值范围：[128，4096]
单位：px
 若只设置 Height 时，
按照视频原始⽐例计算 
Width 4. 必须为偶数

Fps Request.Video 帧率 String 否 ⽆
值范围：(0，60]
单位：fps

Profile Request.Video 编码级别 String 否 high

⽀持 baseline、main、
high
baseline：适合移动设
备；

main：适合标准分辨率
设备；

high：适合⾼分辨率设
备;
仅H.264⽀持此参数。

Bitrate Request.Video 视频输出⽂件的

码率
String 否 ⽆

值范围：[10，50000]
单位：Kbps

Crf Request.Video
码率-质量控制
因⼦

String 否 ⽆

值范围：(0，51]
如果设置了 Crf，则 
Bitrate 的设置失效
当 Bitrate 为空时，默认
为25

Gop Request.Video 关键帧间最⼤帧

数
String 否 ⽆ 值范围：[0, 100000]

Preset Request.Video 视频算法器预置 String 否 medium
仅H.264⽀持该参数
取值 veryfast、fast、
medium、slow、slower

Bufsize Request.Video 缓冲区⼤⼩ String 否 ⽆

值范围：[1000，
128000]
单位：Kb

Maxrate Request.Video 视频码率峰值 String 否 ⽆
值范围：[10，50000]
单位：Kbps



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1830 共2247⻚

Pixfmt Request.Video 视频颜⾊格式 String 否 ⽆ H.264⽀持：yuv420p、
auto
H.265⽀持：yuv420p、
yuv420p10le、auto

Rotate Request.Video 旋转⾓度 String 否 ⽆
值范围：[0, 360)
单位：度

Container 类型 TimeInterval 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是

否

必

选

默认

值
限制

Start Request.TimeInterval 开始时

间
String 否 ⽆

[0 视频时⻓]
单位为秒

⽀持 float 格式，执⾏精度精
确到毫秒

Duration Request.TimeInterval 持续时

间
String 否 ⽆

[0 视频时⻓]
单位为秒

⽀持 float 格式，执⾏精度精
确到毫秒

Container 类型 Audio 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否必

选

默认

值
限制

Codec Request.Audio 编解码格式 String 否 aac 取值 aac、mp3

Samplerate Request.Audio 采样率 String 否 44100

单位：Hz
可选 11025、22050、
32000、44100、48000、
96000
不同的封装，mp3 ⽀持不
同的采样率，如下表所⽰

Bitrate Request.Audio 原始⾳频码

率
String 否 ⽆

单位：Kbps
值范围：[8，1000]

Channels Request.Audio 声道数 String 否 ⽆ 当 Codec 设置为 aac，⽀
持1、2、4、5、6、8
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当 Codec 设置为 mp3，⽀
持1、2

Remove Request.Audio 是否删除源

⾳频流
String 否 false 取值 true、false

说明：

 Y 表⽰⽀持这种采样率，N 表⽰不⽀持。

封装格式/⾳频采样率 11025 22050 32000 44100 48000 96000

flv N Y N Y N N

mp4 N Y Y Y Y N

hls/mkv Y Y Y Y Y N

Container 类型 TransConfig 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型

是

否

必

选

默认

值
限制

AdjDarMethod Request.TransConfig 分辨率调

整⽅式
String 否 none

取值 scale、crop
pad、none
当输出视频的宽⾼

与原视频不等时，

据此参数做分辨率

相应调整

IsCheckReso Request.TransConfig
是否检查

分辨率
String 否 false

true、false
当为 false 时，按
配置参数转码

ResoAdjMethod Request.TransConfig
分辨率调

整⽅式
String 否 0

取值0、1；0 表⽰
⽤原视频分辨率

表⽰返回转码失败

 当 IsCheckReso
true 时⽣效

IsCheckVideoBitrate Request.TransConfig
是否检查

视频码率
String 否 false

true、false
当为 false 时，按
配置参数转码
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VideoBitrateAdjMethod Request.TransConfig 视频码率

调整⽅式

String 否 0 取值0、1；当输
视频码率⼤于原视

码率时，0表⽰使
原视频码率；1表
返回转码失败

当 
IsCheckVideoBit
为 true 时⽣效

IsCheckAudioBitrate Request.TransConfig
是否检查

⾳频码率
String 否 false

true、false
当为 false 时，按
配置参数转码

AudioBitrateAdjMethod Request.TransConfig ⾳频码率

调整⽅式
String 否 0

取值0、1；当输
⾳频码率⼤于原⾳

码率时，0 表⽰使
原⾳频码率；1表
返回转码失败

当 
IsCheckAudioBit
为 true 时⽣效

IsCheckVideoFps Request.TransConfig
是否检查

视频帧率
String 否 false

true、false
当为 false 时，按
配置参数转码

VideoFpsAdjMethod Request.TransConfig
视频帧率

调整⽅式
String 否 0

取值0、1；当输
视频帧率⼤于原视

帧率时，0表⽰使
原视频帧率；1表
返回转码失败

当 IsCheckVideo
为 true 时⽣效

DeleteMetadata Request.TransConfig

是否删除

⽂件中的 
MetaData 
信息

String 否 false
true、false
当为 false 时, 保留
源⽂件信息

IsHdr2Sdr Request.TransConfig
是否开启 
HDR 转 
SDR

String 否 false true/false

HlsEncrypt Request.TransConfig hls 加密
配置

Container 否 ⽆ ⽆
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AdjDarMethod 参数图⽰：

Container 类型 HlsEncrypt 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

必

选

默认

值
限制

IsHlsEncrypt Request.TransConfig.HlsEncrypt

是否

开启

HLS
加密

String 否 false
true/false
当Container.Format
为hls时⽀持加密

UriKey Request.TransConfig.HlsEncrypt HLS
加密

String 否 ⽆ 当IsHlsEncrypt为
true时, 该参数才有
意义



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1834 共2247⻚

的

key

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1835 共2247⻚

<Response>

    <Template>

        <Tag>HighSpeedHd</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1836 共2247⻚

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 
Official

String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1837 共2247⻚

Tag Response.Template 模板类型，

HighSpeedHd
String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

HighSpeedHd Response.Template 详细的模板参数 Container

Container 节点 HighSpeedHd 的内容：

节点名称（关键

字）
⽗节点 描述 类型

TimeInterval Response.Template.HighSpeedHd 同请求体中的 
Request.TimeInterval

Container

Container Response.Template.HighSpeedHd 同请求体中的 
Request.Container

Container

Video Response.Template.HighSpeedHd 同请求体中的 
Request.Video

Container

Audio Response.Template.HighSpeedHd 同请求体中的 
Request.Audio

Container

TransConfig Response.Template.HighSpeedHd 同请求体中的 
Request.TransConfig

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1838 共2247⻚

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1839 共2247⻚

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1840 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>HighSpeedHd</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1841 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1842 共2247⻚

创建截图模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建截图模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1843 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1844 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。 

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1845 共2247⻚

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Tag Request 模板类型：Snapshot String 是

Name Request 模板名称仅⽀持中⽂、英⽂、数字、_、-
和*

String 是

Snapshot Request 截图 Container 是

Container 类型 Snapshot 的具体数据描述如下：

节点名称（关键字） ⽗节点
描

述
类型

是

否

必

选

默认值 限制

Mode Request.Snapshot 截 String 否 Interval 值范围：{Interval, 



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1846 共2247⻚

图

模

式

Average, KeyFrame
Interval 表⽰间隔模
Average 表⽰平均模
KeyFrame 表⽰关键
模式

Interval模式：Start
TimeInterval， 
Count参数⽣效。当
置Count，未设置
TimeInterval时， 
表⽰截取所有帧，共

Count张图⽚
Average模式：Star
Count参数⽣效。表
从Start开始到视频结
束，按平均间隔截取

Count张图⽚

Start Request.Snapshot

开

始

时

间

String 否 0

[0 视频时⻓]
单位为秒

⽀持 float 格式，执
度精确到毫秒

TimeInterval Request.Snapshot

截

图

时

间

间

隔

String 否 ⽆

(0 3600]
单位为秒

⽀持 float 格式，执
度精确到毫秒

Count Request.Snapshot

截

图

数

量

String 是 ⽆ (0 10000]

Width Request.Snapshot 宽 String 否
视频原

始宽度

值范围：[128，409
单位：px
若只设置 Width 时，
照视频原始⽐例计算

Height

Height Request.Snapshot ⾼ String 否
视频原

始⾼度

值范围：[128，409
单位：px
若只设置 Height 时
照视频原始⽐例计算

Width



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1847 共2247⻚

CIParam Request.Snapshot 截

图

图

⽚

处

理

参

数

String 否 ⽆ 参考 图⽚处理 
例如: 
imageMogr2/forma

IsCheckCount Request.Snapshot

是

否

强

制

检

查

截

图

个

数

String 否 false

使⽤⾃定义间隔模式

图时，视频时⻓不够

取 Count 个截图，可
转为平均截图模式截

Count 个截图

IsCheckBlack Request.Snapshot

是

否

开

启

⿊

屏

检

测

String 否 false true/false

BlackLevel Request.Snapshot

截

图

⿊

屏

检

测

参

数

String 否 空

当 IsCheckBlack=tr
时有效

值参考范围[30，10
表⽰⿊⾊像素的占⽐

值，值越⼩，⿊⾊占

越⼩

Start>0，参数设置
效，不做过滤⿊屏

Start =0 参数有效，
帧的开始时间为第⼀

⾮⿊屏开始

PixelBlackThreshold Request.Snapshot 截

图

⿊

屏

检

String 否 空 当IsCheckBlack=tr
有效

判断像素点是否为⿊

点的阈值，取值范围

[0，255]

https://www.tencentcloud.com/document/product/1045/33713


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1848 共2247⻚

测

参

数

SnapshotOutMode Request.Snapshot

截

图

输

出

模

式

参

数

String 否 OnlySnapshot

值范围：

{OnlySnapshot, 
OnlySprite, 
SnapshotAndSprite
OnlySnapshot 表⽰
出截图模式 OnlySp
表⽰仅输出雪碧图模

SnapshotAndSprite
⽰输出截图与雪碧图

式

SpriteSnapshotConfig Request.Snapshot

雪

碧

图

输

出

配

置

Container 否 ⽆ ⽆

Container 类型 Snapshot.SpriteSnapshotConfig 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型
必

选

默

认

值

限制

CellWidth Request.Snapshot.SpriteSnapshotConfig 单图宽

度
String 否

截

图

宽

度

值范围：

[8，4096]
单位：px

CellHeight Request.Snapshot.SpriteSnapshotConfig 单图⾼

度
String 否

截

图

⾼

度

值范围：

[8，4096]
单位：px

Padding Request.Snapshot.SpriteSnapshotConfig
雪碧图

内边距

⼤⼩

String 否 0
值范围：

[0，1024]
单位：px

Margin Request.Snapshot.SpriteSnapshotConfig
雪碧图

外边距

⼤⼩

String 否 0
值范围：

[0，1024]
单位：px



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1849 共2247⻚

Color Request.Snapshot.SpriteSnapshotConfig 背景颜

⾊

String 是 ⽆ ⽀持颜⾊详

⻅ FFmpeg 

Columns Request.Snapshot.SpriteSnapshotConfig 雪碧图

列数
String 是 0 值范围：

[1，10000]

Lines Request.Snapshot.SpriteSnapshotConfig 雪碧图

⾏数
String 是 0 值范围：

[1，10000]

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.ffmpeg.org/ffmpeg-utils.html#color-syntax
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1850 共2247⻚

<Response>

    <Template>

        <Tag>Snapshot</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1851 共2247⻚

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

Tag Response 模板类型，Snapshot String

Name Response 模板名字 String

TemplateId Response 模板 ID String

UpdateTime Response 更新时间 String

CreateTime Response 创建时间 String

Snapshot Response 详细的模板参数，同上述请求体部分 Snapshot 说明 Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1852 共2247⻚

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1853 共2247⻚

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1854 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <Tag>Snapshot</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1855 共2247⻚

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1856 共2247⻚

创建超分辨率模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建超分辨率模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1857 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1858 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1859 共2247⻚

    <Tag>SuperResolution</Tag>

    <Name>TemplateName</Name>

    <Resolution>sdtohd</Resolution>

    <EnableScaleUp>true</EnableScaleUp>

    <Version>Enhance</Version>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选
限制

Tag Request 模板类型：

SuperResolution
String 是 ⽆

Name Request 模板名称：仅⽀持中⽂、

英⽂、数字、_、-和*
String 是 ⽆

Resolution Request 分辨率选项 String 是

sdtohd：标清到超
清

hdto4k：⾼清到4K

EnableScaleUp Request ⾃动缩放开关，默认关闭 String 否 true、false

Version Request 版本，默认值 Base String 否
Base：基础版
Enhance：增强版

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据, 包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1860 共2247⻚

<Response>

    <Template>

        <Tag>SuperResolution</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1861 共2247⻚

        </SuperResolution>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 
Official

String

Tag Response.Template 模板类型，

SuperResolution
String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

SuperResolution Response.Template 详细的模板参数 Container

Container 节点 SuperResolution 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Resolution Response.Template.SuperResolution 同请求体中的 Request.Resolution String

EnableScaleUp Response.Template.SuperResolution 同请求体中的 
Request.EnableScaleUp

String

错误码



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1862 共2247⻚

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1863 共2247⻚

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SuperResolution</Tag>

    <Name>TemplateName</Name>

    <Resolution>sdtohd</Resolution>

    <EnableScaleUp>true</EnableScaleUp>

    <Version>Enhance</Version>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1864 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>SuperResolution</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1865 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1866 共2247⻚

创建⾳视频转码模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建⾳视频转码模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1867 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1868 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1869 共2247⻚

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Audio

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Audio

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1870 共2247⻚

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是

否

必

选

限制

Tag Request 模板类型：Transcode String 是 ⽆

Name Request 模板名称，仅⽀持中⽂、英⽂、数

字、_、-和*
String 是 ⽆

Container Request 容器格式 Container 是 ⽆

Video Request 视频信息 Container 否

不传 Video，
相当于删除视

频信息

TimeInterval Request 时间区间 Container 否 ⽆

Audio Request ⾳频信息 Container 否

不传 Audio，
相当于删除⾳

频信息

TransConfig Request 转码配置 Container 否 ⽆

AudioMix Request 混⾳参数，详情⻅ AudioMix Container 否

Audio.Remove 
为 false 时⽣
效

AudioMixArray Request 混⾳参数, 最多同时传2个。详情⻅ Container 否 Audio.Remove 

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1871 共2247⻚

AudioMixArray 数组 为 false 时⽣
效

Container 类型 Container 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Format Request.Container 封装格式：取值⻅下表 String 是

ClipConfig Request.Container 分⽚配置，当 format 为 hls 和 dash 
时有效

Container 否

Container 类型 ClipConfig 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型 是否必选

Duration Request.Container.ClipConfig 分⽚时⻓，默认5s String 否

设定 container，⾳频视频⽀持的格式如下表所⽰：

Container Audio Codecs Video Codecs

mp4/hls/mkv aac、mp3 H.264、H.265、AV1

hls/mkv aac、mp3 H.264、H.265

ts/flv/avi/mov aac、mp3 H.264

dash aac H.264

WebM Vorbis、opus VP8、VP9、AV1

aac aac 不⽀持

mp3 mp3 不⽀持

flac flac 不⽀持

amr amr 不⽀持

adts aac 不⽀持

m4a aac 不⽀持

wav pcm_s16le 不⽀持

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1872 共2247⻚

Container 类型 Video 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是

否

必

选

默认值 限制

Codec Request.Video
编解

码格

式

String 否

H.264
当 format 
为 WebM 
时，为 VP8

H.264
H.265
VP8
VP9
AV1

Width Request.Video 宽 String 否
视频原始宽

度

值范围：[128, 4096]
单位：px
若只设置 Width 时，按照视
频原始⽐例计算 Height
必须为偶数

Height Request.Video ⾼ String 否
视频原始⾼

度

值范围：[128, 4096]
单位：px
若只设置 Height 时，按照
视频原始⽐例计算 Width
必须为偶数

Fps Request.Video 帧率 String 否 ⽆
值范围：(0, 60]
单位：fps

Remove Request.Video

是否

删除

视频

流

String 否 false true、false

Profile Request.Video 编码

级别
String 否 high

⽀持 baseline、main、
high、auto
当 Pixfmt 为 auto 时，该参
数仅能设置为 auto，当设置
为其他选项时，参数值将被

设置为 auto
baseline：适合移动设备
main：适合标准分辨率设备
high：适合⾼分辨率设备
仅H.264⽀持此参数

Bitrate Request.Video 视频

输出

String 否 ⽆ 值范围：[10, 50000], 单
位：Kbps



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1873 共2247⻚

⽂件

的码

率

auto 表⽰⾃适应码率

Crf Request.Video

码率-
质量

控制

因⼦

String 否 ⽆

值范围：(0, 51]
如果设置了 Crf，则 Bitrate 
的设置失效

当 Bitrate 为空时，默认为
25

Gop Request.Video

关键

帧间

最⼤

帧数

String 否 ⽆ 值范围：[1, 100000]

Preset Request.Video

视频

算法

器预

置

String 否

当 Codec 
为 H.264 
时, 为
medium
当 Codec 
为 VP8 
时，为 
good
当 Codec 
为 AV1 
时，为 5

H.264⽀持该参数，取值 
veryfast、fast、medium、
slow、slower
VP8 ⽀持该参数，取值 
good、realtime
AV1 ⽀持该参数，取值5
（推荐值）、4
H.265 和 VP9 不⽀持该参
数

Bufsize Request.Video
缓冲

区⼤

⼩

String 否 ⽆

值范围：[1000, 128000]
单位：Kb
Codec 为 VP8/VP9时不⽀
持此参数

Maxrate Request.Video
视频

码率

峰值

String 否 ⽆

值范围：[10, 50000]
单位：Kbps
Codec 为 VP8/VP9时不⽀
持此参数

Pixfmt Request.Video
视频

颜⾊

格式

String 否 ⽆

H.264⽀持：yuv420p、
yuv422p、yuv444p、
yuvj420p、yuvj422p、
yuvj444p、auto
H.265⽀持：yuv420p、
yuv420p10le、auto
Codec 为 VP8/VP9/AV1 时
不⽀持此参数

LongShortMode Request.Video ⻓短 String 否 false true、false



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1874 共2247⻚

边⾃

适应

Codec 为 VP8/VP9/AV1 时
不⽀持此参数

Rotate Request.Video 旋转

⾓度
String 否 ⽆

值范围：[0, 360)
单位：度

Container 类型 TimeInterval 的具体数据描述如下：

节点名

称（关

键字）

⽗节点 描述 类型

是

否

必

选

默认值 限制

Start Request.TimeInterval 开始时

间
String 否 0

[0 视频时⻓]
单位为秒

⽀持 float 格式，执⾏精度
精确到毫秒

Duration Request.TimeInterval 持续时

间
String 否

视频原始

时⻓

[0 视频时⻓]
单位为秒

⽀持 float 格式，执⾏精度
精确到毫秒

Container 类型 Audio 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是

否

必

选

默认值 限制

Codec Request.Audio
编解

码格

式

String 否

aac
当 format 
为 WebM 
时，为 
Vorbis
当 format 
为 wav 
时，为 
pcm_s16le

取值 aac、mp3、flac、
amr、Vorbis、opus、
pcm_s16le

Samplerate Request.Audio 采样

率

String 否 44100，当 
Codec 为 
opus 时，

单位：Hz
可选 8000、11025、
12000、16000、22050、



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1875 共2247⻚

默认值为

48000
24000、32000、44100、
48000、88200、96000
不同的封装，mp3 ⽀持不
同的采样率，如下表所⽰

当 Codec 设置为 amr 时，
只⽀持8000
当 Codec 设置为 opus 时，
⽀持8000，16000，
24000，48000

Bitrate Request.Audio
原始

⾳频

码率

String 否 ⽆
单位：Kbps
值范围：[8，1000]

Channels Request.Audio
声道

数
String 否 ⽆

当 Codec 设置为 aac/flac，
⽀持1、2、4、5、6、8
当 Codec 设置为 mp3/opus 
时，⽀持1、2
当 Codec 设置为 Vorbis 
时，只⽀持2
当 Codec 设置为 amr，只
⽀持1
当 Codec 设置为 
pcm_s16le 时，只⽀持1、
2
当封装格式为 dash 时，不
⽀持8

Remove Request.Audio

是否

删除

源⾳

频流

String 否 false 取值 true、false

KeepTwoTracks Request.Audio
保持

双⾳

轨

String 否 false
取值 true、false。 当 
Video.Codec 为 H.265时，
此参数⽆效

SwitchTrack Request.Audio
转换

轨道
String 否 false

取值 true、false。 当 
Video.Codec 为 H.265时，
此参数⽆效

SampleFormat Request.Audio 采样

位宽

String 否 ⽆ 当 Codec 设置为 aac，⽀
持 fltp
当 Codec 设置为 mp3，⽀
持 fltp、s16p、s32p



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1876 共2247⻚

当 Codec 设置为 flac，⽀
持 s16、s32、s16p、s32p
当 Codec 设置为 amr，⽀
持 s16、s16p
当 Codec 设置为 opus，⽀
持 s16
当 Codec 设置为 
pcm_s16le，⽀持 s16
当 Codec 设置为 Vorbis，
⽀持 fltp
当 Video.Codec 为 H.265 
时，此参数⽆效

说明：

 Y 表⽰⽀持这种采样率，N 表⽰不⽀持。
Audio.Codec 采样率⽀持情况，如下表所⽰：

Audio.Codec      aac      amr      flac      opus      Vorbis      pcm_s16le      mp3   

8000 Y Y Y Y Y Y

封装不同，

⽀持不同

11025 Y N Y N Y Y

12000 Y N Y N Y Y

16000 Y N Y Y Y Y

22050 Y N Y N Y Y

24000 Y N Y Y Y Y

32000 Y N Y N Y Y

44100 Y N Y N Y Y

48000 Y N Y Y Y Y

88200 Y N Y N Y Y

96000 Y N Y N Y Y

当 Audio.Codec 为 mp3 时，Container.Format 的采样率兼容情况如下所⽰：

封装格式/⾳频采样率 8000 11025 12000 16000 22050 24000 32000 44100 4



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1877 共2247⻚

flv N N N N Y N N Y N

mp4 N N N Y Y Y Y Y Y

hls/ts/mp3/mkv/avi/mov Y Y Y Y Y Y Y Y Y

Container 类型 TransConfig 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型

AdjDarMethod Request.TransConfig 分辨率调整⽅式 String

IsCheckReso Request.TransConfig 是否检查分辨率 String

ResoAdjMethod Request.TransConfig 分辨率调整⽅式 String

IsCheckVideoBitrate Request.TransConfig 是否检查视频码率 String

VideoBitrateAdjMethod Request.TransConfig 视频码率调整⽅式 String

IsCheckAudioBitrate Request.TransConfig 是否检查⾳频码率 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1878 共2247⻚

AudioBitrateAdjMethod Request.TransConfig ⾳频码率调整⽅式 String

IsCheckVideoFps Request.TransConfig 是否检查视频帧率 String

VideoFpsAdjMethod Request.TransConfig 视频帧率调整⽅式 String

DeleteMetadata Request.TransConfig 是否删除⽂件中的 MetaData 信息 String

IsHdr2Sdr Request.TransConfig 是否开启 HDR 转 SDR String

TranscodeIndex Request.TransConfig

指定处理的流编号，对应媒体信息中的 
Response.MediaInfo.Stream.Video.Index 
和 
Response.MediaInfo.Stream.Audio.Index，
详⻅ 获取媒体信息接⼝ 

String

HlsEncrypt Request.TransConfig hls 加密配置 Container

DashEncrypt Request.TransConfig dash 加密配置 Container

AdjDarMethod 参数图⽰：

https://www.tencentcloud.com/document/product/1045/43732


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1879 共2247⻚

Container 类型 HlsEncrypt 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是

否

必

选

默认

值
限制

IsHlsEncrypt Request.TransConfig.HlsEncrypt

是否

开启 
HLS 
加密

String 否 false

rue/false
当 
Container.Format 
为 hls 时⽀持加密 

UriKey Request.TransConfig.HlsEncrypt

HLS 
加密

的 
key

String 否 ⽆

当 IsHlsEncrypt 
为 true 时，该参
数才有意义



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1880 共2247⻚

Container 类型 DashEncrypt 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是

否

必

选

默认

值
限制

IsEncrypt Request.TransConfig.DashEncrypt

是否

开启 
DASH 
加密

String 否 false

 true/false
当 
Container.Format 
为 dash 时⽀持加
密

UriKey Request.TransConfig.DashEncrypt
DASH 
加密

的 key
String 否 ⽆

当 IsEncrypt 为 
true 时，该参数
才有意义

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1881 共2247⻚

<Response>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1882 共2247⻚

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1883 共2247⻚

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 
Official

String

Tag Response.Template 模板类型，Transcode String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

TransTpl Response.Template 详细的模板参数 Container

Container节点TransTpl的内容：

节点名称（关键

字）
⽗节点 描述 类型

TimeInterval Response.Template.TransTpl 同请求体中的 Request.TimeInterval Container

Container Response.Template.TransTpl 同请求体中的 Request.Container Container

Video Response.Template.TransTpl 同请求体中的 Request.Video Container

Audio Response.Template.TransTpl 同请求体中的 Request.Audio Container

TransConfig Response.Template.TransTpl 同请求体中的 Request.TransConfig Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1884 共2247⻚

AudioMix Response.Template.TransTpl 同请求体中的 Request.AudioMix Container

AudioMixArray Response.Template.TransTpl 同请求体中的 
Request.AudioMixArray

Container 数组

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1885 共2247⻚

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1886 共2247⻚

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Audio

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Audio

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1887 共2247⻚

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1888 共2247⻚

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1889 共2247⻚

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1890 共2247⻚

创建转码 pro 模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建转码 pro 模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1891 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1892 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1893 共2247⻚

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选
限制

Tag Request 模板类型：TranscodePro String 是 ⽆

Name Request 模板名称 仅⽀持中⽂、英⽂、数
字、_、-和*

String 是 ⽆



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1894 共2247⻚

Container Request 容器格式 Container 是 ⽆

Video Request 视频信息 Container 是 ⽆

TimeInterval Request 时间区间 Container 否 ⽆

Audio Request ⾳频信息 Container 否

不传 Audio，
相当于删除⾳

频信息

TransConfig Request 转码配置 Container 否 ⽆

Container 类型 Container 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型 是否必选

Format Request.Container 容器格式：mxf、mov、mkv String 是

设定 container，⾳频视频⽀持的格式如下表：

Container Audio Codecs Video Codecs

mxf pcm_s24le xavc

mov、mkv aac、mp3 apple_prores

Container 类型 Video 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选
默认值 限制

Codec Request.Video 编解码格式 String 是 ⽆ xavc、apple_prores

Profile Request.Video 视频算法器预

置
String 是 ⽆ 取值范围⻅下表

Width Request.Video 宽 String 是 ⽆ 取值范围⻅下表

Height Request.Video ⾼ String 是 ⽆ 取值范围⻅下表

Interlaced Request.Video 场模式 String 是 ⽆ 取值范围⻅下表

Fps Request.Video 帧率 String 是 ⽆ 取值范围⻅下表

Bitrate Request.Video 视频输出⽂件

的码率
String 否 ⽆ 取值范围⻅下表



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1895 共2247⻚

Rotate Request.Video 旋转⾓度 String 否 ⽆ 1. 值范围：[0, 360)
2. 单位：度

视频参数约束表:
注：'-' 表⽰留空。码率可选值与帧率可选值序号对应。
当 Video.Codec 为 xavc 时：

Profile Width Height Interlaced Fps Bitrate(单位:kbps)

XAVC-
HD_intra_420_10bit_class50 1440 1080 true

1、25 
2、
30000/1001

-

XAVC-
HD_intra_420_10bit_class50 1440 1080 false

1、25 
2、
24000/1001 
3、
30000/1001

-

XAVC-
HD_intra_422_10bit_class100 1280 720 false

1、50 
2、
60000/1001

-

XAVC-
HD_intra_422_10bit_class100 1920 1080 true

1、25 
2、
30000/1001

-

XAVC-
HD_intra_422_10bit_class100

1920 1080 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

-

XAVC-
HD_intra_422_10bit_class200 1920 1080 true

1、25 
2、
30000/1001

-

XAVC-
HD_intra_422_10bit_class200

1920 1080 false 1、25 
2、50 
3、
24000/1001 
4、
30000/1001 

-



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1896 共2247⻚

5、
60000/1001

XAVC-
4K_intra_422_10bit_class100

2048 1080 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

-

XAVC-
4K_intra_422_10bit_class300

3840 2160 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

-

XAVC-
4K_intra_422_10bit_class300

4096 2160 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

-

XAVC-
4K_intra_422_10bit_class480

3840 2160 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

-

XAVC-
4K_intra_422_10bit_class480

4096 2160 false 1、25 
2、50 
3、
24000/1001 
4、
30000/1001 

-



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1897 共2247⻚

5、
60000/1001

XAVC-4K_intra_422_10bit 2048 1080 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

1、93000 
2、185000 
3、89000 
4、111000 
5、222000

XAVC-4K_intra_422_10bit 3840 2160 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

1、250000或400000 
2、500000或800000 
3、240000或384000 
4、300000或480000 
5、600000或960000

XAVC-4K_intra_422_10bit 4096 2160 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

1、250000或400000 
2、500000或800000 
3、240000或384000 
4、300000或480000 
5、600000或960000

XAVC-HD_422_10bit 1280 720 false
1、50 
2、
60000/1001

1、50000 
2、50000

XAVC-HD_422_10bit 1920 1080 true
1、25 
2、
30000/1001

1、25000或35000或
50000 
2、25000或35000或
50000

XAVC-HD_422_10bit 1920 1080 false 1、25 
2、50 
3、
24000/1001 
4、
30000/1001 

1、25000或35000或
50000 
2、35000或50000 
3、25000或35000或
50000 
4、25000或35000或



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1898 共2247⻚

5、
60000/1001

50000 
5、35000或50000

XAVC-4K_422_10bit 3840 2160 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

1、100000或140000或
200000 
2、140000或200000 
3、100000或140000或
200000 
4、100000或140000或
200000 
5、140000或200000

XAVC-4K_420_8bit 3840 2160 false

1、25 
2、50 
3、
24000/1001 
4、
30000/1001 
5、
60000/1001

1、188000 
2、300000 
3、188000 
4、188000 
5、300000

当 Video.Codec 为 apple_prores 时：

Profile

1.ProRes_422_Proxy 
2.ProRes_422_LT 
3.ProRes_422 
4.ProRes_422_HQ 
5.ProRes_4444 
6.ProRes_4444_XQ 
7.ProRes_4444_alpha 
8.ProRes_4444_XQ_alpha

Width Height Interlaced Fps Bitrate(单位:kbps)

720 486 false 1、24000/1001 
2、30000/1001

取值范围:[2000,3000000]

720 486 true 1、60000/1001 取值范围:[2000,3000000]

720 576 false 1、25 取值范围:[2000,3000000]

720 576 true 1、50 取值范围:[2000,3000000]

960 720 false 1、25 取值范围:[2000,3000000]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1899 共2247⻚

2、50 
3、24000/1001 
4、30000/1001 
5、60000/1001

1280 720 false

1、25 
2、50 
3、24000/1001 
4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

1280 1080 false 1、24000/1001 
2、30000/1001

取值范围:[2000,3000000]

1280 1080 true 1、60000/1001 取值范围:[2000,3000000]

1440 1080 false
1、24000/1001 
2、25 
3、30000/1001

取值范围:[2000,3000000]

1440 1080 true 1、50 
2、60000/1001

取值范围:[2000,3000000]

1920 1080 false

1、25 
2、50 
3、24000/1001 
4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

1920 1080 true 1、50 
2、60000/1001

取值范围:[2000,3000000]

2048 1080 false

1、25 
2、50 
3、24000/1001 
4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

2048 1556 false

1、25 
2、50 
3、24000/1001 
4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

3840 2160 false 1、25 
2、50 
3、24000/1001 

取值范围:[2000,3000000]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1900 共2247⻚

4、30000/1001 
5、60000/1001

4096 2160 false

1、25 
2、50 
3、24000/1001 
4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

5120 2700 false

1、25 
2、50 
3、24000/1001 
4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

6144 3240 false

1、25 
2、50 
3、24000/1001 
4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

8192 4320 false

1、25 
2、50 
3、24000/1001 
4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

Container 类型 TimeInterval 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选
默认值 限制

Start Request.TimeInterval 开始

时间
String 否 0

[0 视频时⻓]
单位为秒

⽀持 float 格式，执
⾏精度精确到毫秒

Duration Request.TimeInterval 持续

时间
String 否

视频原

始时⻓

[0 视频时⻓]
单位为秒

⽀持 float 格式，执
⾏精度精确到毫秒

Container 类型 Audio 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

默认

值
限制



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1901 共2247⻚

Codec Request.Audio 编解码格式 String 是 ⽆ pcm_s24le、aac、
mp3

Remove Request.Audio 是否删除源⾳

频流
String 否 false 取值 true、false

Container 类型 TransConfig 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型

是

否

必

选

默认

值
限制

AdjDarMethod Request.TransConfig 分辨率调

整⽅式
String 否 none

取值 scale、crop、
pad、none
当输出视频的宽⾼⽐

与原视频不等时，根

据此参数做分辨率的

相应调整

IsCheckReso Request.TransConfig
是否检查

分辨率
String 否 false

true、false
当为 false时，按照
配置参数转码

ResoAdjMethod Request.TransConfig
分辨率调

整⽅式
String 否 0

取值0、1；0 表⽰使
⽤原视频分辨率；

1表⽰返回转码失败
当 IsCheckReso 为 
true 时⽣效

IsCheckVideoBitrate Request.TransConfig
是否检查

视频码率
String 否 false

true、false
当为 false 时，按照
配置参数转码

VideoBitrateAdjMethod Request.TransConfig 视频码率

调整⽅式
String 否 0

取值0、1；当输出
视频码率⼤于原视频

码率时，0表⽰使⽤
原视频码率；1表⽰
返回转码失败

当 
IsCheckVideoBitrate
为 true 时⽣效

IsCheckAudioBitrate Request.TransConfig 是否检查

⾳频码率

String 否 false true、false



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1902 共2247⻚

当为 false 时，按照
配置参数转码

AudioBitrateAdjMethod Request.TransConfig ⾳频码率

调整⽅式
String 否 0

取值0、1；当输出
⾳频码率⼤于原⾳频

码率时，0 表⽰使⽤
原⾳频码率；1表⽰
返回转码失败

当 
IsCheckAudioBitrate
为 true 时⽣效

IsCheckVideoFps Request.TransConfig
是否检查

视频帧率
String 否 false

true、false
当为 false 时，按照
配置参数转码

VideoFpsAdjMethod Request.TransConfig
视频帧率

调整⽅式
String 否 0

取值0、1；当输出
视频帧率⼤于原视频

帧率时，0表⽰使⽤
原视频帧率；1表⽰
返回转码失败

当 IsCheckVideoFps
为 true 时⽣效

DeleteMetadata Request.TransConfig

是否删除

⽂件中的

MetaData
信息

String 否 false
true、false
当为 false 时，保留
源⽂件信息

IsHdr2Sdr Request.TransConfig
是否开启

HDR转
SDR

String 否 false true/false

AdjDarMethod 参数图⽰：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1903 共2247⻚

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1904 共2247⻚

<Response>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransProTpl>

            <Container>

                <Format>mxf</Format>

            </Container>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1905 共2247⻚

            <Video>

                <Codec>xavc</Codec>

                <Profile>XAVC-HD_422_10bit</Profile>

                <Width>1920</Width>

                <Height>1080</Height>

                <Interlaced>true</Interlaced>

                <Fps>30000/1001</Fps>

                <Bitrate>50000</Bitrate>

            </Video>

            <Audio>

                <Codec>pcm_s24le</Codec>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransProTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 
Official

String

Tag Response.Template 模板类型， String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1906 共2247⻚

TranscodePro

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

TransProTpl Response.Template 详细的模板参数 Container

Container 节点 TransProTpl 的内容：

节点名称（关键

字）
⽗节点 描述 类型

TimeInterval Response.Template.TransProTpl 同请求体中的 Request.TimeInterval Container

Container Response.Template.TransProTpl 同请求体中的 Request.Container Container

Video Response.Template.TransProTpl 同请求体中的 Request.Video Container

Audio Response.Template.TransProTpl 同请求体中的 Request.Audio Container

TransConfig Response.Template.TransProTpl 同请求体中的 Request.TransConfig Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1907 共2247⻚

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1908 共2247⻚

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1909 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>TranscodePro</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1910 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransProTpl>

            <Container>

                <Format>mxf</Format>

            </Container>

            <Video>

                <Codec>xavc</Codec>

                <Profile>XAVC-HD_422_10bit</Profile>

                <Width>1920</Width>

                <Height>1080</Height>

                <Interlaced>true</Interlaced>

                <Fps>30000/1001</Fps>

                <Bitrate>50000</Bitrate>

            </Video>

            <Audio>

                <Codec>pcm_s24le</Codec>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransProTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1911 共2247⻚

创建语⾳合成模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建语⾳合成模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1912 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1913 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1914 共2247⻚

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>

    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选
限制

Tag Request 模板类型：Tts String 是 Tts

Name Request
模板名称，仅⽀持中

⽂、英⽂、数字、

_、-和*
String 是 ⽆

Mode Request
处理模式，默认值 
Asyc String 否

Asyc（异步合成）、Sync
（同步合成）当选择 Asyc 
时，codec 只⽀持 pcm

Codec Request
⾳频格式，默认值 
wav（同步）/pcm
（异步）

String 否 wav、mp3、pcm

VoiceType Request ⾳⾊，默认值 ruxue String 否 详⻅下表

Volume Request ⾳量，默认值0 String 否 [-10,10]

Speed Request 语速，默认值100 String 否 [50,200]

⽀持的⾳⾊

名称 Voice 参数值 Sync（同步合成） Asyc（异步合成）

茹雪 ruxue ⽀持 ⽀持



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1915 共2247⻚

爱⼩楠 aixiaonan 不⽀持 ⽀持

爱⼩星 aixiaoxing ⽀持 ⽀持

爱⼩诚 aixiaocheng ⽀持 ⽀持

爱⼩雪 aixiaoxue ⽀持 ⽀持

爱⼩璐 aixiaolu ⽀持 ⽀持

爱⼩栋 aixiaodong ⽀持 ⽀持

爱⼩聊 aixiaoliao 不⽀持 ⽀持

爱⼩倩 aixiaoqian ⽀持 ⽀持

爱⼩阳 aixiaoyang ⽀持 ⽀持

Alice alice ⽀持 ⽀持

⾳⾊说明

名称 Voice 参数值 类型 适⽤场景 ⽀持语⾔ 声⾳品质

茹雪 ruxue 标准⼥声 通⽤场景 中⽂及中英⽂混合 标准版

爱⼩楠 aixiaonan 甜美⼥声 通⽤/社交场景 中⽂及中英⽂混合 精品版

爱⼩星 aixiaoxing 元⽓男声 通⽤/解说场景 中⽂及中英⽂混合 精品版

爱⼩诚 aixiaocheng 标准男声 通⽤场景 中⽂及中英⽂混合 标准版

爱⼩雪 aixiaoxue 标准⼥声 通⽤/客服场景 中⽂及中英⽂混合 标准版

爱⼩璐 aixiaolu 阅读⼥声 通⽤/有声书场景 中⽂及中英⽂混合 标准版

爱⼩栋 aixiaodong 新闻男声 通⽤/新闻播报场景 中⽂及中英⽂混合 标准版

爱⼩聊 aixiaoliao 情绪⼥声 通⽤/社交场景 中⽂及中英⽂混合 精品版

爱⼩倩 aixiaoqian 元⽓⼥声 通⽤/社交场景 中⽂及中英⽂混合 精品版

爱⼩阳 aixiaoyang ⼴播男声 通⽤/新闻播报场景 中⽂及中英⽂混合 标准版

Alice alice 英⽂⼥声 通⽤场景 英⽂ 标准版

多情感⾳⾊说明

名称 Voice 参数值 情绪分类



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1916 共2247⻚

爱⼩星 aixiaoxing 中性、兴奋

爱⼩诚 aixiaocheng 中性、⼴播

爱⼩雪 aixiaoxue 中性、⼴播、客服

爱⼩璐 aixiaolu 中性、故事、客服

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1917 共2247⻚

<Response>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1918 共2247⻚

            <Volume>2</Volume>

            <Speed>200</Speed>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 
Official

String

Tag Response.Template 模板类型，Tts String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

TtsTpl Response.Template 详细的模板参数 Container

Container节点 TtsTpl 的内容：

节点名称（关键字） ⽗节点 描述

Mode Response.Template.TtsTpl 同请求体中的 Request.Mode

Codec Response.Template.TtsTpl 同请求体中的 Request.Codec

VoiceType Response.Template.TtsTpl 同请求体中的 Request.VoiceType

Volume Response.Template.TtsTpl 同请求体中的 Request.Volume

Speed Response.Template.TtsTpl 同请求体中的 Request.Speed



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1919 共2247⻚

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1920 共2247⻚

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>

    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1921 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>Tts</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1922 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1923 共2247⻚

创建精彩集锦模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建精彩集锦模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1924 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1925 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1926 共2247⻚

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMix>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

    </AudioMix>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选
限制

Tag Request 模板类型: 
VideoMontage

String 是 ⽆

Name Request
模板名称 仅⽀持中
⽂、英⽂、数字、

_、-和*
String 是 ⽆

Duration Request 集锦时⻓ String 否 1. 默认⾃动分析时⻓



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1927 共2247⻚

2. 单位为秒
3. ⽀持 float 格式，执⾏
精度精确到毫秒

Container Request 容器格式 Container 是 ⽆

Video Request 视频信息 Container 是 ⽆

Audio Request ⾳频信息 Container 否 ⽆

AudioMix Request 混⾳参数, 详情⻅ 
AudioMix 

Container 
数组

否
仅在 Audio.Remove 为 
false 时⽣效

Container 类型 Container 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型 是否必选

Format Request.Container 容器格式: mp4、flv、hls、ts、mkv String 是

设定 container，⾳频视频⽀持的格式如下表：

Container Audio Codecs Video Codecs

mp4/ts/hls/mkv AAC、MP3 H.264、H.265

flv AAC、MP3 H.264

Container 类型 Video 的具体数据描述如下：

节点名

称（关

键字）

⽗节点 描述 类型

是

否

必

选

默认值 限制

Codec Request.Video 编解码

格式
String 否 H.264 H.264

H.265

Width Request.Video 宽 String 否
视频原始

宽度

值范围：[128，4096]
单位：px
若只设置 Width 时，按照视频
原始⽐例计算 Height
必须为偶数

https://www.tencentcloud.com/document/product/1045/49945


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1928 共2247⻚

Height Request.Video ⾼ String 否 视频原始

⾼度

值范围：[128，4096]
单位：px
若只设置 Height 时，按照视频
原始⽐例计算 Width
必须为偶数

Fps Request.Video 帧率 String 否 ⽆
值范围：(0，60]
单位：fps

Bitrate Request.Video
视频输

出⽂件

的码率

String 否 ⽆
值范围：[10，50000]
单位：Kbps

Crf Request.Video
码率-
质量控

制因⼦

String 否 ⽆

值范围：(0, 51]
如果设置了 Crf，则 Bitrate 的设
置失效

当 Bitrate 为空时，默认为25

Rotate Request.Video 旋转⾓

度
String 否 ⽆

值范围：[0, 360)
单位：度

Container 类型 Audio 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否必

选
默认值 限制

Codec Request.Audio 编解码格

式
String 否 aac 取值 aac、mp3

Samplerate Request.Audio 采样率 String 否 44100

单位：Hz
可选 11025、22050、
32000、44100、48000、
96000
不同的封装，mp3 ⽀持不
同的采样率，如下表所⽰

Bitrate Request.Audio 原始⾳频

码率
String 否 ⽆

单位：Kbps
值范围：[8，1000]

Channels Request.Audio 声道数 String 否 ⽆

当 Codec 设置为 aac，⽀
持1、2、4、5、6、8
当 Codec 设置为 mp3，
⽀持1、2

Remove Request.Audio 是否删除

⾳频流

String 否 false 取值 true、false



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1929 共2247⻚

说明：

 Y 表⽰⽀持这种采样率，N 表⽰不⽀持。

封装格式/⾳频采样率 11025 22050 32000 44100 48000 96000

flv N Y N Y N N

mp4 N Y Y Y Y N

hls/ts/mkv Y Y Y Y Y N

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1930 共2247⻚

<Response>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1931 共2247⻚

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 
Official

String

Tag Response.Template 模板类型，

VideoMontage
String

UpdateTime Response.Template 更新时间 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1932 共2247⻚

CreateTime Response.Template 创建时间 String

VideoMontage Response.Template 详细的模板参数 Container

Container节点VideoMontage的内容：

节点名称（关键字） ⽗节点 描述

Duration Response.TemplateList.VideoMontage 同请求体中的 Request.Duration

TimeInterval Response.TemplateList.VideoMontage 同请求体中的 
Request.TimeInterval

Container Response.TemplateList.VideoMontage 同请求体中的 
Request.Container

Video Response.TemplateList.VideoMontage 同请求体中的 Request.Video

Audio Response.TemplateList.VideoMontage 同请求体中的 Request.Audio

AudioMix Response.TemplateList.VideoMontage 同请求体中的 Request.AudioMix

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1933 共2247⻚

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1934 共2247⻚

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMix>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

    </AudioMix>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1935 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoMontage</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1936 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1937 共2247⻚

创建视频增强模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建视频增强模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1938 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1939 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1940 共2247⻚

    <Tag>VideoProcess</Tag>

    <Name>TemplateName</Name>

    <ColorEnhance>

        <Enable>true</Enable>

        <Contrast></Contrast>

        <Correction></Correction>

        <Saturation></Saturation>

    </ColorEnhance>

    <MsSharpen>

        <Enable>true</Enable>

        <SharpenLevel></SharpenLevel>

    </MsSharpen>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选 限制

Tag Request 模板类型：VideoProcess String 是 ⽆

Name Request 模板名称 仅⽀持中⽂、英
⽂、数字、_、-和*

String 是 ⽆

ColorEnhance Request ⾊彩增强 Container
否，ColorEnhance 
和 MsSharpen 不能
同时为空

⽆

MsSharpen Request 细节增强 Container
否，ColorEnhance 
和 MsSharpen 不能
同时为空

⽆

Container 类型 ColorEnhance 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否

必选

默认

值
限制



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1941 共2247⻚

Enable Request.ColorEnhance ⾊彩增强是

否开启

String 否 false true、false

Contrast Request.ColorEnhance 对⽐度 String 否 ⽆

值范围：[0, 100]，
空字符串（表⽰⾃动

分析）

Correction Request.ColorEnhance ⾊彩校正 String 否 ⽆

值范围：[0, 1000]，
空字符串（表⽰⾃动

分析）

Saturation Request.ColorEnhance 饱和度 String 否 ⽆

值范围：[0, 300]，
空字符串（表⽰⾃动

分析）

Container 类型 MsSharpen 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选

默认

值
限制

Enable Request.MsSharpen
细节增

强是否

开启

String 否 false true、false

SharpenLevel Request.MsSharpen 增强等

级
String 否 ⽆

值范围：[0, 10]，空字
符串（表⽰⾃动分析）

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1942 共2247⻚

<Response>

    <Template>

        <Tag>VideoProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoProcess>

            <ColorEnhance>

                <Enable>true</Enable>

                <Contrast></Contrast>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1943 共2247⻚

                <Correction></Correction>

                <Saturation></Saturation>

            </ColorEnhance>

            <MsSharpen>

                <Enable>true</Enable>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

        <VideoProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 
Official

String

Tag Response.Template 模板类型，

VideoProcess
String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

VideoProcess Response.Template 详细的模板参数 Container

Container节点 VideoProcess 的内容：

节点名称（关键字） ⽗节点 描述



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1944 共2247⻚

ColorEnhance Response.Template.VideoProcess 同请求体中的 
Request.ColorEnhance

MsSharpen Response.Template.VideoProcess 同请求体中的 
Request.MsSharpen

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1945 共2247⻚

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoProcess</Tag>

    <Name>TemplateName</Name>

    <ColorEnhance>

        <Enable>true</Enable>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1946 共2247⻚

        <Contrast></Contrast>

        <Correction></Correction>

        <Saturation></Saturation>

    </ColorEnhance>

    <MsSharpen>

        <Enable>true</Enable>

        <SharpenLevel></SharpenLevel>

    </MsSharpen>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1947 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoProcess</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1948 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ColorEnhance>

            <Enable>true</Enable>

            <Contrast></Contrast>

            <Correction></Correction>

            <Saturation></Saturation>

        </ColorEnhance>

        <MsSharpen>

            <Enable>true</Enable>

            <SharpenLevel></SharpenLevel>

        </MsSharpen>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1949 共2247⻚

创建⼈声分离模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建⼈声分离模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1950 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1951 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1952 共2247⻚

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </AudioConfig>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否

必选
限制

Tag Request 模板类型: 
VoiceSeparate

String 是 ⽆

Name Request
模板名称 仅⽀持中
⽂、英⽂、数字、

_、-和*
String 是 ⽆

AudioMode Request 输出⾳频 String 是

IsAudio：输出⼈声
IsBackground：输出背景声
AudioAndBackground：输出
⼈声和背景声

AudioConfig Request ⾳频配置 Container 是 ⽆

Container 类型 AudioConfig 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否必

选

默认

值
限制



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1953 共2247⻚

Codec Request.Audio 编解码

格式

String 否 aac 取值 aac、mp3、flac、amr

Samplerate Request.Audio 采样率 String 否 44100

单位：Hz
可选 8000、11025、22050、
32000、44100、48000、
96000
当 Codec 设置为 aac/flac 时，
不⽀持8000
当 Codec 设置为 mp3 时，不
⽀持8000和96000
当 Codec 设置为 amr 时，只
⽀持8000

Bitrate Request.Audio 原始⾳

频码率
String 否 ⽆

单位：Kbps 
2. 值范围：[8，1000]

Channels Request.Audio 声道数 String 否 ⽆

当 Codec 设置为 aac/flac，⽀
持1、2、4、5、6、8
当 Codec 设置为 mp3，⽀持
1、2
当 Codec 设置为 amr，只⽀持
1

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1954 共2247⻚

<Response>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1955 共2247⻚

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 
Official

String

Tag Response.Template 模板类型，

VoiceSeparate
String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

VoiceSeparate Response.Template 详细的模板参数 Container

Container 节点 VoiceSeparate 的内容：

节点名称（关键

字）
⽗节点 描述 类型

AudioMode Response.Template.VoiceSeparate 同请求体中的 
Request.AudioMode

String

AudioConfig Response.Template.VoiceSeparate 同请求体中的 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1956 共2247⻚

Request.AudioConfig

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1957 共2247⻚

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </AudioConfig>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1958 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VoiceSeparate</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1959 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1960 共2247⻚

创建⽔印模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建⽔印模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1961 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1962 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。 

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1963 共2247⻚

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Text</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Text>

            <Text>⽔印内容</Text>

            <FontSize>30</FontSize>

            <FontType></FontType>

            <FontColor>0xRRGGBB</FontColor>

            <Transparency>30</Transparency>

        </Text>

    </Watermark>

</Request>

<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Image</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Image>

            <Url>http://test-1234567890.ci.ap-beijing.myqcloud.com/shuiyin_2.png</U

            <Mode>Proportion</Mode>

            <Width>10</Width>

            <Height></Height>

            <Transparency>100</Transparency>

        </Image>

    </Watermark>

</Request>

具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型

Request ⽆ 保存请求的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1964 共2247⻚

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 必选

Tag Request 模板类型: Watermark String 是

Name Request 模板名称，仅⽀持中⽂、英⽂、数

字、_、-和*
String 是

Watermark Request ⽔印信息 Container 是

Container 类型 Watermark 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

必

选

默认

值
限制

Type Request.Watermark ⽔印类型 String 是 ⽆
Text：⽂字⽔印、 
Image：图⽚⽔印

Pos Request.Watermark 基准位置 String 是 ⽆

TopRight、TopLeft、
BottomRight、
BottomLeft、Left、
Right、Top、
Bottom、Center

LocMode Request.Watermark 偏移⽅式 String 是 ⽆
Relativity：按⽐例，
Absolute：固定位置

Dx Request.Watermark ⽔平偏移 String 是 ⽆ 在图⽚⽔印中，如果 
Background 为 true，
当 locMode 为 
Relativity 时，为%，
值范围：[-300 0]；当 
locMode 为 Absolute 
时，为 px，值范围：
[-4096 0]。
在图⽚⽔印中，如果 
Background 为 
false，当 locMode 为 
Relativity 时，为%，
值范围：[0 100]；当 
locMode 为 Absolute 



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1965 共2247⻚

时，为 px，值范围：
[0 4096]。
在⽂字⽔印中，当 
locMode 为 Relativity 
时，为%，值范围：
[0 100]；当 locMode 
为 Absolute 时，为 
px，值范围：[0 
4096]。
当Pos为Top、
Bottom和Center时，
该参数⽆效。

Dy Request.Watermark 垂直偏移 String 是 ⽆

在图⽚⽔印中，如果 
Background 为 true，
当 locMode 为 
Relativity 时，为%，
值范围：[-300 0]；当 
locMode 为 Absolute 
时，为 px，值范围：
[-4096 0]。
在图⽚⽔印中，如果 
Background 为 
false，当 locMode 为 
Relativity 时，为%，
值范围：[0 100]；当 
locMode 为 Absolute 
时，为 px，值范围：
[0 4096]。
在⽂字⽔印中，当 
locMode 为 Relativity 
时，为%，值范围：
[0 100]；当 locMode 
为 Absolute 时，为 
px，值范围：[0 
4096]。
当Pos为Left、Right
和Center时，该参数
⽆效。

StartTime Request.Watermark ⽔印开始时

间
String 否 0

[0 视频时⻓]
单位为秒

⽀持 float 格式，执⾏
精度精确到毫秒

EndTime Request.Watermark ⽔印结束时 String 否 视频 [0 视频时⻓]



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1966 共2247⻚

间 结束

时间

单位为秒

⽀持 float 格式，执⾏
精度精确到毫秒

SlideConfig Request.Watermark

⽔印滑动配

置，配置该

参数后⽔印

位移设置不

⽣效，极速

⾼清/H265
转码暂时不

⽀持该参数

Container 否 ⽆ ⽆

Image Request.Watermark 图⽚⽔印节

点
Container 否 ⽆ ⽆

Text Request.Watermark ⽂本⽔印节

点
Container 否 ⽆ ⽆

Container 类型 SlideConfig 的具体数据描述如下：

节点名称

（关键字）
⽗节点

描

述
类型

必

选

默

认

值

限制

SlideMode Request.Watermark.SlideConfig

滑

动

模

式

String 是 ⽆

Default: 默认不开
启、ScrollFromLeft: 
从左到右滚动，若设

置了ScrollFromLeft
模式，则

Watermark.Pos参数
不⽣效

XSlideSpeed Request.Watermark.SlideConfig

横

向

滑

动

速

度

String 是 ⽆
取值范围：[0,10]内
的整数，默认为0

YSlideSpeed Request.Watermark.SlideConfig 纵

向

滑

动

String 是 ⽆ 取值范围：[0,10]内
的整数，默认为0



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1967 共2247⻚

速

度

Container 类型 Image 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

必

选

默认

值
限制

Url Request.Watermark.Image

⽔印图地

址(需要 
Urlencode 
后传⼊)

String 是 ⽆
同 bucket 的⽔印图
⽚地址

Mode Request.Watermark.Image 尺⼨模式 String 是 ⽆

Original：原有尺⼨
Proportion：按⽐
例

Fixed：固定⼤⼩

Width Request.Watermark.Image 宽 String 否 ⽆

当 Mode 为 
Original 时，不⽀
持设置⽔印图宽度

当 Mode 为 
Proportion，单位
为%，背景图值范
围：[100 300]；前
景图值范围：[1 
100]，相对于视频
宽，最⼤不超过

4096px
当 Mode 为 
Fixed，单位为 
px，值范围：[8，
4096]
若只设置 Width 
时，按照⽔印图⽐

例计算 Height 

Height Request.Watermark.Image ⾼ String 否 ⽆ 当 Mode 为 
Original 时，不⽀
持设置⽔印图⾼度

当 Mode 为 
Proportion，单位
为%，背景图值范
围：[100 300]；前



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1968 共2247⻚

景图值范围：[1 
100]，相对于视频
⾼，最⼤不超过

4096px
当 Mode 为 
Fixed，单位为 
px，值范围：[8，
4096]
若只设置 Height 
时，按照⽔印图⽐

例计算 Width 

Transparency Request.Watermark.Image 透明度 String 是 ⽆
值范围：[1 100]，
单位%

Background Request.Watermark.Image 是否背景

图
String 否 false true、false

⽔印位置说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1969 共2247⻚

Container 类型 Text 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

必

选

默

认

值

限制

FontSize Request.Watermark.Text 字体⼤

⼩
String 是 ⽆

值范围：[5 100]，单
位 px

FontType Request.Watermark.Text 字体类

型
String 是 ⽆ 参考下表

FontColor Request.Watermark.Text 字体颜

⾊
String 是 ⽆ 格式：0xRRGGBB

Transparency Request.Watermark.Text 透明度 String 是 ⽆
值范围：[1 100]，单
位%



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1970 共2247⻚

Text Request.Watermark.Text ⽔印内

容

String 是 ⽆ ⻓度不超过64个字
符，仅⽀持中⽂、英

⽂、数字、_、-和*

Text 的 FontType 具体数据描述如下：

字体名称 ⽀持的语⾔ 描述

simfang.ttf 中/英 仿宋

simhei.ttf 中/英 ⿊体

simkai.ttf 中/英 楷体

simsun.ttc 中/英 宋体

STHeiti-Light.ttc 中/英 华⽂⿊体

STHeiti-Medium.ttc 中/英 华⽂⿊体中

youyuan.TTF 中/英 幼圆

ariblk.ttf 英 ⽆

arial.ttf 英 ⽆

ahronbd.ttf 英 ⽆

Helvetica.dfont 英 ⽆

HelveticaNeue.dfont 英 ⽆

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1971 共2247⻚

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1972 共2247⻚

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>⽔印内容</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 
Official

String

Tag Response.Template 模板类型，

VideoProcess
String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

Watermark Response.Template 同请求体中的 
Request.Watermark

Container

错误码



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1973 共2247⻚

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求1（⽂本⽔印）

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0****&q-sign-tim

Host: test-1234567890.ci.ap-beijing.myqcloud.com

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1974 共2247⻚

Content-Length: 1666

Content-Type: application/xml

<Request>

   <Tag>Watermark</Tag>

   <Name>TemplateName</Name>

   <Watermark>

      <Type>Text</Type>

      <LocMode>Absolute</LocMode>

      <Dx>128</Dx>

      <Dy>128</Dy>

      <Pos>TopRight</Pos>

      <StartTime>0</StartTime>

      <EndTime>100.5</EndTime>

      <Text>

        <Text>⽔印内容</Text>

        <FontSize>30</FontSize>

        <FontType></FontType>

        <FontColor>0xRRGGBB</FontColor>

        <Transparency>30</Transparency>

      </Text>

   </Watermark>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1975 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1976 共2247⻚

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>⽔印内容</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

   </Template>

</Response>

请求2（图⽚⽔印）



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1977 共2247⻚

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0****&q-sign-tim

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

   <Tag>Watermark</Tag>

   <Name>TemplateName</Name>

   <Watermark>

      <Type>Image</Type>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1978 共2247⻚

      <LocMode>Absolute</LocMode>

      <Dx>128</Dx>

      <Dy>128</Dy>

      <Pos>TopRight</Pos>

      <StartTime>0</StartTime>

      <EndTime>100.5</EndTime>

      <Image>

        <Url>http://test-1234567890.ci.ap-beijing.myqcloud.com/shuiyin_2.png</Url>

        <Mode>Proportion</Mode>

        <Width>10</Width>

        <Height>10</Height>

        <Transparency>30</Transparency>

      </Image>

   </Watermark>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1979 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1980 共2247⻚

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Watermark>

            <Type>Image</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Image>

                <Url>http://test-1234567890.ci.ap-beijing.myqcloud.com/shuiyin_2.pn

                <Mode>Proportion</Mode>

                <Width>10</Width>

                <Height>10</Height>

                <Transparency>30</Transparency>

            </Image>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1981 共2247⻚

创建智能封⾯模板
最近更新时间：2024-01-23 10:00:02

功能描述

创建智能封⾯模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1982 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1983 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。 

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1984 共2247⻚

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Tag Request 模板类型：SmartCover String 是

Name Request 模板名称仅⽀持中⽂、英⽂、数

字、_、-和*
String 是

SmartCover Request 智能封⾯参数 Container 是

Container 类型 SmartCover 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选
默认值 限制

Format Request.SmartCover 图⽚

格式
String 否 jpg jpg、png 、webp

Width Request.SmartCover 宽 String 否
视频原

始宽度

值范围：[128，
4096]
单位：px
若只设置 Width 时，
按照视频原始⽐例计

算 Height



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1985 共2247⻚

Height Request.SmartCover ⾼ String 否 视频原

始⾼度

值范围：[128，
4096]
单位：px
若只设置 Height 
时，按照视频原始⽐

例计算 Width

Count Request.SmartCover 截图

数量
String 否 3 [1,10]

DeleteDuplicates Request.SmartCover 封⾯

去重
String 否 false true/false

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1986 共2247⻚

<Response>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f43110a08702470b8fa75894629501fa</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Width>1280</Width>

            <Height>960</Height>

            <Format>jpg</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1987 共2247⻚

            <Count>5</Count>

            <DeleteDuplicates>false</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Tag Response.Template 模板类型，SmartCover String

Name Response.Template 模板名字 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 Official String

TemplateId Response.Template 模板 ID String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

SmartCover Response.Template 详细的模板参数，同上述请求体部分 SmartCover 
说明

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1988 共2247⻚

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1989 共2247⻚

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1990 共2247⻚

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>10</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1991 共2247⻚

删除媒体处理模板

DeleteMediaTemplate
最近更新时间：2024-01-23 10:00:02

功能描述

删除模板。

请求

请求实例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1992 共2247⻚

DELETE /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String （详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1993 共2247⻚

请求头

公共头部

该请求操作的实现使⽤公共请求头，了解公共请求头详情请参⻅ 公共请求头部 ⽂档。

⾮公共头部

该请求操作⽆特殊的请求头部信息。

请求体

该请求的请求体为空。

响应

响应头

公共响应头

该响应包含公共响应头，了解公共响应头详情请参⻅ 公共响应头部 ⽂档。

特有响应头

该响应⽆特殊的响应头。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1994 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TemplateId>A</TemplateId>

<Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1995 共2247⻚

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TemplateId Response 被删除的模板的 ID String

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1996 共2247⻚

DELETE /template/t143ae6e040af6431aa772c9ec3f0a3f36 HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1997 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=

<Response>

    <RequestId>NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=</RequestId>

    <TemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1998 共2247⻚

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1999 共2247⻚

查询媒体处理模板

DescribeMediaTemplates
最近更新时间：2024-01-23 10:00:02

功能描述

查询模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2000 共2247⻚

GET /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String （详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2001 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

参数的具体内容如下：

节点名称（关键

字）

⽗节

点
描述 类型 必选

tag ⽆ 模板类型，默认值: All String 否

category ⽆
Official(系统预设模板)，Custom(⾃定义模板)，默认值: 
Custom

String 否

ids ⽆ 模板 ID，以  , 符号分割字符串 String 否

name ⽆ 模板名称前缀 String 否

pageNumber ⽆ 第⼏⻚，默认值:1 Integer 否

pageSize ⽆ 每⻚个数，默认值:10 Integer 否

tag ⽀持以下⼏种类型:

模板类型 tag

⾳视频转码 Transcode

视频转动图 Animation

视频截图 Snapshot

⾳视频拼接 Concat

⼈声分离 VoiceSeparate

精彩集锦 VideoMontage

视频增强 VideoProcess

超级分辨率 SuperResolution

图⽚/⽂字⽔印 Watermark

https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2002 共2247⻚

语⾳合成 Tts

⾳视频转码Pro TranscodePro

极速⾼清 HighSpeedHd

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2003 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>A</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <TransTpl>

            <Container>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2004 共2247⻚

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 模板总数 Int

PageNumber Response 当前⻚数，同请求中的 pageNumber Int

PageSize Response 每⻚个数，同请求中的 pageSize Int



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2005 共2247⻚

TemplateList Response 模板数组 Container 数组

对于不同的模板类型，TemplateList 内容同创建模板接⼝的Response，请参照以下链接：
⾳视频转码

视频转动图

视频截图

⾳视频拼接

⼈声分离

精彩集锦

视频增强

超级分辨率

图⽚/⽂字⽔印 
语⾳合成

⾳视频转码Pro 

极速⾼清

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

案例⼀：按照模板 ID 维度查询

请求

https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49906
https://www.tencentcloud.com/document/product/1045/49909
https://www.tencentcloud.com/document/product/1045/49907
https://www.tencentcloud.com/document/product/1045/49916
https://www.tencentcloud.com/document/product/1045/49914
https://www.tencentcloud.com/document/product/1045/49915
https://www.tencentcloud.com/document/product/1045/49910
https://www.tencentcloud.com/document/product/1045/49917
https://www.tencentcloud.com/document/product/1045/49913
https://www.tencentcloud.com/document/product/1045/49912
https://www.tencentcloud.com/document/product/1045/49908
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2006 共2247⻚

GET /template?ids=t1847cd4ca57f543e89f551dbe68169eb9,t1a30a323f55434a29b25bf2a16bdf

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2007 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TemplateList>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2008 共2247⻚

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

        <Name>template_name3544697</Name>

        <Tag>Concat</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/input/ad

            </ConcatFragment>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2009 共2247⻚

            <Audio>

                <Codec>aac</Codec>

                <Samplerate/>

                <Bitrate/>

                <Channels/>

                <Remove>false</Remove>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Width>1280</Width>

                <Height>960</Height>

                <Fps>15</Fps>

                <Remove>false</Remove>

                <Crf>25</Crf>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <DirectConcat>false</DirectConcat>

        </ConcatTemplate>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

    </TemplateList>

    <NonExistTIDs>

        <TemplateId>C</TemplateId>

    </NonExistTIDs>

</Response>

案例⼆：按照分⻚列表维度查询

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2010 共2247⻚

GET /template?pageSize=10&pageNumber=1 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2011 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2012 共2247⻚

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

        <Name>template_name3544697</Name>

        <Tag>Concat</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/input/ad



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2013 共2247⻚

            </ConcatFragment>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate/>

                <Bitrate/>

                <Channels/>

                <Remove>false</Remove>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Width>1280</Width>

                <Height>960</Height>

                <Fps>15</Fps>

                <Remove>false</Remove>

                <Crf>25</Crf>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <DirectConcat>false</DirectConcat>

        </ConcatTemplate>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

    </TemplateList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2014 共2247⻚

媒体处理

更新动图模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新动图模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2015 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2016 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2017 共2247⻚

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

    <Container>

        <Format>gif</Format>

    </Container>

    <Video>

        <Codec>gif</Codec>

        <Width>1280</Width>

        <Height></Height>

        <Fps>15</Fps>

        <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 必选

Request ⽆
同创建动图模板接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49906
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2018 共2247⻚

<Response>

    <Template>

        <Tag>Animation</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2019 共2247⻚

                <Width>1280</Width>

                <Height></Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 同创建动图模板接⼝的 Response Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49906
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2020 共2247⻚

PUT /template/t1f16e1dfbdc994105b31292d45710642a HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

    <Container>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2021 共2247⻚

        <Format>gif</Format>

    </Container>

    <Video>

        <Codec>gif</Codec>

        <Width>1280</Width>

        <Height></Height>

        <Fps>15</Fps>

        <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2022 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2023 共2247⻚

    <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

    <TransTpl>

      <Container>

         <Format>mp4</Format>

      </Container>

      <Video>

        <Codec>gif</Codec>

        <Width>1280</Width>

        <Height></Height>

        <Fps>15</Fps>

        <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

      </Video>

      <TimeInterval>

         <Start>0</Start>

         <Duration>60</Duration>

      </TimeInterval>

   </TransTpl>

   <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

   <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2024 共2247⻚

更新拼接模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新拼接模板。

请求

请求实例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2025 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2026 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

公共头部

该请求操作的实现使⽤公共请求头，了解公共请求头详情请参⻅ 公共请求头部 ⽂档。

⾮公共头部

该请求操作⽆特殊的请求头部信息。

请求体

该请求操作的实现需要有如下请求体。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2027 共2247⻚

<Request>

    <Tag>Concat</Tag>

    <Name>TemplateName</Name>

    <ConcatTemplate>

        <ConcatFragment>

            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Ur

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2028 共2247⻚

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMix>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</Au

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMix>

    </ConcatTemplate>

</Request>

具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型

Request ⽆
同创建拼接模板接⼝的 
Request 

Container

响应

响应头

公共响应头

https://www.tencentcloud.com/document/product/1045/49907


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2029 共2247⻚

该响应包含公共响应头，了解公共响应头详情请参⻅ 公共响应头部 ⽂档。

特有响应头

该响应⽆特殊的响应头。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <Template>

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2030 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2031 共2247⻚

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 同创建拼接模板接⼝的 Response Container

错误码

该请求⽆特有错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49907
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2032 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Name>TemplateName</Name>

    <ConcatTemplate>

        <ConcatFragment>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2033 共2247⻚

            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Ur

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMix>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</Au

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMix>

    </ConcatTemplate>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2034 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2035 共2247⻚

        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2036 共2247⻚

更新极速⾼清转码模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新极速⾼清转码模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2037 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2038 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2039 共2247⻚

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆
同创建极速⾼清模板接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

https://www.tencentcloud.com/document/product/1045/49908
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2040 共2247⻚

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <Template>

        <Tag>HighSpeedHd</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2041 共2247⻚

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 同创建极速⾼清模板接⼝的 Response Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49908
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2042 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2043 共2247⻚

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2044 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>HighSpeedHd</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2045 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2046 共2247⻚

更新截图模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新截图模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2047 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2048 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2049 共2247⻚

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

具体数据描述如下：

节点名称（关键

字）

⽗节

点
描述 类型 必选

Request ⽆ 同创建截图模板接⼝的 Request Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49909
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2050 共2247⻚

<Response>

    <Template>

        <Tag>Snapshot</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2051 共2247⻚

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 同创建截图模板接⼝的 Response Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49909
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2052 共2247⻚

PUT /template/t1f16e1dfbdc994105b31292d45710642a HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2053 共2247⻚

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2054 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <Tag>Snapshot</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2055 共2247⻚

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2056 共2247⻚

更新超分辨率模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新超分辨率模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2057 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2058 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2059 共2247⻚

    <Tag>SuperResolution</Tag>

    <Name>TemplateName</Name>

    <Resolution>sdtohd</Resolution>

    <EnableScaleUp>true</EnableScaleUp>

    <Version>Enhance</Version>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆
同创建超分辨率模板接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49910
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2060 共2247⻚

<Response>

    <Template>

        <Tag>SuperResolution</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2061 共2247⻚

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆
同创建超分辨率模板接⼝的 
Response 

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49910
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2062 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SuperResolution</Tag>

    <Name>TemplateName</Name>

    <Resolution>sdtohd</Resolution>

    <EnableScaleUp>true</EnableScaleUp>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2063 共2247⻚

    <Version>Enhance</Version>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2064 共2247⻚

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>SuperResolution</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2065 共2247⻚

更新⾳视频转码模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新转码模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2066 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2067 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2068 共2247⻚

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 必选

Request ⽆
同创建转码模板接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2069 共2247⻚

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2070 共2247⻚

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆
同创建转码模板接⼝的 
Response 

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49911
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2071 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2072 共2247⻚

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2073 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2074 共2247⻚

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2075 共2247⻚

⾳视频转码 pro
最近更新时间：2024-01-23 10:00:02

功能描述

更新⾳视频转码 pro 模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2076 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2077 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2078 共2247⻚

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 必选

Request ⽆
同创建转码 Pro 模板接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49912
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2079 共2247⻚

<Response>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mxf</Format>

        </Container>

        <Video>

            <Codec>xavc</Codec>

            <Profile>XAVC-HD_422_10bit</Profile>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2080 共2247⻚

            <Width>1920</Width>

            <Height>1080</Height>

            <Interlaced>true</Interlaced>

            <Fps>30000/1001</Fps>

            <Bitrate>50000</Bitrate>

        </Video>

        <Audio>

            <Codec>pcm_s24le</Codec>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 同创建转码 Pro 模板接⼝的 Response Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49912
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2081 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2082 共2247⻚

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2083 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>TranscodePro</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2084 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mxf</Format>

        </Container>

        <Video>

            <Codec>xavc</Codec>

            <Profile>XAVC-HD_422_10bit</Profile>

            <Width>1920</Width>

            <Height>1080</Height>

            <Interlaced>true</Interlaced>

            <Fps>30000/1001</Fps>

            <Bitrate>50000</Bitrate>

        </Video>

        <Audio>

            <Codec>pcm_s24le</Codec>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2085 共2247⻚

更新语⾳合成模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新语⾳合成转码模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2086 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2087 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2088 共2247⻚

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>

    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

具体数据描述如下：

节点名称（关键

字）

⽗节

点
描述 类型 是否必选

Request ⽆
同创建语⾳合成模板接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49913
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2089 共2247⻚

<Response>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2090 共2247⻚

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 同创建语⾳合成模板接⼝的 Response Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49913
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2091 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2092 共2247⻚

    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2093 共2247⻚

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2094 共2247⻚

更新精彩集锦模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新精彩集锦模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2095 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2096 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2097 共2247⻚

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMix>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

    </AudioMix>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆
同创建精彩集锦模板接⼝

的 Request 
Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49914
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2098 共2247⻚

<Response>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2099 共2247⻚

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆
同创建精彩集锦模板接⼝的 
Response 

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49914
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2100 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2101 共2247⻚

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMix>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

    </AudioMix>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2102 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoMontage</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2103 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2104 共2247⻚

更新视频增强模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新视频增强模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2105 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2106 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2107 共2247⻚

    <Tag>VideoProcess</Tag>

    <Name>TemplateName</Name>

    <ColorEnhance>

        <Enable>true</Enable>

        <Contrast></Contrast>

        <Correction></Correction>

        <Saturation></Saturation>

    </ColorEnhance>

    <MsSharpen>

        <Enable>true</Enable>

        <SharpenLevel></SharpenLevel>

    </MsSharpen>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆
同创建视频增强模板接⼝的 
Request 

Container 是

响应

响应头

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49915
https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2108 共2247⻚

<Response>

    <Template>

        <Tag>VideoProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoProcess>

            <ColorEnhance>

                <Enable>true</Enable>

                <Contrast></Contrast>

                <Correction></Correction>

                <Saturation></Saturation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2109 共2247⻚

            </ColorEnhance>

            <MsSharpen>

                <Enable>true</Enable>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

        </VideoProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆
同创建视频增强模板接⼝的 
Response 

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49915
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2110 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoProcess</Tag>

    <Name>TemplateName</Name>

    <ColorEnhance>

        <Enable>true</Enable>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2111 共2247⻚

        <Contrast></Contrast>

        <Correction></Correction>

        <Saturation></Saturation>

    </ColorEnhance>

    <MsSharpen>

        <Enable>true</Enable>

        <SharpenLevel></SharpenLevel>

    </MsSharpen>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2112 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoProcess</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2113 共2247⻚

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoProcess>

            <ColorEnhance>

                <Enable>true</Enable>

                <Contrast></Contrast>

                <Correction></Correction>

                <Saturation></Saturation>

            </ColorEnhance>

            <MsSharpen>

                <Enable>true</Enable>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

        </VideoProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2114 共2247⻚

更新⼈声分离模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新⼈声分离转码模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2115 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2116 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体：

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2117 共2247⻚

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>2</Channels>

    </AudioConfig>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆
同创建⼈声分离模板接⼝的 
Request 

Container 是

响应

响应头

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49916#Request
https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2118 共2247⻚

<Response>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2119 共2247⻚

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 同创建⼈声分离模板接⼝的 Response Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49916#Response
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2120 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2121 共2247⻚

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </AudioConfig>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2122 共2247⻚

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2123 共2247⻚

更新⽔印模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新⽔印模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2124 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2125 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2126 共2247⻚

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Text</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Text>

            <Text>⽔印内容</Text>

            <FontSize>30</FontSize>

            <FontType></FontType>

            <FontColor>0xRRGGBB</FontColor>

            <Transparency>30</Transparency>

        </Text>

    </Watermark>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 必选

Request ⽆
同创建⽔印模板接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49917#Request
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2127 共2247⻚

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2128 共2247⻚

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>⽔印内容</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 同创建⽔印模板接⼝的 Response Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49917#Response
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2129 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Text</Type>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2130 共2247⻚

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Text>

            <Text>⽔印内容</Text>

            <FontSize>30</FontSize>

            <FontType></FontType>

            <FontColor>0xRRGGBB</FontColor>

            <Transparency>30</Transparency>

        </Text>

    </Watermark>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2131 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2132 共2247⻚

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>⽔印内容</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2133 共2247⻚

更新智能封⾯模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新智能封⾯模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2134 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2135 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2136 共2247⻚

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 必选

Request ⽆
同创建智能封⾯模板接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/50614
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2137 共2247⻚

<Response>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f43110a08702470b8fa75894629501fa</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Width>1280</Width>

            <Height>960</Height>

            <Format>jpg</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2138 共2247⻚

            <Count>5</Count>

            <DeleteDuplicates>false</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 同创建智能封⾯模板接⼝的 Response Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/50614
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2139 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2140 共2247⻚

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2141 共2247⻚

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f43110a08702470b8fa75894629501fa</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Width>1280</Width>

            <Height>960</Height>

            <Format>jpg</Format>

            <Count>5</Count>

            <DeleteDuplicates>false</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2142 共2247⻚

AI 内容识别
创建 AI 内容识别模板
创建语⾳识别模板
最近更新时间：2024-03-01 17:30:47

功能描述

创建语⾳识别模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2143 共2247⻚

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2144 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2145 共2247⻚

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选
限制

Tag Request 模板类型：SpeechRecognition String 是 ⽆

Name Request 模板名称 仅⽀持中⽂、英⽂、数字、
_、-和*

String 是 ⽆

SpeechRecognition Request 语⾳识别参数 Container 是 ⽆

Container 类型 SpeechRecognition 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

EngineModelType Request.SpeechRecognition 引擎模型类型，分为电话场景

和⾮电话场景。

电话场景：

8k_zh：电话 8k 中⽂普通话
通⽤（可⽤于双声道⾳频）；

8k_zh_s：电话 8k 中⽂普通
话话者分离（仅适⽤于单声道

String 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2146 共2247⻚

⾳频）；

8k_en：电话 8k 英语；
⾮电话场景：

16k_zh：16k 中⽂普通话通
⽤；

16k_zh_video：16k ⾳视频领
域；

16k_en：16k 英语；
16k_ca：16k 粤语；
16k_ja：16k ⽇语；
16k_zh_edu：中⽂教育；
16k_en_edu：英⽂教育；
16k_zh_medical：医疗；
16k_th：泰语；
16k_zh_dialect：多⽅⾔，⽀
持23种⽅⾔。
极速 ASR 仅⽀持8k_zh、
16k_zh、16k_en、
16k_zh_video

ChannelNum Request.SpeechRecognition

仅⽀持⾮极速 ASR
语⾳声道数：

1 表⽰单声
道.EngineModelType 为⾮电
话场景仅⽀持单声道；

2 表⽰双声道（仅⽀持 8k_zh 
引擎模型 双声道应分别对应
通话双⽅）。

Integer 是

ResTextFormat Request.SpeechRecognition

仅⽀持⾮极速 ASR
识别结果返回形式：

0 表⽰识别结果⽂本（含分段
时间戳）；

1 词级别粒度的详细识别结
果,不含标点，含语速值.（词
时间戳列表，⼀般⽤于⽣成字

幕场景）

2 词级别粒度的详细识别结果
（包含标点、语速值）。

Integer 是

FilterDirty Request.SpeechRecognition

是否过滤脏词（⽬前⽀持中⽂

普通话引擎）：

0 表⽰不过滤脏词；
1 表⽰过滤脏词；
2 表⽰将脏词替换为 *。
默认值为 0。

Integer 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2147 共2247⻚

FilterModal Request.SpeechRecognition 是否过语⽓词（⽬前⽀持中⽂

普通话引擎）：

0 表⽰不过滤语⽓词；
1 表⽰部分过滤；
2 表⽰严格过滤 。
默认值为 0。

Integer 否

ConvertNumMode Request.SpeechRecognition

是否进⾏阿拉伯数字智能转换

（⽬前⽀持中⽂普通话引

擎）：

0 表⽰不转换，直接输出中⽂
数字；

1 表⽰根据场景智能转换为阿
拉伯数字。

3 表⽰打开数学相关数字转
换。仅⾮极速 ASR ⽀持
默认值为 0。

Integer 否

SpeakerDiarization Request.SpeechRecognition

是否开启说话⼈分离：

0 表⽰不开启；
1 表⽰开启(仅⽀持8k_zh，
16k_zh，16k_zh_video，单
声道⾳频)。
默认值为 0。
注意：8k电话场景建议使⽤
双声道来区分通话双⽅，设置

ChannelNum=2即可，不⽤开
启说话⼈分离。

Integer 否

SpeakerNumber Request.SpeechRecognition

仅⽀持⾮极速ASR
说话⼈分离⼈数（需配合开启

说话⼈分离使⽤），取值范

围：0-10。
0代表⾃动分离（⽬前仅⽀持
≤6个⼈），1-10代表指定说
话⼈数分离。默认值为 0。

Integer 否

FilterPunc Request.SpeechRecognition

是否过滤标点符号（⽬前⽀持

中⽂普通话引擎）：

0 表⽰不过滤。
1 表⽰过滤句末标点。
2 表⽰过滤所有标点。
默认值为 0。

Integer 否

OutputFileType Request.SpeechRecognition 输出⽂件类型，可选txt、
srt。默认为txt

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2148 共2247⻚

极速ASR仅⽀持txt

FlashAsr Request.SpeechRecognition 是否开启极速 ASR，可选 
true、false。默认为 false

String 否

Format Request.SpeechRecognition

极速 ASR ⾳频格式。⽀持 
wav、pcm、ogg-opus、
speex、silk、mp3、m4a、
aac。

String

当 
FlashAsr 
为 true 时
必选

FirstChannelOnly Request.SpeechRecognition

极速 ASR 参数。表⽰是否只
识别⾸个声道，默认为1。
0：识别所有声道；1：识别
⾸个声道。

Integer 否

WordInfo Request.SpeechRecognition

极速 ASR 参数。表⽰是否显
⽰词级别时间戳，默认为0。
0：不显⽰；1：显⽰，不包
含标点时间戳，2：显⽰，包
含标点时间戳。

Integer 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2149 共2247⻚

<Response>

    <Template>

        <Tag>SpeechRecognition</Tag>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime></CreateTime>

        <UpdateTime></UpdateTime>

        <BucketId></BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2150 共2247⻚

            <EngineModelType>16k_zh</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

TemplateId Response.Template 模板 ID String

Name Response.Template 模板名称 String

BucketId Response.Template 模板所属存储桶 String

Category Response.Template 模板属性，Custom 或者 Official String

Tag Response.Template 模板类型，SpeechRecognition String

UpdateTime Response.Template 更新时间 String

CreateTime Response.Template 创建时间 String

SpeechRecognition Response.Template 同请求体中的 
Request.SpeechRecognition

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2151 共2247⻚

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2152 共2247⻚

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2153 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2154 共2247⻚

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

        </SpeechRecognition>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2155 共2247⻚

查询 AI 内容识别模板
DescribeTemplates
最近更新时间：2024-01-23 10:00:02

功能描述

查询模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2156 共2247⻚

GET /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2157 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

请求参数

参数的具体内容如下：

节点名称（关键

字）

⽗节

点
描述 类型 必选

tag ⽆ 模板类型，默认值：All String 否

category ⽆
Official（系统预设模板），Custom（⾃定义模板），默认
值：Custom

String 否

ids ⽆ 模板 ID，以  , 符号分割字符串 String 否

name ⽆ 模板名称前缀 String 否

pageNumber ⽆ 第⼏⻚，默认值：1 Integer 否

pageSize ⽆ 每⻚个数，默认值：10 Integer 否

tag ⽀持以下⼏种类型:

模板类型 tag

语⾳识别 SpeechRecognition

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2158 共2247⻚

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2159 共2247⻚

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

TotalCount Response 模板总数 Int

PageNumber Response 当前⻚数，同请求中的 
pageNumber

Int

PageSize Response 每⻚个数，同请求中的 pageSize Int

TemplateList Response 模板数组 Container 数组

对于不同的模板类型，TemplateList 内容同创建模板接⼝的 Response，请参照链接 语⾳识别。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

案例⼀：按照模板 ID 维度查询

请求

https://www.tencentcloud.com/document/product/1045/50303
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2160 共2247⻚

GET /template?ids=t1847cd4ca57f543e89f551dbe68169eb9,t1a30a323f55434a29b25bf2a16bdf

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2161 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TemplateList>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2162 共2247⻚

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t1a30a323f55434a29b25bf2a16bdf5f59</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <SpeechRecognition>

            <EngineModelType>8k_zh_s</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <NonExistTIDs>

        <TemplateId>C</TemplateId>

    </NonExistTIDs>

</Response>

案例⼆：按照分⻚列表维度查询

请求



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2163 共2247⻚

GET /template?pageSize=10&pageNumber=1 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2164 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2165 共2247⻚

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t1a30a323f55434a29b25bf2a16bdf5f59</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <SpeechRecognition>

            <EngineModelType>8k_zh_s</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2166 共2247⻚

更新 AI 内容识别模板
更新语⾳识别模板
最近更新时间：2024-01-23 10:00:02

功能描述

更新语⾳识别模板。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2167 共2247⻚

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2168 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2169 共2247⻚

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 必选

Request ⽆
同创建语⾳识别模板接⼝的 
Request 

Container 是

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/50303#Request
https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2170 共2247⻚

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2171 共2247⻚

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

        </SpeechRecognition>

    </Template>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆
同创建语⾳合成模板接⼝的 
Response 

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/50303
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2172 共2247⻚

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2173 共2247⻚

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2174 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2175 共2247⻚

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

        </SpeechRecognition>

    </Template>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2176 共2247⻚

批量任务接⼝

触发任务（独⽴节点）
最近更新时间：2024-01-23 10:00:02

功能描述

通过独⽴任务参数触发批量数据处理任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2177 共2247⻚

POST /inventorytriggerjob HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。

https://www.tencentcloud.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2178 共2247⻚

通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

    <Name>demo</Name>

https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/43609


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2179 共2247⻚

    <Type>Job</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <UserData>this is my inventorytriggerjob</UserData>

        <CallBack>https://www.callback.com</CallBack>

        <Tag>Transcode</Tag>

        <JobParam>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        </JobParam>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

        </Output>

        <JobLevel>0</JobLevel>

    </Operation>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Name Request
存量触发任务名称，⽀持中

⽂、英⽂、数字、—和_，⻓
度限制128字符

String 是

Type Request 批量处理任务类型：Job String 是

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2180 共2247⻚

Container 类型 Input 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Manifest Request.Input COS 清单列表⽂件名，COS 清单⽣成的 
manifest.json ⽂件

String 否

UrlFile Request.Input URL ⽂件名，⽂件中每⾏的 URL 为⼀个 COS 
中对象的访问地址

String 否

Prefix Request.Input Object 前缀 String 否

Object Request.Input 媒体⽂件名 String 否

Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否必

选

TimeInterval Request.Operation 按时间过滤的触发范围 Container 否

Tag Request.Operation 创建的媒体任务类型 Tag String 是

Output Request.Operation

输出地址信息 
当媒体任务类型不为 VideoTag 、 
ExtractDigitalWatermark 、 
MediaInfo 、 QualityEstimate 时，该
参数必选

Container 否

JobParam Request.Operation 任务参数 Container 是

QueueId Request.Operation 队列 ID String 是

UserData Request.Operation ⽤户信息 String 否

JobLevel Request.Operation 任务优先级，级别限制：0 、1 、2。级
别越⼤任务优先级越⾼，默认为0

String 否

CallBackFormat Request.Operation 任务回调格式，JSON 或 XML，默认 
XML，优先级⾼于队列的回调格式

String 否

CallBackType Request.Operation 任务回调类型，Url 或 TDMQ，默认 
Url，优先级⾼于队列的回调类型

String 否

CallBack Request.Operation
任务回调地址，优先级⾼于队列的回调

地址。设置为 no 时，表⽰队列的回调
地址不产⽣回调

String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2181 共2247⻚

CallBackMqConfig Request.Operation 任务回调 TDMQ 配置，当 
CallBackType 为 TDMQ 时必填

Container 否

Container 类型 CallBackMqConfig 的具体数据描述如下：

节点名称

（关键字）
⽗节点 描述 类型

是否

必选

MqRegion Request.Operation.CallBackMqConfig

消息队列所属园区，⽬前⽀持园

区 sh（上海）、bj（北京）、gz
（⼴州）、cd（成都）、hk（中
国⾹港）

String 是

MqMode Request.Operation.CallBackMqConfig

消息队列使⽤模式，默认 
Queue。
主题订阅：Topic 
队列服务: Queue

String 是

MqName Request.Operation.CallBackMqConfig TDMQ 主题名称 String 是

Operation.Tag ⽀持的类型如下：

任务类型 Tag

视频转动图 Animatin

智能封⾯ SmartCover

⾳视频转码 Transcode

视频截图 Snapshot

语⾳识别 SpeechRecognition

⾳视频拼接 Concat

⼈声分离 VoiceSpearte

精彩集锦 VideoMontage

SDR to HDR SDRtoHDR

⼈声分离 VoiceSeparate

视频增强 VideoProcess

超级分辨率 SuperResolution



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2182 共2247⻚

⾳视频转封装 Segment

视频标签 VideoTag

图⽚处理 PicProcess

数字⽔印 DigitalWatermark

提取数字⽔印 ExtractDigitalWatermark

异步获取媒体信息 MediaInfo

⾳视频流分离 StreamExtract

语⾳合成 Tts

⾳频降噪 NoiseReduction

视频质量分析 QualityEstimate

Container 类型 TimeInterval 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是

否

必

选

默

认

值

限制

Start Request.Operation.TimeInterval 开始

时间
String 否 0

扫描对象的上传时

间

%Y-%m-
%dT%H:%m:%S%z

End Request.Operation.TimeInterval 结束

时间
String 否

当

前

时

间

扫描对象的上传时

间

%Y-%m-
%dT%H:%m:%S%z

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是

否

必

选

限制

Region Request.Operation.Output 存储桶的地域 String 是 ⽆



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2183 共2247⻚

Bucket Request.Operation.Output 存储桶的名称 String 是 ⽆

Object Request.Operation.Output 结果⽂件名称 String 否

当媒体任务类型不为 Sna
、 StreamExtract 时，该参
当媒体任务类型为SmartC
Request.Operation.JobPa
⼤于1时，必须包含 ${Nu
当媒体任务类型为 Snaps
Snapshot.Count ⼤于1时，
参数

AuObject Request.Operation.Output ⼈声结果⽂件

名
String 否

当媒体任务类型为 VideoS
效，且不能和 Object 同时

SpriteObject Request.Operation.Output 雪碧图名 String 否

当媒体任务类型为 Snaps
且不能和 Object 同时为空
当 Snapshot.Count ⼤于1
${Number} 参数
仅⽀持 jpg

StreamExtract Request.Operation.Output

流分离结果⽂

件配置信息，

当媒体任务类

型为 
StreamExtract 
时该参数有

效，且必选

Container 是 ⽆

Container 类型 StreamExtract 的具体数据描述如下：

节点名称（关键字） ⽗节点 描述 类型

是

否

必

选

TemplateId Request.Operation.JobParam 模板 ID String 否

TranscodeTemplateId Request.Operation.JobParam

转码模板 ID，当媒体任务
类型为 VideoProcess 、
SuperResolution 、 
SDR2HDR 时有效

Container 否

Animation Request.Operation.JobParam 动图任务参数，当媒体任

务类型为 Animation 时有效
Container 否

Transcode Request.Operation.JobParam 转码任务参数，当媒体任

务类型为 Transcode 、
String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2184 共2247⻚

VideoProcess 、
SuperResolution 、 
SDR2HDR 时该参数有效

SmartCover Request.Operation.JobParam
智能封⾯任务参数，当媒

体任务类型为 SmartCover 
时有效

Container 否

DigitalWatermark Request.Operation.JobParam

数字⽔印参数，当媒体任

务类型为 Transcode 、
VideoProcess 、
SuperResolution 、 
DigitalWatermark 时该参数
有效

Container 否

Watermark Request.Operation.JobParam

指定⽔印模板参数，同创

建⽔印模板 
CreateMediaTemplate 接
⼝的 
Request.Watermark，当媒
体任务类型为 Transcode 
、 SDR2HDR 、 
VideoProcess 、 
SuperResolution 时该参数
有效

Container 否

RemoveWatermark Request.Operation.JobParam
指定去除⽔印参数，当媒

体任务类型为 Transcode 
时有效

Container 否

WatermarkTemplateId Request.Operation.JobParam

指定⽔印模板参数，同创

建⽔印模板 
CreateMediaTemplate 接
⼝的 Request.Watermark 
，当媒体任务类型为 
Transcode 、 SDR2HDR 
、 VideoProcess 、 
SuperResolution 时该参数
有效

Container 否

RemoveWatermark Request.Operation.JobParam
指定去除⽔印参数，当媒

体任务类型为 Transcode 
时有效

Container 否

Snapshot Request.Operation.JobParam 截图任务参数，当媒体任

务类型为 Snapshot 时有效
Container 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2185 共2247⻚

SpeechRecognition Request.Operation.JobParam 语⾳识别任务参数，当媒

体任务类型为 
SpeechRecognition 时有效

Container 否

ConcatTemplate Request.Operation.JobParam 拼接任务参数，当媒体任

务类型为 Concat 时有效
Container 否

VoiceSeparate Request.Operation.JobParam
⼈声分离任务参数，当媒

体任务类型为 
VoiceSeparate 时有效

Container 否

VideoMontage Request.Operation.JobParam
精彩集锦任务参数，当媒

体任务类型为 
VideoMontage 时有效

Container 否

SDRtoHDR Request.Operation.JobParam
SDR2HDR 任务参数，当
媒体任务类型为 
SDRtoHDR 时有效

Container 否

VideoProcess Request.Operation.JobParam
视频增强任务参数，当媒

体任务类型为 
VideoProcess 时有效

Container 否

SuperResolution Request.Operation.JobParam
超分辨率任务参数，当媒

体任务类型为 
SuperResolution 时有效

Container 否

Segment Request.Operation.JobParam
转封装任务参数，当媒体

任务类型为 Segment 时有
效

Container 否

ExtractDigitalWatermark Request.Operation.JobParam

提取数字⽔印任务参数，

当媒体任务类型为 
ExtractDigitalWatermark 时
有效

Container 否

VideoTag Request.Operation.JobParam
视频标签任务参数，当媒

体任务类型为 VideoTag 时
有效

Container 否

TtsTpl Request.Operation.JobParam 语⾳合成模板参数，当媒

体任务类型为 Tts 时有效
Container 否

注意：

 优先使⽤ TemplateId，⽆ TemplateId 时使⽤对应任务类型的参数。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2186 共2247⻚

Container 类型 DigitalWatermark 的具体数据描述如下：

节点名称

（关键

字）

⽗节点 描述 类型
必

选

Message Request.Operation.JobParam.DigitalWatermark

数字⽔印嵌⼊的字符串信

息，⻓度不超过64个字
符，仅⽀持中⽂、英⽂、

数字、_、-和*

String 是

Type Request.Operation.JobParam.DigitalWatermark ⽔印类型，当前仅可设置

为 Text
String 是

Version Request.Operation.JobParam.DigitalWatermark ⽔印版本，当前仅可设置

为 V1
String 是

IgnoreError Request.Operation.JobParam.DigitalWatermark

当添加⽔印失败是否忽略

错误继续执⾏任务，限制

为 true/false，默认为
false
当 
Request.Operation.Tag 
为 DigitalWatermark 时，
该参数⽆效，添加⽔印失

败任务失败

String 否

Container 类型 Animation 的内容： 

同 提交动图任务 的 Request.Operation.Animation
Container 类型 Transcode 的内容： 
同 提交⾳视频转码任务 的 Request.Operation.Transcode
Container 类型 Watermark 的内容： 
同 提交⾳视频转码任务 的 Request.Operation.Watermark

Container 类型 RemoveWatermark 的内容： 
同 提交⾳视频转码任务 的 Request.Operation.RemoveWatermark
Container 类型 SmartCover 的内容：
同 提交智能封⾯任务 的 Request.Operation.SmartCover
Container 类型 Snapshot 的内容： 
同 提交截图任务 的 Request.Operation.Snapshot

Container 类型 SpeechRecognition 的内容： 
同 提交语⾳识别任务 的 Request.Operation.SpeechRecognition

https://www.tencentcloud.com/document/product/1045/49569
https://www.tencentcloud.com/document/product/1045/48941
https://www.tencentcloud.com/document/product/1045/48941
https://www.tencentcloud.com/document/product/1045/48941
https://www.tencentcloud.com/document/product/1045/48937
https://www.tencentcloud.com/document/product/1045/48938


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2187 共2247⻚

Container 类型 ConcatTemplate 的内容： 
同 提交拼接任务 的 Request.Operation.ConcatTemplate
Container 类型 VoiceSeparate 的内容： 

同 提交⼈声分离任务 的 Request.Operation.VoiceSeparate
Container 类型 VideoMontage 的内容： 
同 提交精彩锦集任务 的 Request.Operation.VideoMontage
Container 类型 SDRtoHDR 的内容： 
同 提交SDRtoHDR任务 的 Request.Operation.SDRtoHDR

Container 类型 VideoProcess 的内容： 
同 提交视频增强任务 的 Request.Operation.VideoProcess
Container 类型 SuperResolution 的内容： 
同 提交超分辨率任务 的 Request.Operation.SuperResolution
Container 类型 Segment 的内容： 
同 提交流分离任务 的 Request.Operation.Segment

Container 类型 ExtractDigitalWatermark 的内容： 
同 提交提取数字⽔印任务 的 Request.Operation.ExtractDigitalWatermark
Container 类型 VideoTag 的内容： 
同 提交智能视频标签任务 的 Request.Operation.VideoTag
Container 类型 TtsTpl 的内容： 

同 提交语⾳合成任务 的 Request.Operation.TtsTpl

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/48929
https://www.tencentcloud.com/document/product/1045/48946
https://www.tencentcloud.com/document/product/1045/48943
https://www.tencentcloud.com/document/product/1045/48935
https://www.tencentcloud.com/document/product/1045/48944
https://www.tencentcloud.com/document/product/1045/48940
https://www.tencentcloud.com/document/product/1045/48936
https://www.tencentcloud.com/document/product/1045/48931
https://www.tencentcloud.com/document/product/1045/48945
https://www.tencentcloud.com/document/product/1045/48942
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2188 共2247⻚

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==<RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2189 共2247⻚

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <Tag>Transcode</Tag>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关键

字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State为 Failed 时有意义 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2190 共2247⻚

Message Response.JobsDetail 错误描述，只有 State为 Failed 时有意义 String

Type Response.JobsDetail 批量处理任务类型，Job String

Name Response.JobsDetail 新创建任务的名称 String

JobId Response.JobsDetail 新创建任务的 ID String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

Input Response.JobsDetail 该任务的输⼊资源地址，同请求中的 
Request.Input 节点

Container

Operation Response.JobsDetail 该任务的操作规则，同请求中的 Request.Input 
Operation

Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2191 共2247⻚

POST /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Name>demo</Name>

    <Type>Job</Type>

    <Input>

        <Prefix>input</Prefix>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2192 共2247⻚

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <UserData>this is my inventorytriggerjob</UserData>

        <CallBack>https://www.callback.com</CallBack>

        <Tag>Transcode</Tag>

        <JobParam>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        </JobParam>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

        </Output>

        <JobLevel>0</JobLevel>

    </Operation>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2193 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==<RequestId>

    <JobsDetail>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2194 共2247⻚

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <Tag>Transcode</Tag>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2195 共2247⻚

触发任务（⼯作流）
最近更新时间：2024-01-23 10:00:02

功能描述

通过⼯作流触发批量数据处理任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2196 共2247⻚

POST /inventorytriggerjob HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2197 共2247⻚

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求操作的实现需要有如下请求体。

<Request>

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896
https://www.tencentcloud.com/document/product/1045/49351


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2198 共2247⻚

    <Name>demo</Name>

    <Type>Workflow</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

    </Operation>

</Request>

具体的数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

Request ⽆ 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型

是否必

选

Name Request 批量触发任务名称，⽀持中⽂、英⽂、数字、—和
_，⻓度限制128字符

String 是

Type Request 批量处理任务类型: Workflow String 否

Input Request 待操作的媒体信息 Container 是

Operation Request 操作规则 Container 是

Container 类型 Input 的具体数据描述如下：

节点名称（关

键字）
⽗节点 描述 类型 是否必选

Manifest Request.Input COS 清单列表⽂件名，COS 清单⽣成的 
manifest.json ⽂件

String 否

UrlFile Request.Input URL ⽂件名，⽂件中每⾏的 URL 为⼀个 COS 
中对象的访问地址

String 否

Prefix Request.Input Object 前缀 String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2199 共2247⻚

Object Request.Input 媒体⽂件名 String 否

Container 类型 Operation 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型 是否必选

WorkflowIds Request.Operation 触发的⼯作流 ID String 是

TimeInterval Request.Operation 按时间过滤的触发

范围
Container 否

Container 类型 TimeInterval 的具体数据描述如下：

节点名称（关键

字）
⽗节点 描述 类型

是否

必选
默认值 限制

Start Request.TimeInterval 开始时

间
String 否 0

扫描对象的上传时

间

%Y-%m-
%dT%H:%m:%S%z 

End Request.TimeInterval 结束时

间
String 否

当前时

间

扫描对象的上传时

间

%Y-%m-
%dT%H:%m:%S%z 

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/49352


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2200 共2247⻚

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <Type>Workflow</Type>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2201 共2247⻚

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

JobsDetail Response 任务的详细信息 Container

Container 节点 JobsDetail 的内容：

节点名称（关

键字）
⽗节点 描述 类型

Code Response.JobsDetail 错误码，只有 State 为 Failed 时有意义 String

Message Response.JobsDetail 错误描述，只有 State 为 Failed 时有意义 String

Type Response.JobsDetail 批量处理任务类型 String

Name Response.JobsDetail 新创建任务的名称 String

JobId Response.JobsDetail 新创建任务的 ID String

State Response.JobsDetail 任务的状态，为 Submitted、Running、Success、
Failed、Pause、Cancel 其中⼀个

String

CreationTime Response.JobsDetail 任务的创建时间 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2202 共2247⻚

StartTime Response.JobsDetail 任务的开始时间 String

EndTime Response.JobsDetail 任务的结束时间 String

Input Response.JobsDetail 同请求中的 Request.Input Container

Operation Response.JobsDetail 同请求中的 Request.Operation Container

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2203 共2247⻚

POST /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Name>demo</Name>

    <Type>Workflow</Name>

    <Input>

        <Prefix>input</Prefix>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2204 共2247⻚

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

    </Operation>

</Request>

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2205 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2206 共2247⻚

        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2207 共2247⻚

取消任务
最近更新时间：2024-01-23 10:00:02

功能描述

取消批量数据处理任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2208 共2247⻚

PUT /inventorytriggerjob/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2209 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该请求⽆响应体。

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/49351
https://www.tencentcloud.com/document/product/1045/49352
https://www.tencentcloud.com/document/product/1045/49353


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2210 共2247⻚

PUT /inventorytriggerjob/b-xxx-xxx-xxx-xxxx?cancel HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2211 共2247⻚

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2212 共2247⻚

查询任务
最近更新时间：2024-03-01 18:06:24

功能描述

查询批量数据处理任务。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2213 共2247⻚

GET /inventorytriggerjob/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2214 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求的请求体为空。

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2215 共2247⻚

<Response>

    <RequestId><RequestId>

    <JobsDetail>

    ...

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

具体的数据内容如下：

节点名称（关键字） ⽗节点 描述 类型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2216 共2247⻚

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

JobsDetail Response 任务的详细信息 Container

NonExistJobIds Response 查询的 ID 中不存在的任务，所有任务都存在时不返回 String

对于不同的触发⽅式，JobsDetail 的内容不同，请参照以下链接：
⼯作流

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/47029
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2217 共2247⻚

GET /inventorytriggerjob/b3deffea2f84911ec9cb15254008618d9 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2218 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==</RequestId>

    <JobsDetail>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2219 共2247⻚

        <Code>Success</Code>

        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2220 共2247⻚

批量拉取任务
最近更新时间：2024-01-23 10:00:02

功能描述

拉取批量数据处理任务列表。

请求

请求⽰例



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2221 共2247⻚

GET /inventorytriggerjob?size=&states=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参⻅ 请求签名 ⽂档）。
通过⼦账号使⽤时，需要授予相关的权限，详情请参⻅ 授权粒度详情 ⽂档。

https://www.tencentcloud.com/document/product/436/7778
https://www.tencentcloud.com/document/product/1045/49896


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2222 共2247⻚

请求头

此接⼝仅使⽤公共请求头部，详情请参⻅ 公共请求头部 ⽂档。

请求体

该请求⽆请求体。

请求参数

参数的具体内容如下：

节点名称（关键

字）
⽗节点 描述 类型 必选

nextToken ⽆ 请求的上下⽂，⽤于翻⻚。上次返回的值 String 否

size ⽆ 拉取的最⼤任务数。默认为10。最⼤为100 Integer 否

type ⽆
拉取批量任务类型，⼯作流类型 Workflow 、任务类
型 Job

String 否

orderByTime ⽆ Desc 或者 Asc。默认为 Desc String 否

states ⽆

拉取该状态的任务，以,分割⽀持多状态 All，
Submitted，Running，Success，Failed，Pause，
Cancel。默认为 All

String 否

startCreationTime ⽆
拉取创建时间⼤于等于该时间的任务。格式

为：  %Y-%m-%dT%H:%m:%S%z  
String 否

endCreationTime ⽆
拉取创建时间⼩于等于该时间的任务。格式

为：  %Y-%m-%dT%H:%m:%S%z 
String 否

workflowId ⽆ ⼯作流 ID String 否

jobId ⽆ 批量触发任务 ID String 否

name ⽆ 批量触发任务名称 String 否

响应

响应头

此接⼝仅返回公共响应头部，详情请参⻅ 公共响应头部 ⽂档。

响应体

https://www.tencentcloud.com/document/product/1045/43609
https://www.tencentcloud.com/document/product/1045/43610


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2223 共2247⻚

该响应体返回为 application/xml 数据，包含完整节点数据的内容展⽰如下：

<Response>

    <RequestId></RequestId>

    <JobsDetail>

    ...

    </JobsDetail>

    <NextToken></NextToken>

</Response>

具体的数据内容如下：



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2224 共2247⻚

节点名称（关键字） ⽗节点 描述 类型

Response ⽆ 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） ⽗节点 描述 类型

RequestId Response 请求的唯⼀ ID String

JobsDetail Response 任务的详细信息 Container 数组

NextToken Response 翻⻚的上下⽂ Token String

对于不同的触发⽅式，JobsDetail 的内容不同，请参照以下链接：
独⽴任务

⼯作流

错误码

该请求操作⽆特殊错误信息，常⻅的错误信息请参⻅ 错误码 ⽂档。

实际案例

请求

https://www.tencentcloud.com/document/product/1045/47029#jobsDetail
https://www.tencentcloud.com/document/product/1045/33700


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2225 共2247⻚

GET /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2226 共2247⻚

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==</RequestId>

    <JobsDetail>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2227 共2247⻚

        <Code>Success</Code>

        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2228 共2247⻚

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <NextToken>25</NextToken>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2229 共2247⻚

错误码
最近更新时间：2024-01-23 10:00:02

功能说明

图⽚下载失败时，返回包 Headers 中的 X-ErrNo 为错误码字段，请参考下表进⾏处理。
说明：

 其他透传⾃ COS 下载侧错误码详⻅ COS 错误码。

错误码列表

下载时处理错误码

错误码 说明 处理措施

-103 ⽆效的请求；请求报⽂⽆法识别。 请检查请求内容。

-104 ⽆效的 APPID，URL 中包含的 APPID ⽆效，或者
域名没有和 APPID 绑定。

请检查 APPID 是否正确。

-105 ⽆效的样式名，URL 中指定的样式名或者别名没有
配置。

请检查样式配置或样式名内容。

-106 ⽆效的 URL，URL 格式不符合格式要求。 请检查 URL 格式。

-107 ⽆效的 Host 头域。 请检查 Host 是否正确。

-108 ⽆效的 Referer。 请检查相关 Referer 配置。

-109
⽆效的样式名 ID。没有找到该样式名对应的图⽚。
可能是上传该图⽚后，新增的样式名， 因此图⽚上
传时不能⽣成该样式名对应的数据。

-

-110 该图⽚在⿊名单中。 -

-113 该⽂档的类型不⽀持
⽂档预览⽬前所⽀持的输⼊⽂件类型，请

参⻅ 规则与限制

-120 回源到源站获取数据时，源站返回的数据有异常，

⽆法正常获取到图⽚数据。
请检查源站数据。

-124 下载偏移错误。HTTP 请求的 Range 断点续传偏移 请检查断点续传偏移量的相关配置。

https://www.tencentcloud.com/document/product/436/7730
https://www.tencentcloud.com/document/product/1045/33425


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第2230 共2247⻚

量可能设置错误。

-154 原图保护机制禁⽌该 URL 下载。 请使⽤样式访问。

-156 强制执⾏302流程。 -

-162 业务配置为⽋费，禁⽌下载图⽚。 请及时充值。

-163 业务配置不存在。 请检查相关配置项。

-164 热图下载，限制。
请降低请求频率，或 提交⼯单 联系我们处
理。

-165 攻击性下载请求，限制。 -

-166 消息格式错误。 -

-167 ⽂件太⼤，⽆法⽀持图⽚下载。 请降低图⽚⼤⼩。

-441 图⽚格式不符，⽆法进⾏压缩。

请使⽤数据万象⽀持的图⽚格式进⾏图⽚

处理操作。具体⽀持格式为 jpg、bmp、
gif、png、webp。

-442 图⽚超过限制⼤⼩。 请将图⽚⻓宽限制在9999像素以内。

-443 图⽚格式不满⾜处理限制。
请使⽤⽀持的图⽚格式进⾏处理，详情请

参⻅ 规则与限制

-447 图⽚分辨率超出限制或动图帧数过多。
请将图⽚⻓宽限制在9999像素以内（动图
请限制帧数）。

-901 压缩超时。 -

-902 回源超时，镜像存储功能把请求转发到开发商源

站，但没有收到响应，超时了。
请检查源站数据或回源配置。

-3006 该⽂档被加密，⽆法解析。 -

-3008 该⽂件为空⽂件，⽆法解析。 -

-3011 该⽂档的类型不⽀持。
⽂档预览⽬前所⽀持的输⼊⽂件类型，请

参⻅ 规则与限制

-3015 请求的⻚码不存在。 -

-3075 该⽂档超过100MB，⽆法解析。 输⼊⽂件⼤⼩需限制在100MB之内

-5062 图⽚涉嫌违禁。 请检查图⽚内容是否违规。

https://console.tencentcloud.com/workorder/category
https://www.tencentcloud.com/document/product/1045/33425
https://www.tencentcloud.com/document/product/1045/33425
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-6101 图⽚不存在、图⽚没有上传或者图⽚已经删除。 请检查请求源数据。

-29033 下载请求⽆有效的 range。 -

-29034 下载的 offset ⼤于⽂件 size。 -

-29214 触发频控。
请降低请求频率，或 提交⼯单 联系我们处
理。

-40168 原图为空数据。 请检查请求源数据。

-46152 ⾮法的 bucketName。 请检查存储桶名称是否正确。

-46154 ⾮法的 APPID。 请检查 APPID 是否正确。

-46614 ⽂件尚未上传完成，禁⽌下载。 请等待⽂件上传成功后请求。

-46617 命中⿊名单。 请检查图⽚内容是否违规。

-46618 签名校验失败。 请检查签名是否准确。

-46619 签名过期。 请更新签名。

-46620 Bucket 被封禁。 您的 Bucket 已被封禁，请 提交⼯单 联系
我们处理。

-46621 ⽂件被封禁。
您的资源已被封禁，请 提交⼯单 联系我们
处理。

-46627 ⽤户⽬前在⿊名单中。
您的账号已被封禁，请 提交⼯单 联系我们
处理。

-46628 ⽂件不存在。 请确认请求下载的⽂件是否真实存在。

-46642 APPID 不存在。 请检查 APPID 是否正确。

-46646 ⽂件已封禁。
⽂件已被封禁，请检查⽂件内容是否违

规。

-46661 ⽆权访问 请联系资源所有者授予权限。

持久化处理错误码

错误码 说明 处理措施

-60998 图⽚处理参数⽆效。 请检查图⽚处理规则是否正确。

-60997 图⽚处理规则过多。 持久化处理当前最多⽀持五条规则，请控制在五条以内。

https://console.tencentcloud.com/workorder/category
https://console.tencentcloud.com/workorder/category
https://console.tencentcloud.com/workorder/category
https://console.tencentcloud.com/workorder/category
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-60996 ⽂件太⼤，⽆法处

理。

请将⽂件控制在32MB以内。

-60987 图⽚获取失败。 请检查图⽚ URL。

-60983 ⽆效的 Host。 请检查 Host。

-60972 ⽆效地域。
请检查请求地域是否⽀持数据万象服务。数据万象现有地域详⻅ 地域与域
名。

-60967 图⽚样式不存在。 请检查图⽚样式。

-60957 样式数量超过上限。 当前样式数量上限为100条，如需更多样式请 提交⼯单 联系我们。

-60955 ⽆效的 URL。 请检查 URL 是否正确。

-60950 未指定⽂件。 请在请求中指定需要处理的⽂件。

-60949 请求频率过⾼。 请放缓请求频率。如有需要请 提交⼯单 联系我们提升频率限制。

-60948 账号涉嫌违规。 您的 APPID 已被封禁，请 提交⼯单 联系我们处理。

-60938 签名信息不完整。 请检查签名信息中的必选项。

-60936 请求被拒绝。 AccessDenied。

-60932 签名错误。 签名⽆效，请检查签名信息是否匹配。

-62999 ⽆效的图⽚格式。 请检查图⽚格式是否正确。

⽂档预览错误码

错误

码
说明 处理措施

-3006 ⽂档为加密⽂件 建议使⽤已解密的⽂档。

-3008 ⽂档⻓度为0 请确认⽂档是否正常。

-3011 ⽂档类型不⽀持
请确认⽂档是否在⽀持范围内，⽀持的⽂档类型详情请参⻅ 规则与限
制。

-3015 请求的⻚数超过了⽂档总

⻚数
请检查请求⻚数是否正确。

内容审核错误码

错误码 说明 处理措施

https://www.tencentcloud.com/document/product/1045/33423
https://console.tencentcloud.com/workorder/category
https://console.tencentcloud.com/workorder/category
https://console.tencentcloud.com/workorder/category
https://www.tencentcloud.com/document/product/1045/33425
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-61011 ⽂件不存在。 请检查⽂件是否存在。

-65007 ⽂件内容错误，解码失败。 请检查⽂件格式是否正确。

-65010 下载⽂件失败。
请检查⽂件链接是否正确，私有读⽂件需

要携带签名。

-65011 ⽂件过⼤，⽆法处理。 当前不⽀持审核过⼤的⽂件。

-65012 图⽚分辨率过⼩，⽆法处理。 当前不⽀持分辨率过⼩的图⽚。

-65013 不符合要求（例如不⽀持识别的⽂件后缀、⽂件过⼤

等），未进⾏处理。
请检查⽂件是否符合规则。

-65014 没有数据万象⾓⾊ CI_QCSRole。 请绑定数据万象⾓⾊。

-65015 未启⽤审核场景。 请使⽤⾄少⼀种审核场景进⾏审核。

-65016 使⽤的 BizType 不存在。 请填写正确的 BizType。

其他 内部错误 ⽆。

媒体处理错误码

错误码 错误信息 说明

1007 InternalError 内部错误

1010 InvalidUrl ⽆效的 url

1011 InvalidContent ⽆效的请求体

1012 MissingAuthorization 缺失签名

1013 InvalidAuthorization ⽆效的签名

1014 SignatureExpired 签名已过期

1015 InvalidArgument ⽆效的参数

1016 MissingContent 缺失请求体

1017 InvalidHost ⽆效的 host

1018 AccessDenied 拒绝访问

1019 SecretidNotExist 密钥不存在
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1020 SlowDown 频率控制

1021 InvalidContentType 请求体类型⽆效

1100 BucketAlreadyBinded 存储桶已绑定

1103 ResourceNotFound 资源未找到

1106 QueueNotFound 队列未找到

1107 TemplateNotFound 模板未找到

1109 BindedBucketNumLimit 绑定的存储桶数量超过上限

1110 CreatedTemplateNumLimit 创建的模板数量超过上限

1111 MediaBucketUnBinded 存储桶未绑定

1112 TemplateNameDuplicate 模板命名重复

1114 ActiveWorkflowForbiddenUpdate 开启的⼯作流禁⽌更新

1120 WorkFlowNumLimit 创建的⼯作流数量超过上限

1124 WriteTargetBucketDenied 禁⽌写⼊存储桶

1145 QueueNumLimit 创建的队列数量超过上限
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附录

结构体
最近更新时间：2024-03-05 14:13:34

MediaWorkflow_Topology_Nodes_Start_Input

节点名称（关键字） 描述 类型 是否必选 限制

ObjectPrefix Object 前缀 String 是 ⽆

QueueId 队列 ID String 是 ⽆

PicProcessQueueId 图⽚处理队列 ID String 当存在图⽚处理节

点时必选
⽆

SpeechRecognitionQueueId 语⾳识别队列 ID String 当存在语⾳识别节

点时必选
⽆

AIProcessQueueId AI 处理队列 ID String 当存在 AI 识别节
点时必选

⽆

NotifyConfig 回调信息，如果不设置，则使⽤

队列的回调信息
Container 否 ⽆

ExtFilter ⽂件后缀过滤器 Container 否 ⽆

Container 类型 NotifyConfig 的具体数据描述如下：

节点名称（关

键字）
描述 类型

是否必

选

默认

值
限制

Url 回调地址 String 是 ⽆ 不能为内⽹地址

Type 回调类型 String 是 ⽆
Url：url 回调
TDMQ：tdmq 消息回调

Event 回调信息 String 是 ⽆

TaskFinish：任务完成
WorkflowFinish：⼯作流完成
⽀持多种事件，以逗号分隔

ResultFormat 回调格式 String 否 XML XML：xml 格式
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JSON：json 格式

MqRegion TDMQ 所属
园区

String 否 ⽆
当回调类型为 TDMQ 时必填，⽀持园区
详⻅ TDMQ请求地域说明 ⽂档

MqMode
TDMQ 使⽤
模式

String 否 ⽆

当回调类型为 TDMQ 时必填。
Topic：主题订阅
Queue：队列服务

MqName TDMQ 主题
名称

String 否 ⽆ 当回调类型为 TDMQ 时必填。

Container 类型 ExtFilter 的具体数据描述如下：

节点名称（关

键字）
描述 类型 是否必选 默认值 限制

State 开关 String 否 Off On/Off

Video 打开视频后缀限

制
String 否 false false/true

Audio 打开⾳频后缀限

制
String 否 false false/true

Image 打开图⽚后缀限

制
String 否 false false/true

ContentType
打开 
ContentType 限
制

String 否 false false/true

Custom 打开⾃定义后缀

限制
String 否 false false/true

CustomExts ⾃定义后缀 String 否 ⽆

多种⽂件后缀以/分
隔，后缀个数不超过

10个
当 Custom 为 true 
时，该参数必填

AllFile 所有⽂件 String 否 false false/true

MediaWorkflow_Topology_Nodes_***_Operation_Output

https://www.tencentcloud.com/document/product/406/12667
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节点名称（关键字） 描述 类型 是否必

选

限制

Region 存储桶的地域 String 是 ⽆

Bucket 存储桶的名称 String 是 ⽆

Object 结果⽂件名称 String 是

当⼯作流节点类型为 Snapshot 或 
SmartCover，且结果⽂件不⽌⼀个
时，必须包含 ${Number} $ 
当⼯作流节点类型为 Segment，设置
了 Duration，且 Format 不为 HLS 或 
m3u8 时，必须包含 ${Number} 

SpriteObject 雪碧图的名称 String 否
当⼯作流节点类型为 Snapshot，且
打开了雪碧图时，该字段必填

AuObject
⼈声结果⽂件名

称
String 否

当⼯作流节点类型为 
VoiceSeparate，且有⼈声输出时，
该字段必填

MediaWorkflow_Topology_Nodes_Snapshot_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

TemplateId 截图模板 ID String 是 ⽆

Output 输出地址 Container，详情请参⻅ Output 是 ⽆

MediaWorkflow_Topology_Nodes_Animation_***_Operation

节点名称（关键

字）
描述 类型 是否必选 限制

TemplateId 视频转动图模板 ID String 是 ⽆

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆

MediaWorkflow_Topology_Nodes_SmartCover_***_Operation
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节点名称（关键

字）
描述 类型 是否必选 限制

TemplateId 智能封⾯模板 ID String 否 ⽆

SmartCover 智能封⾯参数

Container，详情
请参⻅ 
SmartCover

否 ⽆

Output 输出地址
Container，详情
请参⻅Output

是 ⽆

说明：

 TemplateId 和 SmartCover 都可以不设置，默认以原视频⼤⼩⽣成3张封⾯。如果同时设置 TemplateId 和 
SmartCover，TemplateId 优先⽣效。

MediaWorkflow_Topology_Nodes_Transcode_***_Operation

节点名称（关键字） 描述 类型
是否必

选
限制

TemplateId ⾳视频转码模板 
ID

String 否 ⽆

WatermarkTemplateId ⽔印模板 ID String 数组 否
可以使⽤多个⽔印模板，

不超过3个

RemoveWatermark 去除⽔印参数
Container，详情请参
⻅ RemoveWatermark

否 ⽆

DigitalWatermark 数字⽔印参数
Container，详情请参
⻅ DigitalWatermark

否 ⽆

Output 输出地址
Container，详情请参
⻅ Output

是 ⽆

Input 输⼊配置 Container 否 ⽆

Container 类型 MediaWorkflow_Topology_Nodes_Transcode_***_Operation.Input 的具体数据描述如下：

节点名称（关键字） 描述 类型 必选 限制

SpeedTranscodingQueueId 倍速转码队列 String 否 ⽆
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MediaWorkflow_Topology_Nodes_Concat_***_Operation

节点名称（关键

字）
描述 类型 是否必选 限制

TemplateId 拼接模板 ID String 是 ⽆

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆

MediaWorkflow_Topology_Nodes_VoiceSeparate_***_Operation

节点名称（关键

字）
描述 类型 是否必选 限制

TemplateId ⼈声分离模板 ID String 是 ⽆

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆

MediaWorkflow_Topology_Nodes_VideoMontage_***_Operation

节点名称（关键

字）
描述 类型 是否必选 限制

TemplateId 精彩集锦模板 ID String 是 ⽆

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆

MediaWorkflow_Topology_Nodes_SDRtoHDR_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

SDRtoHDR SDRtoHDR 配置 Container 是 ⽆

TranscodeTemplateId ⾳视频转码模板 
ID

String 是 ⽆
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WatermarkTemplateId ⽔印模板 ID String 数组 否 可以使⽤多个⽔

印模板，不超过3
个

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆

Container 类型 SDRtoHDR 的具体数据描述如下：

节点名称（关键

字）
描述 类型 是否必选 限制

HdrMode HDR 标准 String 是
HLG
HDR10

MediaWorkflow_Topology_Nodes_VideoProcess_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

TemplateId 视频增强模板 ID String 是 ⽆

TranscodeTemplateId ⾳视频转码模板 
ID

String 是 ⽆

WatermarkTemplateId ⽔印模板 ID String 数组 否

可以使⽤多个⽔

印模板，不超过3
个

DigitalWatermark 数字⽔印参数

Container，详情
请参⻅ 
DigitalWatermark

否 ⽆

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆

MediaWorkflow_Topology_Nodes_SCF_***_Operation

节点名称（关键

字）
描述 类型 是否必选 限制

SCF SCF 函数信息 Container 是 ⽆
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Container 类型 SCF 的具体数据描述如下：

节点名称（关键

字）
描述 类型 是否必选 限制

Region 函数地域 String 是 ⽆

FunctionName 函数名称 String 是 ⽆

Namespace 命名空间 String 否 ⽆

Alias 函数别名 String 否 ⽆

MediaWorkflow_Topology_Nodes_SuperResolution_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

TemplateId 超级分辨率模板 
ID

String 是 ⽆

TranscodeTemplateId ⾳视频转码模板 
ID

String 是 ⽆

WatermarkTemplateId ⽔印模板 ID String 数组 否

可以使⽤多个⽔

印模板，不超过3
个

DigitalWatermark 数字⽔印参数

Container，详情
请参⻅ 
DigitalWatermark

否 ⽆

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆

MediaWorkflow_Topology_Nodes_Segment_***_Operation

节点名称（关键

字）
描述 类型 是否必选 限制

Segment ⾳视频转封装参数 Container 是 ⽆

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆
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Container 类型 Segment 的具体数据描述如下：

节点名称（关键

字）
描述 类型

是否必

选
限制

Format 封装格式 String 是
aac、mp3、flac、mp4、ts、
mkv、avi、hls、m3u8

Duration 转封装时⻓,单位:
秒

String 否 不⼩于5的整数

HlsEncrypt hls 加密配置 Container 否
只有当封装格式为 hls 时⽣
效，详情请参⻅ HlsEncrypt

MediaWorkflow_Topology_Nodes_PicProcess_***_Operation

节点名称（关键

字）
描述 类型 是否必选 限制

TemplateId 图⽚处理模板 ID String 是 ⽆

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆

MediaWorkflow_Topology_Nodes_Tts_***_Operation

节点名称（关键

字）
描述 类型 是否必选 限制

TemplateId 语⾳合成模板 ID String 是 ⽆

Output 输出地址
Container，详情
请参⻅ Output

是 ⽆

MediaWorkflow_Topology_Nodes_SpeechRecognition_***_Operati
on

节点名称（关键

字）
描述 类型 是否必选 限制
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Output 输出地址 Container，详情
请参⻅ Output

是 ⽆

StreamPackConfig 打包配置 Container 是 ⽆

MediaWorkflow_Topology_Nodes_StreamPackConfig_***_Operatio
n

节点名称（关键

字）
描述 类型 是否必选 限制

StreamPackConfig 打包配置 Container 否 ⽆

Container 类型 StreamPackConfig 的具体数据描述如下：

节点名称（关键

字）
描述 类型 是否必选 限制

PackType 打包类型。默认

值：HLS
String 否 HLS/DASH

IgnoreFailedStream
忽略转码失败的⼦

流，继续打包。默

认值：true
String 否 true/false

MediaWorkflow_Topology_Nodes_VideoStream_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

TemplateId ⾳视频转码模板 
ID

String 否 ⽆

WatermarkTemplateId ⽔印模板 ID String 数组 否

可以使⽤多个⽔

印模板，不超过3
个

RemoveWatermark 去除⽔印参数

Container，详情请
参⻅ 
RemoveWatermark

否 ⽆

Output 输出地址 Container，详情请 是 ⽆
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参⻅ Output

MediaWorkflow_Topology_Nodes_StreamPack_***_Operation

节点名称（关键

字）
描述 类型 是否必选 限制

StreamPackInfo 打包规则 Container 否 ⽆

Container 类型 StreamPackInfo 的具体数据描述如下：

节点名称（关键

字）
描述 类型 是否必选 限制

VideoStreamConfig 视频⼦流配置 Container 否 ⽆

Container 类型 VideoStreamConfig 的具体数据描述如下：

节点名称（关键

字）
描述 类型 是否必选 限制

VideoStreamName 视频⼦流名称 String 是
必须和存在的视频节点

对应

BandWidth

视频⼦流带宽限制，单位

b/s，范围[0, 
2000000000]，0表⽰不限
制

String 否 ⼤于等于0，默认值是0

AudioMix

节点名称（关

键字）
描述 类型 必选 默认值 限制

AudioSource 需要被混⾳的⾳轨媒

体地址
String 是 ⽆

需与Input媒体⽂件存储于
同⼀bucket

MixMode 混⾳模式 String 否 Repeat Repeat:背景⾳循环
Once:背景⾳⼀次播放

Replace 是否⽤混⾳⾳轨媒体

替换Input媒体⽂件的
String 否 false true/false
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原⾳频

EffectConfig 混⾳淡⼊淡出配置 Container 否 false ⽆

Container 类型 EffectConfig 的具体数据描述如下：

节点名称（关键

字）
描述 类型 必选 默认值 限制

EnableStartFadein 开启淡⼊ String 否 false true/false

StartFadeinTime 淡⼊时⻓ String 否 ⽆
⼤于0, ⽀持浮
点数

EnableEndFadeout 开启淡出 String 否 false true/false

EndFadeoutTime 淡出时⻓ String 否 ⽆
⼤于0, ⽀持浮
点数

EnableBgmFade 开启bgm转换
淡⼊

String 否 false true/false

BgmFadeTime bgm转换淡⼊
时⻓

String 否 ⽆
⼤于0, ⽀持浮
点数

CallBackMqConfig

节点名称（关键

字）
描述 类型

是否必

选

MqRegion
消息队列所属园区，⽬前⽀持园区 sh（上海）、
bj（北京）、gz（⼴州）、cd（成都）、hk（中国
⾹港）

String 是

MqMode
消息队列使⽤模式，默认 Queue 
主题订阅：Topic
队列服务: Queue

String 是

MqName TDMQ 主题名称 String 是

DigitalWatermark
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节点名称（关键

字）

描述 类型 是否必

选

限制

Message 嵌⼊数字⽔印的⽔印信息 String 是

⻓度不超过64个字符，仅
⽀持中⽂、英⽂、数字、

_、-和*

Type 数字⽔印类型 String 是 当前仅可设置为 Text

Version 数字⽔印版本 String 是 当前仅可设置为 V1

IgnoreError 当添加⽔印失败是否忽略错误继

续执⾏任务
String 是 限制为 true/false

State
添加⽔印是否成功，执⾏中为

Running，成功为 Success，失败
为 Failed

String 否

该字段不能主动设置，当

任务提交成功时，会返回

该字段

DashEncrypt

节点名称（关

键字）
描述 类型 是否必选 默认值 限制

IsEncrypt 是否开启 DASH 
加密

String 否 false true/false

UriKey DASH 加密的 key String 否 ⽆

当 IsEncrypt 为 
true 时，该参数
才有意义

HlsEncrypt

节点名称（关

键字）
描述 类型 是否必选 默认值 限制

IsEncrypt 是否开启 HLS 
加密

String 否 false true/false

UriKey
HLS 加密的 
key String 否 ⽆

当 IsEncrypt 
为 true 时，该
参数才有意义
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RemoveWatermark

节点名称（关键

字）
描述 类型 是否必选 限制

Dx 距离左上⾓原点 x 
偏移

String 是
值范围：[0, 4096]
单位：px

Dy 距离左上⾓原点 y 
偏移

String 是
值范围：[0, 4096]
单位：px

Width ⽔印的宽度 String 是
值范围：(0, 4096]
单位：px

Height ⽔印的⾼度 String 是
值范围：(0, 4096]
单位：px

SmartCover

节点名称（关键

字）
描述 类型 是否必选 默认值 限制

Format 图⽚格式 String 否 jpg jpg、png 、webp

Width 宽 String 否
视频原始

宽度

值范围：[128，4096]
单位：px
若只设置 Width 时，按照视
频原始⽐例计算 Height

Height ⾼ String 否
视频原始

⾼度

值范围：[128，4096]
单位：px
若只设置 Height 时，按照视
频原始⽐例计算 Width

Count 截图数量 String 否 3 [1,10]

DeleteDuplicates 封⾯去重 String 否 false true/false


